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Preface
1. About Mandriva Linux
Mandriva Linux is a GNU/Linux distribution supported by Mandriva S.A. which
was born on the Internet in 1998. Its main goal was and still is to provide an easyto-use and friendly GNU/Linux system. Mandriva's two pillars are open source
and collaborative work.
On April 7th 2005 the Mandrakesoft company changed its name to Mandriva to reflect its merger with Brazil-based Conectiva. Its core product,
Mandrakelinux, became Mandriva Linux.

1.1. Contacting the Mandriva Linux Community
The following are various Internet links pointing you to the most important Mandriva Linux-related sources. If you wish to know more about the Mandriva company, connect to our web site [http://www.mandriva.com/]. You can also check
out the Mandriva Linux distribution web site [http://www.mandrivalinux.com/]
and all its derivatives.
Mandriva Expert [http://www.mandrivaexpert.com/] is Mandriva's support
platform. It offers a new experience based on trust and the pleasure of rewarding
others for their contributions.
We also invite you to subscribe to the various mailing lists [http://www.mandriva.
com/community/resources/newsgroups] where the Mandriva Linux community
demonstrates its vivacity and keenness.
Please also remember to connect to our security page [http://www.mandriva.
com/security]. It gathers all security-related material about Mandriva Linux distributions. You will find security and bug advisories, as well as kernel update
procedures, the different security-oriented mailing lists which you can join, and
Mandriva Online [https://online.mandriva.com/] (see Chapter 23, Mandriva Online
Services [331]). This page is a must for any server administrator or user concerned
about security.

1.2. Join the Club!
Mandriva offers a wide range of advantages through its Mandriva Club [http://
club.mandriva.com]:
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1.3. Subscribing to Mandriva Online
• download commercial software normally only available in retail packs, such
as special hardware drivers, commercial applications, freeware, and demo
versions;
• vote for and propose new software through a volunteer-run RPM voting system;
• access more than 50,000 RPM packages for all Mandriva Linux distributions;
• obtain discounts for products and services on Mandriva Store [http://store.
mandriva.com];
• access a better mirror list, exclusive to Club members;
• read multilingual forums and articles;
• access Mandriva's Knowledge Base [http://club.mandriva.com/xwiki/bin/
view/KB/], a wiki-based site which holds documentation on many subjects
such as administration, connectivity, troubleshooting, and more;
• chat with the Mandriva Linux developers on the Club Chat [https://www.
mandrivaclub.com/user.php?op=clubchat];
• enhance your GNU/Linux knowledge through Mandriva's e-training lessons
[http://etraining.mandriva.com/].
By financing Mandriva through the Mandriva Club you will directly enhance the
Mandriva Linux distribution and help us provide the best possible GNU/Linux
desktop to our users.

1.3. Subscribing to Mandriva Online
Mandriva offers a very convenient way to keep your system automatically up-todate, keeping away bugs and fixing security holes. Consult Chapter 23, Mandriva
Online Services [331].

1.4. Purchasing Mandriva Products
Mandriva Linux users may purchase products on-line through the Mandriva Store
[http://store.mandriva.com/]. You will not only find Mandriva Linux software,
operating systems and “live” boot CDs (such as Move), but also special subscription
offers, support, third-party software and licenses, documentation, GNU/Linuxrelated books, as well as other Mandriva goodies.
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1.5. Contributing to Mandriva Linux
The skills of the many talented folks who use Mandriva Linux can be very useful
in the making of the Mandriva Linux system:
• Packaging. A GNU/Linux system is mainly made of programs picked up
on the Internet. They have to be packaged in order to work together.
• Programming. There are many, many projects directly supported by Mandriva: find the one which most appeals to you and offer your help to the main
developer(s).
• Internationalization. You can help us translate web pages, programs and
their respective documentation.
Consult the development projects [http://qa.mandriva.com/] page to learn more
about how you can contribute to the evolution of Mandriva Linux.

2. About this Definitive Guide to Mandriva Linux
This book is divided into several parts, each one detailing a specific use of your
Mandriva Linux system.
• Before performing the installation you should read the preliminary chapters
(see Chapter 1, Installation Warning [1] and Chapter 2, Before Installation [3])
which will make your installation as smooth as possible. Then comes the installation itself (Chapter 3, Installation with DrakX [5]) in which we show you how
to correctly install and configure your Mandriva Linux distribution.
• Discovering Mandriva Linux [35] is an introduction to Linux basics. We discuss
the system philosophy and the most important differences with respect to
other operating systems, as well as the KDE graphical environment (Chapter 7,
Using KDE [55]).
• Using the Internet [65] explores the many different uses which can be made
of Mandriva Linux on the Internet. We discuss surfing on the web, sending emails and reading news, as well as chating.
• Linux Office [103] describes everyday applications such as the OpenOffice.org
office suite and file managers.
• Multimedia [135] helps you discover some of the multimedia applications you
can use on Mandriva Linux. We cover topics such as audio, movie and video
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applications, image manipulation, as well as related devices like printers, digital
cameras, scanners and CD/DVD burners.
• Configuring and Fixing your Machine [199] goes through basic configuration
aspects of a Mandriva Linux system using the Mandriva Linux Control Center,
installing packages, controlling a remote system, synching machines and
troubleshooting.
• The next part (Introduction to Linux [379]) initiates you to the core of
GNU/Linux wisdom. Subjects covered range from basics to more advanced
usage such as disk partitioning, the organization of the file tree and some file
systems such as ext2.
• Linux in Depth [431], goes deeper into GNU/Linux knowledge, discussing
topics such as file systems and mount points, command-line basics and utilities,
text editing and startup schemes. We also speak about accessing remote machines securely and how to install packages from the command line.
• Then we tackle server essentials (Configuration Wizards for Common Services [505]). We go through various wizards to help you set up FTP, Samba and
Web servers, amongst many others. We also discuss masquerading clients
through your machine set up as a gateway.
• The next part (In-Depth Configuration of Common Services [549]) deals with
the most common services you might want to enable. These include setting up
a BIND DNS server, mingling with SMTP, POP and IMAP to ensure the sending
of e-mails, activating file sharing throughout your network, and setting up a
database with MySQL.
• The last part (Applied Theory [623]) although more theoretical will be most
helpful to readers who wish to fully comprehend security and networking issues.

3. Note from the Editor
In the open-source philosophy, contributors are always welcomed! Updating the
Mandriva Linux documentation pool is quite a task. You could provide help in
many different ways. In fact, the documentation team is constantly looking for
talented volunteers to help us out accomplish the following tasks:
• writing or updating;
• translating;
xxiv
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• copy editing;
• XML/XSLT programming.
If you have a lot of time, you can write or update a whole chapter; if you speak a
foreign language, you can help us translate our manuals; if you have ideas on how
to improve the content, let us know; if you have programming skills and would
like to help us enhance the Borges Collaborative Content Creation System (C3S)
[http://sourceforge.net/projects/borges-dms], join in. And don't hesitate to contact
us if you find any mistakes in the documentation so we can correct them!
For any information about the Mandriva Linux documentation project, please
contact the documentation administrator [mailto:documentation@mandriva.com]
or visit the Mandriva Linux Documentation Project Pages [http://qa.mandriva.
com/twiki/bin/view/Main/DocumentationTask/].
Please note that since June 2004 the Mandriva Linux documentation and
the development of Borges is handled by NeoDoc [http://www.neodoc.
biz].

4. Conventions Used in this Book
4.1. Typing Conventions
In order to clearly differentiate special words from the text flow, we use different
renderings. The following table shows examples of each special word or group of
words with its actual rendering, as well as its significance.
Formatted Example Meaning
inode

Used to emphasize a technical term.

ls -lta

Used for commands and their arguments. (see Section 4.2.1,
“Commands Synopsis” [xxvi]).

a_file

Used for file names. It might also be used for RPM package
names.

ls(1)

Reference to a man page. To read the page, simply type man
1 ls, in a command line.

$ ls *.pid

Formatting used for text snapshots of what you may see on
your screen including computer interactions, program listings,
etc.
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Formatted Example Meaning
localhost

Literal data which does not generally fit in any of the previously defined categories. For example, a key word taken from
a configuration file.

OpenOffice.org

Defines application names. Depending on context, the application and command name may be the same but formatted
differently. For example, most commands are written in
lowercase, while applications names usually begin with an
uppercase character.

Files

Indicates menu entries or graphical interface labels. The underlined letter, if present, informs you of a keyboard shortcut,
accessible by pressing the Alt key plus the letter in question.

Le petit chaperon
rouge

Identifies foreign language words.

Warning!

Reserved for special warnings in order to emphasize the importance of words. Read out loud.
Highlights a note. Generally, it gives additional information about a
specific area.
Represents a tip. It can be general advice on how to perform a particular
action, or hints at nice features, such as shortcuts, which could make your
life easier.
Be very careful when you see this icon. It always means that very important information about a specific subject will be dealt with.

4.2. General Conventions
4.2.1. Commands Synopsis
The example below shows the symbols you will see when the writer describes the
arguments of a command:
command <non literal argument> [--option={arg1,arg2,arg3}] [optional arg ...]

These conventions are standard and you will find them elsewhere such as in the
man pages.
The “<” (lesser than) and “>” (greater than) symbols denote a mandatory argument
not to be copied as is, which should be replaced according to your needs. For exxxvi
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ample, <filename> refers to the actual name of a file. If this name is foo.txt you
should type foo.txt, not <foo.txt> or <filename>.
The square brackets (“[ ]”) denote optional arguments, which you may or may not
include in the command.
The ellipsis (“...”) means an arbitrary number of arguments may be included.
The curly brackets (“{ }”) contain the arguments authorized at this specific place.
One of them is to be placed here.

4.2.2. Special Notations
From time to time, you will be asked to press, for example, the keys Ctrl - R , which
means you need to press and hold the Ctrl key and tap the R character right after
as well. The same applies for the Alt and Shift keys.
We use capital letters to represent the letter keys; this doesn't mean that
you have to type them capitalized. However, there might be programs
where typing R is not the same than typing r . You will be informed
when dealing with such programs.
Regarding menus, going to menu item File → Reload user config ( Ctrl - R ) means:
click on the File text displayed on the menu (generally located in the upper-left
of the window). Then in the pull-down menu, click on the Reload user config
item. Furthermore you are informed that you can use the Ctrl - R key combination
(as described above) to get the same result.

4.2.3. System-Generic Users
Whenever possible, we use two generic users in our examples:
Queen Pingusa

queen This is our default user, used through most
examples in this book.

Peter Pingus

peter This user can be created afterward by the
system administrator and is sometimes used
to vary the text.
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Chapter 1. Installation Warning
This guide only covers the most common steps of the installation process. If you
plan on using Windows® as well as GNU/Linux by dual-booting (meaning being
able to access either system on the same computer), please note that it is easier to
install Windows® before GNU/Linux. If Windows® is already set up on your system,
and you have never installed GNU/Linux before, DrakX — Mandriva Linux's installation program — will have to resize your Windows® partition. This operation
can be harmful to your data. Therefore, you must perform the following steps before
proceeding:
• Run chkdsk on your Windows® computer (called scandisk on non-NT systems,
such as Windows® 9x). The resizing program can detect some obvious errors,
but chkdsk is better suited for this task. Refer to the chkdsk documentation
for more information on the different options it has.
Before using chkdsk make sure your screen saver and any other
program that might write to the hard disk is turned off. To obtain
even better results, you should run chkdsk from Windows®'s “Safe
Mode”.
• For maximum data security, also run defrag on your partition if you use Windows® 9x1. This further reduces the risk of data loss. This isn't mandatory, but
it's highly recommended. Doing so will make the resizing process much faster
and easier.
• The ultimate insurance against problems is to always back up your data! Of
course, you should back up your data on another computer, upload your backups on the web, on a friend's computer, etc. Do not back it up onto the computer
on which you want to install GNU/Linux.
NTFS Partitions. Windows® 2000, NT and XP users should remain
careful: even though DiskDrake (through the ntfsresize application) is
able to resize NTFS partitions, it's highly recommended that you back
up your data before starting the installation. Please see the Linux-NTFS
site [http://linux-ntfs.sourceforge.net/info/ntfs.html#2.6] as well as
these NTFS Resize FAQ [http://linux-ntfs.sourceforge.net/info/
ntfsresize.html] for more information on the subject.

1

On NT-based operating systems, defragmentation has little to no effect.

1

Windows® users could be tempted to use Norton PartitionMagicTM to
resize a NTFS partition. However many reports indicate that it fails and
the end result could be a broken partition! Therefore we recommend you
use Mandriva Linux's DiskDrake program. In doubt refer to the FAQ
mentioned above.

2

Chapter 2. Before Installation
This chapter covers issues which should be addressed before you start your new
Mandriva Linux installation. Make sure you read it completely since it will save
you a lot of time. Also back up your data (on a different disk to the one you will
install the system into) and plug in and turn on all your external devices (keyboard,
mouse, printer, scanner, etc.).

1. Configuring your BIOS
The BIOS (Basic Input/Output System) is used to find the device on which the operating system is located and starts it up. It's also used for the initial hardware configuration and low-level hardware access.
The appearance of plug'n'play devices and their widespread use means that all
modern BIOSes can initialize these devices. In order for Linux to recognize
plug'n'play devices, your BIOS must be configured to initialize them.
Changing your BIOS' settings is usually performed by holding down the Del key
(some BIOSes use the F1 , F2 , F10 or Esc keys instead) right after the computer
is switched on. Unfortunately, there are many types of BIOSes. Therefore you will
need to look for the appropriate option yourself. It's often called PNP OS installed
(or Plug'n'Play OS installed ). Set this option to No and the BIOS will then initialize
any plug'n'play devices, which helps Linux to recognize them.
All recent systems can boot from a CD-ROM. Look for Boot sequence or First boot
device in the BIOS' features setup, and set the CD-ROM as the first boot device. If
your system can't boot from a CD-ROM you will need to use a floppy boot disk.
If you want to use a parallel printer connected locally to your machine,
make sure the parallel port mode is set to ECP+EPP (or at least to one of
ECP or EPP) and not to SPP, unless you have a really old printer. If the
parallel port is not set this way you might still be able to print, but your
printer will not be detected automatically and you will have to configure
it manually. Also make sure the printer is properly connected to your
machine and powered on beforehand.

2. Supported Hardware
Mandriva Linux can handle a large number of hardware devices, and the list is
far too long to be quoted exhaustively. Nevertheless some of the steps we describe
will help you to find out if your hardware is compatible. It will also guide you in
configuring some problematic devices.
3

2. Supported Hardware
You may also consult an up-to-date list of supported hardware on the Mandriva
Linux Hardware Database [http://www.mandriva.com/hardware] web site.
Legal Disclaimer: The Mandriva Linux Hardware Database contains information about hardware devices which have been tested and/or have been
reported to function properly with Mandriva Linux. Due to the wide
variety of system configurations, Mandriva cannot guarantee that a
specific device will work properly on your system.
USB devices: support for USB 1.x and USB 2.0 is now extensive. Most peripherals
are fully supported. You can obtain the list of supported hardware on the LinuxUSB device overview [http://www.qbik.ch/usb/devices/] site. Relevant information can also be found on the Linux USB [http://www.linux-usb.org] web site.
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Chapter 3. Installation with DrakX
1. The Mandriva Linux Installer
With the DrakX installation program, it doesn't matter whether you're a newbie
or a GNU/Linux guru. The job of DrakX is to provide you with a smooth installation and an easy transition to Mandriva Linux's latest version.
DrakX works best of all if your hardware is connected to your computer
and powered on during the installation. Printers, modems, scanners and
joysticks are just a few examples of peripherals which DrakX can automatically detect and configure as Mandriva Linux is being installed.

Figure 3.1. Very First Installation Welcome Screen
The first screen offers to run the installation with special options if the standard
mode wasn't suited for your hardware. Let the installation start automatically with
no options. If something goes wrong, see Section 1.2, “Installation Options” [6].
5
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1.1. The Installation Process
When the installer starts, you see a nice graphical interface (see Figure 3.3,
“Choosing the Default Language” [8]). On the left are the various installation
steps, the current one marked by a highlighted bullet. The installation occurs in
two phases: installation, then configuration.
Each step may present various screens. You can surf between those screens through
the Next and Previous buttons. Additionally an Advanced button may be
available to show more advanced configuration options. Note that most of the
latter should only be used by expert users. But there's no harm in looking at them!
The Help button displays explanations concerning the current installation
step.

1.2. Installation Options
If something goes wrong during the first installation attempt, pressing F1 at the
welcome screen (see Figure 3.1, “Very First Installation Welcome Screen” [5])
opens a help window (see Figure 3.2, “Available Installation Options” [6]). Here
are some useful options to choose from:

Figure 3.2. Available Installation Options
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2. Choosing your Language
• vgalo: If you tried a default installation and didn't see the graphical interface
(see Figure 3.3, “Choosing the Default Language” [8]), you can try to run the
installation in low resolution mode. This happens with certain types of video
cards. With Mandriva Linux you are given a number of options to work around
problems related to older hardware. To try the installation in low resolution
mode, enter vgalo at the prompt.
• text: If your video card is very old and the graphical installation doesn't work
at all, you can always choose to install in text mode. Since all video cards can
display text, this is the “last resort” kind of installation. However don't worry:
it's unlikely that you will need this option.
• noauto: In some rare cases, your PC may appear to freeze or lock up during
the hardware detection phase. If that happens, adding the word noauto as a
parameter tells the installation program to bypass hardware detection. Therefore
you will need to manually specify hardware parameters later in the installation
process. You can add the noauto parameter to the previous modes, so depending
on your hardware you may have to specify vgalo noauto to perform a lowresolution graphical installation without DrakX performing a hardware scan.
• kernel options: Most machines don't require specific kernel options. Due to
bugs in the design or in the BIOS, there have been a few cases of motherboards
incorrectly reporting the amount of memory installed. If you need to manually
specify the amount of RAM installed in your PC, use the mem=xxxM parameter.
For example, to start the installation in normal mode with a computer containing
256 MB of memory, your command line would look like linux mem=256M

2. Choosing your Language
The first step is to choose your preferred language.
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2. Choosing your Language

Figure 3.3. Choosing the Default Language
Open the tree relative to the continent you're located in, then choose your language.
Your language choice will affect the installer, the documentation, and the system
in general.
Use the list accessible through the Multi languages button to select other languages
to be installed on your workstation, thereby installing the language-specific files
for system documentation and applications. For example, if Spanish friends are
to use your machine, select English as the default language in the tree view and
Español in the list view.
About UTF-8 (unicode) support: Unicode is a character encoding intended
to cover all existing languages. However full support for it in GNU/Linux
is still under development. For that reason, Mandriva Linux's use of UTF8 depends on your choice:
1.
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If you choose a language with a strong legacy encoding (latin1 languages, Russian, Japanese, Chinese, Korean, Thaï, Greek, Turkish,

2. Choosing your Language
and most iso-8859-2 languages), the legacy encoding will be used
by default.
2.

Other languages use Unicode by default.

3.

If two or more languages are to be installed, and those languages
don't use the same encoding, then Unicode is used for the whole
system.

4.

Finally, Unicode can also be forced for use throughout the system
at a user's request by selecting the Use Unicode by default option
independently of which languages have been chosen.

Note that you're not limited to choosing a single additional language. You may
choose several, or even install them all by selecting the All languages option. Selecting support for a language means translations, fonts, spell checkers, etc. are
also installed for that language. Make sure you select all languages which are likely
to be useful on the machine now, it may be difficult to configure support for languages not chosen at install time at a later time.
To switch between the various languages installed on your system, you
can launch the localedrake command as root to change the language
used by the entire system. Running the command as a regular user only
changes the language settings for that particular user.
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3. License Terms of the Distribution

3. License Terms of the Distribution

Before continuing, you should carefully read the terms of the license. It covers the
entire Mandriva Linux distribution. If you agree with all the terms it contains, select
Accept and click on Next . If not, clicking on Quit reboots your computer.
If you are curious about any technical changes which have occurred in
the distribution since the last release, you can click on the Release Notes .

4. Installation Class
This step is shown only if an existing GNU/Linux partition is found on your machine.
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4. Installation Class

DrakX now needs to know if you want to install from scratch or to upgrade your
existing Mandriva Linux system:
Upgrade
This installation type simply updates the packages currently installed on your
Mandriva Linux system. Your current partitioning scheme and user data won't
be altered. Most of the other configuration steps remain available and are
similar to a standard installation.
Install
For the most part, this completely wipes out the old system. However, depending on your partitioning scheme, you can prevent some of your existing data
(particularly /home directories) from being overwritten.
Using the “Upgrade” option should work fine on Mandriva Linux systems
running version 10.1 or later. Performing an upgrade on prior versions
is not recommended.
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5. Configuring your Keyboard

5. Configuring your Keyboard
This step only shows if your language settings don't match one single
keyboard. Otherwise, your keyboard layout is automatically selected.

Depending on the language you choose (see Section 2, “Choosing your Language” [7]), DrakX automatically selects a particular type of keyboard configuration. Verify that the selection suits you or choose another keyboard layout.
Also, you may not have a keyboard which corresponds exactly to your language:
for example, if you are an English-speaking Swiss native, you may have a Swiss
keyboard. Or if you speak English and are located in Québec, you may find yourself
in the same situation where your native language and country-set keyboard don't
match. In either case, this installation step will allow you to select an appropriate
keyboard.
Click on the More button and a list list of supported keyboards appears.
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6. Security Level
If you choose a keyboard layout based on a non-Latin alphabet, the next dialog
allows you to choose the key binding which can switch the keyboard between the
Latin and non-Latin layouts.

6. Security Level

At this point, DrakX allows you to choose your machine's security level. As a rule
of thumb, the security level should be set higher if the machine is to contain crucial
data, or if it's to be directly exposed to the Internet. The trade-off is that a higher
security level is generally obtained at the expense of ease of use.
If you don't know what to choose, keep the default option. You'll be able to change
it later with the draksec tool in the Mandriva Linux Control Center.
Fill the Security Administrator field with the e-mail address of the person responsible for security. Security-related messages will be sent to that address.
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7. Partitioning your Disk

7. Partitioning your Disk

You now have to decide where you want to install Mandriva Linux on your hard
drive. Your hard drive needs to be partitioned which means it must be logically
divided in order to create the required space for your new Mandriva Linux system.
Because the process of partitioning a hard drive is usually irreversible and can
lead to data loss, it can be intimidating and stressful for the inexperienced user.
Fortunately, DrakX includes a wizard which simplifies this process. Before continuing with this step, read through the rest of this section and above all, take your
time.
Depending on the configuration of your hard drive, several options are available:
Use free space
This option performs an automatic partitioning of your blank drive(s). If you
use this option there will be no further prompts.
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7. Partitioning your Disk
Use existing partitions
The wizard detected one or more existing Linux partitions on your hard drive.
If you want to use them, choose this option. Then choose the mount points
associated with each of the partitions. The legacy mount points are selected
by default, and for the most part it's a good idea to keep them. Then choose
the partitions to be formatted or preserved.
Use the free space on the Windows partition
If Windows® is installed on your hard drive, you might have to create free
space for GNU/Linux. To do so, you can delete your Windows® partition and
data (see the “Erase entire disk” solution below) or resize your FAT or NTFS
partition. Resizing can be performed without the loss of any data, provided you
previously defragmented the Windows® partition. Backing up your data is strongly
recommended. Using this option is recommended if you want to use both
Mandriva Linux and Windows® on the same computer.
Before choosing this option, please understand that after this procedure, the
size of your Windows® partition will be smaller than when you started, which
means you will have less free space to store your data or to install new software.
Erase entire disk
Choose this option to delete all data and partitions present on your hard drive.
You won't be able to undo this operation after you confirm.
If you choose this option, all data on your disk will be deleted.
Remove Windows(TM)
This option appears when the hard drive is entirely taken by Windows®.
Choosing this option simply erases the entire drive, partitioning everything
from scratch.
If you choose this option, all data on your disk will be lost.
Custom disk partitioning
Choose this option to manually partition your hard drive. Be careful: it's a
powerful but dangerous choice and you can very easily lose all your data. This
option is only recommended if you performed custom disk partitioning before,
and have enough GNU/Linux experience. For more instructions on how to
use the DiskDrake utility, refer to Section 1, “Managing your Hard Drive
Partitions with DiskDrake” [303].
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8. Choose the Partitions to Format

8. Choose the Partitions to Format
This step is only available if you choose to reuse existing Linux partitions.

You may wish to reformat some of your legacy GNU/Linux partitions and erase
any data they contain. To do so, please select those partitions as well.
Please note that you don't have to reformat all pre-existing partitions. You must
reformat the partitions containing the operating system (such as /, /usr and /var)
but not the partitions containing data you wish to keep (typically, /home).
Please be careful when selecting partitions. After the formatting is completed, all
data on the selected partitions is deleted and you won't be able to recover it.
• Click on Next once you've selected the partitions to format.
• Click on Previous if you want to choose another partition for your new Mandriva Linux operating system installation.
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9. Package Selection
• Click on Advanced if you want to check for partitions with bad blocks on the
disk.

9. Package Selection
We now enter the software package installation itself. It first consists of selecting
the installation media and then the packages to be installed.

9.1. Media Handling
If you are doing an installation from a CD, you are first asked to select the CDs
you actually have available.
You are also given the option to copy all packages on your hard drive. This will
probably speed up installation and will ease later package installation as all packages will already be available on the hard disk.

9.2. Supplementary Installation Media

17

9.3. Choose Package Groups to Install
It is now possible to add new installation media, such as a CD or remote network
repositories from Mandriva Club for example. If you choose a network repository,
you will go through the following steps:
1.

Network Configuration
Simply choose the connection type needed to access the remote repository.
Your settings will be preserved for the actual system network configuration.

2.

Media Selection
Provide the information (URL or NFS server and path) to access the new media.

9.3. Choose Package Groups to Install

It's now time to specify which programs you wish to install on your system. There
are thousands of packages available for Mandriva Linux, and to make it simpler
to manage, they have been placed into groups of similar applications.
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Minimal Installation
Mandriva Linux sorts package groups into categories. You can mix and match
applications from the various categories, so a Workstation installation can still
have applications from the Server category installed.
1.

Workstation: if you plan to use your machine as a workstation, select one or
more of the groups in this category. The special LSB group will configure your
system so that it complies as much as possible with the Linux Standard Base
Project [http://www.linuxbase.org/] specifications.

2.

Server: if your machine is intended to be a server, select which of the more
common services you wish to install on your machine.

3.

Graphical Environment: this is where you will choose your preferred graphical environment. At least one must be selected if you want to have a graphical
interface available.
Moving the mouse cursor over a group name will display a short explanatory text about that group.

You can check the Individual package selection box, which is useful if you're familiar with the packages being offered or if you want to have total control over
what will be installed.
If you start the installation in Upgrade mode, you can deselect all groups and
prevent the installation of any new packages. This is useful for repairing or updating
an existing system.

Minimal Installation
If you deselect all groups when performing a regular installation (as opposed to
an upgrade), a new dialog shows after pressing the Next button, suggesting different options for a minimal installation:
• With X: install the minimum number of packages possible to have a working
graphical desktop.
• With basic documentation: installs the base system plus basic utilities and their
documentation. This installation is suitable for setting up a server.
• Truly minimal install: installs the absolute minimum number of packages necessary to get a working Linux system. With this installation you will only have
a command-line interface.
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9.4. Choosing Individual Packages to Install

9.4. Choosing Individual Packages to Install

If you choose to install packages individually, the installer will present a tree
structure containing all packages classified by groups and subgroups. While
browsing the tree, you can select entire groups, subgroups, or individual packages.
Whenever you select a package on the tree, a description will appear on the right
to let you know the purpose of that package.
If a server package has been selected, either because you specifically
chose the individual package or because it was part of a group of packages, you will be asked to confirm that you really want those server
packages to be installed. By default Mandriva Linux will automatically
start any installed services (servers) at boot time. Even if they are safe
and have no known issues at the time the distribution was shipped, it is
entirely possible that security holes were discovered after this version of
Mandriva Linux was finalized. If you don't know what a particular service
is supposed to do or why it's being installed, then click No .
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10. Root Password
The Show automatically selected packages option is used to disable the warning
dialog. Those appear whenever the installer automatically selects a package to resolve a dependency issue. Some packages depend on others and the installation
of one particular package may require the installation of others. The installer can
determine which packages are required to satisfy a dependency and to successfully
complete the installation.
The little floppy disk icon at the bottom of the list allows you to load or save the
packages list. This is useful if you have a number of machines that you wish to
configure identically. Click on this icon and select whether you wish to Load or
Save the packages list, then select the medium in the following screen and click
on the Ok button.

10. Root Password

This is the most crucial decision point for the security of your GNU/Linux system:
you must enter the root password. Root is the system administrator and is the
only user authorized to make updates, add users, change the overall system configuration, and so on. In short, root can do everything! That's why you must choose
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10. Root Password
a password which is difficult to guess: DrakX tells you if the password you choose
is too simple. Depending on the security level you chose, you're not forced to enter
a password, but we strongly encourage you to do so. GNU/Linux is just as prone
to operator error as any other operating system. Since root can overcome all limitations and unintentionally erase all data on partitions by carelessly accessing the
partitions themselves, becoming root must be difficult.
The password should be a mixture of alphanumeric characters and at least 8
characters long. Never write down root's password — it makes it far too easy to
compromise your system.
One caveat: don't make the password too long or too complicated because you
must be able to remember it too!
The password won't be displayed on screen as you type it. To reduce the chance
of a blind typing error you have to enter the password twice.
You can change the way users are authenticated on your computer by clicking on
the Authentication method button. The following authentication methods are
available:
• Local file. Use a local file for all authentication and user information. This is
the default method.
• LDAP. Use an LDAP server for some or all authentication needs. An LDAP
directory consolidates certain types of information within your organization.
• NIS. Authenticates users against a NIS domain. This allows you to run a group
of computers in the same NIS domain using a common password and group
file.
• Smart Card. Uses SmartCard hardware for providing authentication services.
• Windows Domain. Uses a Windows® domain controller to provide authentication services through Active Directory, Microsoft's implementation of LDAP.
If you select a method other than Local file, you are asked to provide some parameters which vary from one method to the other. If you don't know those parameters, you should ask your network administrator.
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11. Adding a User

11. Adding a User

GNU/Linux is a multi-user system which means each user can have his own
preferences, files and so on. But unlike the system administrator called root, the
users you add at this point are not authorized to change anything except their own
files and their own configurations, protecting the system from unintentional or
malicious changes which could have a serious impact on it.
You must create at least one regular user for yourself — this is the account which
you should use for routine, day-to-day usage. Although it's very easy to log in as
root to do anything and everything, it may also be very dangerous! A very simple
mistake could render your system unusable. If you make a serious mistake as a
regular user, the worst that can happen is that you'll lose some information, but
you won't affect the entire system.
You are first asked for a real name. DrakX uses the first word you type in this field
and copies it, all in lowercase, to the Login name field, which is the name this user
must enter to log on to the system. Then enter a password, twice (for confirmation).
From a security point of view, a non-privileged (regular) user's password isn't as
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12. Installing a Bootloader
crucial as the root password, but that's no reason to neglect it by making it blank
or too simple: after all, your files could be the ones at risk.
Once you click on Accept user you can add other users. Add a user for each one
of your friends, your father, your sister, etc. Click Next when you're finished
adding users.
Clicking the Advanced button allows you to change the default shell
for that user (bash by default), and to manually choose the user and group
IDs for that user.

12. Installing a Bootloader

A bootloader is a small program which is started by the computer at boot time.
It's responsible for starting up the whole system. Normally, the bootloader installation is totally automated. DrakX analyzes the disk boot sector and acts according
to what it finds:
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13. Checking Miscellaneous Parameters
• If a Windows® boot sector is found, it is replaced by a GRUB/LILO boot sector.
This way you are able to load either GNU/Linux or any other OS installed on
your machine.
• In any other case it asks you where it should place the boot loader. Generally,
the First sector of drive (MBR) is the safest place.
Choosing Skip won't install a bootloader. Use this option only if you know what
you're doing.

13. Checking Miscellaneous Parameters
13.1. Summary

As a review, DrakX presents a summary of information it gathered about your
system. Depending on the hardware installed on your machine, you may have
some or all of the following entries. Each entry is made up of the hardware item
to be configured, followed by a quick summary of the current configuration. Click
on the corresponding Configure button to make any changes.
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13.1. Summary
• Keyboard: check the current keyboard map configuration and change it if necessary.
• Country / Region: check the current country selection. If you're not in the
country selected by DrakX, click on the Configure button and choose another.
If your country isn't in the list shown, click on the Other Countries button to
get a complete country list.
• Timezone: by default, DrakX deduces your time zone based on the country
you have chosen. You can click on the Configure button here if this is not
correct.
• Mouse: verify the current mouse configuration and change it if necessary.
• Printer: clicking on the Configure button will open the printer configuration
wizard. Consult Section 6, “Configuring Printers with PrinterDrake” [234]Section 6, “Configuring Printers with PrinterDrake” [234] for more information on
how to set up a new printer. The interface presented in our manual is similar
to the one used during installation.
• Sound card: if a sound card is detected on your system, it will be displayed
here. If you notice the sound card isn't the one actually present on your system,
you can click on the button and choose a different driver.
• TV card: if you have a TV card, this is where information about its configuration
will be displayed. If you want to try a different driver for your TV card, or its
detection wasn't accurate you can click on Configure to try to configure it
manually.
• Graphical Interface: by default, DrakX configures your graphical interface with
a resolution that best matches your video card and monitor combination. If
that doesn't suit you, or DrakX could not automatically configure it (not configured is displayed), click on Configure to reconfigure your graphical interface.
You can click on Help from within the configuration wizard to benefit from
full in-line help.
• Network: if you wish to configure your Internet or local network access, you
can do so from here. Refer to the printed documentation or use the Mandriva
Linux Control Center after the installation has finished to benefit from full inline help.
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13.2. Time Zone Options
• Proxies: allows you to configure HTTP and FTP proxy addresses if the machine
you're installing on is to be located behind a proxy server.
• Security Level: this entry allows you to redefine the security level as set in a
previous step (see Section 6, “Security Level” [13]).
• Firewall: if you plan to connect your machine to the Internet, it's a good idea
to protect yourself from intrusions by setting up a firewall. Consult Section 3,
“Securing your Internet Access via DrakFirewall” [323]Section 3, “Securing your
Internet Access via DrakFirewall” [323] for details about firewall settings.
• Bootloader: to change your bootloader configuration. This should be reserved
to advanced users. Refer to the printed documentation or the in-line help about
bootloader configuration in the Mandriva Linux Control Center.
• Services: with this entry you can fine tune which services will be run on your
machine. If you plan to use this machine as a server it's a good idea to review
this setup.

13.2. Time Zone Options
This setup allows to refine the time zone you are currently located in. After you've
chosen the location nearest to your time zone, two more options for time management are shown.
Hardware clock set to GMT. GNU/Linux manages time in GMT (Greenwich
Mean Time) and translates it to local time according to the time zone you selected.
If the clock on your computer is set to local time, you may deactivate this by
deselecting Hardware clock set to GMT, which will let GNU/Linux know that the
system clock and the hardware clock are in the same time zone. This is useful when
the machine also hosts another operating system.
Automatic time synchronization. This option will automatically regulate the
system clock by connecting to a remote time server on the Internet. For this feature
to work, you must have a working Internet connection. We recommend that you
choose a time server located near you or the generic World Wide entry which will
select the best server for you. This option actually installs a time server which can
be used by other machines on your local network as well.
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13.3. Configuring X, the Graphical Server

13.3. Configuring X, the Graphical Server

X (for X Window System) is the heart of the GNU/Linux graphical interface on
which all the graphical environments (KDE, GNOME, AfterStep, WindowMaker,
etc.) bundled with Mandriva Linux rely on.
You will see a list of different parameters which you can change in order to optimize
your graphical display.
Graphic Card
If everything works fine, the installer should detect and configure the video
card installed on your machine. If the detection or configuration is incorrect,
you can choose the card installed on your system from a list.
Monitor
If the installer fails to detect or configure your monitor properly, you can
choose from this list the monitor which is connected to your computer.
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13.3. Configuring X, the Graphical Server
Resolution
Here you can choose the resolution and color depth from the available ones
for your graphics hardware. Choose the one which best suits your needs (you
will be able to make changes after the installation). A sample of the chosen
configuration will be shown in the monitor picture.
Test
Depending on your hardware, this entry might not appear.

The system will try to open a graphical screen at the desired resolution. If you
see the test message during the test and answer Yes , then DrakX will proceed
to the next step. If you don't see it, it means that some part of the auto-detected
configuration was incorrect and the test will automatically end after a few
seconds and return you to the menu. Change settings until you get a correct
graphical display.
Options
This step allows you to choose whether you want your machine to automatically switch to a graphical interface at boot. Obviously, you may want to select
the No option if your machine is to act as a server, or if you were not successful
in getting the display configured.
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13.4. Selecting Available Services at Boot
Time

13.4. Selecting Available Services at Boot Time

This dialog is used to select which services you wish to start at boot time.
DrakX will list all services available on the current installation. Review each of
them carefully and uncheck those which aren't needed at boot time.
A short explanatory text will be displayed about a service when it is selected. However, if you're not sure whether a service is useful or not, it
is safer to leave the default setting.
At this stage, be very careful if you intend to use your machine as a
server: you probably don't want to start any services which you don't
need. Please remember that some services can be dangerous if they're
enabled on a server. In general, select only those services you really need.
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14. Installing Updates from the Internet

14. Installing Updates from the Internet

By the time you install Mandriva Linux, it's likely that some packages have been
updated since the initial release. Bugs may have been fixed, security issues resolved,
etc. To benefit from these updates select Yes if you have a working Internet connection, or No if you prefer to install updated packages later.
Choosing Yes displays a list of web locations from which you can retrieve updates.
You should choose one near to you. Review the packages from the tree selection,
and press Install to retrieve and install the selected packages.
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15. It's Done!

15. It's Done!

There you are. The installation is now complete and your GNU/Linux system is
ready to be used. Just click on Reboot to restart the system. Remember to remove
the installation media (CD-ROM or floppy). The first thing you should see after
your computer has finished doing its hardware tests is the bootloader menu, which
allows you to choose between the OSes your system can boot.

15.1. Advanced Options
The Advanced button shows more buttons to:
1.

Generate auto-install floppy : enables you to create an installation floppy disk
which automatically performs a whole installation, similar to the one just
finished, without the help of an operator.
Note that different options are available after clicking on that button:
•
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Replay . This is a partially automated installation. The partitioning step is
the only interactive procedure.

16. How to Uninstall Linux
•

Automated . Fully automated installation: the hard disk is completely rewritten,
all data is lost.

This feature is very handy when installing on a number of similar machines.
See the Auto install [http://qa.mandriva.com/twiki/bin/view/Main/
AutoInstall] section on our web site for more information.
2.

Save package selection 1: saves a list of the packages selected in this installation.
The following screen shows you the possible media to use to save the package
list onto: you might need to fill some parameters when you click on the Next
button.
To use this selection of packages with another installation, perform the installation as usual up to the point of the package selection, and choose to select
individual packages, without worrying about the current package selection.
Use the floppy icon and select the Load option. Then choose the medium
which contains the package list. Finally click OK : the list of packages you
loaded will be selected and installed.

16. How to Uninstall Linux
If for any reason you want to uninstall Mandriva Linux, you can do so. The process
of uninstalling Mandriva Linux is done in two steps:
Removing partitions on your hard drive will inevitably result in the loss
of all data stored on those partitions. Please make sure you've backed up
all of the data you want to keep before proceeding.
1.

Remove the bootloader, LILO in this example, from the Master Boot Record
(MBR). To do so, execute lilo -U in a console, as root. Doing this will not only
uninstall LILO but will also restore the previous master boot record, if any.
If you have a different boot loader, please refer to its documentation to determine how to regenerate the master boot record.

2.

Delete all partitions related to Mandriva Linux on your hard drive (usually
partitions hosting ext3 file systems and the Swap partition) and — optionally —
replace them with a single partition using fdisk.
a.

Log out from your current session and log back in as root.

1
You need a FAT-formatted floppy to save on a floppy disk. To create one under GNU/Linux, type
mformat a: or, as root, fdformat /dev/fd0 followed by mkfs.vfat /dev/fd0.
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b.

Open a terminal window and run fdisk /dev/hda (if the hard disk containing Mandriva Linux is other than the 1st IDE disk, change /dev/hda
accordingly).

c.

Use the p command to display partition information, and then use the d
command to delete all unneeded partitions.

d.

If you want to create a single partition, use the c command, specify 1 as
the partition number, make it use the whole space available, and when
asked for the partition type use the L command to list the supported
partition types and choose the right one for the OS you plan to install
later. Some examples: c for a FAT32 (Windows® 9x) partition, 7 for a
NTFS (Windows® NT/Windows® 2000/XP) partition, 83 for a
GNU/Linux partition. Finally use the w command to write changes back
to disk.

Once this is done, just reset or shutdown the machine “the hard way”.
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Part 1. Discovering Mandriva Linux

Chapter 4. Migrating to Linux from
®
®
Windows and Mac OS X
This chapter is aimed at users migrating from Windows® or Mac OS® X. Instead
of presenting the various applications in depth, it tries to answer the most common
questions and/or issues former Windows® or Mac OS® X users might ask.

1. Where's my...?
Experienced Windows® and Mac OS® X users are normally accustomed to certain
functions and/or concepts which are often treated differently in GNU/Linux.

1.1. Start Menu
In Windows®, most applications and system tools are accessed through the socalled Start Menu; this concept remains more or less the same, except it's now
called the Main Menu: you open it by clicking on the yellow star in the panel.
For users coming from Mac OS® X, Mandriva Linux's Main Menu can be considered
as a replacement for functions from both the Apple Menu, located at the far left
of the menu bar, and the Applications folder available in the Finder.

1.2. Applications
The wide variety of applications is a large differentiator between GNU/Linux and
Windows®. Mandriva Linux installs many more applications onto your system,
and clicking on the main menu gives you a wide range of choices depending on
what you would like to do. Most standard file formats can be handled: PNG pictures, Rich Text Format texts, PostScript printouts, etc. These file formats should
always be preferred as they facilitate exchange of data between applications, while
ensuring your freedom to change to another application and/or operating system
at any time.
You may also have many files in proprietary formats such as Microsoft® Excel or
Microsoft® Word documents. OpenOffice.org is just one application which can
handle most popular formats for office applications (see Section 1, “Word Processor” [105] and Section 2, “Spreadsheet” [113]).
We specifically mention office documents because they are widely used.
Due to space constraints we cannot cover every single Windows® application and its GNU/Linux equivalent. However, there is a high probability
that you will find GNU/Linux equivalents for all the programs you used
under Windows® or Mac OS® X. To get an idea of GNU/Linux equival37
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ents of Windows® applications, you can consult this table of equivalents
[http://linuxshop.ru/linuxbegin/win-lin-soft-en/table.shtml].
Mac OS® X users may find similarities between Mac OS® X and GNU/Linux applications, because Mac OS® X is based on BSD®, a UNIX®-like system on which
GNU/Linux is also based. Moreover, other applications designed for the desktop
have been ported to, or are available under, the X11 implementation available for
Mac OS® X.
You may also install a large number of applications through the RpmDrake utility
(please refer to Chapter 16, Package Management through Rpmdrake [209]).

1.3. Control Panel/System Preferences
The Control Panel in Windows® and the System Preferences utility in Mac OS® X
are replaced by the Mandriva Linux Control Center under Mandriva Linux. It can
be accessed by choosing System + Configuration → Configure Your Computer in
the main menu. With this interface, you have the ability to modify most of your
system's settings with graphical tools.

1.4. Command Shell
GNU/Linux is still very fond of shell environments. Unlike Windows® the popularity of the shell is not fading away as is evident by the availability of the shell
in Mac OS® X. By default, Mandriva Linux installs bash, a truly powerful shell
environment. You can access it by opening the main menu and choosing System + Terminals → Konsole .
Few of your DOS commands or functions work in a Linux shell. Take a
look at Chapter 33, Introduction to the Command Line [441] to discover their
equivalents and much, much more.

1.5. Network Neighborhood
GNU/Linux uses TCP/IP by default, not SMB (the Windows® network protocol),
so there's nothing like a network neighborhood icon to give you a view of the
network you're in. However, you may use the LinNeighborhood application to
give you similar functionality.
Konqueror can also accomplish the same tasks. Just type smb:/ in the location bar,
and all of the shared Windows® resources on the network will appear.
See Section 1.5, “File Sharing” [132] for more information.
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1.6. C: Drive
The “lettered drive” is a concept exclusive to Windows®. On UNIX® systems, the
drive notion (C:, D:, ..., Z:) is replaced by “mount points”. From a user perspective,
you're always accessing directories. Your system is configured to “load” all relevant
disks, disk partitions and remote systems, and then assign them to a specified
directory, generally under the /mnt directory. While this concept is similar to that
found in Mac OS® X, it is slightly different. What is mounted under /mnt with
GNU/Linux is mounted under /Volumes in Mac OS® X but is made available as
a “root file system” in the Finder.

1.7. CD/DVD Drives
The same concept as for C: applies here. CD-ROMs are mounted in /mnt/cdrom.
To access the CD-ROM, just click on the desktop icon and the CD-ROM's contents
appear in a new window.
Things are a bit different for audio and data CDs: upon inserting an audio
CD in the drive, the CD player is automatically loaded and starts playing.
Please see Section 1, “Audio Applications” [137].

1.8. Other Removable Media (floppy, USB key, etc.)
Like CD-ROMs and disk partitions, floppy disks, USB keys, and other removable
media are mounted and will appear under the /mnt directory. Icons are displayed
on your desktop to access some media directly; all media is accessible through the
media icon on the desktop.

1.9. My Documents
Under Mandriva Linux every user has a directory called the user's home directory:
that is the place to store the user's documents. For example, Peter should store
documents in /home/peter. A My Documents directory could be created inside the
user's home to “mimic” Windows® behaviour.
The home directory concept is analogous to the C:\Winnt\Profiles\user_name\
or C:\Documents and Settings\user_name\ directories in Windows NT®, Windows® 2000 and Windows® XP and is explained in Chapter 7, Using KDE [55].
Under Mac OS® X this is very similar. The home directory's equivalent is
/Users/user_name which contains a directory called Documents.
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2. A Brave New World!
Now that you have found your way around GNU/Linux, here is a brief presentation
of the features which make excellent reasons to migrate to GNU/Linux.

2.1. A Multiuser Environment
GNU/Linux, like Mac OS® X, is based on UNIX®. This basically implies a shift in
the structure of your environment, from a single workstation to a multiuser architecture and implies very thorough user management. Each file, service and application is exclusively allocated to a user or a group of users, according to its nature.
For example, every user has his or her own personal directory, containing personal
data and personal configuration files, which can be made inaccessible (even invisible) to other users.

2.2. Multiple Tasks
GNU/Linux has always been a very strong operating system for multi-tasking
(running many applications concurrently) and still remains a leader in this domain.

2.3. Multiple Desktops
Modern desktop environments available for GNU/Linux give you many virtual
desktops to work with, instead of just a single desktop. Users who like to have
numerous applications running at the same time will greatly appreciate this feature
since it makes for a much cleaner working environment.

2.4. Full Desktop Customization
Regarding aesthetics, GNU/Linux truly rocks! Not only can you choose between
many different window managers, but you can also highly customize their appearance with themes. Themes go beyond just the initial look and feel: actually,
everything you see can be modified, from the background image to the behavior
of applications when they are closed, which is truly unique.
See the themes page on Freshmeat [http://themes.freshmeat.net/] for available
designs.

2.5. Thousands of Free Applications
The GNU/Linux community is by far the most generous one. Given a specific
problem, you will most likely find a script or an application to answer your needs,
for free! Also, Mandriva Linux includes hundreds of applications not documented
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in this book, so don't be shy, try them out. You'll most probably be surprised by
the extent of the possibilities GNU/Linux offers.
GNU/Linux also offers advanced server functionality, such as the ability to host
mail or web page servers “out of the box”.

2.6. No More Reboots!
Windows® and Mac OS® (although this has largely been addressed in Mac OS®
X) users know the level of frustration generated by crashing systems. Even though
GNU/Linux is not perfect, its stability is one of its strongest points. Sometimes,
applications crash, but rarely do they take the operating system down with them.
Also, installing new applications or devices and modifying the system's configuration doesn't require a reboot: they are immediately taken into account.
We hope this rapid tour will help you truly appreciate GNU/Linux's strengths.
For a very detailed guide on migrating from Windows® in an enterprise environment (though also applicable to a personal workstation), you can take a look at
IBM's RedBook: Linux Client Migration Cookbook [http://www.redbooks.ibm.
com/abstracts/sg246380.html]. Do not be afraid to explore further!
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Chapter 5. Linux for Beginners
1. Introduction
This chapter is written for inexperienced GNU/Linux users. If you know how to
log in and out, use KDE and know where your applications reside on your Mandriva Linux system, skip ahead to the next chapter. If not, read on! After reading
this chapter, all subsequent chapters will make much more sense to you.
If you're an experienced Windows® or Mac OS® user, refer to Chapter 4,
Migrating to Linux from Windows® and Mac OS® X [37], which will ease
the transition between those operating systems and GNU/Linux.

2. The Bootloader Menu
The first component you see when your Mandriva Linux boots is the bootloader
menu. It allows you to boot your GNU/Linux system, or any other operating
system installed on your machine, as well as some special options.
The number of items and their names vary depending on your particular configuration. The one labeled linux starts your Mandriva Linux system and it's the default item unless you manually configure it differently. Wait a few seconds or press
Enter , and Mandriva Linux starts to load. Use the arrow keys on your keyboard
and press Enter to select another item.

3. Getting Ready for your Session
GNU/Linux is a multiuser system which means more than one user can access
your machine, each with the ability to keep his own data and configuration files
private and protected from other users. The different user accounts must be created
by the administrator who is called root. You must have set his password during
the installation, and he has no restrictions at all on the system.
It's very important to understand the terms “to log in” and “to log out”. To log in
means to identify yourself to the computer. Think of it as a security officer verifying
who you are before letting you in. After logging in, the system takes a number of
actions in order to give you access to the system's resources. By logging in, you
start a so-called “session”.
When you log out you are telling the system you no longer need to use its resources.
Your personal session is closed, you exit the graphical interface and the login screen
appears once more.

43

4. Beginning your Session
Although these definitions are valid within the scope of this chapter,
they are oversimplified. As you read the following chapters, you will
better understand these concepts, their advantages and options.

4. Beginning your Session
We assume that you are sitting in front of a running Mandriva Linux computer
which, when turned on, automatically displays the graphical login screen. If this
isn't the case and you're facing a black screen with something like:
Mandriva Linux release 2006.0 for i586
Kernel 2.6.12-8mdk on an i686 / tty1
machine_name login:

with a flashing cursor, type your user name then your password. You should now
be logged in. Now type startx to launch the graphical interface (KDE by default,
see Chapter 7, Using KDE [55]). If this doesn't work, please refer to Section 5.3, “X
Doesn't Start” [364]. In order to automatically start your system in graphical mode,
refer to Section 2, “Controlling the Graphical Configuration” [225].

Identifying Yourself
To log into the system, you need to supply your user name and password (see
Figure 5.1, “The Login Window” [45]).
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Figure 5.1. The Login Window
If you're the only user on your Mandriva Linux system, and typing your user name
and password annoys you, you can set your system to boot directly into your favorite desktop environment. This feature is called auto-login (see Section 1, “Configuring the Login Mode” [325]).
Be careful with this option as no password is asked for, therefore anybody
sitting in front of your system can use it and have access to your files.

5. Using your Graphical Environment
5.1. The Mandriva Linux Desktop
All modern graphical environments share a common set of features: a main menu,
a desktop area with some icons, a panel, etc. In the following paragraphs we describe the elements which comprise the desktop environment.
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5.1. The Mandriva Linux Desktop

Figure 5.2. The KDE Desktop
1.

Icons are located on the left of the screen and in the panel at the bottom of the
screen. Clicking on an icon either launches a program or opens a folder. In
both cases a window appears on your desktop.

2.

The panel is located in the lower part of the screen. It provides quick access to
useful tools such as a Terminal, a web browser, a text editor, etc. Each icon
represents a program.

3.

The desktop, also called the background, is where everything you see or use
lives, such as the icons and the panel. Right-click on a free area on the desktop
(i.e. where there is nothing) and a menu appears. It gives you access to several
more functions such as configuring your background or accessing your
bookmarks.
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5.2. Accessing Applications

Click on the main menu to access the software installed on your machine.
The applications are organized by task so finding the program you're looking for
is pretty easy.

5.3. Opening a Window on the Desktop
Click on this icon on your desktop to launch your file manager:

Figure 5.3. KDE File Manager
The Konqueror file manager displays the content of your Home directory where all
your personal documents and files are stored. Only you and root can access them.
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5.4. Managing Desktops
We introduced the desktop to point out the area of the screen where all objects are placed. On the panel there's a group of desktop buttons.
These buttons give you access to virtual desktops, which are identical copies of the
desktop you see after you log in. You will find more information about the handling
and usage of virtual desktops in Section 1.3, “Virtual Desktops” [57].
Click on the button labeled 2 to simply switch desktops. Click on the button labeled
1 to go back to previous desktop.
This feature called virtual desktops is very handy. It allows you to open several
windows and to organize them as you wish.
You can also change which virtual desktop a window is currently in. This may be
handy to logically organize your work by desktop, for instance moving all Internetrelated windows into desktop 2, all multimedia applications into another desktop,
and so on.
Right-click on the window's title bar and access the To Desktop item. Simply choose
the virtual desktop to which you want to move your window.

6. Logging Out of Your Session
When you are finally done using your computer, don't forget to log out in a proper
manner.
Logging out can be done from the main menu or from the menu which appears
when you right-click on the desktop.
The screen shades and a little box with options appears. Click on End Current
Session and you return to the login screen.
Two other options are available: you can choose to shutdown the system (Turn
Off Computer), as well as reboot your system (Restart Computer).
This is the correct and safe way to shut down or reboot your system. You should
never do it by pushing your computer's power or reset buttons because this can
lead to serious problems such as file-system corruption or the loss of data.
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Chapter 6. Accessing Documentation
Apart from the manuals included with Mandriva Linux, documentation is available
from many sources. The next few pages contain suggestions which you might find
useful.

1. Mandriva Linux-Specific Documentation
1.1. Mandriva's Own Documentation
The manual you have in hand contains most of the documentation available for
home and corporate usage. You may also consult our on-line versions for other
products on our documentation pages [http://www.mandriva.com/community/
resources/documentation].
Some of these manuals may be available in your Mandriva Linux pack, in the
mandriva-doc-en package. Once this is installed, a new menu entry will be available: More Applications + Documentation → Mandriva Linux documentation in
English .

1.2. Internet Resources
Internet information sources are widespread and many web sites are devoted to
GNU/Linux and its use or configuration. However, some sources of information
are better than others.
Your preferred source of information should be the Mandriva Linux official web
site [http://www.mandrivalinux.com/]. In particular, check out the support section
[http://expert.mandriva.com].
On the other hand, many unofficial sources will also be of value. For one there is
the Mandriva Community Twiki [http://mandriva.vmlinuz.ca/bin/view/Main/
WebHome]. It offers a lot of resources and gives information and documentation
which can certainly interest Mandriva Linux users.

1.2.1. Mandriva Club
If you're familiar with Mandriva Linux's web sites, you probably know about
Mandriva Club [http://club.mandriva.com/]. It's the meeting point for all Mandriva Linux users. On it you will find questions along with their answers, suggestions and news related to Mandriva Linux and GNU/Linux. You will be able to
express your opinions and influence future development of Mandriva Linux. If
you're not a member yet, we encourage you to join.
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2. GNU/Linux Useful Resources
One specific area of the Club is of particular interest: the Mandriva Club Knowledge
Base [http://club.mandriva.com/xwiki/bin/view/KB//] is the Mandriva Linux
user's database. It is probably the largest collection of Mandriva Linux-related
documentation on the web.
It collects submissions by Mandriva Linux users. It also features a discussion forum
and a community newsletter. These articles are meant to be practical and target
beginner and intermediate users.
Topics range from administrative issues, such as the handling of the shell, to the
tweaking of X, GNU/Linux's graphical subsystem.

1.2.2. Mandriva Security Advisories
The Mandriva Security Advisories web site [http://www.mandriva.com/security/]
is Mandriva's very own security site which covers package vulnerabilities.

1.2.3. Mandriva E-training
The Mandriva E-Training web site allows you to buy quality GNU/Linux training
in order to improve your Open Source knowledge. You can access this web site
[http://etraining.mandriva.com/] by using your Mandriva Club account. A free
demo on Samba is available.

2. GNU/Linux Useful Resources
In this section we present resources useful for any GNU/Linux distribution. Most
are not written specifically for Mandriva Linux, but may nevertheless prove useful.

2.1. The /usr/share/doc Directory
Most packages include their own documentation in one of /usr/share/doc's subdirectories, which will be named after the specific package. Mandriva Linux's own
documentation, when installed, is available in the /usr/share/doc/mandriva/
directory.

2.2. Internet Resources
2.2.1. Security-Related Web Sites
Security Focus [http://www.securityfocus.com/]
Reviews current attacks and publishes vulnerability advisories for a great
number of products, including Mandriva Linux.

50

2.3. The Man Pages
Linux Security [http://www.linuxsecurity.com/]
Entirely devoted to Linux and includes news, advisories, newsletters, and
many other resources such as documentation, forums, tools, etc. Check out
the site's documentation page [http://www.linuxsecurity.com/docs].
Linux dot com [http://www.linux.com]
Excellent site regularly fed with articles on present security issues. It also features articles about desktop, sound, etc. You should particularly check out the
HOWTO [http://howtos.linux.com/] section.

2.2.2. Other Linux Web Sites
Of the many existing web sites, here are some with the most information:
Linux Online! [http://www.linux.org/]
One of the very first sites devoted to Linux, containing a whole slew of links
to other useful sites.
Freshmeat [http://freshmeat.net/]
This is the place to visit to get the latest applications available in the Linux
world.
Linux Weekly News [http://www.lwn.net/]
One of the most exhaustive Linux publications available. It covers everything
from the latest security alerts to new distributions, information about current
and past kernels, books, and a weekly newsletter (for subscribers only).
And, of course, remember your favorite search engines. Generally speaking, they
are the most practical information seeking tools. A few carefully chosen keywords
in a search engine will often produce the answers you need for your specific
problem. With Google™, you can even make a GNU/Linux-oriented search by
visiting its Linux section [http://www.google.com/linux].

2.3. The Man Pages
The Manual Pages (also known as “man pages”) are a set of exhaustive documents
which help you acquire better knowledge of GNU/Linux commands. The latter
are usually issued through a “command line” and allow great control over your
system (see the Introduction to the Command Line chapter of the Reference Manualsee Chapter 33, Introduction to the Command Line [441]). Although these man pages
might seem discouraging at first, they offer great detail and we encourage you to
browse through them when a problem occurs.
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2.4. Info Pages
This should be your primary source of information for shell commands. Almost
all commands have a manual page. Other items, such as certain configuration files,
library functions for programmers and others system aspects also have their own
man pages.
Man page contents are arranged in different sections. References to these are made
in the following manner: for example, open(2), fstab(5) will respectively refer to
the open page in section 2 and the fstab page in section 5.
The easiest way to view a man page is through a browser. Using Konqueror, type man:/man(1) in the Location bar and the man page for the
man command will be displayed. For example, to display the man page
for fstab(5), type in the Location field: man:/fstab(5).
To display a man page in a terminal (or shell), type man. The syntax to obtain a
man page is:
man [options] [section] <manual page>

man also has documentation, which can be obtained by typing man man. Manual
pages are formatted and then displayed using the less pager.
The names of the manual pages and their relevant sections appear at the top of
each page. At the bottom of the page you will find references to other pages with
related subjects (usually in the SEE ALSO section).
You can start by consulting the pages related to the different commands covered
in the Reference ManualIntroduction to Linux [379]: ls(1), chmod(1), etc.
If you cannot find the right manual page — for example, you want to use the mknod
function in one of your programs but you end up on the mknod command page —
make sure you spell out the section explicitly. In our example: man 2 mknod. If
you forgot the exact section, man -a mknod will read through all the sections
looking for pages named mknod.

2.4. Info Pages
info pages complete the documentation included in the manual pages. The command to access info pages from a terminal is info.
Info pages are organized using a tree structure, the top of which is called dir. From
there, you can access all info pages.
info may be called up in two ways: either by omitting any argument, thereby
placing you at the very top of the tree structure, or by adding a command or a
package name, which (if it exists) will open the relevant page. For example:
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2.5. HOWTOs
info emacs

In the info pages:
* Buffers::

will indicate a link. Moving the cursor to this link (using the arrow keys) and
pressing Enter will take you to the corresponding info page.
You may also use the following keyboard shortcuts:
•

u : for Up, takes you up one level;

•

n : for Next, takes you to the next info page on the same tree-structure level;

•

p : for Prev, takes you back to the previous info page.

•

q : for Quit, will exit the info page viewer.

A great number of commands may be listed by pressing the ? key.
You can also display info pages in Konqueror by using the info:/ prefix
in your URL. For example, to display the info page for make, type in the
Location field: info:/make
This makes the navigation into info pages much easier.

2.5. HOWTOs
HOWTOs published by the TLDP (The Linux Documentation Project) are available
in many languages and cover many aspects of your system. As long as the proper
packages are installed (the howto-html-en package for the English edition), HOWTOs
will provide you with an answer to a specific question or a solution to a problem.
The documentation is located in the /usr/share/doc/HOWTO/HTML/en/ directory.
These are HTML files readable and printable with any web browser.
The list is quite long. To get an idea of its length, consult the index from the main
menu: Documentation → Howtos English .
When you encounter a complex problem, start by reading the corresponding HOWTO,
if available. Not only will you be given a solution to your problem but you will
also learn a great deal at the same time. Examples of what is covered range from
networking (NET-3-HOWTO), sound card configuration (Sound-HOWTO), the writing
of CD media (CD-Writing-HOWTO) as well as NIS and NFS configuration and much
much more.
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2.5. HOWTOs
An important step is to check the modification dates of the HOWTO documents — such as the publication date located at the beginning of the
document — to make sure they are up-to-date. Otherwise, the information
may be invalid. Watch out for old HOWTOs relating to hardware configuration: Linux evolves very quickly in the hardware area. Something else
to keep in mind: in the free software world the term “old” carries even
more weight than in IT in general: free software may be considered old
after being around for only fifteen days!
HOWTOs are available on-line on TLDP [http://www.tldp.org/] web site
and are likely to be slightly more up-to-date there. Have a look at the
following as well: HOWTOs classified by categories [http://www.tldp.org/
HOWTO/HOWTO-INDEX/categories.html], and FAQs [http://www.
tldp.org/docs.html#faq].
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Chapter 7. Using KDE
1. Discovering the K Desktop Environment
This chapter will introduce the K Desktop Environment (KDE) and its panel. It
will also talk about the concept of virtual desktops, how to navigate through and
manage them, the KDE help system and session support. The range of features
KDE offers as well as its degree of personalization is huge and you are encouraged
to refer to its integrated help to learn more about this great desktop environment.

1.1. The Desktop

Figure 7.1. The KDE Desktop
KDE follows the modern desktop paradigm. In the above figure you see the desktop
itself with some icons on it, while the panel sits at the bottom. This figure also introduces something new if you come from the Windows® world: virtual desktops
(see Section 1.3, “Virtual Desktops” [57]).
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1.2. The Panel
Virtual desktops are not an exclusive KDE concept. Other GNU/Linux
desktop environments and window managers also make use of them.
The icons on the desktop represent files, directories, applications, devices, web
pages, etc. Almost “everything” can be placed on it. Clicking on each icon opens
its associated application.
Here are some of your desktop's default icons, along with a brief explanation for
each of them.

Home. Gives access to all your personal files. Under UNIX®-like operating
systems (Mandriva Linux is one of these), every user has a personal directory
usually named /home/login_name.

Trash. Gives access to all deleted files (the equivalent of Windows®' Recycle Bin). Files can also be deleted without being thrown into the trash can (“direct”
file deletion) so some deleted files might not be accessible through the trash can.

System and media Icons. Gives you access to your home folder, system's
settings, networked places, storage media and the trash can. The media icon gives
you access to all the storage media present in the system, fixed and removable:
hard disk partitions, CD/DVD drive, floppy disk drive, ZIP/JAZ drives, USB keys,
and others. Double clicking on a device icon opens the corresponding medium.

1.2. The Panel

Figure 7.2. The KDE Panel
The panel is the bar which sits at the bottom of your desktop1 and contains the
following main components:

1

By default the panel is at the bottom, but it may be placed on any border of the desktop.
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1.3. Virtual Desktops

The Main Menu. Allows you to access the software installed on your
system. It is the equivalent of Windows®' Start menu. Programs are arranged into
convenient categories, so you can quickly and easily find the application you want
to run.

Show Desktop. Use this to minimize all currently opened windows.
Pressing it again will restore the windows to the state they were previously in.
Handy when you your desktop is so full of opened windows and you want to access, for example, a folder on your desktop.

Desktop Switching Applet. Makes switching between virtual desktops
as easy as one, two, three. See Section 1.3, “Virtual Desktops” [57] for more information.

Kat Search Tool. Allows you to perform searches on files according to
different criteria and metadata. Please refer to Section 3, “Searching For Files” [59]
for more information.

1.3. Virtual Desktops
Think of virtual desktops as having several screens available but with only one
monitor. By default, there are two virtual desktops, right click on the desktop
switching applet and select Configure Desktops to add or remove virtual desktops
and change desktop names for more meaningful such as Work, Play or Internet.
When you log in into KDE the last virtual desktop you were in when you closed
your last session is opened. To switch between virtual desktops just click on the
desktop number in the desktop switching applet et voilà !

2. Personalizing your Desktop
2.1. Changing your Desktop's Appearance
To change the desktop color scheme choose System + Configuration + KDE +
LookNFeel → Colors from the main menu. In the Color Scheme list are predefined
color schemes. Select the one you like and click on Apply .
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2.1. Changing your Desktop's Appearance

Figure 7.3. Changing KDE's Color Scheme
You can also define custom color schemes: click on the element you want to change
(for example, Active Window to change the active window colors), then on the
color bar, choose the color you like and click on OK to apply it.
Clicking on Save Scheme will allow you save the color scheme for later use; fill
its name and click on OK . Clicking on Remove Scheme will remove the currently
selected customized color scheme; predefined color schemes cannot be removed.
You are not asked for confirmation before removing a color scheme.
Therefore use the Remove Scheme button carefully.
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3. Searching For Files

Figure 7.4. Changing KDE's Background Wallpaper
To change the desktop background, choose System + Configuration + KDE +
LookNFeel → Background from the main menu. Select the background picture
option in the Background section and background scaling, colors and blending in
the Options section.
Click on the Advanced Options button to adjust settings such as an external program to draw the background, the cache size for images, etc.
All desktop background settings can be applied on a per-desktop basis
using the Setting for desktop pull-down list. Please note that doing so
consumes more memory.

3. Searching For Files
Kat is a search tool that is able to index your files based on the content of
the file, thus allowing you to look for files on your system. For example it can help
you find all of your PDF documents containing a given project. Kat is made of two
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3. Searching For Files
parts: a daemon responsible for periodically indexing files, and an interface to
manage catalogs and perform searches.
Choose System + Archiving + Other → Kat from the main menu to open Kat.

Figure 7.5. Kat Catalogs View
1.

Check configuration
Launch the setup wizard ( Settings → Launch Wizard ) to check everything
works correctly. Pay particular attention to the Helper Programs step. If some
applications are missing, it is time to install them through the Mandriva Linux
Control Center (see Chapter 16, Package Management through Rpmdrake [209]).

2.

Add Catalogs
This is done using the Catalog → New menu, or by right-clicking on the Kat
applet, and choosing Configure KAT , then clicking on the Add button in the
Catalog section.
Add a catalog for your home folder, and another one for
/usr/share/doc so that you can perform searches both on your
personal files and on the documentation installed on your computer.

3.

Check Indexation is Done
After adding new catalogs it can take some time before they get fully indexed.
To check the indexation status of each catalog, simply click on the Kat applet.
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4. KDE Help System
4.

Perform Searches
Click on the search button in Kat's main interface to toggle to the search
utility.

Figure 7.6. Sample Search Using Kat

4. KDE Help System
You can have access to all KDE and other system wide documentation resources
through the KDE help center. Choose More applications → KDE Help Center
from the main menu to open it.
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4. KDE Help System

Figure 7.7. KDE Help Center Main Window
KDE Help Center is organized like a two-frame web page, the left frame containing
the category menus organized as a tree, while the right frame displays the contents
of the category currently selected.
Navigation buttons are like Konqueror's browser ones:

Home. Returns to the page which opens when the Help Center is launched,
that is the “index” page. Keyboard shortcut: Ctrl - Home .

Back. Goes “back” to the previously visited help topic. Keyboard shortcut:
Alt - Left_arrow .

Forward. Goes “forward” in KDE's Help Center's site and topic history.
Keyboard shortcut: Alt - Right_arrow .
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Print.

Prints the currently displayed help topic. Keyboard shortcut: Ctrl - P

You should also take a look at the KDE Documentation web site [http:/
/kde.org/documentation/] where you will find many documents to
help you discover and master the K Desktop Environment.

5. KDE Sessions
KDE and its applications support sessions. This feature allows the system to save
the state of all applications that are in use when the user logs out of the desktop
environment, and to restore them when the user logs back in.
Please bear in mind that non-KDE applications, and even some KDE
ones, may have limited session support. The degree of session recovery
is up to the application, ranging from just opening the application again,
to opening it along with all the files that were open inside that application.
By default, KDE automatically saves sessions whenever you log out of the desktop
environment. To change the default behavior, open the Session Manager ( System + Configuration + KDE + Components → Session Manager from the main
menu.), make your choices and click on the OK button. The settings are effective
the next time you log into KDE.
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Part 2. Using the Internet
Using the Internet with Mandriva Linux
Using the Internet with Mandriva Linux is very easy. And since it includes many
mail clients and web browsers, you can choose whichever one really suits your
needs. In this part, however, we concentrate on one application per usage.
The default e-mail client in Mandriva Linux is part of the Kontact suite of applications and is called KMail. With it you can read and write e-mails, filter spam, sign
and encrypt your messages, and more (see Section 1, “Writing E-mails and Reading
News” [67]). The growing popularity of RSS feeds convinced us to document
Akregator, an open-source news feed reader (Section 1.2, “Akregator” [78]). To
browse the web we provide you with documentation about the very popular
Mozilla-based Firefox (see Chapter 9, Surfing The Web With Firefox [81]. Since it's
also available on Windows®, it's seriously threatening Internet Explorer's monopoly.
With it you can enjoy tabbed browsing, watch RSS feeds, as well as the other
standard web browser features such as managing bookmarks.
On the instant messaging front, we provide you with documentation about Kopete
(Section 1, “Instant Messaging” [93]). It supports the most popular instant messaging protocols like MSN Messenger and Yahoo ® Messenger. If you prefer using
IRC (Internet Relay Chat) we discuss X-Chat in Section 2, “IRC Using X-Chat” [95].

Chapter 8. Sending E-mails and Reading
News
1. Writing E-mails and Reading News
The KMail mailer is integrated into a groupware client named Kontact which also
contains the Akregator RSS news reader. This chapter describes how to configure
and use both of these applications to compose, read and organize your e-mail
messages, as well as your news feeds.

1.1. KMail
Launch KMail by choosing Internet + Mail → KMail from the main menu.
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1.1.1. Configuring KMail

Figure 8.1. KMail's Startup Interface
The first time you run KMail, Kontact's main window appears and the Mail section
is selected. Access the configuration window through the Settings → Configure
KMail menu. First of all, you must define an identity1 under the Identities category.
Click on the Modify button and fill in Your name, Organization and E-mail address.

1
It is useful to create a different identity for each e-mail address you might have (work and private, for
instance).
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Use the Cryptography, Advanced and Signature tabs to set up other parameters
such as different “Reply-To” addresses, a GPG key to send messages securely, and
so on. Click on OK and Apply to define your default identity.
Now configure the mail servers in the Accounts section. Click on Add in the Receiving tab, select POP3 as the account type2.

Figure 8.2. Configuring a POP3 Mail Account
Complete the Name field with a meaningful one for this account and the Host
field with your POP3 server's name or IP address. Type in the e-mail user name
and password which your ISP provided you with in the Login and Password
fields. Check the Store POP Password option to avoid having to type your password
2
We use POP3 in our example since most ISPs provide POP3 accounts to retrieve mail. If you have
another account type, such as an IMAP (Internet Mail Access Protocol) one, the configuration differs
slightly.
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each time you want to retrieve messages (see Figure 8.2, “Configuring a POP3 Mail
Account” [69])3. If you use many computers to access your e-mail with a POP3
account, you should check the Leave fetched messages on the server option which
allows you to access the messages you already downloaded from another computer.
Click on OK to add the account.
If you have a permanent network connection (such as DSL or cable-modem) activate the Enable interval mail checking option which tells KMail
to fetch messages periodically.

Figure 8.3. Setting the Outgoing Mail Server
In the Sending tab click on Add , and select SMTP as the transport type. Fill the
Name field with a meaningful name for this server and the Host field with the
SMTP server's name or IP address (see Figure 8.3, “Setting the Outgoing Mail
Server” [70]).
3
However please understand that this means anyone can actually access your e-mails if they are using
your user account.
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For security reasons, the outgoing mail server you use may need authentication. If this is the case, check the Server requires authentication box
and complete the login and password provided by your ISP or network
administrator.

1.1.2. KMail's Interface

Figure 8.4. KMail Client Interface
Toolbar. Where the main action buttons lie. See Table 8.1, “KMail's Toolbar
Buttons” [72].
Messages List. Where information (subject, date, sender, etc.) about messages
stored in the currently selected folder is displayed.
Message View Pane.
played.

Where the currently selected message's contents are dis-
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Folders List. Where all folders are listed. The default folders are inbox (incoming
messages), outbox (unsent templates), sent-mail (already sent messages), trash
(deleted messages) and drafts (draft messages).
Kontact Buttons. On the left of the interface are buttons to access Kontact's
components such as RSS Feeds (see Section 1.2, “Akregator” [78]).
The following table shows the most important buttons available in KMail's toolbar,
their equivalent keyboard shortcuts and a brief explanation of the functions they
provide.
Table 8.1. KMail's Toolbar Buttons
Button K e y - Function
board
Shortcut
Ctrl-N Compose a New Message.

Ctrl -L Get new messages for all defined e-mail accounts. Keep this button
pressed to display a list of all defined accounts; select the one you
want to get mail from in order to retrieve messages only for that
account.
R

Reply to the author of the selected message. A message-compose
window pops up with some fields already set.

F

Forward (send to a third party) the selected message.

Del

Delete the selected messages. Deleted messages are moved to the
Trash folder. You can recover messages moved to the trash
folder, but deletion from the Trash folder cannot be undone: be
careful!

Some of those buttons have a little black arrow at the bottom right corner.
An additional menu with related actions can be displayed by pressing
the mouse button a little longer.

72

1.1. KMail

1.1.3. Composing a Message

Figure 8.5. The Message-Compose Window
Toolbar. This is where the main composition buttons reside. See Table 8.2,
“Message-Composition Toolbar Buttons” [74]
Message Body.

The area where you will type the content of your message.

Message Recipients. The list of all recipients of this message. By default, the
following options are shown:
• To: the “principal” intended recipient of this message.
• CC (Carbon Copy): not-hidden “secondary” intended recipient(s) of this message.
All recipients will have access to the mail addresses to which this message is
sent.
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• BCC (Blind Carbon Copy): these recipients are also “secondary” but are hidden
from the other recipients of this message. No recipients of the message will
have access to the other mail addresses to which this message was sent.
The following table shows the buttons which are mostly used in the messagecomposition window, their equivalent keyboard shortcuts and a brief explanation
of the functions they provide.
Table 8.2. Message-Composition Toolbar Buttons
Button Keyboard Function
Shortcut
Ctrl -Enter Sends the message immediately (your network connection
must be active). A copy of the message will be kept in the
sent-mail folder.
Queue the message. The message will be saved in the outbox
folder and will be sent the next time you request mail to be
sent ( File → Send Queued Messages ).
Attach a file to the message. This function is also accessible
through the Attach → Attach File menu. A standard file
dialog will pop up. Select the file you want to attach and click
on Attach . Repeat for multiple files.

1.1.4. Folders and Filters
The filter tool is located in the Settings → Configure Filters menu and can automatically sort mail into different folders according to specified criteria (sender,
subject, date, etc.) using filters.
Let's assume you want to filter incoming messages according to the sender and
you have at least one message from that sender in your inbox folder. You want
all incoming e-mail from someuser@somecompany.net to go directly into the
SomeUser folder. The first step is to create a new folder to store the messages.
So access the Folder → New Folder menu and give your new folder a meaningful
name, select the mbox mailbox format and click on OK to create the folder.
To create the filter select one of the sender's messages and right click on it. From
the contextual menu, select Create Filter → Filter on From , select the destination
folder (Filter Actions) and accept that rule by clicking on Apply and OK .
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1.1.5. Cryptography
Using a PGP Key
KMail allows you to use cryptography in order to encrypt and sign your e-mails,
ensuring that your communications are not tampered with.
The easiest way to use encryption with KMail is if you already have a PGP key. If
you don't here's how to proceed:
1.

Open a terminal window ( System + Terminals → Konsole ).

2.

Type gpg --gen-key.

3.

You are asked for what type of key you want: choose DSA and ElGamal.

4.

Choose a key size: 2048 bits is the default, and is enough for today's needs;
4096 bits is probably extreme.

5.

You can select an expiration date: 0 is for no expiration date.

6.

Enter your user identification which contains your Real Name, then E-mail
Address and finally an optional Comment.

7.

Enter a passphrase which should be composed of upper- and lowercase letters,
numbers and symbols: you need to enter it twice.

8.

GPG now generates your key. Move your mouse around, surf the web, play
music since it needs a lot of random data.

9.

Finally to make sure everything works, type gpg --list-keys. You should get
something similar to this as a result:
[peter@community peter]$ gpg --list-keys
pub
1024D/95DBB95A 2005-03-15 Your Name (Comment) <your@email.com>
sub
1024g/47FBB9BA 2005-03-15

For more information about generating a GPG key, please refer to the gpg(1) man
page or to this excellent tutorial [http://linsec.ca/bin/view/Main/GnuPG].
Go in the Manage Identities window ( Settings → Configure KMail ) and click on
Cryptography: click on the Change buttons for the OpenPGP signing key and
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OpenPGP encryption key fields and select your key (see Figure 8.6, “Using
OpenPGP within KMail” [76]), then OK.

Figure 8.6. Using OpenPGP within KMail
Two new icons are now displayed when you open a new composition window:
•

•

Allows you to electronically sign your e-mail, which proves without a doubt
that the e-mail comes from you.
Permits you to encrypt a message for a specific recipient. Note however
that the recipient must have shared his public key with you.

Once you're finished writing your e-mail, click on the relevant icon (sign, encrypt
. A dialog box appears and you are asked to confirm your
or both) then click on
key and the recipient's:
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Figure 8.7. Encryption Key Approval Dialog
Finally enter your GPG passphrase.

Figure 8.8. Passphrase Dialog
When you receive encrypted mail, you are prompted for your passphrase: simply
type it in the dialog box which pops up.
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1.2. Akregator
Akregator is a feed reader or aggregator which can check on RSS-enabled web
sites for the latest headlines or articles. RSS is typically used on blogs, personal
web sites but also on major media sites such as those from the BBC and Reuters.

Figure 8.9. Akregator's Interface
Find a syndicated site4 and save the feed's URL by right-clicking on it. Then rightclick on the All Feeds folder at the top of Akregator's tree structure. Paste the URL
by clicking on your middle mouse button in the Feed URL field and click OK.

4

A site which offers RSS feeds.
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Figure 8.10. Adding a Feed
Right-click on a feed and select Fetch Feed to retrieve all of its articles. The right
side of Akregator's window allows you to see all of your feed's article titles. Click
on a title and then on the Complete Story link to read that story in a new tab.
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Chapter 9. Surfing The Web With Firefox
This chapter deals with the Firefox browser which is gaining more and more
popularity each day, and is also challenging other very widespread browsers on
different operating systems due to its cross-platform availability. One of Firefox's
fortes is that you can personalize it endlessly through extensions (Section 6, “Extensions” [86]) and themes (Section 7, “Themes” [86]).

1. A First Glance at Firefox

Figure 9.1. Firefox Interface

To launch Firefox click on this icon on your panel. You can also access it
through the Internet + Web Browsers → Mozilla Firefox submenu.
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If Firefox's interface isn't displayed in the language you expected, access
the Edit → Preferences menu entry, and select the General Language
option. Add your preferred language on top of the list. Refresh your
browser for the changes to apply.
Firefox's interface (Figure 9.1, “Firefox Interface” [81]) is composed of the following:
• Page Display Area. Where the contents of the sites you browse are displayed.
• Bookmarks Bar. Contains buttons which give you quick access to your favorite
sites (see Section 4, “Managing Bookmarks” [85]), as well as Live Bookmarks.
• Navigation Buttons & Location Bar. Enter the URLs you wish to visit in the
location bar. Local files can be accessed through the file:// protocol.
• Search Engine Field. Type in a keyword and choose your preferred search engine
(such as Googletm or Yahoo!). The results are available in the Page Display
Area.

2. Surfing the Web
The following table summarizes the most commonly used navigation buttons
every web browser possesses.
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Table 9.1. Firefox's Web Browser Toolbar Buttons
B u t - Keyboard Shortcut Function
ton
Alt - left_arrow

Go back. Returns to the page visited before the current one. By clicking on it more than once, you can
go back more than one page, but some pages use
automatic redirection so this may not always work.
Keeping this button pressed (or clicking on the little
black triangle at its right) will show you a list of all
the pages you can access through this feature.

Alt - right_arrow

Go forward. Returns to the page visited after the
current one. The comments for the “Go back” button
apply.

Ctrl - R

Reload. Refreshes the current page. By default, the
browser will first look for the page in its cache (ondisk temporary storage space) and use the local copy,
if relevant. Press the Shift key while clicking on the
reload button to force the browser to fetch the page
from the network.

Esc

Stop. Stops transferring the currently requested object
and will therefore cancel the page currently being
loaded. Notice that we use the word “object” instead
of “page” since web pages might be not only HTML
code, but images and other media too.
Home page. Returns you to the default Firefox home
page which you can set through the Edit + Preferences → General sub-menu.
Engines. Filling this field with a keyword (such as
Linux) will send for a request in one of the predefined
search engines, such as Googletm, Yahoo! and Creative Commons. By clicking on the Googletm logo, you
can even customize your engines by clicking on Add
Engines.

Ctrl - P

Print. Prints the currently displayed page. Please remember that printing a web page usually takes up
more space than a single sheet of paper.
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3. Using the Sidebar
The sidebar gives you quick access to the history of the sites you visited recently,
as well as to your bookmarks. To enable it, choose View + Sidebar from the menu
and then choose between Bookmarks ( Ctrl - B ) or History ( Ctrl - H ).

Figure 9.2. Bookmarks and History in the Sidebar
Search. Enter the keyword you wish to find results for (i.e. Mandriva Linux) in
the Search field and press Enter . This applies for both the Bookmarks and History
sidebars.
Bookmarks. Clicking on one of your bookmarks from the sidebar automatically
launches a request for that page. It's then shown in the display area. To search for
specific bookmarks based on keywords, type one in the Search field.
History. If you want to return to a site you visited three days ago, access the 3
days ago folder in the History sidebar and click on the plus sign (+). The same
behavior as for the bookmarks sidebar applies.
To change the number of history days to keep, choose Edit + Preferences
→ Privacy from the menu and open the History sub-section.
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4. Managing Bookmarks

Figure 9.3. Bookmarks Manager Dialog
Select Bookmarks → Manage Bookmarks from the browser's menu to open the
bookmarks manager (Figure 9.3, “Bookmarks Manager Dialog” [85]). They are
classified in a tree structure, all operations taking place on the currently selected
tree node. Click on the different available buttons to create folders, add separators,
etc. Click on the Properties button to change the current bookmark's name or URL.
To export bookmarks to an HTML file choose File → Export , type a file name
(bookmarks.html by default) and click on Save .
To import bookmarks from an HTML file access File → Import , enter the name
of the file you want to import and click on Open .

5. Tabbed Browsing
Firefox allows you to browse many web pages at a time through tabbed browsing.
Tabs let you browse many sites at once without opening another browser window.
Just hit Ctrl - T to open a new tab.

Figure 9.4. Firefox Tabs
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6. Extensions
Located at the right of the tab list the cross button allows you to close the current
tab. By right-clicking on it you access more options.

6. Extensions
Extensions are addons or plugins which enhance Firefox's functionalities. To install
extensions access Tools → Extensions and then Get More Extensions .

Figure 9.5. Firefox Extension Page
Once you find an extension which interests you click on it and install it. You need
to close and reopen your browser for the extension to be activated. Access the
Extensions sub-menu again. The new extension will be there and you can check
out its Options .

7. Themes
A theme is what determines a window's appearance. To acquire new themes:
• access the Tools → Themes submenu;
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• select a theme and install it;
• close and reopen Firefox.

8. Installing Plugins
Plugins are programs which let your browser handle content other than HTML
and graphics, such as animations, streaming audio, Javatm applets, and more.
Firefox's plugins are stored in the /usr/lib/mozilla-firefox-VERSION/plugins
directory and installing plugins requires root privileges.
We will look at the procedures to install Javatm, Flash® and Real plugins. If you
own a commercial version of Mandriva Linux, installation is greatly simplified
and all the needed packages are on the CDs. If not you will need to find them on
the Web yourself.
If you are a Mandriva Club member, you may be able to install even
newer versions of the software mentioned here.
tm

®

8.1. Java , Flash and Real Player
To use Java install the jre RPM package. To view sites built with Flash technology
install the FlashPlayer RPM. To listen to streaming media install the RealPlayer
RPM (see Chapter 16, Package Management through Rpmdrake [209]).

9. Password Management
Firefox can remember login and passwords for Intranet pages, web-mail pages,
bank-account information pages, etc. Therefore you do not have to type them in
each time you access such pages.
Even if Firefox stores passwords in a secure manner, some may feel this
is a security risk. If you do not feel confident with this feature, or feel
other people may access your computer, use it only for accounts that do
not give access to sensitive information. You may not want to store
passwords for sites such as bank accounts.
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Figure 9.6. Enter your Login and Password
Whenever you access a protected web page, the dialog shown in Figure 9.6, “Enter
your Login and Password” [88] pops up. Check Use Password Manager to remember this password and next time you browse to that page, both fields will already
be filled for you.
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Figure 9.7. Passwords Preferences Dialog
To access your Saved Passwords (Figure 9.7, “Passwords Preferences Dialog” [89])
choose Edit + Preferences , then Privacy.
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Figure 9.8. Manage Stored Passwords Dialog
Click on the View Saved Passwords button to remove some or all saved passwords.
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Figure 9.9. Master Passwords Preferences Dialog
The master password is the one used to encrypt all sensitive information Firefox
stores on disk. This password should be of high quality (the change-password
dialog has a quality meter) to ensure maximum security.
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Chapter 10. Instant Messaging and IRC
1. Instant Messaging

Kopete is a very complete instant messaging (IM) client. With it, you
can chat with people using many protocols, such as AIM/ICQ, MSN, Yahoo!, etc.
Access the Internet + Instant Messaging → Kopete menu to launch Kopete. The
first time you launch Kopete, the configuration dialog shows up. You can also
open it by going to the Settings → Configure Kopete menu to add an account.

Figure 10.1. Adding an Account
First select the protocol associated to your account (Jabber, MSN, Yahoo!, ICQ,
etc.) Then enter your user name, review the protocol's options, and click on Next
and Finish . You are connected with the protocol you've chosen and your contacts
appear in the main window. Click on your protocol's logo (bottom right of the
window) to control the connection and presence status.

1.1. Sending Instant Messages
Double-click on the name of one of your contacts to initiate a conversation.
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Figure 10.2. Chatting with a Friend
Use the different icons to add smileys, change the font, align your text, etc. Access
the Chat + Invite → <Friend's Name> menu to invite another friend to your conversation which creates a “chatroom”.

1.2. Sending Files and Email
From Kopete's main window right-click on your contact's name and then click on
Other Actions → Send File .
Use the same method to send an e-mail. If you use the MSN protocol a browser
window appears and connects you to Hotmail where you can write your e-mail.

1.3. Setting Up Plugins
Access the Settings → Configure Plugins menu. Here's a selection of the most interesting ones. Bear in mind that some of those plugins are somewhat immature
and might not behave like you expect:
Bookmarks. Allows you to bookmark sites sent by your friends, either by contact
or as a unique file.
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Highlight. Enables you to filter certain words or expressions and to highlight
them: background or foreground color, sound, etc.
History. Keeps a log file of all the messages you exchange with your contacts.
They are stored in the /home/username/.kde/share/apps/kopete/logs/[*]Protocol folder.
Netmeeting. Allows you to use voice and video transmission with MSN Messenger clients through GnomeMeeting (see Section 3, “Webcams and Video Conferencing” [145]).

2. IRC Using X-Chat
IRC allows more than two people to simultaneously send short messages in real
time. IRC servers are grouped into networks (also called “nets”), the largest ones
being DALnet [http://www.dal.net], EFnet [http://www.efnet.net] — the original
IRC network — and IRCNet [http://www.ircnet.com]. These server collections
are connected together so you're in “contact” with all of the users who are logged
on to all the servers of a specific network (such as DALnet).
IRC servers are made up of channels where users gather to chat about a specific
topic. Anyone can make up a channel name, if that channel doesn't already exist.
And although many people join a channel to discuss with many users, it's also
possible to send private messages which other users won't see.
Channels are server-dependent. Therefore, the #linux channel on the
irc.someserver.net server is different from the #linux channel on the
irc.someotherserver.net server: they don't communicate with one
another.

2.1. Launching X-Chat
Choose Internet → X Chat from the main menu to start X-Chat.
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Figure 10.3. X-Chat Server List
Once X-Chat is launched, the server-list window pops up (see Figure 10.3, “X-Chat
Server List” [96]). First of all, you can change your nickname (peter in our example)
in the appropriate field, by which you will be known by on IRC1. Then, choose a
network to connect to and click on Connect .
If you cannot find a specific server you wish to connect to, you can either
add a new network or simply add a server to an existing network. By
clicking on the Edit button, you can add a new network and access the
server list for each network. You can then Add a new server or set which
channels to connect to by default when connecting to a specific network.
1

On some servers nicknames are registered, so it's possible for you to always have the same nickname
on that server. A tab pops up and shows you how to proceed if that's the case. In the Server List, you
can edit the server's information on which you connect regularly and fill the Nickserv password field
in order for X-Chat to log you in directly.
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The X-Chat main window (shown in Figure 10.5, “X-Chat Channel” [98]) appears
and the connection with the server is established. Once this is done check the list
of existing channels from the Window → Channel List menu entry and enter one
(see Figure 10.4, “X-Chat Channels' List” [97]).

Figure 10.4. X-Chat Channels' List
You can change the Minimum Users parameter to list more or less populated
channels, and specify a string in Regex Match to search for specific channels. Then
click on Refresh the list , select a channel to connect to and click on Join Channel .
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Figure 10.5. X-Chat Channel

2.2. The X-Chat Window
The X-Chat window has the following major components.
Menu Bar
Contains the basic menus: X-Chat, IRC, Server, Settings, Window and Help.
Tool Bar
Under the menu bar. It shows an “X” at the left which you can click to close
the current channel/server. At the right of the “X” you have a text box that
shows the channel's topic: you might be able to type in a new topic and press
Enter to set it.
User List
Located on the right side of the window, it displays the list of users currently
in the channel. A green dot means that the user is the channel operator. A
yellow dot means that user can post to a moderated channel. Through the
Settings + Preferences → User list menu, you can add function buttons which
allow for easy one-on-one dialogs and file transfers. Check the User list buttons
enabled box to activate it.
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Input Box
At the bottom of the window. On the left is your nickname. To the right is the
mini-buffer where you can type your text and tap on Enter to send it. You can
set up some options through the Settings + Preferences menu, such as beeping
when a new message comes up on a channel.

2.3. Essential X-Chat Commands
Commands are issued on the Input Box. All IRC commands start with a / and are
followed by the name of the command. Here's a list of useful ones.
AWAY
Informs channel users that you are busy. By default, your nickname will be
gray-shaded. You can also use the Alt - A keyboard shortcut.
BACK
Tells other users you are available again. Your nickname will revert to its original color (black by default). The same keyboard shortcut as for the AWAY
command can also be used.
HELP
Displays the list of available commands in your X-Chat window.
JOIN
Used to join a channel. /join #mandriva will make you to join the #mandriva
channel. If the channel name doesn't exist, a new channel with that name is
created.
ME
Can be used to tell others what you are doing or feeling in the third person.
/me feels in a good mood displays:
* peter feels in a good mood

MSG
Sends a private message to a user which other users won't see. However, it
doesn't open a new tab (channel) like the QUERY command (see below). The
syntax is:
/msg nickname_of_the_recipient message

So, /msg queenpingusa how are you? displays:
>queenpingusa< how are you?
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NICK
Allows you to change your IRC nickname. For example, if Peter Pingus wanted
to change his nickname to Johnny, he would issue /nick Johnny. Then, this is
be displayed:
* You are now known as Johnny

PART
Disconnects yourself from a channel, and possibly tells other users why you
are leaving the channel. The syntax is:
/part #channel message

Once you issue that command, you are disconnected from the channel you
were connected to. To reconnect, simply type:
/join #channel

QUERY
Opens up a new tab in your X-Chat window and starts a private conversation
with a user. The syntax is similar to the MSG command:
/query user

When the new tab appears, type your message.
Servers which require for users to register their nicknames don't allow
for private messages between a registered and a non-registered user
in order to avoid SPAM.
QUIT
Terminates your IRC session. You can add a comment, like /quit going to bed.

2.4. Basic IRC Rules of Conduct
Here are the basic rules which we strongly suggest you follow strictly. They are
all common-sense rules, but unfortunately, it's the least common of all senses. We
encourage you to read the excellent Freenode Channel Guidelines [http://freenode.
net/channel_guidelines.shtml].
Spoken Language
Most IRC users speak English, that's just plain fact. However, it's not the only
language spoken on IRC. Before starting a thread, let's say in Portuguese, you
should inquire about the channel's language policy. If it's obvious the channel
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on which you are talking is an English-speaking one, create or choose another
channel where you can write in the language you prefer.
Greetings
Depending on the number of users on a specific channel, it might not be wise
to greet everyone who enters or leaves the channel. Usually, one “Hello!” or
“Goodbye!” is quite enough.
Attitude
If you don't know the people with whom you chat, chances are they will only
know you through what you write. Therefore if you don't want to be perceived
as a jerk, don't act as one! This means:
• do not dump large amount of data on a channel or user;
• do not harass others or flame them for any reason.

101

102

Part 3. Linux Office
Using Mandriva Linux on a Daily Basis
This part is an introduction to the many office or home-usage applications available
under Mandriva Linux.
First we explore office software with the OpenOffice.org suite in Chapter 11, The
OpenOffice.org Suite [105]. It provides a word processor (see Section 1, “Word Processor” [105]), a spreadsheet (see Section 2, “Spreadsheet” [113]) and a presentation
application (see Section 3, “Presentation” [120]) amongst other components.
Then Chapter 12, Managing Files [129] goes through Konqueror different usages,
whether it be as a file manager, a file sharing tool, or even a web browser.

Chapter 11. The OpenOffice.org Suite
1. Word Processor
This section will give you a brief introduction to OpenOffice.org Writer's word
processing functions.
In order to make the text a little easier to read, we will alternate between
the popular OOo acronym and the very long, yet full and correct OpenOffice.org name.

1.1. What Is a Word Processor?
One of the tasks most performed with a computer nowadays is some form of word
processing. Word processors replaced typewriting machines while allowing you
to write text using many fonts, paragraph alignments, tables, images, lists, etc.
Even though word processors also offer some desktop publishing features, they
are very limited ones: limited precision in measurements, limited text flow around
images and tables, etc.

1.2. OpenOffice.org Writer
OpenOffice.org Writer is the part of the OpenOffice.org suite which provides the
word processing functions. OpenOffice.org Writer can read most popular Office
formats, easing the transition from, and ensuring compatibility with, other Office
suites.

1.2.1. Starting
To launch OpenOffice.org Writer, select Office + Wordprocessors → OpenOffice.org
Writer from the main menu. You can also open it from any other OOo application
screen, by selecting File + New → Text Document , which will open a blank OOo
Writer document.
When you first launch OpenOffice.org Writer, a dialog will show up (see Figure 11.1, “Choosing the Default File Format” [106]) asking you whether you prefer
to use the Microsoft® or OpenOffice.org format to save your files.
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Figure 11.1. Choosing the Default File Format
Your decision depends on whether you plan to exchange a lot of files with people
who only use Microsoft® tools. If this is the case, click Use the Microsoft ® Word
file format , but be warned that it is not perfectly supported. Also this is only the
default format and can always be overridden by changing the File type in the Save
as dialog.
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1.2.2. Interface

Figure 11.2. OpenOffice.org Writer's Main Window
Format Bar
This is the standard format bar used for all OpenOffice.org applications and
is used to change fonts, colors, alignment, etc. of the application's data.
Rulers
Rulers define the horizontal location of the text and format elements. They are
extremely useful when you want to establish tabulation and paragraph indentation.
Work Area
Where you enter the content of your document: words, numbers, images,
tables, hyperlinks, etc.
Insertion Point
All characters typed on your keyboard will be placed at the left of this point.
Also called the cursor.
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Stylist
Clicking on any of the styles shown on the list will change the current selected
text's style or the whole page style if no text is currently selected.
Page Style
Page size, margins, text-orientation, etc. all define the style. Page style can be
changed by choosing Format → Page from the menu. You may use any one
of the predefined styles or define one of your own.

1.3. Using the Word Processor
1.3.1. Styles
Word processor users often waste a lot of time formatting (changing paragraph
alignment, font family, weight and size, etc.) their documents instead of using that
time to concentrate on document structure and document content writing.

Styles provide a structure-centric approach to writing documents with a
word processor, while normalizing document formatting and layout, and easily
automating the generation and maintenance of table of contents (TOC), indexes,
references, etc. In OpenOffice.org Writer, styles are handled using the Stylist, click
on its icon in the tool bar to open/close it.
Table 11.1. Suggested Styles
When you have a...

Then apply the ... style

Chapter Title

Heading 1

Section Title

Heading 2

Sub-Section Title

Heading 3

Sub-Subsection Title

Heading 4

Paragraph

Text Body, First Line Indent

List Item

List

Use the styles listed in Table 11.1, “Suggested Styles” [108], as a guide. Select the
region of the document to apply the style to, and in the Stylist window, doubleclick on the style you want to apply to that region.
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The styles you use from the Stylist automatically become available in the
styles drop-down list (the first one in the format bar), so you have the
most used styles handy.

1.3.2. Margins
You can always adjust margins by hand with the ruler, but if you want to format
a long document, this may not be the best solution. This is where the Stylist comes
in handy.
By clicking on this icon in the Stylist, you will access the page formatting
section of the Stylist. First, make a copy of the Default style:
1.

Right-click on the Default item in the Stylist.

2.

Choose New from the menu which pops up.

3.

Assign a Name to your new style. The Next Style field will be updated accordingly when you select it. For the purpose of this example, Default Copy will
be used as the style name.

4.

Click on OK to insert your new style into the list of available styles.

Then, right-click on your newly created style item and choose Modify from the
pop-up menu. The Page Styles: Default Copy window will appear. Open the Page
tab and modify the margins to your liking.
This is the same as choosing the Format → Page menu.

In the Page Styles: Default Copy window, you can modify many formatting elements. If most of your work with a word processor consists of writing business
letters with a predefined format, you could set it up right now, thereby saving lots
of time.
If you modify an existing style, you will overwrite that style's original
settings. If you feel that you have made a mistake, simply click on the
Reset button to return to the last saved settings.
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1.3.3. Lists
Use lists to enumerate the properties of an object (“unordered” or “bullet” list), or
the steps to be performed in order to accomplish some task (an “ordered” or
“numbered” list).

Clicking on this button will format the selected text into an unordered list.
Selecting the list items and choosing Format → Numbering/ Bullets from the
menu will allow you to change the bullet type from a predefined set.

Clicking on this button will format the selected text into an ordered list. The
same rules as for unordered lists apply regarding to the numbering format.

1.3.4. Multiple Columns
Choosing Format → Columns in the menu will open the dialog shown in Figure 11.3, “Text Columns Options Dialog” [110], allowing you to format the text in
the page into more than one column (the default).

Figure 11.3. Text Columns Options Dialog
The dialog options are self-explanatory. Make your selections and click on OK to
apply the column settings.
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1.3.5. Table of Contents
In order to make your documents look professional, you can create tables of contents
and index parts of your document.

Figure 11.4. Table of Contents
The image in Figure 11.4, “Table of Contents” [111], shows what the TOC for an
example document looks like.
Even if TOC items can be manually inserted and maintained, it is highly
recommended that you use styles to make the TOC more consistent and
easier to maintain.
Let us say you want to insert a TOC at the beginning of your document and you
have followed the styles suggested in Table 11.1, “Suggested Styles” [108]. Make
the 1st page an empty one by going to the very top of your document and pressing
the Ctrl - Enter keys.
Then choose Insert + Indexes and Tables → Indexes and Tables from the menu to
bring up the table/index options dialog. Make sure the Type field is set to Table
of Contents and the Protected against manual changes check-box is checked. Fill
the title and the rest of the options and click on OK to insert the TOC.
If you continue to add content to your document (whether “structural” or “essential”) you must update the table of contents for the modifications to be taken into
account. To do so, click on any part of the TOC to put the cursor “inside” of it,
then right click on it and choose Update Index/Table from the menu which pops
up.
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1.3.6. Index
To index important terms in your document, proceed as follows:
1.

Select the word you wish to index.

2.

Access the Insert + Indexes and Tables → Entry sub-menu.

3.

Make sure the Index type is set to Alphabetical Index and click the Insert
button.

4.

When you are finished entering all the terms you wish to index, generate the
index table by accessing the Insert + Indexes and Tables → Indexes and Tables
sub-menu.
Remember to choose the appropriate Title and to set the Type to
Alphabetical Index. Bear in mind that indexes generally go at the
end of documents.

If you continue to add index terms to your document you must update the index
for your modifications to be taken into account. Proceed as described above for
the TOC, but clicking “inside” the index.

1.3.7. Page Headers and Footers
By default page headers and footers are common to all pages of a document. Use
them to describe certain aspects about the document's content, for example: page
number, total number of pages, chapter, section, document's title, etc.
Choose Insert + Header → Default from the menu to add a page header to your
document, and choose Insert + Footer → Default to add a page footer to your
document. Just type the header/footer text you want to be shown or use one or
more of the Insert → Fields menu items to compose the header/footer.

1.4. Going Further
If you wish to learn more on the usage of OpenOffice.org Writer, you should consult
the tutorial available on the Tutorials for OpenOffice [http://www.
tutorialsforopenoffice.org/category_index/wordprocessing.html] Web site.
Also don't hesitate to refer to the OpenOffice.org Writer's help which is accessible
through the Help → Contents menu, or by pressing the F1 key. You are bound
to find the answers to your questions.
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OpenOffice.org Writer is able to export your documents in PDF format
(choosing File → Export as PDF from the menu). This allows you to
publish your documents in the Adobe® Reader® format.

2. Spreadsheet
This section will give you a brief introduction to OpenOffice.org Calc's spreadsheet
functions. We take for granted that you know why you intend to use a spreadsheet
and will not delve deeply into application-specific (accounting, financial, simulation,
etc.) considerations.

2.1. What's a Spreadsheet?
Spreadsheets are electronic replacements for an accountant's ledger book and calculator. They use columns and rows to allow math operations to be performed on
previously entered data. Nowadays, spreadsheets do a lot more as they are often
used as (very) simple databases or as a charts and graphs application, even though
that was not the original intention of such software.
Rows are named 1, 2, etc. Columns are named A, ..., Z, AA, AB, etc. The intersection
of a row and a column is a cell, and its name is composed of the column and row
attributes, for example: C3 (shown in Figure 11.5, “Rows, Columns and Cells” [114]).
The active row and column names are highlighted.

2.2. OpenOffice.org Calc
2.2.1. Starting
To launch OpenOffice.org Calc, select Office + Spreadsheets → OpenOffice.org
Calc from the main menu. You can also open it from any other OpenOffice.org
application screen, selecting File + New → Spreadsheet , which will open an
OpenOffice.org Calc window with a blank spreadsheet on it.
When you first launch OpenOffice.org Calc, a dialog will show up (see Figure 11.6,
“Choosing the Default File Format” [114]) asking you whether you prefer to use
the Microsoft® or OpenOffice.org format to save your files.
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Figure 11.5. Rows, Columns and Cells

Figure 11.6. Choosing the Default File Format
Your decision depends on whether you plan to exchange a lot of files with people
who use only Microsoft® tools. If this is the case, click Use the Microsoft® Excel
file format , but be warned that it is not perfectly supported. Also note that this is
only the default format and can always be overridden by changing the File type
in the Save as dialog.
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2.2.2. Interface

Figure 11.7. OpenOffice.org Calc's Main Window
Format Bar
This is the standard format bar for all OpenOffice.org applications used to
change fonts, colors, alignment, etc. of the application's data.
Formula Bar
Use it to enter, edit or delete formulas inside cells.
Work Area
Where you enter the data in the spreadsheet: numbers, dates, formulas, images,
etc.
Select All
Clicking on this little area at the top left corner of the work area will select all
cells at once. It's useful when you need to make changes which are “global”
to the spreadsheet. For example, changing all font sizes in the cells to 10pts
(points).
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Sheet Changing Buttons and Tabs
Spreadsheets usually contain more than one sheet. Use these buttons to easily
navigate through each of the spreadsheet's sheets. From left to right they are:
Go to the first sheet, Go to the previous sheet, Go to the next sheet and Go to
the last sheet. You may also use the tabs to switch between sheets.

2.3. Using the Spreadsheet
The following sections explore basic functions such as entering data and formulas
in the spreadsheet and adding graphics to represent that data. An example of an
imaginary company's monthly expenses and sales figures is used.
OpenOffice.org Calc is an enterprise-ready spreadsheet application and includes
many features way beyond the scope of this document. Consult Section 2.4, “Going
Further” [119], for more information on how to make full use of OpenOffice.org
Calc.

2.3.1. Entering Data
To enter data into a cell navigate to the cell and type the data in it, pressing the
Enter key when you are finished. You can also use the Tab key or the Shift - Tab
keys to move to the cell on the right or on the left, respectively.
Auto-completion simplifies data entry “guessing” the next cell's value using the
current cell's value as a base. It works for any kind of data which can be associated
to a series of consecutive integral numbers.
To use auto-completion put your mouse over the cell “handle” (the little black
square located at the bottom right of the cell border), click on it and drag the cell.
The cell values will be shown in a tool-tip (see Figure 11.8, “Simplifying Data Entry
Using Auto-Completion” [117]). Release the mouse button to complete the cells
once the desired final value is shown.
Cell data can also be sorted according to different criteria. Select the cells you want
to sort and then open the sort options dialog choosing Data → Sort from the menu.
Specify the sort criteria, order and additional options and click on the OK button
to sort the cells.
Make sure you also select columns and rows which act as “headers” for
the data (in our example, the column B which contains the months) in
order for those to “follow” the sorting of the data.
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Figure 11.8. Simplifying Data Entry Using Auto-Completion

2.3.2. Adding Formulas
Formulas can be used to “automate” the spreadsheet allowing you, for example,
to run complex simulations. Within cells, formulas are defined by preceding all
cell data with the = sign. Anything else is treated as “static” data.
Operations are expressed using conventional algebraic notation. For example
=3*A25+4*(A20+C34/B34) divides the value in cell C34 by the value in cell B34,
adds the value in A20 to the result, multiplies that by 4 and adds to 3 times the
value of cell A25. Thus, rather complex expressions can be made using simpler
ones as a base.
OpenOffice.org Calc gives you many pre-defined functions which you can use in
your formulas, explore them by choosing the Insert → Function menu or by
pressing the Ctrl - F2 keys.
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Under KDE the Ctrl - F2 key combination switches to desktop number
two, so you might want to redefine that in order to be able to invoke
OpenOffice.org Calc's functions wizard using a keyboard shortcut.
Figure 11.9, “Using a Function in a Formula” [118] shows the AVERAGE function
applied to the selected range of cells to calculate their average value. Note the use
of the : character to specify a range of contiguous cells in the function.

Figure 11.9. Using a Function in a Formula

2.3.3. Charts: Explaining Data in a Simpler Way
When a spreadsheet contains too much information it often becomes difficult to
understand how pieces of data relate to one another: too many numbers and too
little meaning. The best way to represent this kind of data is through a chart.
As in all data-analysis functions, you must select the region you intend to show
in the chart. So, select a range of cells and then chose Insert → Chart from the
menu to bring up the chart assistant.
Make your selections for the chart type, variant, title, axis titles, etc. and then click
on Create to create and insert the chart in the spreadsheet (see Figure 11.10, “A
3D Chart Inside the Spreadsheet” [119]).
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Figure 11.10. A 3D Chart Inside the Spreadsheet
Charts are “dynamic” in the spreadsheet which means that when you
change data in a cell belonging to a chart, the chart will be automatically
updated.
Clicking and then right-clicking on an inserted chart brings up a menu
showing options to change many chart parameters. For instance, the
chart's title can be changed by double-clicking on it.

2.4. Going Further
If you wish to learn more on the use of OpenOffice.org Calc, you should consult
the tutorial available at the Tutorials for OpenOffice [http://www.
tutorialsforopenoffice.org/category_index/spreadsheet.html] Web site.
Also, don't hesitate to refer to OpenOffice.org Calc's help accessible through the
Help → Contents menu, or by pressing the F1 key. There you are bound to find
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answers to your questions. Topics are accessible through a table of contents. An
index is also available as well as a contextual search tool.

3. Presentation
This section will give you a brief introduction to OpenOffice.org Impress'
presentation functions and features which allow you to build stunning presentations
for any purpose, making it an excellent choice for any number of working environments.

3.1. What Is Presentation Software For?
Whether you are a salesman, an engineer, an accountant or a student, you need to
“communicate” your work to others in a simple and succinct way. Presentation
software lets you replace long texts with images, graphs, little tables, small amounts
of text, and maybe even some animations, to convey your ideas and be able to
project them on a big white screen or wall.

3.2. OpenOffice.org Impress
3.2.1. Starting
Choose Office → Presentations → OpenOffice.org Impress from the main menu
to launch OpenOffice.org Impress.
You can also open it from any other OOo application screen, by selecting File →
New → Presentation , which will open the presentation wizard, answer its questions to create the “skeleton” for your presentation.
When you first launch OpenOffice.org Impress, a dialog will show up (see Figure 11.11, “Choosing the Default File Format” [121]) asking you whether you prefer
to use the Microsoft® or OpenOffice.org format to save your files.
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Figure 11.11. Choosing the Default File Format
Your decision depends on whether you plan to exchange a lot of files with people
who only use Microsoft® tools. If this is the case, click on Use the Microsoft ®
PowerPoint file format , but be warned that it is not perfectly supported. Also, this
is only the default format and can always be overridden by changing the File type
in the Save as dialog.
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3.2.2. Interface

Figure 11.12. OpenOffice.org Impress' Main Window
Slide Format Bar
There are options for changing the slide shading, background color, line
thickness, etc.
View Mode
These buttons let you change between:
• Drawing View. The default. Used to compose slides.
• Outline View. Shows a numbered list of all slides at the left with the text
they contain (allowing you to edit it, for example) and a preview window
on the right so you can have a quick look at the slide.
• Slide View. Shows all slides at once allowing you to navigate through them
and take a quick look at your whole presentation.
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• Notes View. You can add notes to your slides in order to help you, your
colleagues, or even your audience (if you print them) during the presentation.
• Handout View. This can be used to print several slides in one page in order
to distribute printouts of your presentation to your audience, which is
considered almost mandatory for many professional presentations.
• Start Slide Show. Pressing this button will “run” your presentation. The
same button is located at the end of the toolbar (explained below).
Work Area
Where you compose the slides which build up your presentation.
Slide Tabs
Every slide which makes up your presentation possesses a tab which enables
you to quickly reach a particular slide. At the left of the tabs are the slide
navigation buttons which behave exactly like OpenOffice.org Calc's sheet
navigation buttons (see Section 2, “Spreadsheet” [113]).
Tool Bar
It contains the main tools you use to create your slides: the text, shapes, curves,
lines and arrow input tools, as well as the object rotate, alignment and arrangement tools, effects tools, and the view-presentation button at the bottom.
Some of these buttons contain a little triangle on one corner. Keeping
these buttons pressed will open a menu of options for that tool. For
example: filled or hollow rectangles, sharp or round edges, etc.

3.3. Building Presentations
By default OpenOffice.org Impress uses blank slides. Choose Format → Modify
Layout from the menu to change the slide's template. Select the one you want to
use for (most of) your slides, in our example we chose “Title, Text” (see Figure 11.13,
“Selecting a Slide Template” [124]). Selecting a particular template does not tie all
your slides to that template, just makes it the default one.
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Figure 11.13. Selecting a Slide Template
Presentations are an important means to convey your ideas, whether it
be to clients, teachers, students, or colleagues. By trying to respect the
principle which states that “Simple is elegant” — that is, by trying not
to overload your presentations with too many graphics, large tables and
complex animations and transitions effects — you will keep your audience
focused on what you are trying to communicate. Use the simplest template possible.

3.3.1. Slide's Title
In this case, the template is fairly intuitive. Click on the box labeled Click to add
title. Type your title and then click on an “empty” spot of the slide to exit edit
mode. That's it.

3.3.2. Inserting Text
Click on the lower box to insert your text (where Click to add an outline is
written). This automatically formats it as a bullet list. You can change these settings
through the Format menu.
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3.3.3. Adding Slides to your Presentation
Choose Insert → Slide from the menu to add a new slide: the familiar slide type
window appears (see Figure 11.13, “Selecting a Slide Template” [124]). Proceed as
explained before.
Choose Insert → Duplicate Slide instead if you want to base your new
slide's content on the current one.

3.3.4. Simple Graphics
It is often useful to build simple diagrams to explain or show a concept. After all
a picture does speak a thousand words. Table 11.2, “Graphics Tools” [125] summarizes the available tools to build simple graphics.
Table 11.2. Graphics Tools
Button Function
Draws rectangles and squares, either filled or unfilled, with sharp or
rounded edges.
Draws ellipses and circles, either filled or unfilled; elliptical and circular
pies, segments and arcs.
Draws 3D objects such as cubes, spheres, cylinders, cones, pyramids,
torus, shells, or half-spheres.
Draws curves, polygons, and free-form lines, either filled or unfilled.
Draws lines and arrows. Lines can have arrows at either end or at both.
Draws “connectors”. Connectors are lines, either straight or curved, with
or without arrows at either end which link objects with each other.
Right click on the drawn object and access the menu to change attributes
such as color, shadowing, transparency, etc.

3.3.5. Simple Charts
Choose Insert → Chart from the menu to insert a chart diagram into the current
slide. A “default” bar chart will be inserted, drag the border handles to adjust its
size.
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Double-click on the drawn chart and then right-click on it and select Chart Data
to enter the data according to the chart you want to build (see Figure 11.14, “Entering Chart Data” [126]).

Figure 11.14. Entering Chart Data
Once you have entered the chart's data, close the data entry window and click on
the Yes button to update the chart in the slide, then click on an empty spot in the
slide.
Repeat the double-click / right-click sequence in order to change the chart's title,
legends, axis, type (2D or 3D, bar, pie, points, lines, etc.) selecting the appropriate
entries from the pop-up menu.

3.3.6. Slide Background
Use the Format → Page menu and click on the Background tab to define colors,
gradients, patterns, or bitmapped backgrounds for the slide. Each background
type has options of its own, feel free to explore them.
Using bitmaps for backgrounds increases the file's size considerably. This
could lead to a performance hit, especially on older systems.
Once the background is selected you are offered the option to make that background
the default one for all slides. Make your choice and the slide(s) background(s) will
be changed.

3.3.7. Transitions, Animations and Effects
The Slide Show menu has slide transitions, animations and effects options/wizards
which let you add “dynamism” to your presentations. However, you should try
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not to overuse transitions, animations and effects because they can be distracting
to your audience, turning their attention to the effects themselves instead of the
presentation's content.

3.3.8. Running your Presentation
Choose Slide Show → Slide Show , or press the F9 key, to run your presentation.
The presentation will take up the entire screen. Press the Esc key to stop the
presentation.

3.4. Going Further
If you wish to learn more on the use of OpenOffice.org Impress, you should consult
the tutorial available at the Tutorials for OpenOffice [http://www.
tutorialsforopenoffice.org/category_index/presentation.html] web site.
Also, don't hesitate to refer to the OpenOffice.org Impress inline help accessible
through the Help → Contents menu, or by pressing the F1 key. There you are
bound to find answers to your questions. Topics are accessible through a table of
contents. An index is also available as well as a contextual search tool.
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Chapter 12. Managing Files
1. Managing Your Files
File managers have grown to become multi-tasking applications, which don't only
take care of basic tasks such as copying and moving files around. With Konqueror
you can browse a LAN, listen to songs, view your photos, and more.
Access your file manager by clicking on the Home icon located on the top left of
your desktop.

Figure 12.1. Konqueror's Main Window

1.1. Sidebar
A sidebar may appear on the left side of the main view. Select Window → Show
Navigation Panel (or use the F9 key) to show it.
Here are short definitions of the icons in Konqueror's sidebar:
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Table 12.1. Konqueror Sidebar Icons
Icon Meaning
amaroK. Gives you access to the amaroK music player (Section 1.1, “amaroK Audio Player” [137]).
Bookmarks. Quick access to your bookmarks.
History. Permits you to access folders and network (web, FTP, etc.) sites
you visited recently.
Home Directory. Represents your personal folder in which you organize
your personal files.
Network. Gives you access to FTP archives as well as to Mandriva Linuxand KDE-specific web sites (of course, you can add or delete entries too).
Root Folder. Lets you access your whole tree structure. Usually, you don't
have sufficient rights to manipulate files outside your home directory.
Only the system administrator (root) can do this.
Services. Gives you access to all your applications as well as your Audio
CD Browser, your Fonts, your LAN Browser, Printer Browser and your
system Settings.

1.2. Accessing Storage Media
Access the Go → Storage Media menu to read the contents of your USB keys, external hard drives as well as every media your computer contains (hard disks,
mounted partitions, CD drives, etc.).
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1.3. Manipulating Files
There are many ways to manipulate files within your file manager.
Drag'n'drop, keyboard shortcut combinations, opening two file managers,
etc. Choose the method you prefer (check out the Edit and Window
menus).
Copying Files. The easiest way to copy a file elsewhere in your tree structure is
to select it and then to press the Ctrl - C keys. Go in the directory in which you
want to copy the files and press the Ctrl - V keys.
Moving Files. The same principle applies to moving files around. Cut the file
using the Ctrl - X keys and paste it with Ctrl - V keys.
Linking Files. Linking files allows you to access them without actually copying
them to a different location. Let's imagine one of your files is buried into the
/home/queen/Music/Artists/FavoriteArtist/ directory and you want to access
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it quickly. Simply drag it to the desired folder, release the mouse button and select
Link Here.
Deleting Files. The safe way to remove a file is to move it to the Trash, while
the unsafe way is to delete it for good directly. Select a file and press the Del key
to remove it. To restore it, double-click on the Trash icon on your desktop and
drag the file(s) back into your Konqueror. To delete trashed files, simply Empty
Trash Bin by right-clicking on the Trash icon. To delete a file directly and permanently, select it and press the Shift - Del keys.

1.4. Browsing Web Pages
If you frequently browse through directories containing HTML files, for example
your distribution's documentation, these directories generally contain a file called
index.html.
Let's take the /usr/share/doc/mandriva/en/Drakxtools-Guide.html/ directory
as an example. Click on index.html to display its contents and browse through
the documentation.

1.5. File Sharing
This feature allows you to share your documents with other people on a local
network and to access documents other people share. It also enables system administrators to provide users with common repositories where everyone can add,
modify and consult files.

1.5.1. Sharing Files
If file sharing is activated through the Mandriva Linux Control Center (please see
Section 5, “Allowing Users to Share Folders” [312]) right-click on folders in your
Konqueror window and choose Share which enables you to share one or as many
folders as you like through NFS1 or Samba2.

1

NFS (Network File System) allows you to share files to or from your computer in a networked environment. Although the NFS setup is easier than the Samba one, it can only be used within a UNIX®-based
system (like GNU/Linux). Moreover, NFS is an insecure protocol and should be used exclusively in a
secure local network environment.
2
SMB is a protocol by which PCs share resources such as files and printers. Windows® and GNU/Linux
(through Samba) and OS/2 operating systems, among others, support the SMB protocol. It can be
considered an alternative to Netware and NFS.
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1.5.2. Browsing Shared Files with Konqueror
The lisa package must be installed for LAN browsing to work. If not,
you will have to start the lisa service after installing it.
Browse all available shared files on the network by opening the LAN Browser
section in the Services sidebar. All machines offering shared files will appear as
folders under this section. Inside the host name folder appears one folder per
protocol supported by this machine. Those may be:
FISH
This protocol relies on ssh communications. Every local machine running an
ssh server is able to connect (providing proper authentication) and browse all
the folders you have access to.
NFS
Under this Remote Share folder the shares provided by UNIX® machines are
displayed (see Section 4, “Importing Remote NFS Directories” [312]).
SMB
Shares provided by Windows® or SMB-enabled machines (see Section 3, “Importing Remote SMB Directories” [310]) show up under this Remote Share
folder.
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Part 4. Multimedia
Home Entertainment Applications
After exploring office software, you will definitely want to try out some multimedia
applications. On the sound side, we discuss amaroK, a multi-format audio player,
and briefly describe the KMix mixer's functions, in Section 1, “Audio Applications” [137]. In Section 2, “Movie Applications” [142], we cover the Kaffeine movie
player, and briefly present other movie playing software such as Xine, MPlayer
and Totem. In Section 3, “Webcams and Video Conferencing” [145], we review how
to use GnomeMeeting with which you can organize videoconferencing.
Next we cover the GIMP image manipulation program (see Section 1, “Graphic
Art And Image Manipulation” [151]), as well as some of the peripherals and applications you can use to access multimedia devices: digital camera software with digiKam (see Section 2, “Digital Cameras” [161]), scanning with ScannerDrake (see
Section 3, “Installing and Using Scanners” [170]), printing with kprinter (see Section 4, “Printing and Faxing from Applications” [178], and CD burning with K3b
(see Section 5, “CD Burning” [186]).

Chapter 13. Multimedia Applications
1. Audio Applications
1.1. amaroK Audio Player
amaroK is “the” multimedia application to use to listen to your favorite music.
You can organize your music in collections, get information about recordings such
as artist, lyrics, album covers, and more.
In this section we go through its essential features. Choose Multimedia + Sound
→ Amarok from the main menu to launch amaroK.

Figure 13.1. amaroK's Main Window
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1.1. amaroK Audio Player
Once amaroK is launched this icon appears on the panel. Right click
on it to access its options.
Click on the Build Collection button to configure a collection, check all folders
you want amaroK to look for music files and click Ok to start building the collection
( see Figure 13.2, “Music Collection” [138]).

Figure 13.2. Music Collection
Choose Settings + Configure amaroK → Collection from the menu to add more
folders to your collection. Then choose Tools → Rescan Collection from the menu
to update the collection.
If you added files from removable devices (such as a USB key or an external hard drive), make sure they are mounted at the same location as
when you originally added them to your collection or amaroK won't be
able to find the files they contain.
Click on this tab to access all your playlists. If you don't have any you can listen
to the Cool-Streams, which is a collection of online radio broadcasts. To build a
playlist, simply drag tunes into the playlist then select Playlist → Save Playlist As
and give it a name.
Click on the Media Device Browser tab to transfer songs to your portable audio
device, such as an iPod.
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Finally this icon allows you to access you local file system. You can use it as
an alternative to amaroK's Collection.

1.1.1. Context Browser
It's made up of tabs which display information about the music you play most
frequently, usage statistics, and more. Now click on the Current tab (see Figure 13.3,
“Using Context Information” [140]).
The album cover is displayed in the upper part if it's listed in the MusicBrainz
[http://www.musicbrainz.org] community-driven music database (hence the
“brain” icon). It will give you usage statistics. The most played songs by the currently playing artist are displayed in Favorite Tracks by [Artist], and all of the
current artist's albums are listed in the lower part of the Context Browser.
The next tab displays the artists Lyrics. Click on a song in your playlist and then
on the Lyrics tab. amaroK shows a few suggestions and by clicking on the accurate
title, the lyrics are displayed in the lyrics browser. The last tab (Wiki) fetches wikitype information on the artist (if available).

1.1.2. Burning Tracks with K3b from amaroK
Right-click on songs or music folders and access the Burn contextual menu item
(it's slightly different whether you choose to burn an entire album or a single song).
You can burn in two formats: the “data” format means you'll be able to listen to
the songs on your computer and your MP3 CD player, for example, while the
“audio” format also permits you to listen to the music through a traditional CD
player.

1.1.3. Cover Manager
Access the Tools → Cover Manager menu for album covers to be displayed in
the Context Browser.
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1.2. KsCD CD Player

Figure 13.3. Using Context Information

Figure 13.4. amaroK Cover Manager
Click on Fetch Missing Covers to recover missing album covers. To find covers
from a specific artist, type his/her name in the filter input box (

).

1.2. KsCD CD Player
When you insert an audio CD in your CD drive the KsCD player starts up.
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Figure 13.5. KsCD's Main Window
On the left you have the typical CD player controls: Play/Pause , Stop , Eject , etc.
The ones below alter the playing order. Then, there are buttons to give you information on the disk you are listening to and to access more advanced configuration
options.

1.3. Using the KMix Mixer
KMix is a sound card mixer application under KDE. It allows you to fine-tune your
sound cards through various sliders.

Figure 13.6. KMix Main Window
The Output tab controls the volume levels of the sound sources of your sound
card. The most important one is the Master which controls the general volume.
By right-clicking on each slider you have extra options such as Split Channels,
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Muted Hide, etc. Clicking on the green dot at the top of a column will mute/unmute that sound source.
Clicking on this icon pops up a slider which lets you control the
master volume, as well as to mute all sound and to launch the full mixer
window.
The Input tab controls the volume levels of the recording sources of your sound
card. If you use videoconferencing software or are a musician, this is where you'll
want to adjust your microphone and your auxiliary devices. Clicking on the green
dot at the top of a column will mute/unmute that recording source, the red dot at
the bottom enables or disables it.
The Switches tab goes deeper into your sound card's configuration. Boosting your
microphone, using an external amplifier: these features are for advanced users
who wish to really master their sound system. To activate them, simply click on
the dot at the top of each column.
Finally the horizontal slider enables you to balance your sound between the left
and right speakers. Notice that if your sound card supports separate levels for
master's right and left, the Output's Master controllers will be modified following
the movement of the horizontal balance slider.

2. Movie Applications
2.1. Introduction
The main problem with video players under GNU/Linux is that most popular
video codecs are proprietary, and to implement them in a free software application
(mainly due to the cost of licensing), the codecs have to be reverse-engineered.
This is very complex and may not be legal in some countries, which limits the
availability of such codecs, and thus the type of video files which may be displayed
under GNU/Linux.
For example, it's virtually impossible to play some compressed digital video files
or DVDs without downloading the corresponding codecs from the Internet.
In some countries, the status of DVD playback and reverse-engineered
codecs are still under review. That is why Mandriva does not include all
the plugins to use those codecs1. The information included here is meant
to help Mandriva Linux users who know that, in their country, using
1

The box set editions of Mandriva Linux do include some of the codecs.
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2.2. Kaffeine
these codecs and plugins is legal. Mandriva does not encourage law violation
and you should verify the law(s) which apply in your case before you download
and use these codecs and plugins.

2.2. Kaffeine
Kaffeine is based on Xine libraries which can play video files and streams.
Double-clicking on a supported video file launches Kaffeine, opens the file, and
starts playing it. You can also launch Kaffeine by selecting Multimedia + Video →
Kaffeine from the main menu.
The first time you run Kaffeine, a configuration wizard pops up and we
recommend you accept the default options.

Figure 13.7. Kaffeine's Interface
Kaffeine's simple interface (Figure 13.7, “Kaffeine's Interface” [143]) is comprised
of the following:
• Display Area. Where the movie being played is shown. Press the Ctrl - Shift - F
keys to switch between full-screen and windowed modes.
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• Position Control. You can “jump” to any part of the movie by dragging the
slider right (or press the right arrow key) to go forward; drag the slider left (or
press the left arrow key) to rewind.
• Volume Control. Drag the slider right (or press the plus key) to make the sound
louder; drag the slider left (or press the minus key) to make it softer.
• Play Controls. A reduced set of the usual VCR controls: Previous, Play/Pause
(keyboard shortcut: Space Bar ), Stop (keyboard shortcut: Backspace ) and
Next.
• Status. Located at the bottom right of Kaffeine's window, it shows information
about the playlist and the movie being played.
To play a DVD, simply insert the disc in the drive and Kaffeine starts playing the
DVD title. We recommend you use full-screen mode to play DVDs.

2.3. Other Movie Applications for Linux
Xine
Xine is one of the most interesting video application for GNU/Linux. It supports a wide range of formats and input sources. It's fast, flexible and extensible.
It's also provided as a library on which many players are based.
MPlayer
MPlayer is yet another interesting application and supports multiple output
drivers, and even older video cards. It can also handle DVD, AVI, VideoCD,
amongst others. However you'll probably have to download and install
winDLLs and proprietary codecs to make it work with many popular video
formats. On one hand this might seem unfortunate, but on the other it gives
you access to all formats supported under Windows®.
Totem
Totem is a GNOME 2 application based on Xine's libraries. As you might
imagine, its capabilities are very similar to those of its “parent”, but it's better
integrated in the GNOME environment.
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3. Webcams and Video Conferencing
3.1. Getting Started
In this section, we will show you how to do video (and audio) conferencing using
your webcam and GnomeMeeting. We will only discuss USB webcams since parallel models are really old and don't have the image quality of USB devices.
Before buying your new webcam, it would be a good idea to check the
Mandriva Linux supported hardware database [http://www.mandriva.
com/hardware]. You can also refer to the Linux USB [http://www.
linux-usb.org/devices.html] and to the excellent Linux USB device
overview [http://www.qbik.ch/usb/devices/devices.php] web sites
for more information on USB webcams.
The hardware set up is very easy. Just plug your webcam in an empty USB slot
and it will be automatically recognized and configured. You should see this icon
appear on your desktop with a legend like GnomeMeeting /dev/v4l/video0 underneath it; if not, you can run it choosing Surf the Internet + Use More Connectivity
Utilities → GnomeMeeting from the main menu. Remember to connect your microphone and speakers to the proper place on your sound card.
When GnomeMeeting is run for the first time, a configuration wizard appears
which will guide you through the setup process. Use the Forward and Back buttons to move through the wizard's pages. Configuration options are self-explanatory, so fill in the fields, advance through the wizard until you get to its last page
and click on the Apply button.
You can access the wizard later from within GnomeMeeting by choosing
Edit → Configuration Druid from its menu.
To be able to communicate with your friends using NetMeetingTM (or other
H.323/ILS compatible software), you will need to configure the directory settings
by choosing Edit → Preferences from the menu and opening the Directory Settings
sub-section of the General settings.
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3.1. Getting Started

Figure 13.8. GnomeMeeting's Main Window
This icon appears in GNOME's or KDE's panel whenever GnomeMeeting is
run, and can be used to control GnomeMeeting by right clicking on it.
On the left side of the main window you have the tool bar with a few buttons. The
first three are:
Table 13.1. GnomeMeeting's Toolbar Buttons
Opens/closes the text chat window on the right side of GnomeMeeting's
main window so you can chat with the remote party you are currently
connected to. Just type the text you want in the Send Message field and
press Enter .
Opens/closes the control panel at the bottom of GnomeMeeting's main
window where you can see communications statistics (lost/late packets,
delay and jitter), the dial-pad from where you can call memorized URLs,
as well as the audio and video settings panels.
Opens/closes the ILS window to find and connect with friends registered
on ILS.
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In the control panel's audio tab you can use the sliders to set the speaker and microphone levels as shown in Figure 13.9, “Setting Audio Levels for GnomeMeeting” [147].

Figure 13.9. Setting Audio Levels for GnomeMeeting
In the control panel's video tab you can adjust the following video parameters
(from top to bottom):
• Brightness level. The higher the value, the brighter the image will be.
• The whiteness level. This tells the video device which signal level should be
considered “white”.
• The color level. This adjusts the amount of color the image from your camera
will display. It might have no effect with certain cameras/light conditions.
• The contrast level. With the lighting conditions found in a typical office, the
contrast is normally set to zero.

Figure 13.10. Setting Video Levels for GnomeMeeting
Example video settings are shown in Figure 13.10, “Setting Video Levels for
GnomeMeeting” [147]. Please note that for the most part, these settings are auto147

3.2. Connecting with Another User
matically configured when GnomeMeeting starts up based on the lighting conditions of the environment and your webcam.

3.2. Connecting with Another User

Figure 13.11. Video Conferencing with a Remote Party
To connect directly (end-to-end, no servers) to another user, you need to input a
callto:// or h323:// URL with the remote user's host or IP address and optionally
the port, in the pull-down list at the top of GnomeMeeting's main window. Then
click on the button on the right (the one with the plug). If the connection succeeds
and the remote party accepts your call, right-click on the video window and select
Remote Video to see only the remote party, Both (Local Video Incrusted), meaning
yourself and the remote party video within the same window, as shown in Figure 13.11, “Video Conferencing with a Remote Party” [148], or Both (Local Video
In New Window) to have yourself and the remote party in different windows.
callto:// and h323:// URLs can be used to communicate with users through a
“gatekeeper” server (just input the URL in the pull-down list at the top of GnomeMeeting's main window and click on the button on the right) and callto://
URLs can also be used to make icons to call those users directly from your desktop,
although this last feature was available only for GNOME at press time.
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3.3. Connecting with ILS (NetMeetingTM)
Users
TM

3.3. Connecting with ILS (NetMeeting

) Users

You can use GnomeMeeting to connect to an ILS server and video-conference with
people using NetMeetingTM or other compatible software.
Click on this button or choose Tools → Address Book from the menu to
open the ILS directory window and click on Find to update the list of available
users connected to that ILS server, as shown in Figure 13.12, “Finding People on
ILS Servers” [149].

Figure 13.12. Finding People on ILS Servers
Select the search criteria in the pull-down list at the bottom and fill the field at its
right, then click on the Find button. You can also leave the field blank and click
on Find to look up all registered GnomeMeeting and NetMeeting users. Once you
have found the person you want to communicate with, double-click on his name
to initiate the call. You can change ILS servers in the Servers tree in the left part
of the window.

3.4. Setting GnomeMeeting for Use Behind a Firewall
Most users have the good idea of configuring a firewall to avoid crackers from
breaking into their systems. However, a tight firewall might prevent you from
using GnomeMeeting. The solution simply resides in opening the specific ports
GnomeMeeting uses to communicate with the other party.

3.4.1. Allowing Incoming and Outgoing Traffic
Here's the list of ports you must allow and forward:
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TCP Control Port
Allow incoming and outgoing traffic on port 1720.
TCP Data Port Range
Make sure the 30000-30010 port range is open. If you plan on using GnomeMeeting with NetMeetingTM users, this action is mandatory.
UDP Data Port Range (mandatory)
Allow and forward the 5000-5007 UDP port range which is used for audio and
video transmission.

3.4.2. Example Setup with Shorewall
Mandriva Linux comes with the Shorewall set of firewall tools. Here's an excerpt
of what your /etc/shorewall/rules file should contain:
# H.323 calls with GnomeMeeting
ACCEPT net loc udp 5000:5007
ACCEPT net loc tcp 30000:30010
ACCEPT fw loc udp 5000:5007
ACCEPT fw loc tcp 30000:30010
ACCEPT loc fw tcp 1720
ACCEPT loc fw tcp 30000:30010
ACCEPT loc fw tcp 5000:5007
ACCEPT loc fw udp 5000:5007

For more information about using GnomeMeeting behind a firewall, please visit
the GnomeMeeting web site [http://www.gnomemeeting.org].
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Chapter 14. Graphics Tools And Practical
Devices
1. Graphic Art And Image Manipulation
This chapter concentrates mainly on GIMP, and introduces other interesting applications you may wish to explore on your own.

1.1. GIMP
The GNU Image Manipulation Program (GIMP) is a free software program challenging proprietary applications such as Adobe® Photoshop® or Corel® Painter™,
allowing advanced photo editing tasks such as cropping, resizing, painting,
drawing, modifying colors, etc. Its true beauty lies in its extensibility and its
scripting options, which opens GIMP to full integration in programs and scripts
therefore enabling it to act as a mass production image rendering application.

1.1.1. Strengths
For normal users, GIMP will seduce you with its advanced functions for web images
and formats. You can easily create animations and optimize your art for web
publishing, and take advantage of GIMP's extensive photo manipulation features.
Power users, publishers and document management specialists truly benefit from
GIMP through its advanced scripting capabilities and the programs' function accessibility.

1.1.2. Weaknesses
GIMP, like most Free Software graphic design applications, suffers from the fact
that prepress standards, such as PANTONE® Color Systems, are proprietary and
closed. So for GIMP, it means that there are no usable implementations of these
standards. Also, because the press world is dominated by Apple-compatible computers you will have to put in some extra effort to print professionally with GIMP,
although it is feasible.

1.1.3. Finding More Information
GIMP includes extensive documentation. If the gimp-help package is installed,
pressing the F1 key lets you access a help index for the current “active” item, and
pressing Shift - F1 gives you access to contextual help.
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On the net, GIMP is a very well documented application and a lot of information
is freely available. Please refer to The GIMP web site [http://www.gimp.org/
docs/] for more information about the available GIMP documentation.

1.2. Concepts
GIMP embraces differences. Therefore, there are usually many ways to achieve
the same goal. The following is a brief description of some concepts and the way
they work under GIMP.

1.2.1. Menu
From GIMP's main window (called the tool box), you can access the basic program
options such as opening a file, creating a new file, etc.

1.2.2. Right-clicks
Once an image is opened or created, you can right-click in the image window and
access the image's specific options such as Close, Save, Save as, Dialogs, Filters,
etc. We call this the “image menu” in the following sections.

1.2.3. Layers, Image Modes and File Formats
Some of the key concepts to grasp in order to truly benefit from an advanced
graphic design application like GIMP are those to do with layers, formats and file
modes. Roughly put, digital image editing adds a 4th dimension: layers. Images
are built vertically (as are animations), and each layer has user-defined properties
which determine other tasks that can be accomplished. File mode defines the inner
logic of the graphic elements. Hence, an RGB image allows for different operations
and capabilities that you would not have for a gray scale image. Finally, the file
format also impacts on which operations can be done on that file.
If you face difficulties accomplishing any task described below, check those three
elements before jumping to conclusions.

1.3. Starting GIMP and its Interface
Choose Multimedia + Graphics → The GIMP v2 from the main menu to start
GIMP.
The first time GIMP is run, a wizard appears allowing you to set up some
parameters, such as default paths, monitor resolution, etc. Unless you
really know what you are doing, we recommend you leave these options
at their defaults and just click on the Continue button in all the steps of
the wizard.
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1.4. Using GIMP
Unlike Adobe® Photoshop®, when you open GIMP a few dialogs appear, the main
one being the toolbox (see Figure 14.1, “GIMP's Main Interface” [153]). It offers
GIMP's core functions and allows you to initiate other tasks.

Figure 14.1. GIMP's Main Interface

1.4. Using GIMP
1.4.1. Basic Operations
Opening a File. Choose File → Open from the menu. Your image appears in a
new window. From that window, you can access the image's menu (File, Edit,
Select, etc.) or right-click as explained in Section 1.2.2, “Right-clicks” [152]. Depending on the file format you want to open, you may have to answer some questions
pertaining to the details of that format and its conversion. Keyboard shortcut:
Ctrl - O .
Creating a New File. Choose File → New from the menu. A dialog appears
letting you determine image dimensions in different measurement units (pixels,
inches, millimeters, etc.), image orientation (landscape or portrait) and some advanced options (see Figure 14.2, “Creating a New File” [154]). You may also specify
a Template from the pulldown list and have most image parameters filled for you.
Once you click on the OK button the image is created in a new window. Keyboard
shortcut: Ctrl - N .
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Figure 14.2. Creating a New File
Saving a File. The first time you Save, or when you Save as, a dialog pops up
which allows you to set the name and location of your image. More importantly,
it is the place to define the file type such as JPEG or PNG. Keyboard shortcut:
Ctrl - S for Save, Shift - Ctrl - S for Save as.
New users, at the stage of saving their work, run into multiple problems
such as losing layers or simply damaging their work. Most of these
problems come from the specific options allowed for each file format. If
you have no idea, preserve the image format or save in XCF, GIMP's own
file format. You can always try saving the image under different formats
later.

1.4.2. The Tool Box
The tool box contains your basic graphic design tools. If you move your mouse
over any item, its name and keyboard shortcut pops up in a help balloon. Tool
options are accessible through the Active Tools Options section of the tool box.
We will not detail each tool in this guide as there are already books written about
GIMP to assist you. Remember that all operations take place in the current active
layer.
If you close the tool box, GIMP and all windows are closed. Closing any
other window only affects that window.

1.4.3. Image Window
This window manages either new or opened images and it is where tools selected
in the tool box may be used.
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1.4.4. View Size
At the very top of the image window is a numeric value shown as a percentage.
This is the zoom ratio. You can increase it or decrease it by right-clicking and accessing the View menu. You can also press the + key to increase zoom or the key to decrease it.
Press the Ctrl - Shift - N keys, or choose View → Nav. Window in the image menu,
to launch a window navigator allowing you to pan and change the zoom ratio of
an image window.

1.4.5. Undo and Redo
All operations can be undone and redone. You can change how far, as a minimum,
you can go back in the commands “history” and how much memory to reserve
for it, by choosing File + Preferences → Environment from the menu. Please bear
in mind that both settings have a large impact on RAM usage which might make
it difficult, or even impossible, to manipulate a large image file.
Choose Edit → Undo from the image menu, or press the Ctrl - Z keys, to undo
the last operation.
Choose Edit → Redo from the image menu, or press the Ctrl - R keys, to redo the
last undo operation.

1.4.6. Copy, Cut and Paste
GIMP allows you to copy ( Ctrl - C ), cut ( Ctrl - X ) and paste ( Ctrl - V ) within any
window, as well as between any GIMP image window. You can also paste as layers.

1.4.7. Layers, Channels and Paths
Choose Dialogs → Layers (or press the Ctrl - L keys); Dialogs → Channels ;
Dialogs → Paths from the image menu to access the layers, channels and paths
dialogs respectively (see Figure 14.3, “Layers, Channels and Paths Dialogs” [156]).
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Figure 14.3. Layers, Channels and Paths Dialogs
GIMP allows for an unlimited number of layers. Each layer has a specific set of
properties.
In a RGB color image there are three predefined channels, one for red, one for
green and one for blue. The channels dialog lets you turn a channel off or on, as
well as add and remove other channels. Clicking on the eye at the left of a channel
name turns it on or off depending of its original status.
Paths let you manipulate your selections in very complex ways. You can transform
selections into paths which let you treat the selection as a curve, giving you more
control over it since you can, for example, add points to the curve to manipulate
it.
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1.4.8. Filters
Filters are a set of programmed actions which modify your image according to
some specified options. GIMP offers a vast range of filters such as blurs, noise effects
or image enhancement operations that may be applied to selections and layers.
Feel free to explore them all.

Figure 14.4. Filter's Menu

1.5. Dialogs
Dialogs give any tool further options. There is quite a large number of them and
for the purpose of this introduction, we only discuss the Color Selection and
Brushes dialogs.
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1.5.1. Color Selection

Figure 14.5. Color Selection Dialog
Choose the Dialogs → Colors menu to open the color selection dialog. Use the
buttons at the top to select the color “space” you want to use for color selection:
RGB, CMYK, color triangle, watercolor or scales. The fore/background colors are
handled the same way they are in GIMP's tool box. Selected colors are active immediately after choosing them. Rule of thumb: try to work in RGB so you can have
a wider number of formats to save your work into.
If you double click on the tool box's foreground/background color rectangles, the dialog may be a bit different to the one shown in Figure 14.5,
“Color Selection Dialog” [158], but its functions and behavior are the
same.
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1.5.2. Brushes

Figure 14.6. Brushes Dialog
This dialog lets you define the type and size of the brushes which apply to most
drawing and erasing tools. Click on the active brush section of the tool box, or
choose the Dialogs → Brushes menu to open this dialog. Keyboard shortcut:
Ctrl - Shift - B .

1.6. Printing
GIMP is ideal for web development but printing from GIMP is sometimes tricky.
Because of the absence of PANTONE® Color Systems support, GIMP might not
be ideal for prepress work, although CMYK images are supported.
Internally GIMP supports many printers and it is always feasible to filter images
through GhostScript or print to file (PostScript). Therefore, you can print images
relatively easily. Remember to adjust your resolution to match your printer's capabilities.
A lot of online documentation is available to further your knowledge about
printing with GIMP, and we encourage you to explore further.

1.7. Advanced Features
1.7.1. Scripting
GIMP offers several scripting interfaces for power users. These may automate almost any GIMP operation and allow external programs to “talk” to GIMP. You
may use some scripts more or less like filters by choosing Script-Fu from the image
menu.
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Script-Fu is the primary GIMP scripting language, but there are also other APIs
such as GIMP-Perl, which allows you to write GIMP scripts in perl.

1.7.2. Plugins
Plugins are external applications which extend a program's core functionalities.
GIMP, like Adobe® Photoshop®, relies on a vast range of plugins to extend its
capabilities. You may also contribute plugins to the community. Most of them are
free to use and distribute.
Choose Xtns → Plugin Browser from the menu to view all installed plugins.

1.7.3. Conclusion
Hopefully, this brief introduction caught your interest for this amazing piece of
software. GIMP is a first-class application and should be considered by any
GNU/Linux graphic artist.

1.8. Vector Graphic Applications
GIMP is a bitmap graphics applications, however for enterprise logos, diagrams,
maps or any kind of drawing (as opposed to photo), a vector graphics applications
is preferred.
Dia
Dia is a diagramming application which can be considered as an alternative
to Microsoft® Visio®. It contains a set of predefined symbols for different types
of diagrams you may use. Just like GIMP, Dia offers many common look-andfeel features. Right-clicking in the image gives you image-specific menus, and
allows you to modify the image to your needs. Please refer to the Dia web site
[http://www.gnome.org/projects/dia/] for more information.
Kivio
Very much like Microsoft® Visio®. Kivio possesses a very complete stencil set
and it can even use Dia stencils. Worth a try if you are familiar with Microsoft®
Visio®. Please refer to the Kivio web site [http://www.koffice.org/kivio/] for
more information.
Inkscape
Inkscape could be considered the “star” of current vector drawing applications
for Linux. With it you can draw anything you want with Inkscape (unlike Dia
and Kivio). It's a very mature application available under both GNU/Linux
and Windows® and it saves in the SVG format by default, facilitating interop160
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erability and the support of standards. Please refer to the Inkscape web site
[http://inkscape.sourceforge.net/] for more information.

2. Digital Cameras
2.1. Configuring Your Digital Photo Camera
Even if there are still serial (RS-232) digital cameras around, virtually all recent
digital cameras use USB, so we assume that you have a USB camera.
GNU/Linux software uses the Gphoto2 library to communicate with your digital
camera. Check GPhoto2's supported cameras list [http://www.gphoto.org/proj/
libgphoto2/support.php] for more information on camera support. If your camera
uses the Picture Transfer Protocol (PTP), it may be supported even if it's not in
Gphoto2 list.
You can also consult the very complete Digital Camera Support for UN*X
[http://www.teaser.fr/~hfiguiere/linux/digicam.html] web page.
Plug your camera in a free USB slot, turn it on into “play” mode1, and choose
Multimedia + Graphics → digiKam from the main menu to launch digiKam. If
your camera is not listed in the Camera menu, then choose Add Camera and click
on Auto-Detect . If detection fails, click on Add and look for your camera in the
list, or fill the parameters corresponding to your camera, and accept your settings.

2.1.1. Handling Digital Camera Storage Media
If your digital camera is not recognized you can still try to use a USB “card reader”
which lets you plug in the camera's memory and usually appear mounted under
/mnt/removable or /mnt/memory_card, so you can access it like you would any
other storage device. There are many card readers that support multiple memory
card types: Compact Flash, Secure Digital, etc.
If you have a laptop computer with a PCMCIA slot, you can use the ATA photo
memory PCMCIA card adapters. They are mounted just like any other ATA device
(CD-ROM, hard disk, etc.) in order to access your pictures. This is the fastest
method to access photo cards. It also means the camera's batteries may last longer.
Actually, any file can be accessed this way, not only pictures. You can
put whatever file you want on your memory card.

1

As opposed to “record” mode, which is the mode used to take pictures.
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2.2. Transferring and Manipulating Pictures
Choose the Camera → Your_Digital_Camera_Model menu and select the photos
you want to transfer in the digiKam camera import window (see Figure 14.7, “Selecting Pictures to Transfer” [162]) and then click on Download and select the
Download Selected option. Then choose (or create) the album to store photos into
and click OK : the pictures will be transferred to that album2.
New in-camera images will be marked with a star on a border.

Figure 14.7. Selecting Pictures to Transfer

2

Albums are stored under the /home/user_name/Photos folder.
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2.2.1. Deleting Pictures
Create a set of pictures and choose Image → Move to Trash from the menu. You
are not asked for confirmation, the images are moved to the desktop's Trash immediately. Keyboard shortcut: Shift - Delete .

2.2.2. Rotating Pictures
Create a set of pictures and choose one of the entries (90º, 180º or 270º) of the Image + Rotate menu.
Many digital cameras store rotation information within the image file. In this case
you can choose Image → Auto Rotate/Flip Using Exif Information from the menu
to have the picture rotated automatically in the correct direction.
All transformations on pictures (such as rotation) are done on the ondisk file. digiKam doesn't make a backup of the transformed pictures.
Also bear in mind that all transformations are, when possible, loss-less.

2.2.3. Touching-Up Pictures
Double click on a picture to open the image edit window. Note that all touch-up
operations affect the quality of the picture's on-disk file. Also bear in mind that
on-screen rendering is quite different from printing your digital pictures on photographic paper. So if you intend to both print and publish your pictures for online
viewing, it might be wise to treat both copies differently from the beginning.
Press Ctrl - Z to undo the last transformation operation. However, once
you have saved the image, changes cannot be undone.
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Brightness, Contrast and Gamma
Brightness, Contrast and Gamma

Choose Fix + Colors → Brightness/Contrast/Gamma from the menu and use the
sliders to adjust the brightness, contrast and gamma of the picture using the picture
copy as a guide.
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Sharpen
Sharpen

Choose Fix → Sharpen from the menu, drag the square to the part of the image
to be used as a guide, and use the slider to sharpen the picture.
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Red-Eye Reduction
Red-Eye Reduction

Select the pupil of the eye to fix, choose Fix → Red Eye Reduction from the menu,
and then select the aggressive (only part of the eye selected) or mild (more than
the eye selected) option to reduce the red-eye flash effect. Repeat for the other eye.
Image Resizing and Cropping

Multi-megapixel images are excellent for photographic paper print-ups, but are
far from adequate for e-mailing or publishing on the web. Choose Transform →
Resize from the menu, then select the desired size, either in pixels or in percentage,
and whether to keep (recommended) or not aspect ratio.
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Image Resizing and Cropping

You can also crop an image to a desired size while keeping aspect ratio. Choose
Transform → Aspect Ratio Crop from the menu, drag the square to frame the
part of the image you are interested on and select the aspect ratio, orientation,
width and height (one follows the other according to the aspect ratio selected).
For electronic publication, the usual aspect ratio is 4:3, while for printing
the usual aspect ratio is 3:2.
Usually a size of 640x480 is enough for e-mailing a photo, while 800x600
is enough for web publishing.
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2.3. EXIF: Digital Camera Photographic Settings
Most digital cameras produce EXIF (Exchangeable Image File Format) files. EXIF
are JPEG files with extra tags containing information about the image such as the
date, the camera model, the exposure time, the ISO speed setting, the aperture,
etc.
Select the picture, choose Image → Properties from the menu, and select the EXIF
tab. Then, select the level of information detail: either Simple (shows the most
important settings only) or Full (shows all EXIF information).
To add a comment to a picture select it and press the F3 key, then fill your Comments (see Figure 14.8, “Adding an EXIF Comment to a Picture” [168]).

Figure 14.8. Adding an EXIF Comment to a Picture
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2.4. Web Albums
If you want to share your pictures with your family and friends, you can easily
create a “Web Album” of your pictures. Choose Album + Export → HTML Export
from the menu, select the album to export (by default, the current one is selected)
and then set the album's title in the Look section. Customize the album options
(picture and thumbnails size, pictures per row, etc.) and click OK to create it: the
album is then opened inside Konqueror for you to preview it. You can then upload
the album to the web.

Figure 14.9. Previewing a Web Album
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This section explains how to install a scanner using ScannerDrake, and how to use
it with SANE and XSane (scanner interface software). We also present a list of
other scanner interface software you could use with GNU/Linux.
Please note that not all scanners are supported under GNU/Linux. Before
buying new hardware, remember to check out Mandriva's Hardware
Database [http://www.mandriva.com/hardware] and the SANE home
page [http://www.sane-project.org/] for compatibility issues.

3.1. Configuring your Scanner
3.1.1. ScannerDrake
The ScannerDrake wizard helps you install your scanner. Make sure your
scanner is powered on and launch ScannerDrake by clicking on the Scanners entry
of the Mandriva Linux Control Center's Hardware section.
The program tries to detect your scanner's manufacturer and model. If it finds one
then information about it is displayed in the upper part of the wizard's main window. Other options are also available (Figure 14.10, “Installing your Scanner” [170]):

Figure 14.10. Installing your Scanner
Click on Search for new scanners to autodetect a new scanner you just plugged
in. Click on Add a scanner manually if the automatic detection fails and look for
the specific model you own by browsing through the list of available models.
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Figure 14.11. The Tree-list of All Known Scanner Models
After choosing the appropriate model, you can leave the default Auto-detect
available ports option and click on OK. If you have a parallel port scanner, selecting
/dev/parport0 in the pull-down list should be the right choice.
Your scanner should now be installed and you should be ready to use the programs
which come with SANE, XSane or other acquisition software.
Note that HP multi-function devices, such as the OfficeJet and PSC
printers, must be configured through PrinterDrake. Please refer to Section 6, “Configuring Printers with PrinterDrake” [234]. The scanning part
of non-HP multi-function devices can be set up with ScannerDrake as a
stand-alone scanner.
To test that everything works correctly, launch xscanimage3 from a terminal and
try to acquire a picture from your scanner. You may first acquire a preview of the
3

The sane-frontends package must be installed.
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scanned image by clicking on the Preview window button, as shown in Figure 14.12,
“Acquiring Images with xscanimage” [172].

Figure 14.12. Acquiring Images with xscanimage
Note that xscanimage can also be launched directly from GIMP by choosing
File + Acquire + xscanimage → Device dialog .
ScannerDrake allows for scanner sharing between users connected via a LAN. Installation is very easy: just click on Scanner sharing and either select The scanners
on this machine are available to other computers or Use scanners on remote
computers depending on what you want to do. With these buttons you can define
which machines are allowed to use your scanners and which remote scanners you
want to use.
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Figure 14.13. Sharing Scanners within a LAN
In order to share your scanner on your LAN, the saned package needs
to be installed. If it isn't, ScannerDrake will ask you if you want to install
it. You also need to set up scanner sharing on the machines from which
you want to access the scanner. Check the Use scanners on remote computers box, and then click on Add host . Fill in the information in the
Name/IP address of host field for each of the machines which scanners.

3.2. Using Image Acquisition Software
3.2.1. XSane
While xscanimage is more than enough for your basic scanning needs, more experienced and/or graphic-oriented users will want to use a more sophisticated program. XSane4 offers more options and a more informative display during the image
acquisition process.
You can launch XSane through the Multimedia + Graphics → XSane menu item.
Several windows pop up on your screen.

4

The xsane package must be installed.
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Figure 14.14. XSane Multiple Windows
If the xsane-gimp package is installed, a GIMP plugin will be at your
disposal. It allows you to import your images directly into GIMP for
image retouching tasks (see Section 1, “Graphic Art And Image Manipulation” [151]). Choose File + Acquire → XSane: device dialog to launch
XSane. You can now scan your image and have it sent directly to GIMP.

3.3. Advanced Configuration
3.3.1. Fine-Tuning the Resolution
Most modern scanners boast high resolutions, such as 1200, 1600 or 2400 DPI (Dots
Per Inch). But it would be a mistake to perform all of your scanning at the maximum
available resolution. You will notice very little — if any — quality difference
between a 300 and a 600 DPI image scan, but the file size will grow exponentially,
up to many MBs of disk space for a single image file.
The resolution value should be chosen according to the device on which the image
is to be reproduced. For images to be viewed on computer monitors, e.g. for web
sites, the resolution should be close to typical monitor resolution values, between
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70 and 100 DPI. Higher values will result not only in bigger images, but the dimensions will also increase, so that an image scanned at 160 DPI instead of 80 will be
about twice as large5.
If you intend to print your images, a resolution of 300 DPI should be enough for
most home printers. Increase this value if you have a very high quality printer.
Higher values should be chosen only for specific uses, such as enlarged images on
very high quality printers, or quality scans of black and white originals. You will
have to experiment a little until you're satisfied with the results.

3.3.2. OCR Software
By installing the kdegraphics-kooka and ocrad packages, you'll be able to use
Kooka, a simple graphical front-end to SANE which is also able to perform OCR
tasks. To launch it, choose Multimedia + Graphics → Kooka from the main menu.
First choose the scanning device and then Kooka's main window appears.

5
However scanning at a higher resolution and then reducing the resulting image size using graphic
manipulation software such as GIMP is one method often used to obtain better results than directly
scanning at the desired final resolution.
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Figure 14.15. Kooka's Main Window
Place the image you want to scan onto your scanner and click on Preview Scan at
the bottom left of Kooka's window. For better results, you should choose the Binary
Scan mode, and set the resolution to no less than 300 DPI. Then select the part of
the image to be scanned and click on Final Scan .
To benefit from Kooka's OCR features, you must configure it. Access the Settings
→ Configure Kooka menu, click on OCR, and select the OCR engine you want to
use.
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Figure 14.16. Kooka's Configuration Window
Once this is done you can click on this icon ( Image → OCR Image ) and click
on Start OCR . The resulting text will appear along with a spell-correction window.
Kooka is still in beta phase. Although it's possible to make it work
properly you will need to adjust its parameters until you obtain a decent
rendering. For more information on Kooka please read its handbook
( Help → Kooka Handbook ).

3.4. Other Scanner Interface Software
Here is a list of other scanner interface software which is known to work under
GNU/Linux.
• Users of the FLTK (“Fast Light Tool Kit”) graphic user interface could try FlScan
[http://freshmeat.net/projects/flscan/], a FLTK front-end for SANE.
• For EPSON scanners, you could download Image Scan! for Linux [http://www.
avasys.jp/english/linux_e/index.html], a scanner utility provided free of charge
to GNU/Linux users by EPSON KOWA Corporation.
• While multi-functional HP devices are configured using PrinterDrake, owners
of these devices should have a look at the HP Linux Inkjet Project [http://
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hpinkjet.sourceforge.net/]. The developers involved in the project aim at
providing GNU/Linux support for most Hewlett-Packard OfficeJet, PSC,
LaserJet, and PhotoSmart printer multi-function peripherals (MFPs).

4. Printing and Faxing from Applications
GNU/Linux applications support a simple printing method based on a program
called kprinter which can even be used to build PDF files and to send faxes.

4.1. Accessing KPrinter
Just click on any application's print button to invoke the printing interface. In most
cases, this is kprinter. Select the different printing settings and click on the Print
button to start printing.
Every X application which supports the definition of its printing command can
use kprinter. All you have to do is invoke the application's print options, look for
an option named “Print command”, “Printer”, “Printer Options” or similar, and
fill it with kprinter --stdin. Then when clicking on the Print button kprinter's
main window is displayed (no actual document will be printed at this point).

4.2. KPrinter's Interface
kprinter allows you to set many options for printing your documents6, such as the
output device (generally a physical, local or remote printer), the number of copies,
the paper size, the printer resolution, etc.

6

The actual printing options you are able to set depend on the output device you have selected.
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Figure 14.17. KPrinter Window
Choose the printer using the pull-down list in the Printer section. You can further
configure the printer settings by clicking on the Properties button. Click on the
Options >> button at the bottom to set more printing options (see Section 4.2.2,
“Setting More Printing Options” [182]) and on the System Options button to access
global printing configuration.
Usually, your local printer, the “Print to file” printers (both PDF and
Postscript) and the “Fax” printer are listed. However, if you are in a
network, all printers available on the network will be listed too, so network printing becomes very simple.
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4.2.1. Printer Properties

Figure 14.18. Printer Properties Window
One option worth mentioning is Pages per sheet (set to 2 in the example). This allows you to put up to 4 pages onto a single sheet of paper (or 8 if you can print on
both sides). This is a nice feature to save paper when printing book drafts or other
lengthy material which changes often.
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Figure 14.19. Changing Printer Resolution
Click on the Driver Settings tab to change printer-specific options such as the resolution of the printing device. When you click on the Resolution option the available
resolutions are displayed, select the one you want from the list.
Other settings include printing modes which use much less toner or ink (search
for something like “Economy Mode”, “Toner Density” or “Toner Saving”). However, the output is much paler. If this is not available, choosing a lower resolution
often has similar effects.
Use the Save button to store current settings, making them the defaults
for subsequent printing jobs.
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4.2.2. Setting More Printing Options

Figure 14.20. More Printing Settings
In the Copies tab you have the page range settings and the number and order of
the copies. Select the Range option and fill the page range to print only a given
part of a document. You can specify pages or groups of pages separated by commas:
1,2,5 prints pages 1, 2 and 5; 1-3,7,21 prints pages 1 to 3 and pages 7 and 21,
10- prints from page 10 to the end of the document, and -3 prints the first three
pages of the document.
The Page set pull-down list lets you specify predefined sets of pages to print (All
pages, Odd pages or Even pages). This allows you to print double-sided documents
on a printer without a duplex unit: print the odd pages, turn the stack of printed
pages over and put them back into the input tray, then print the even pages.
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When you are printing multiple copies, you may check the Collate check box to
print the whole document before starting to print the second copy, instead of getting
all copies of page number 1, then all copies of page number 2, and so on.
The Reverse check box makes the printing job start at the last page and end at the
first one (the document is printed “backwards”). This option is useful if your
printer leaves the paper sheets face-up in the output tray.
In the Advanced options tab you may set some options concerning printing time,
priority of the print job and so on.

4.3. Building PDF Files
Select the Print To File (PDF) special printer, enter the file name in the Output file
field as shown in Figure 14.21, “Generating a PDF File” [183], and click on Print
to build a PDF file.

Figure 14.21. Generating a PDF File

4.4. Sending Faxes
The special Send To Fax printer allows you to send the document you are working
on directly by fax7. When you click on the Print button, a dialog (Figure 14.22,
“Faxing Main Window” [184]) will appear.

7

Of course a modem fax must be installed on your computer and connected to the phone line.
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Figure 14.22. Faxing Main Window
The first time you need to make sure that your fax modem is properly configured,
select Settings → Configure KdeprintFax from the menu. Fill the information
under the Personal section with your name, company and fax number. In the
System section make sure that the correct faxing system and its corresponding
parameters are set. An example is shown in Figure 14.23, “Fax Settings” [185].
Fill in the Fax number field and click on the Send Fax button, or press the
Enter key, to send the fax immediately.
The View Log button ( Ctrl - L ) shows a window with the fax activity log (check
it to make sure your fax has been sent correctly).
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Figure 14.23. Fax Settings
The Address Book button ( Ctrl - A ) opens the KDE address book to let you
select fax numbers to dial.

4.5. Handling Print Jobs
This icon appears on the panel whenever you have print jobs, printing or
queued. Click on it to open the print queue control window.
The print jobs handling interface is also available from the main menu:
System + Configuration + KDE + Peripherals → Printers .
Table 14.1, “Jobs Queue Control Buttons” [186] lists the most important job queue
control functions. Please bear in mind that, unless you have sufficient rights, you
can only control print jobs launched by yourself. You won't have control on print
jobs launched by other users. Also note that not all buttons might be enabled at
all times.
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Table 14.1. Jobs Queue Control Buttons
But- Function
ton
Puts the currently selected print job on hold, its printing is paused.

Resumes printing of the currently selected paused print job, its printing
continues.
Removes the currently selected print job from the queue, and cancels its
printing. Please bear in mind that you will not be asked for confirmation,
the job will be removed immediately.
Click on the “up arrow” button to increase the priority of the print job and
click on the “down arrow” button to decrease it. Use these buttons to give
some jobs preference over others.

5. CD Burning
In this section we discuss using K3b to perform common CD burning operations.
K3b also supports DVD recording, but we concentrate only on CD recording in
this section. You only need to install the k3b-dvd package. DVD recording is very
similar to its CD counterpart.
Copyrighted Material. Please note that data, audio, video CD or DVD
copying is often forbidden by copyright law. The examples provided
here are informational only and are not intended to make a CD/DVD
pirate out of you. We assume that if you want to duplicate copyrighted
material, it's because you have the right to do so.

5.1. Getting Started
K3b is automatically configured to give normal users access to the CD burner.
However, we highly recommended that these users be part of the cdwriter group
to minimize burning errors due to system overload. So, go ahead and add those
users to the cdwriter group. Please refer to Section 7, “Managing Users and
Groups” [287], for information on users and group management.
Choosing System + Archiving + CD burning → K3b from the main menu starts
K3b. Figure 14.24, “K3b's Interface” [187] shows K3b's interface with a new data
project open.
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The first time K3b is run, or if you change the CD-R(W) drive, a dialog
pops up asking you for confirmation about the burner's speed. Set the
speed to match the fastest speed of your burner and click the OK button.

Figure 14.24. K3b's Interface
Tool Bar. Where buttons to perform common actions lie. See Table 14.2, “K3b's
Toolbar Buttons” [188].
File Manager. To choose which files to include in the burned CD. Use the leftside tree to navigate the file system and drag and drop the files you want to include
in the project into the Project Manager.
Project Manager. Where all files which will be on the burned CD are shown and
handled. Files can be removed and their location (directory) on the CD can be
changed here.
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The following table shows the most important buttons available in K3b's tool-bar,
their equivalent keyboard shortcuts and a brief explanation of the functions they
provide.
Not all buttons are enabled at all times. For example, the Save button is
not enabled if there is no active project.
Table 14.2. K3b's Toolbar Buttons
Button K e y - Function
board
Shortcut
Create a New Project. Once you click on this button a list of
available project types are shown: choose New Data CD Project
to create a data CD (see Section 5.2, “Burning Data CDs” [189]) ;
choose New Audio CD Project to create an audio CD (see Section 5.3, “Burning Audio CDs (CDDA)” [194]); choose New Mixed
Mode CD Project to create a mixed mode (data+audio) CD; choose
New Video CD Project to create a digital compressed video CD;
choose New eMovix CD Project to create an eMovix [http://
movix.sourceforge.net] CD.
Ctrl-O Open an Existing Project. A standard file dialog opens from where
you can choose the project you wish to open. Select the project
you are interested in and click the OK button.
Ctrl -S Save the Current Project. A standard file dialog opens where you
can enter the name under which the current project will be saved.
Type the name of the project and click the Save button.
Copy a CD. To make an exact copy of a CD. It opens a window
which asks for the copy settings. Refer to Section 5.4, “Duplicating
a CD” [196], for more information. Please note that you cannot
duplicate copyrighted DVD movies with this function, as they
are encrypted.
Erase a CD-RW. To erase re-writable media. It opens a window
which asks for the erase operation settings. Please refer to Section 5.6, “Erasing CD-RW media” [198], for more information.
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5.2. Burning Data CDs
5.2.1. Burning From an ISO Image
Let's presume you have downloaded a CD-ROM image from the Internet and you
want to burn it on a CD. Choose Tools → Burn CD Image from K3b's menu. Click
the “open file” button to browse for the CD image file and select the file in the
standard open file dialog. The CD image is then verified and information about it
is displayed (see Figure 14.25, “Burn CD Image Options” [190]).
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Figure 14.25. Burn CD Image Options
Once the image is verified, you can insert the recordable medium and click on
Start to write it to the disc.
If an already written re-writable medium is found in the CD burner, a
dialog pops up asking you whether to erase it first. Click Yes and follow
subsequent instructions if you want to erase it, or change the medium
for a non-written one and click No .
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The Speed pull-down list should be set to Auto to make K3b select the
fastest possible recording speed supported by the combination of your
CD burner and the currently inserted recordable medium. The “slowest”
speed between the two limits the maximum recording speed.

5.2.2. Burning a Set of Files or Directories
Choose File + New Project → New Data CD Project from K3b's menu . Then drop
into the Project Manager the files and directories you want to include on the CD
(see Figure 14.26, “Selecting Files and Directories to Include on a CD” [192]).
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Figure 14.26. Selecting Files and Directories to Include on a CD
Adding directories containing lots of files can take some time. Please be
patient and wait until the Adding files to Project PROJECT_NAME
message disappears.
The space occupied by the selected files and directories is shown by a color-coded
bar at the bottom of the Project Manager, together with the volume expressed in
192

5.2. Burning Data CDs
MB and the available MB of the medium's total capacity. The bar's color codes are
as follows:
Green
The size of the set is less than that of the selected medium's capacity (700 MB
by default). There are no capacity-related problems.
Yellow
The size of the set is nearly equal the selected medium's capacity. If it's a few
MB below the medium's capacity, there won't be any capacity-related problems;
if it's a few MB above the medium's capacity, the CD might be written without
problems, but there's little guarantee of success.
Red
The size of the set exceeds the medium's capacity by many MB. The CD won't
be recorded properly.
Right-clicking on any file or directory in the Project Manager pops up a contextual
menu with options to remove and rename files, create new (empty) directories,
etc. Files and directories can be relocated (change the directory under which you
want them to appear) on the CD using drag-and-drop.
Renaming the top element of the left side tree in the Project Manager
changes the CD's volume name (K3b data project by default for data
CDs).
Choosing the Project → Burn menu entry displays a window where you can select
writing parameters (see Figure 14.27, “Setting Writing Parameters” [194]). Insert a
recordable medium in the CD burner and click the Burn button to start writing
the CD.
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Figure 14.27. Setting Writing Parameters

5.3. Burning Audio CDs (CDDA)
By audio CDs, we mean the ones you play in your car or home stereo equipment,
not data CDs containing OGG, MP3 or any other digital audio format files.
At the time of writing, K3b supports recording audio CDs from tracks digitized
in Wave (*.wav), Ogg Vorbis (*.ogg), and MP3 (*.mp3) formats. You can mix digital audio formats since K3b decompresses the compressed ones on-the-fly. K3b
can also create digital audio tracks from audio CDs, also known as “ripping” (see
Section 5.5, “Audio CD Extraction (Ripping)” [196]).
Choose File + New Project → New Audio CD Project from K3b's menu. Select
K3b's File Manager's filter to Sound Files, navigate to where the digitized audio
files are and then drag the audio tracks and drop them in the Project Manager (see
Figure 14.28, “Selecting Audio Tracks to Include on the CD” [195]).
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5.3. Burning Audio CDs (CDDA)

Figure 14.28. Selecting Audio Tracks to Include on the CD
Use drag and drop to move the files up and down the compilation. Once you have
the tracks compiled in the order you want in the Project Manager, you can write
them to CD.
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5.4. Duplicating a CD

Figure 14.29. Setting Options to Copy a CD
Choose Tools → Copy CD from the menu. Select the number of copies (1 in the
example), whether to remove the temporary image or not (yes), the reader and
burning devices (automatically set) and click on Start . The “source” CD is then
read, an image of it is made and the “target” CD is written.

5.5. Audio CD Extraction (Ripping)
Make sure that enough temporary space is available. You can check the available
space in K3b's status bar near the right. Bear in mind that each minute of CDquality digitized uncompressed audio takes a bit more than 10MB of disk space.
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5.5. Audio CD Extraction (Ripping)

Insert the audio CD to rip tracks from and double click on the drive in the left
side of the File Manager. The CD is read and, by default, all tracks are marked to
be ripped. Remove the check mark from those you don't want to rip and click on
the gears button to show a dialog to set ripping options (see Figure 14.30, “CD
Ripping Options” [197]).

Figure 14.30. CD Ripping Options
Review the different ripping options (especially the file naming ones) and once
you're satisfied with your settings click on the Start Ripping button.
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5.6. Erasing CD-RW media

5.6. Erasing CD-RW media

Figure 14.31. Setting CD-RW Blanking Options
You might want to format your CD-RW media in order to write it with different
data. To do so, choose Tools → Erase CD-RW from the menu (see Figure 14.31,
“Setting CD-RW Blanking Options” [198]). The Erase Type can be set to Fast (the
CD-RW is quickly erased in up to 3 minutes); Complete (the CD-RW is completely
erased taking up to 90 minutes); and a few options related to multi-session recording
are also available. Insert the medium on the CD burner and click the Start button
to erase the CD-RW.
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Part 5. Configuring and Fixing your
Machine
Mandriva Linux Configuration Tools
Now that you know how to use your Mandriva Linux system on a daily basis, you
surely want to fine-tune your external devices, set up another Internet connection,
or install new and secure software. This part explores the following topics:
Configuring your Machine
In Section 1, “MCC's Components” [201], we review the different configuration
tools available under Mandriva Linux Control Center, a Mandriva Linuxspecific tool which allows you to set up network printers, manage the fonts
on your system, adjust the time and date, back up your data, and much more.
We speak briefly about Drakbug, a bug reporting tool in Section 3, “The
Drakbug Reporting Tool” [206]. The chapters which follow present each section
of Mandriva Linux Control Center in depth.
Package Management
In Chapter 16, Package Management through Rpmdrake [209], we show you how
to update your software, whether it be for security or bleeding-edge reasons,
using the Mandriva Linux Software Manager. You can set up many software
sources in order to obtain the packages you really need. If you want to be in
sync with Linux's fast-paced development, this is the way to go.
Controlling a Remote Machine
In Chapter 24, Controlling a Remote Machine [341], we discuss Rfbdrake which
you can use to control remote machines without leaving your desk. This lets
you administer remote machines using graphical administration tools. Through
Virtual Network Computing (VNC) you are able to solve remote problems
easily and even show your users how to troubleshoot themselves.
Synchronizing Machines
In Chapter 25, Synchronizing Directories Between your Machines [347], we show
you how to synchronize a local and a remote machine through DrakSync.

Troubleshooting
Finally, Chapter 26, Troubleshooting [357] gives you tips and tricks if something
goes wrong: although not exhaustive, this section is undoubtedly very informative and important.

Chapter 15. Introduction to the Mandriva
Linux Control Center
1. MCC's Components
The Mandriva Linux Control Center (MCC) enables the system administrator to
configure the hardware and the services used by all users in a friendly way.

Access the Mandriva Linux Control Center through the main menu ( System + Configuration → Configure Your Computer ).
Some of the Mandriva Linux Control Center components are also available
from the command line in text mode by running drakconf.

Figure 15.1. The Control Center's Main Window
Here are some of the available menu entries:
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1. MCC's Components
•

Options → Display Logs . When activated this option displays a Tools Logs
window. It shows all system modifications made by the configuration tools
launched from within the Mandriva Linux Control Center.

•

Options → Expert mode . Gives you access to some of the more advanced
tools, which are shown in the table below.

•

Profiles . This menu gives you access to the configuration profiles features.
We cover this topic in Section 2, “Managing Configuration Profiles” [204].

•

Help → Help . Opens the help browser which displays documentation about
the active configuration tool.

•

Help → Report Bug . Allows you to report a bug to the development team.
See Section 3, “The Drakbug Reporting Tool” [206].

The tools are sorted into categories. The following table lists them all and refers
to the corresponding sections of this manual.
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1. MCC's Components
Table 15.1. Overview of Graphical Tools
Software Chapter 16, Package Management through Rpmdrake [209]
Management
Configuration Uploader: allows you to upload your configuration to
the Mandriva Online facility in order to benefit from available software
updates. Available only in Mandriva Linux Control Center's expert
mode.
Hardware

Section 1, “Configuring your Hardware” [223]
Section 2, “Controlling the Graphical Configuration” [225]
Section 3, “Setting up a TV Card with DrakxTV” [230]
Section 4, “Changing your Keyboard Layout” [232]
Section 5, “Changing your Mouse” [233]
Section 6, “Configuring Printers with PrinterDrake” [234]
Section 3, “Installing and Using Scanners” [170]
Section 7, “Setting up your UPS” [249]

Network Section 1, “Network and Internet Connection Management” [253]
& Internet
DrakProxy: enables you to configure a proxy to access the Internet.
Section 2, “Internet Connection Sharing” [265]
System

Section 1, “Customizing your Menus with MenuDrake” [271]
Display manager chooser: allows you to choose the X11 display manager
for users who graphically log onto the machine. Basically, all display
managers offer the same features, it's just a question of taste.
Section 2, “Configuring Start-Up Services” [276]
Section 3, “Managing Available Fonts on your System with DrakFont” [278]
Section 4, “Setting your Machine's Date and Time” [280]
Section 5, “Monitoring System Activity and Status” [281]
Console: simply opens a terminal to directly enter commands with the
administrator account (root).
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2. Managing Configuration Profiles
Section 7, “Managing Users and Groups” [287]
Section 8, “Backing Up and Restoring your Files” [290]
DrakAuth enables you to select the authentication mode to be used to
authenticate users on your system. Available only in Mandriva Linux
Control Center's expert mode.
Mount
Points

Section 1, “Managing your Hard Drive Partitions with DiskDrake” [303]
Section 2, “Managing Removable Devices” [308]
Section 4, “Importing Remote NFS Directories” [312]
Section 3, “Importing Remote SMB Directories” [310]
Section 6, “Setting up WebDAV Mount Points” [314]. This utility allows
you to mount remote WebDAV directories.
Section 5, “Allowing Users to Share Folders” [312]

Security Section 1, “Securing your Machine through DrakSec” [317]. Available
only in Mandriva Linux Control Center's expert mode.
Section 2, “Controlling File Permissions with DrakPerm” [320]. Available
only in Mandriva Linux Control Center's expert mode.
Section 3, “Securing your Internet Access via DrakFirewall” [323]
Boot

Section 1, “Configuring the Login Mode” [325]
Section 2, “Changing your Boot-up Configuration” [326]
Section 3, “Customizing your Boot Theme” [328]
Additionally, the Online Administration category only appears if the
rfbdrake package is installed. This tool allows you to take control of a
remote host (Linux/UNIX®, Windows®). We cover the usage Rfbdrake
in Chapter 24, Controlling a Remote Machine [341].
Some more categories appear if the drakwizard package is installed. The
documentation for those wizards is available ondisk as well as in the
Server Administration Guide. Those wizards enable you to do basic configuration of common LAN services such as web, FTP, mail and database
servers.

2. Managing Configuration Profiles
By default Mandriva Linux Control Center profiles enable you to configure network
setups for different locations. This is especially useful for laptops which need a
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2.1. Profile Handling
different configuration for home, at the office, the coffee shop, etc. It also allows
you to activate different services from one profile to another (see Section 2, “Configuring Start-Up Services” [276]).

2.1. Profile Handling
New profiles you wish to create are based on the active one. All modifications are
automatically recorded in the active profile. A single menu ( Profiles ) lets you
manage them.

Figure 15.2. The Control Center's Profile Menu
New
Creates a new profile based on the active one's settings. A dialog pops up
asking for the name of the new profile. Don't forget to switch to that profile
after creating it.
Delete
Shows a list of profiles you can remove. The active profile won't be shown
because it can't be removed while being used.
default
The entries which follow correspond to all available profiles, the active one
being checked. Click on a profile name to switch the host configuration to that
profile.
Let's take an example. You come back home with your brand new laptop which
your system administrator configured so you can connect to your corporate network. You now want to configure the network to access the Internet from home
with a dial-up connection.
1.

Create a new profile called “Home”.

2.

Switch to it.
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3.

Reconfigure your network so that the modem, instead of the network card, is
used to access the Internet (see Section 1, “Network and Internet Connection
Management” [253]).

4.

Connect to the Internet.

5.

When back at the office, switch back to the “default” profile.

2.2. Choosing a Profile at Boot Time
It's more convenient to specify a profile at boot time than to activate it once the
system is booted. drakboot (Section 2, “Changing your Boot-up Configuration” [326])
allows you to associate a specific profile to each menu entry of the bootloader.

Figure 15.3. Associating a Profile to a Boot Entry
Create or modify a boot entry in drakboot. In the Advanced options, access the
Network profile pull-down menu and select the profile you want to associate to
it.

3. The Drakbug Reporting Tool
If you encounter unexpected behavior in Mandriva Linux-specific tools, Drakbug
allows you to report it to the development team.
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3. The Drakbug Reporting Tool
To be able to report bugs using Drakbug, you need a working Internet
connection as well as a Drakbug account [http://qa.mandriva.com/
createaccount.cgi].
To run Drakbug, go to the Help → Report Bug menu entry of the faulty tool, or
run it from Mandriva Linux Control Center's own menu. Drakbug can also be
triggered automatically by a crashed Mandriva Linux tool.

Figure 15.4. Reporting a Bug
In order to correctly report a bug, it is important to identify the package it is related
to. To make this task easier, enter the application name in the Application Name
(or Full Path) field and click on the Find Package button.
Click on the Report button. Your web browser will then open. If you are not logged
in to the Mandriva Bugzilla web site [http://qa.mandriva.com/] you will be asked
to log in (or create an account if you do not have one). Once you are logged on the
site, complete the bug report as completely and accurately as possible and click
on Commit
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Chapter 16. Package Management through
Rpmdrake
Mandriva Linux uses the RPM packaging system and provides convenient tools
to simplify package installation by handling software dependencies automatically.
The urpmi set of tools is command line based and discussed briefly in Chapter 39,
Package Management From The Command Line [501]; here we will concentrate on
Rpmdrake: Mandriva Linux's graphical software installation tool.
Rpmdrake consists of different tools, which you access by choosing one of the
entries of System + Configuration + Packaging in the main menu or by clicking on
Software Management in the Mandriva Linux Control Center (see Figure 16.1,
“Software Management in the Mandriva Linux Control Center” [209]).

Figure 16.1. Software Management in the Mandriva Linux Control Center
We recommend that you access Rpmdrake via the Mandriva Linux Control Center.
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1. Install Software

1. Install Software
When launching this tool you have to wait a few seconds, while Rpmdrake
searches the available packages database. Then you are presented the Software
Packages Installation interface.

Figure 16.2. The Software Package Installation interface
The window is divided into four parts: the upper part offers you some possibilities
to manipulate the list of packages you can install. You will find this list in the
middle on the left. Next to it, on the right, you have an area where you can find a
description of the currently selected package. At the bottom of the window you
will find two buttons and information about how much space is required to install
the selected packages and how much space you have available on your disk.
Additionally, a status bar in the lower part of the window displays
messages about actions currently in progress or completed.
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1.1. Selecting Packages to Install

1.1. Selecting Packages to Install
Let us have a closer look at the interface as shown in Figure 16.2, “The Software
Package Installation interface” [210]. A package named “frozen-bubble-1.0.07mdk” is selected in the tree-view and in the package description area you see the
required disk space, a short summary (Frozen Bubble arcade game) and a detailed
description (Full-featured, colorful animated penguin eye candy...).
If your software medium repository is configured to use complete package
lists (not the summary synthesis files, but the full hdlist ones, which
happens to be the default option after installing your Mandriva Linux
system), you may get more information on the package by choosing the
Maximum information radio button in the access-area. In addition you
can see a list of the files provided by the package and the change log.
The status bar shows you the disk space required by the selected packages as well
as the current free space. Please note that due to dependencies, the disk space required by the selected packages might be greater than the size required by the
chosen package by itself.
Rpmdrake shows you an alert box if you try to install more software than
the free available disk space. Nevertheless you may proceed (you may,
for example, be able to remove some no longer required files, such as
programs downloaded from Internet in the past and which you do not
use anymore, to allow the installation to continue).
Now you can begin the installation, by simply clicking on the Install button. A
new window appears, showing you a progress bar of how your installation is
proceeding. If you prefer to leave without doing anything, you can just click on
the Quit button.
While selecting applications to install, it may happen that you choose a package
which requires dependencies (additional libraries or another tool) to work correctly.
In this case Rpmdrake displays an information window allowing you to choose
whether to accept the selected dependencies, or to Cancel the operation (Figure 16.3, “Rpmdrake — dependency alert box” [212]).
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Figure 16.3. Rpmdrake — dependency alert box
Another possible scenario might be: you want to install a package which requires
dependencies, and various packages are capable of providing that dependency.
The list of alternatives is then presented (Figure 16.4, “Rpmdrake — package alternatives” [212]). You may read the additional information presented by clicking
the Info... button to help you choose the best alternative.

Figure 16.4. Rpmdrake — package alternatives
We will now take a closer look at the search and sort functions provided to ease
your job as a system administrator.

1.2. Searching Packages
Sometimes you may know about some tool you saw somewhere or you heard of
at a friend's place, now you wonder how to find and install them on your system.
It is really easy: just type the name, (or part of the name), in the text area next to
the Search button. Then choose, from the pull-down list, where you want to look
for it (either in the package name, in the description provided with the package
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1.2. Searching Packages
or in the names of the files stored in the packages). After clicking on the Search
button, a new list appears (Search results), showing you the results Rpmdrake
found while scanning the packages databases.
Let us take a look on the different sort orders:
Mandriva Linux choices
This sort order shows the list of packages in the four groups you saw during
the installation of Mandriva Linux. This is the easier sort order because it focuses on a selected part of the available packages, those which are considered
to be the most useful of the distribution.
All packages, alphabetical
Instead of a tree view, you are presented with a flat list of all available packages
you can install on your system.
All packages, by group
Here you are shown the list of packages grouped by their functions (e.g. Games,
System, Video, etc.).
All packages, by size
Here you get a list sorted by size (the biggest package at the top, the smallest
at the bottom of the list).
All packages, by selection state
If you choose this presentation, you end up with a flat list, in which all selected
packages are shown first, the other available packages below them. To make
it easier for you, those two parts are sorted alphabetically. This sort order is
particularly useful just before the actual package installation, because it helps
you to see the selection of packages to be installed.
All packages, by medium repository
Once again you find the packages sorted alphabetically, but this time they are
shown under the name of the data medium they belong to.
All packages, by update availability
In this mode, you might get two groups of packages: a list of packages which
might be added to your machine, and a second list of the packages of which
you have an older version already installed on your computer.
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2. Remove Software
As this interface works like the “Install Software” one, we will not repeat
its basic functions. The only difference to the installation interface is that you will
deal with the already installed packages list from which you'll choose those you
want to remove, instead of those packages which might be useful to install on your
computer.

3. Mandriva Linux Update
Mandriva now provides an automatic updates service; see Chapter 23,
Mandriva Online Services [331].

Once again: if you have already worked with Rpmdrake's software installation interface, you should feel comfortable with Mandriva Linux Update. But let
us look at the details.
When you launch this tool, it first asks you to choose an Internet repository to
check for updates. You should choose one in a country near you.
A small difference to the “Install Software” interface is the ability to choose which
kind of update you want to install on your computer by grouping them in certain
ways. You may select:
Security updates
These updates solve security issues and should be installed as soon as possible.
Bugfixes updates
These updates fix application misbehavior.
Normal updates
These updates just bring slight improvements.
The other difference is a new text section (Reason for update) inside the package
description area. It provides you with information about why this update was
made available. This may help you decide if you want to update certain packages
or not. When you have a slow Internet connection or you have to pay per MB when
you are downloading, it would be wise to read it.
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4. The Software Media Manager
If you are not yet familiar with the interface, please go back to Section 1, “Install
Software” [210] to learn about it.

4. The Software Media Manager
This part of Rpmdrake is dedicated to the configuration of the package
media repositories. As you can see in Figure 16.5, “The “Software Media Manager”” [215] there are some media configured: “Main”, “Contrib”, etc. With this
tool you can add other software media: a CD from a magazine containing RPMs,
a Web repository, etc.

Figure 16.5. The “Software Media Manager”
The check boxes in the left-hand columns allow you to flag the repositories:
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4. The Software Media Manager
Enabled?
Uncheck this box to temporarily disable the corresponding medium. The
packages contained in this medium will not be available for installation until
you enable the medium again.
Updates?
This box must be checked for update media, that is, media that contains updates
of packages that are already in another medium, albeit with an older version
number. Thus only update media are taken into account when looking for
updates.
Various buttons allow you to perform actions on the selected media.
Remove
Allows you to remove a medium which you no longer use. Simply select the
medium to be removed in the list and click this button.
Edit
Here you may change the URL or the relative path to the synthesis/hdlist
(if you do not know what we are talking about it is wise to leave this window
via Cancel instead of Save changes ).
In case you need to pass through a specific proxy to access this medium, you
can configure it here by clicking on the Proxy... button. Note that you can also
define a global proxy for all remote media through the Proxy... button of the
main interface.
This option also allows you to change from using hdlist files to synthesis
files, which are much smaller but with less information on packages. Synthesized files only have information about package names, their dependencies and
a short summary, you won't be able to search for files inside uninstalled
packages, for example, and you won't be able to see the full description for a
package if you click on its name.
Add...
Use this button to add to your system all publicly available official package
sources from Internet repositories. This is useful for example if you have a fast
Internet connection or only have the first installation CD at hand. Choose a
mirror geographically near to your location.
After choosing a mirror and clicking Ok , package information for the source
you chose is downloaded and all included packages will be available for you
to install and update your system.
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4. The Software Media Manager
Add custom
This button provides access to a new dialog, in which you may reference a
new software package medium.

Figure 16.6. Rpmdrake — adding Media
Update...
You are here shown a list of already defined data media. You can choose the
ones where you want to update the list of available packages in it. This is
useful for remote media to which new packages are being added. Just start
the process by clicking on Update .
Manage keys...
It is important that any new packages you install are authenticated. To do so,
each package can be electronically signed with a “key”, and you can allow/disallow keys on a per-medium basis. On Figure 16.7, “Rpmdrake — managing
keys” [218], you can see that Mandriva Linux key is allowed for medium “Installation CD”. Click on Add a key... to allow another key for the selected
medium (beware, do this with care, as with all security-related questions), and
on Remove key to remove a key from the selected medium.
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4. The Software Media Manager

Figure 16.7. Rpmdrake — managing keys
Proxy...
If you are sitting behind a firewall and you still need to access remote media
(especially for package updates), you can do so if you have a proxy server
which leads to the Internet (at least in an area where you can find a package
server). Normally it should be enough to fill in the Proxy hostname to get it
working (Figure 16.8, “Rpmdrake — configuring a proxy” [218]). If you need
a user / password combination to get through the proxy, you can also specify
these here. Just confirm your changes by clicking on OK and you are done.

Figure 16.8. Rpmdrake — configuring a proxy
Parallel...
If you are running a large network of computers, you may want to install a
package on all the computers in parallel; this button opens a dialog window
allowing the configuration of the “Parallel” mode. Please refer to Section 5,
“Manage Computer Group” [219] for more information about the parallel mode.
Global options...
This button allows you to configure the program used to download new
packages and if the source should be checked against a given key. These choices
are used on all installed sources.
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5. Manage Computer Group
Up and Down arrows
These buttons allow changing the order in which sources will be used when
installing packages.

For advanced users
Rpmdrake
processes
the
urpmi
configuration
file
(/etc/urpmi/urpmi.cfg) from top to bottom to obtain a list of medium repositories and the packages that each contains.
If a given package appears in more than one medium, and versions
differ, then the one with the newest version will be used, ignoring
the rest.
When a package with the same version appears in more than one
medium, only the one appearing first will be used, the rest will be
ignored.
Either way, you won't miss available packages, the newest one appearing first is the one that will be used.

5. Manage Computer Group
5.1. Defining the Group

Using Rpmdrake's parallel mode you can define groups of machines
to install the same software packages on. This greatly simplifies managing a large
number of systems, for example in a LAN. Make sure park-rpmdrake, urpmiparallel-ssh and urpmi-parallel-ka-run are installed.
This tool is accessible only in expert mode. Choose Options → Expert
mode from the menu and then access the Software Management section
of Mandriva Linux Control Center.
Click on New Group , provide a Name for the group, select the Protocol to use
(ssh in our example), check the networks to be scanned for hosts in the list or add
other networks: by default, only your local network is listed, and click on Scan .
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5.2. Managing Packages in the Group of
Computers
Hosts on the network must have an SSH server running and the corresponding ports (tcp/22 by default) open if they also host a firewall. The
rsync package must be installed as well. Also, root must be allowed to
login using SSH (PermitRootLogin yes in /etc/ssh/sshd_config, on
the hosts).
Wait a few minutes until the network scan finishes and then check the hosts to be
made part of the group (see Figure 16.9, “Adding Computers to a Group” [220]).

Figure 16.9. Adding Computers to a Group
You are then asked for root's password on each of the selected hosts in order to
automate packages installation on them.

5.2. Managing Packages in the Group of Computers
For package installation or removal on the computers part of a group to
succeed, all computers in that particular group must be available.

220

5.2. Managing Packages in the Group of
Computers
Simply select the group and click on the Use Group button, the interface explained
in Section 1, “Install Software” [210] appears. You can now install packages on the
selected computers group as you would on a single computer.
You can also install packages on the computers group from the command line,
use:
urpmi --parallel <group_name> <package_name>

For example, issuing urpmi --parallel GraphicDesign gimp will install GIMP on
all computers part of the GraphicDesign group.
To remove a package from a computer group, use:
urpme --parallel <group_name> <package_name>

For example, issuing urpme --parallel GraphicDesign gcc will remove the C
compiler from all computers part of the GraphicDesign group.
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Chapter 17. Configuring your Hardware and
Devices
1. Configuring your Hardware
1.1. Hardware Detection and Configuration

The HardDrake project has been developed to simplify hardware
detection and configuration under GNU/Linux by providing a user-friendly interface.

1.1.1. What Is HardDrake?
HardDrake is a service for hardware detection, run at system boot time, and also
a full GUI-based tool which ties together many of the tools already included in a
GNU/Linux distribution. It automates and simplifies the process of installing new
hardware. For the most part, HardDrake will be able to detect most devices.
On one hand, HardDrake is used to display information, and on the other, it can
launch configuration tools. With its easy-to-use interface, you can browse all the
hardware your system contains.
HardDrake uses the “ldetect” engine, so if your new hardware is not detected, you
may try to upgrade the ldetect library itself and its hardware database, located
in the ldetect-lst package.

1.1.2. Usage
To launch HardDrake, you can start it through:
• the Mandriva Linux Control Center: click on the Hardware category, and then
on the Hardware icon.
• a terminal: type harddrake2 as root. You can also pass parameters to HardDrake
through the command line (type harddrake2 -h to get a list of possible parameters).
• the desktop: go to the main menu. The HardDrake entry is in the System + Configuration + Hardware → HardDrake sub-menu.
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1.1. Hardware Detection and Configuration
After all devices have been detected, the main HardDrake window will appear
(see Figure 17.1, “Selected Device” [224]).
On the left, you can see the device tree showing you all of the hardware categories.

Figure 17.1. Selected Device
By selecting a device, you will see additional information about it in the right
frame. To better understand the meaning of the information presented, you can
consult the help page accessible by choosing Help → Fields description from the
menu.
Depending on the device selected, two other buttons may appear:
•

Configure module . This pops up a window with all the module device
parameters listed. For experts only!

•

Run config tool . Launches the Mandriva Linux configuration tool (available
through the Mandriva Linux Control Center) associated with that device.
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1.2. Problems/Troubleshooting
A special category called Unknown/Others might also show up, containing all the
currently unknown hardware in your system, as well as known hardware that
does not fit into the existing categories (such as thermal sensors, random number
generators, etc.).
You can also toggle the entries in the Options menu to enable automatic detection
of some hardware which wouldn't have been detected otherwise. You need to restart HardDrake for those changes to have effect.
If you have a Mandriva Online account and want to help us improve hardware
support under Mandriva Linux, or want to see your hardware better supported
in the future, you can choose File → Upload the hardware list from the menu and
fill the form with your account data, then click on the Ok button: your hardware
list will be uploaded. You need a working Internet connection.

1.2. Problems/Troubleshooting
If you think you have found a bug related to HardDrake, report it using the Mandriva Linux bug reporting tool (see Section 3, “The Drakbug Reporting Tool” [206]).
HardDrake does not probe for ISA PnP devices. If you have an ISA PnP sound
card, run sndconfig or alsaconf from the command line. You may need to install
the sndconfig package or the alsa-utils package.

2. Controlling the Graphical Configuration
This set of tools allows you to configure your graphical display. With it you will
be able to change your video card, your resolution and your monitor. It can be
useful if you happen to change one of your graphical components after the initial
installation.
If you cannot boot into graphical mode and you end up in a console
(command-line interface), log in as root and launch XFdrake. You will
get a tool similar to the one described in Section 2.3, “Controlling All
Video Parameters” [228], but in text mode.
The graphical configuration tools are accessible through different icons in the
Mandriva Linux Control Center Hardware section.
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2.1. Changing the Monitor

2.1. Changing the Monitor

Figure 17.2. Choosing a New Monitor

This tool allows you to change the monitor type currently in use. When
you click on it a window pops up, listing many monitor models (see Figure 17.2,
“Choosing a New Monitor” [226]). If your monitor was automatically detected it
will be listed as Plug'n Play along with its model.
If your monitor wasn't automatically detected, you can choose it from the list. If
you don't find your monitor or a compatible one, choose one with parameters
corresponding to your own monitor from the Generic entry, at the bottom.
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2.2. Changing Resolution

Figure 17.3. Changing the Resolution of your Screen

This tool enables you to change the current screen resolution (800x600,
1024x768, etc.) and the color depth. Simply choose the one you wish to use. The
monitor in the window displays what the desktop will look like with the chosen
configuration (see Figure 17.3, “Changing the Resolution of your Screen” [227]). If
it looks good, click on OK.
The changes will be activated after you quit and restart your graphical environment.
By default, the available resolution list only shows resolutions supported by your
video card and monitor combination. There is a special entry named Other which
adds more possible resolutions along with their ratio. Bear in mind that most
monitors are designed with a 4:3 horizontal vs. vertical ratio.
227

2.3. Controlling All Video Parameters

2.3. Controlling All Video Parameters

Figure 17.4. XFdrake Main Window
If you happen to change your video card after installing your system, or want to
have full control over the graphic configuration, run as root, XFdrake from a
console. The tool shown in Figure 17.4, “XFdrake Main Window” [228] will be
shown.
Let's look at the interface. The first three buttons allow you to change certain aspects
of the graphical configuration:
Graphic Card
The button displays the name of the graphic card currently configured. If you
wish to change it, just click on it. Depending on your card, different servers
may be available, with or without 3D acceleration. You may need to try different
ones until you get the best result.
In case you cannot find the graphic card you have, but you know which driver
supports it, select it from the Xorg entry at the bottom.
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Monitor
Enables you to change the monitor with the tool described in Section 2.1,
“Changing the Monitor” [226].
Resolution
Enables you to change the pixel resolution and the color depth with the tool
described in Section 2.2, “Changing Resolution” [227].
If you are using KDE you can also change the screen resolution on the
fly by using the screen resize applet, accesible choosing System + Configuration + Hardware → KRandRTray from the main menu.
If you are using GNOME you can also change the screen resolution on
the fly by using the Screen Resolution Preferences applet, accessible by
choosing System + Configuration + GNOME → Screen Resolution from
the main menu. Select the desired resolution and refresh rate and click
on Apply to test your selection. You can then keep the settings or return
to the previous ones.
Then, there are more buttons:
• Test. Click on this button to verify that your modifications actually work. It
is highly recommended you do test it, because if it does not work, it will be
harder to recover a working graphical environment later. If the test fails simply
wait until it ends. If you are not satisfied with the suggested settings, choose
No during the test, and you will be returned to XFdrake's main menu.
Depending on your video card, video testing may not be available.
You will be warned of such a situation. If it happens that the settings
are incorrect and your display does not work, refer to Chapter 26,
Troubleshooting [357] to use XFdrake's text version.
• Options. You can choose to start the graphical server when your system
boots. Answer No if you prefer to have a text login. Selecting Yes will launch
the graphical login manager at boot time.
• Quit. If you modified your graphical display in some way, the current configuration will be displayed and XFdrake will ask you whether you want to
keep your changes or not. This is your last chance to go back to the old configuration. If all seems OK, click on Yes . If you wish to restore the previous
parameters, click on No .
229

3. Setting up a TV Card with DrakxTV
The changes will be activated after you confirm them and restart your graphical
environment.

3. Setting up a TV Card with DrakxTV

This tool will configure your TV tuner card in order for you to watch
television on your computer display.
First of all you should make sure your card is supported by Mandriva Linux by
consulting the Hardware Compatibility page [http://www.mandriva.com/
hardware] or the BTTV driver home page [http://linux.bytesex.org/v4l2/bttv.
html/].
Modern TV viewing programs have their own configuration and channelscanning interface embedded. You only need to run DrakxTV if you plan
to use xawtv with old TV cards based on the btxxx or saa71xx chips.
Make sure your card is correctly connected to your antenna or cable, so
that channel scanning runs properly.
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3. Setting up a TV Card with DrakxTV

Figure 17.5. Choosing the TV Card Model
When you first launch the tool, and if a TV card is detected, the main configuration
dialog (Figure 17.5, “Choosing the TV Card Model” [231]) will appear. Leave the
default Auto-detect entries and press OK . If you notice afterward that your card
was not properly configured, you can run DrakxTV again and select the proper
card.
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4. Changing your Keyboard Layout

Figure 17.6. Choosing the TV Norm and Country
You simply need to inform DrakxTV about the norm used for the television signal
you receive, and the country you're in. You also have to select the user who is going
to use xawtv so that his configuration file is created.
After you press OK , DrakxTV will begin automatic channel scanning. Once this
is done, your TV setup will be complete and you will be able to watch television
on your computer using xawtv. Other applications allowing to you watch TV under
Mandriva Linux are kdetv, tvtime and zapping.

4. Changing your Keyboard Layout
This tool allows you to define another keyboard layout. This is commonly done when the keyboard you want to use is different from the one chosen
at installation time.
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5. Changing your Mouse

Figure 17.7. Choosing a Different Keyboard Layout
Select your keyboard's language and then its model from the lists shown in Figure 17.7, “Choosing a Different Keyboard Layout” [233]. If you own a multimedia
keyboard and are lucky enough to have it listed in the manufacturer list, chances
are most multimedia keys on it will be supported. Otherwise, choose your keyboard
type under the Generic branch. Changes are effective immediately after clicking
OK.
If you choose a keyboard layout based on a non-Latin alphabet, the next
dialog will ask you to choose the key binding that will switch the keyboard configuration between the Latin and non-Latin layouts.

5. Changing your Mouse

This tool enables you to set up a different mouse, which is useful if
the mouse you are currently using is not the same as the one you chose at installation time.
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6. Configuring Printers with PrinterDrake
Synaptics Touchpad function is automatically configured to work with
almost every touch pad found on notebook computers. The same goes
for Wacom® tablets.

Figure 17.8. Choosing a Different Mouse
Mice are sorted into a tree according to their connection type and model (see Figure 17.8, “Choosing a Different Mouse” [234]). Highlight the mouse of your choice
and click OK . Changes take effect immediately after the mouse test is done.
The Any PS/2 & USB mice option works with virtually all modern mice.

6. Configuring Printers with PrinterDrake

This tool allows you to:
• configure a newly installed printer on your machine;
• configure your machine to act as a server for a printer which has just been
connected to your local network;
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6.1. Initial Configuration
• set up your machine to access network printers served by other servers
(GNU/Linux as well as Windows® ones).
If you just installed a printer that wasn't available when you installed
Mandriva Linux, make sure it is correctly connected and powered on
before launching the configuration tool.

6.1. Initial Configuration
When you first launch the PrinterDrake tool, it may be in one of these states:

6.1.1. There is no printer directly connected to the computer.

Figure 17.9. Activate Printing
The tool did not detect any local printers. However you can print on network
printers, or manually install printers which weren't detected by clicking on Yes .
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6.1. Initial Configuration

Figure 17.10. Activating Network Printers
• Select the Local CUPS printing system option if you wish to configure your
machine to act as a print server for either a local printer which was not detected,
or a network printer connected to your local network.
Any required software will be installed and then the main configuration interface (see Figure 17.12, “Managing Printers” [238]) appears. Click on Add
Printer to install the network printer.
• Select the Remote server option if you wish to be able to print on printers served
by another CUPS printing server on the network. Your applications will immediately have access to all public printers served by that server. You only need
to provide the hostname or IP address of that server in the field (ask your system
administrator).
When this is done, the main configuration interface (see Figure 17.12, “Managing
Printers” [238]) appears. The Configured on other machines tab will be filled
with the available network printers.

6.1.2. New Printer Detected
The following window appears when PrinterDrake detects a new printer.
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6.2. The Printer Management Interface

Figure 17.11. A New Printer Is Detected
Simply confirm the automatic installation of the new printer. The main configuration interface (see Figure 17.12, “Managing Printers” [238]) is then displayed. Make
sure you check that the printer parameters fit your needs (see Section 6.5, “Reconfiguring an Existing Printer” [246]).

6.1.3. Printer Configured at System Installation Time
The main configuration interface (see Figure 17.12, “Managing Printers” [238]) is
shown. Make sure that the printer parameters fit your needs (see Section 6.5, “Reconfiguring an Existing Printer” [246]).

6.2. The Printer Management Interface
Use the printer configuration tool's first tab for locally connected printers (Configured on this machine), and the other tab for printers available on your local
network (Configured on other machines).

237

6.2. The Printer Management Interface
If your local printer was automatically added you should now verify its
configuration. Select it in the list, click on Edit and check the Printer
options.

Figure 17.12. Managing Printers
The following buttons give you access to all available maintenance tasks:
•

Add Printer : launches the printer configuration wizard described in Section 6.4,
“The Printer Configuration Wizard” [241].

•

Set as default : sets the selected printer as the default printer when no specific
printer is chosen at print time. A cross appears in the Def. column of that
printer.

•

Edit : opens the printer configuration dialog described in Section 6.5, “Reconfiguring an Existing Printer” [246].

•

Delete : removes the selected printer from the available printer pool.
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6.3. Print Server General Configuration
•

Refresh : updates the list of printers with possible new or removed printers,
especially useful for networked printers.

•

Configure CUPS : by default, your system is totally open. PrinterDrake uses
all of the network's available printers and shares all of its local printers with
the local network. Click on this button if you don't want to access network
printers, or if you want to restrict the access to your local printers. This dialog
also lets you configure access to servers outside the local network.
The Options → Expert mode menu adds extra features to the tool. See
Section 6.6, “Expert Mode” [247].

6.3. Print Server General Configuration
The Configure CUPS button allows you to control the behavior of printers connected to your machine and to your network.

Figure 17.13. CUPS Printer Server Configuration
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6.3. Print Server General Configuration
This dialog enables you to switch between the client and server printing modes
through the Remote CUPS server and no local CUPS daemon button.

6.3.1. Client Mode

Figure 17.14. Client Mode Configuration
Select the On option to connect to another printer server. You then just need to
specify the name or IP address of that server in the field below.
If you choose this mode, your printing configuration is now finished. Accept the
options by clicking the OK buttons, and you will be able to check the list of
available printers in the Configured on other machines tab of the main interface
(see Figure 17.12, “Managing Printers” [238]).

6.3.2. Server Mode
If you want your machine to access locally connected printers (through parallel or
USB ports), or network printers not already configured on another server, you
need to select the Off option. Click OK , and you will then be able to fine tune your
printer server (see Figure 17.13, “CUPS Printer Server Configuration” [239]).
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6.4. The Printer Configuration Wizard
A number of options are available to further secure and enhance your print server
features:
The printers on this machine are available to other computers
Allows other computers to print on printers configured locally. Remember to
restrict access by clicking on Printer sharing on hosts/networks (see below).
Automatically find available printers on remote machines
Tells your print server to automatically make all printers found on other
servers available on the local network, as if they were locally connected to
your print server. This way your system's users are able to print on any
printer the print server “sees”. If the remote printers you intend to use are
served by a server not on your local network, you can still tell the print server
to use them with the Additional CUPS servers button (see below).
Printer sharing on hosts/networks
Allows you to specify from which networks the local printers are made available.
Additional CUPS servers
Allows you to specify one or more CUPS servers to which you can connect
and access printers. Specify the IP address and port of the CUPS server in the
dialog.
Japanese text printing mode
Replaces the original text filter for one more suited to Japanese texts, but with
less features. Use it if you have to print Japanese text-only files.

6.4. The Printer Configuration Wizard
Click on Add printer and the configuration wizard comes up.

6.4.1. Detecting a Printer
This tools enables the auto-detection of locally connected printers, network printers,
and finally printers served by SMB (Windows®) servers. First choose which type
of printer you want to add (Local printer, Network printer, Printer on remote lpd
server, etc.).
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6.4. The Printer Configuration Wizard

Figure 17.15. Printer Type
Select the printer you want to add from the list. If the detected printer isn't the
correct one check the Manual configuration box and proceed with the printer
model step (see Figure 17.17, “Choosing a Name for your Printer” [244]). If autodetection fails, remove the check mark from all check boxes, click on Next and follow
the instructions below.
If you own a multi-function device such as those of HP or Sony, an information
window pops up and gives you information about your scanner and scanner
software (Section 3.1.1, “ScannerDrake” [170]). Additional packages are also installed.
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6.4. The Printer Configuration Wizard
PrinterDrake displays your printer's model name. Choose Select model manually
if it's incorrect. Select the printer you have or a compatible one (see Figure 17.16,
“Choosing the Printer Model” [243]) if yours is not specifically listed.

Figure 17.16. Choosing the Printer Model
If you want to install the driver supplied by your printer manufacturer, click on
the Install a manufacturer-supplied PPD file button and select the medium containing the PPD file and browse to it. Accept subsequent dialogs to use your chosen
PPD file.
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6.4. The Printer Configuration Wizard

Figure 17.17. Choosing a Name for your Printer
Provide a name for your printer. The printer name must contain only letters,
numbers and the underscore (“_”) character. It's better to limit its length to 12
characters maximum so that Windows® clients don't have problems when accessing
it through Samba.
If you have one or more configured printers, you are asked whether the
printer you are configuring is to be the default printer. If you say No ,
the previous default printer will be retained.
Finally we strongly recommend that you print a test page in order to make sure
everything works as expected.
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6.4. The Printer Configuration Wizard

6.4.2. Printing Options
Once the configuration is done, the options associated with the chosen printer are
shown (see Figure 17.18, “Configuring the Printer's Options” [245]). It's important
you choose the proper settings (such as paper size, media source, etc.) currently
installed on the printer. If the settings you choose are incorrect, printing may fail.

Figure 17.18. Configuring the Printer's Options
For settings referring to printout quality, bear in mind that higher quality
levels may make the printing operation slower and may consume more
ink.

6.4.3. Printer Test
A few test pages are available (see Figure 17.19, “Testing the Printer” [246]). We
recommend you print at least one test page so you can immediately correct the
parameters if something goes wrong. The printer should begin to print almost
immediately.
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6.5. Reconfiguring an Existing Printer

Figure 17.19. Testing the Printer

6.4.4. It's Done
If you're not satisfied with your test page, answer the appropriate question with
No and you will be led to the printer configuration menu (see Figure 17.20,
“Modifying an Existing Printer” [247]) where you can correct the settings. See Section 6.5, “Reconfiguring an Existing Printer” [246].
Your printer will now appear in the list of available printers in the main window
(see Figure 17.12, “Managing Printers” [238]).

6.5. Reconfiguring an Existing Printer
Double-clicking on a printer's name in the list, or clicking on the Edit button, displays a menu where you can choose actions to take on the selected printer (Figure 17.20, “Modifying an Existing Printer” [247]). Each option gives access to a
particular step of the wizard we described above (see Section 6.4, “The Printer
Configuration Wizard” [241]). One difference is that the current settings are predefined in all fields, and you may update them where required.
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6.6. Expert Mode

Figure 17.20. Modifying an Existing Printer
There are a few additional options:
1.

Disable Printer. Use this option to remove that printer from the printers
available to the system's users. You might need to temporarily disable a
printer under maintenance so that users don't try to use it in the meantime.
When a printer is disabled, that option changes to Enable printer.

2.

Learn how to use this printer. Displays information on how to use a particular
printer model. In the case of a multi-function device from HP, information
about scanning and photo memory card access is also displayed.

3.

Remove printer. Deletes that printer's configuration from the system.

Select an action in the dialog and then click on the Do it! button to perform it.

6.6. Expert Mode
The expert mode has three additional features:

247

6.6. Expert Mode
• Choose a Different Driver to the Default One for a Printer. Different drivers
are available for the same printer. In expert mode, a third level appears in the
printer model selection list (see Figure 17.16, “Choosing the Printer Model” [243]). It allows you to change each printer's driver.
• Install Many Kinds of Remote Printers. This feature enables you to print
on remote printers using the LPD protocol, printers on Windows® servers
which require authorization, or other arbitrary printer types.
If PrinterDrake is in expert mode, it doesn't automatically configure new
local printers on start-up. Use the Add printer button to configure the
printer. However you can choose to Configure Auto Administration
from the Options menu to override that behavior.
If you start the new printer wizard in expert mode, there is an additional step at
the beginning.

Figure 17.21. Configuring a Remote Printer
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7. Setting up your UPS
Different connection types are available:
• Local printer. A printer directly connected to a parallel or USB port on your
computer. In most cases, the printer model will be auto-detected.
• Printer on remote lpd server. A printer already served by another machine on
a lpd server.
• Network printer (TCP/socket). A printer directly connected to your local network. The network can be scanned and printer models automatically detected
provided the Printer auto-detection box is checked.
• Printer on SMB/Windows 95/98/NT server. Relevant for printers already
connected to a computer running an OS which serves printers with the SMB
protocol, including Samba printers (the necessary Samba components will be
automatically installed in this case). The network can be scanned provided the
Printer auto-detection box is checked.
• Enter a printer device URI. This option allows you to directly enter the printer's
Universal Resource Identifier (URI) on your network. It can be used for any of
the above remote connections, and more. This is useful when your system administrator provides you with the printer's URI.
Click on the Modify timeout for network printer auto-detection button to change
the default timeout (4000 milliseconds, or 4 seconds) for detection of networked
printers. Please bear in mind that the bigger the timeout, the better the chances of
detecting remote printers. However the auto-detection process will also take more
time.

7. Setting up your UPS
The role of a UPS (Uninterruptable Power System) is to provide you with
electrical power whatever happens. A UPS enables you to continue working for a
certain amount of time due to its battery (usually up to 10 minutes depending on
the model) even if there's a power outage in your area. Its main function, however,
is to allow you to save your data and to cleanly close your machine, minimizing
and even avoiding data corruption and loss.
Open the Mandriva Linux Control Center in the hardware section and click on Set
up a UPS for power monitoring to launch DrakUPS.
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7. Setting up your UPS
The nut-server (“nut” stands for Network UPS Tool) package needs to
be installed.

Figure 17.22. DrakUPS Setup
Next let DrakUPS autodetect your UPS. If all goes well you should get a congratulation message. If not try to do it manually.
Select your UPS in the list of manufacturers and models.
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7. Setting up your UPS

Figure 17.23. Selecting the Manufacturer and Model
Then assign a Name, Driver, and Port 1.

1

The Name and Driver fields should automatically be filled. Of course, you can change its name but
we recommend you keep the driver name.

251

7. Setting up your UPS

Figure 17.24. Name, Device and Port Names
If all went well your UPS should now be configured and ready to help avoid bad
power outage surprises.

252

Chapter 18. Configuring your Internet
Connection
1. Network and Internet Connection Management
Before connecting to the Internet, you are encouraged to set up a firewall
on your machine so as to avoid bad surprises such as intrusions on your
system. You can set up a very simple, yet effective, firewall using DrakFirewall. Please refer to Section 3, “Securing your Internet Access via
DrakFirewall” [323] for more information.
The drakconnect set of tools allows you to easily configure your network access,
whether it be to the Internet or to a local network. Open Mandriva Linux Control
Center and select the Network & Internet section to access drakconnect tools. A
view of the main interface is shown in Figure 18.1, “DrakConnect Tools” [254]. The
Internet connection sharing tool is described in Section 2, “Internet Connection
Sharing” [265].
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1.1. Set Up a New Network Interface

Figure 18.1. DrakConnect Tools

1.1. Set Up a New Network Interface

drakconnect supports different types of Internet and network connections.
The first step consists of choosing which type of connection you wish to configure.
Always make sure you have all the information provided by your ISP or network
administrator at hand.

1.1.1. LAN Connection
Select the LAN connection type and continue to the next step. Your NICs are detected automatically; if you have more than one, you have to select the one you
wish to configure. You can also load a driver for your NIC manually.
Then, you have to specify if the network parameters will be automatically set up
(Automatic IP (BOOTP/DHCP)) or not (Manual configuration): fill the next steps
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with the parameters which your ISP or network administrator gave you. An example of the manual configuration of IP parameters is shown in Figure 18.2, “Setting
Primary Static LAN Connection Parameters” [255].

Figure 18.2. Setting Primary Static LAN Connection Parameters
Check the Network Hotplugging box to have your network brought up
and down automatically when you connect and disconnect the network
cable. This is specially handy for laptop users.
Following the static IP example, you have to specify the rest of the parameters,
namely the hostname, DNS server IP address(es) and the IP address of the machine
giving you access to the Internet, known as the gateway (see Figure 18.3, “Setting
the DNS and Gateway IP Addresses” [256]).
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Figure 18.3. Setting the DNS and Gateway IP Addresses
If you configure the network with DHCP you can optionally provide the machine's
hostname. Then you can supply the Zeroconf hostname: this is the name which
will be assigned to the machine when no network configuration has been found.
After the configuration is done, you can bring the network connection up or down
as described in Section 1.4, “Monitoring Connections” [263]. Please bear in mind
that LAN connection types are set up to always be started at boot time.
An applet appears in the desktop's panel indicating that the connection
is up
or down
. Right click on it to access a menu that will also let
you control the connection's state as well as other parameters.

1.1.2. Wireless Connection
This entry allows to configure WiFi PCMCIA or PCI devices.
1.
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Choose the card you wish to configure. If your card is not listed, choose the
Use a Windows driver entry. The next step then asks you to select the driver
from the manufacturer's card drivers CD.

1.1. Set Up a New Network Interface
2.

Network configuration is then similar to the LAN connection type (see Section 1.1.1, “LAN Connection” [254]).

3.

Finally some wireless specific parameters are asked, make sure to set them
correctly according to your wireless access point configuration.

1.1.3. ADSL Connection
You will be asked which device your ADSL modem is connected to, select it and
click Next .
You will then see a list of countries/ISPs. If yours is listed select it: most of the
following parameters will be automatically set. If your ISP is not listed, select the
Unlisted - edit manually option, click on Next and fill the parameters with the
settings provided by your ISP.
You have to specify the connection type. The following options are available:
• DSL over CAPI. CAPI means Common ISDN Applications Programming Interface. This communication API was mainly used for ISDN but is now also
used for ADSL.
• Dynamic Host Configuration Protocol (DHCP). This is the usual cable-modem
connection type used by ISPs for ADSL. The rest of the configuration is the
same as the one explained in Section 1.1.1, “LAN Connection” [254] (automatic
configuration option).
• Manual TCP/IP Configuration. This is rarely needed, but it is provided for
flexibility. The rest of the configuration is the same as the one explained in
Section 1.1.1, “LAN Connection” [254] (manual configuration option).
• PPP over ATM (PPPoA). A protocol which encapsulates PPP frames in an ATM
adaption layer (AAL5). A common ADSL connection type, used mainly with
USB ADSL modems.
• PPP over Ethernet (PPPoE). A protocol which encapsulates PPP frames in
Ethernet frames. The most widely used ADSL connection type. If unsure about
yours, try this one first.
• Point-to-Point Tunneling Protocol (PPTP). It is Microsoft's variation of PPP,
used by some ADSL providers. It is not considered a very secure protocol, and
it's not a RFC standard.
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Figure 18.4. Setting the ADSL Connection Parameters
All the PPP types need at least a user name and a password. Here you can also
specify the DNS servers, if needed (see Figure 18.4, “Setting the ADSL Connection
Parameters” [258]). The required packages will be installed.
Click on the Advanced button to be able to specify the VPI (Virtual Path
ID) and VCI (Virtual Circuit ID) numbers if needed.
You are then asked whether or not to bring the connection up at boot. Since ADSL
connections are of the “always up” type, you can safely select Yes. Finally you can
test the connection: we strongly recommend you to do so, to make sure all parameters are accurate.

1.1.4. Cable Connection
Some cable ISPs need you to authenticate. If this is your case, select the Use BPALogin option. If you are unsure or don't know, it is safe to select the None option.
Your NICs will be detected automatically. If you have more than one, you will
have to select the one you wish to configure. You can also manually load a driver
for your NIC.
The rest of the configuration is very similar to the one described in Section 1.1.1,
“LAN Connection” [254]. Make sure you have all needed parameters provided by
your ISP handy.
258

1.1. Set Up a New Network Interface

1.1.5. ISDN Connection
Simply make sure you select the right parameters in all steps, concerning your
area and provider.
The last step gives you the option to handle the connection status through the net
applet, this can prove useful if you only need the Internet connection from time
to time.

1.1.6. Modem Connection
A list of detected modems is shown. If no modem was detected then only the
Manual choice option is shown, click on Next and choose the communications
port the modem is connected to. The required packages will be installed.
You will then see a list of countries/ISPs. If yours is listed select it and continue
to the next step: some parameters (connection name, phone number to dial, and
authentication scheme) will be automatically set. Verify them, add the missing
ones and accept them. If yours is not listed, select the Unlisted - edit manually
option, click on Next and fill the parameters with the settings provided by your
ISP (see Figure 18.5, “Entering Dial-up Connection Parameters” [260]).
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Figure 18.5. Entering Dial-up Connection Parameters
All parameters should be obvious, except for the authentication type. The value
in the Authentication pull-down depends on what your ISP supports: Script-based
(an old type of authentication method based on “expect” and “send” types of chat
between your system and your ISP); Terminal based (a terminal window will pop
up when the connection is made and you will have to login interactively); PAP,
CHAP, or PAP/CHAP (authentication information exchange protocols, CHAP is
preferred because it is more secure, PAP/CHAP will automatically choose the
supported one).
Then come the IP, DNS and gateway settings. Nowadays, most ISPs provide them
automatically when a connection is made, so selecting the Automatic option on
them is usually a safe bet. You will then be asked whether you wish to allow users
to start the connection. The safest choice is No. Otherwise any user will be able to
take the link down, therefore disconnecting every other user.
During the next step you will be asked whether to start the connection at boot time
or not: it is probably safer and cheaper to choose No. Finally you will be asked to
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1.2. Internet Settings
test the connection: we recommend you to do so to make sure all parameters are
accurate. You can now control your Internet connection using the net applet. You
can also use the kppp remote access connection dialer (package kppp) through the
main menu: Internet + Remote Access → KPPP

1.1.7. DVB Connection
This connection type is used for satellite connections.
1.

Choose the connection card you wish to configure, and then the adapter settings.

2.

Network configuration is then similar to the LAN connection type (see Section 1.1.1, “LAN Connection” [254]).

1.2. Internet Settings

Figure 18.6. Configuring the Internet Access
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1.3. Reconfigure Interfaces

This tool allows you to specify Internet access parameters if they need
to be modified after your initial configuration. Please bear in mind that these
parameters are system-wide and apply to all interfaces.

1.3. Reconfigure Interfaces

Figure 18.7. Manage Network Connections

This tool permits you to modify network interface-specific parameters,
after you have set them up through the new interface wizard (see Section 1.1, “Set
Up a New Network Interface” [254]). Use the drop-down list at the top to select
the interface you want to configure. The tabs allow you to change parameters and
options according to the network interface type selected.
This interface can be brought up by users through the net applet to
monitor traffic.
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1.4. Monitoring Connections

Figure 18.8. Real-Time Network Connection Monitoring

This tool shows the network interfaces activity. You can specify some
options for the traffic graphic and statistics: update interval, scale, etc (see Figure 18.8, “Real-Time Network Connection Monitoring” [263]). It can also be used
to control the status of the network connection, bringing it up or down using the
button at the lower left.
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1.5. Removing a Connection

This tool simply allows you to remove a network interface. Select the
interface to be removed in the Net Device pull-down list.
You will not be asked for confirmation. Once an interface is selected for
removal, pressing the Next button deletes it immediately.

1.6. Proxy Settings

This tool allows you to define the hostnames or IP addresses of proxies
for the FTP and HTTP protocols your computer will use. Fill the fields with the
required values and click OK .
A proxy is a server which retrieves information from the Internet on your behalf,
keeping a local copy of the web pages which are most frequently requested. They
are referred to as “caching proxies”, and optimize bandwidth usage. In some organizations, you cannot access the Internet directly. You must pass through a proxy
which authenticates you before allowing you to connect to the Internet. This is
usually combined with a firewall which only guarantees the proxy direct access
to the Internet. They are referred to as “authentication proxies”. In corporate or
business environments, proxies perform both caching and authentication functions
for performance and security reasons.

1.7. Wireless Connection Management

This tool shows the wireless networks currently available allowing you
to switch between them.
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2. Internet Connection Sharing

This tool configures your system so that it acts as a gateway to the
Internet for other machines connected to it via a LAN. This is very useful at home
for example, if you wish all computers to access the Internet through the same Internet link.

Figure 18.9. A Simple Gateway Configuration
The overall procedure is the following:
1.

Configure your Internet access (Section 1, “Network and Internet Connection
Management” [253]). In order for your machine to act as a gateway, you will
need an already configured and working connection to the Internet, plus a
network connection to your LAN. This implies at least two interfaces, for example, a modem and an Ethernet card.

2.

Setup the gateway (Section 2.1, “The Gateway Connection Wizard” [266]).

3.

Configure the other local machines as clients (Section 2.2, “Configuring the
Clients” [268]).

265

2.1. The Gateway Connection Wizard
This wizard will also configure a firewall to block most connections from
the Internet. You are encouraged to check that the firewall configuration
(Section 3, “Securing your Internet Access via DrakFirewall” [323]) suits
you after completing the wizard.
After you complete this wizard, all computers on the LAN will be able to access
the Internet. Their configuration will be automated due to the DHCP server which
will be installed on your gateway, and the web access will be optimized due to the
use of the Squid transparent proxy cache.

2.1. The Gateway Connection Wizard
These are the steps that the wizard takes:
1.

Choosing the Internet Interface
You first need to specify the name of the interface connected to the Internet.
Make sure you select the correct one: use the examples in the on-line help as
a guide.

2.

Choosing The LAN Network Adapter
If you have more than one Ethernet interface, and depending on what you
chose as your Internet interface, the wizard might ask you to select the one
connected to your LAN. Make sure you select the correct one. Note that all
traffic to and from this network passing through the gateway will be masqueraded, that is: it will appear to come from the gateway instead of from the LAN.
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3.

Local Area Network Settings

Figure 18.10. Configuring The LAN
At this point, if it is the 1st time the system has been configured as a gateway,
the wizard proposes default parameters for the new local network to be
managed. Check that these values are not already in use in your network, and
go on to next step.
Otherwise, the wizard will first offer to reconfigure the LAN interface so that
it will be compatible with the gateway services. It is recommended that you
leave the default options and click on Next . Then, all the software needed
will be installed.
4.

DNS Configuration
If you plan on having a local name server on your machine, you can check
the box. Otherwise you can choose to use the name server of your provider.
If you don't know what a name server is, leaving the box checked is safe.

5.

DHCP Server Configuration
Installing a DHCP server on your machine will allow all client machines to
have their network configuration automatically done. Otherwise you will
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have to configure each of the clients by hand: IP address, network, gateway,
DNS.
6.

Proxy Caching Server (SQUID)
A caching server records the Internet pages requested by local browsers. Then
if the same page is asked for again by someone else, it'll be able to serve it
without needing to retrieve it again from the Internet, thus saving bandwidth,
and improving response time. This is very useful for many clients.
The application used to perform this task is Squid [http://www.squid-cache.
org/].

When the wizard is completed, any required packages are installed and configured.

2.2. Configuring the Clients
Configuration of the clients mainly depends on whether you chose to install a
DHCP server on your gateway or not. By configuring the clients on the local network to use DHCP, they will automatically use the Mandriva Linux machine as a
gateway to the Internet. This works for Windows®, GNU/Linux and any other OS
which supports DHCP.
If you have no DHCP server, you will have to configure each of your machines
manually, according to the network settings configured during the connection
sharing wizard.
For DHCP, on a Mandriva Linux client system, make sure you selected DHCP in
the Protocol pull-down list when configuring the network as shown in Figure 18.11,
“Configuring a Client to Use DHCP” [269].
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Figure 18.11. Configuring a Client to Use DHCP
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Chapter 19. Managing your Users, Menus
and Services
1. Customizing your Menus with MenuDrake

In order to help you manage the main menu of your preferred
graphical interface, Mandriva Linux provides you with a menu editor which ensures
menus from all desktop environments (such as KDE or GNOME) are coherent.
This tool allows system administrators to control the menus for all users (the system
menu) but can also be utilized by users to personalize their own menus. You can
launch MenuDrake from the Mandriva Linux Control Center or from the System + Configuration + Other → Menudrake menu entry.

Figure 19.1. Launching MenuDrake in System or User Mode
If started by root, MenuDrake can be used in two different modes: either changing
menus for all users, or customizing the menus for user root. You will be able to
switch from within the application thereafter, but for now, click on:
•

System menu to make changes to menus available for all system users;

•

Root menu to customize the menus for the root user only.

When you launch MenuDrake, it first scans your current menu structure and displays it. The main window (see Figure 19.2, “MenuDrake's Main Window” [272])
is divided in two parts: the menu itself on the left, and a form relative to the highlighted menu item on the right.
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1.1. Adding a New Menu Entry

Figure 19.2. MenuDrake's Main Window
You can click on the tree's [+] signs to view the content of the related sub-menus,
and on [-] to hide them.
In your tree you may see entries which do not appear in your actual
menu. These are empty directories which are not displayed but can be
used for future applications which you may wish to install.

1.1. Adding a New Menu Entry
This should seldom happen as all Mandriva Linux graphical applications should
provide a menu entry. However if you want to add a menu entry for a package
you compiled yourself, or for a console mode program, use this function. Let's
suppose you want to run the top command in a terminal window to view running
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1.1. Adding a New Menu Entry
processes and the utilization of system resources through a menu entry in the
System → Monitoring menu.
Select the System → Monitoring entry, and click on the tool bar's Add application
button. A dialog will appear asking you for the title of the menu entry and the
command associated with it.

Figure 19.3. Adding a New Menu Entry
Edit the title (you could insert “Table Of Processes”) to be shown in the menu.
Then you need to provide the action the system should execute in the Command
field: top. Click on OK and the entry will be added to the menu tree.
You can also choose an icon for your entry from the list which appears once you
click the icon button itself. The new entry is shown in Figure 19.4, “A New Menu
Entry with MenuDrake” [274]. Do not forget to check the Open in a terminal box
to have the program run in a terminal window.

273

1.2. Advanced Features

Figure 19.4. A New Menu Entry with MenuDrake
While modifying your menus, you might make a big mess out of them...
Remember that you can reload the menus as you last saved them by
pressing the Ctrl - R keys (or accessing the File → Reload user config
sub-menu). You can also revert to the default menus by accessing the
File → Reload system menu sub-menu.
Finally to activate your modifications, click on the Save button and that's it. Congratulations! You can now test your new settings by accessing the main menu.
Depending on the graphical interface you are using, the changes to your
menu may not be shown immediately. In some cases, you may need to
log out and back in again for the changes to take effect.

1.2. Advanced Features
1.2.1. Different Menu Styles
Depending on the experience the users working with your machine have, you may
want to provide them with different menu styles. Mandriva Linux provides a few
template menus which you can eventually customize. They are available through
the main window's Menu Style button.
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Figure 19.5. Choosing a Menu Style
Choose one of the available options:
• Use system administrator settings. If you started MenuDrake as a simple
user, you can choose to set your personal menu style to use the menus prepared
by the system's administrator.
• All applications. This is the traditional menu shipped with Mandriva Linux
and it contains nearly all the available applications, sorted into functional categories.
• What to do?
Specifically designed by our ergonomics team, this menu
provides a fast access to most common applications sorted by usage, such as
Play a game , Use the Internet , etc.
• Original menu. These are the plain menus as provided by the KDE or
GNOME desktops. This menu probably lacks some applications.
When you have chosen a menu style, click on OK . You will then be able to see the
corresponding menu structure in the main window, and you can then customize
it.

1.2.2. About the Environment Menu
The entry we have just added to the menu is now available in the active graphical
manager menu. It is also possible to make modifications to all graphical manager
menus by choosing Environment → All environments .
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2. Configuring Start-Up Services
All entries which only apply to the active graphical environment appear in blue
in the tree structure on the left.

1.2.3. Moving and Removing Entries
MenuDrake entries support the drag-and-drop feature. Similarly, you may have
noticed that whenever you remove an application from the menu, it appears in
the “attic”, that is the Available applications list on the bottom right corner. If you
ever wish to add them again, you simply have to drag them to the desired place
in the menu tree.

2. Configuring Start-Up Services

At boot time, the system starts a number of services (programs running
in the background to perform a variety of tasks). This tool gives the administrator
control over those services. See Chapter 37, The Start-Up Files: init sysv [493]).
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2. Configuring Start-Up Services

Figure 19.6. Choosing the Services Available at Boot Time
For each service, this is the list of items found in each column:
• Service name;
• Current Status: either running or stopped;
•

Info : click on this button to get a little explanation about that service;

• On Boot: check this box if you wish this service to be automatically brought
up at boot time1. Alternatively, if xinetd is installed and the service is a xinetd
service, the label Start when requested will be displayed. Checking the box
will then mean to activate that service in xinetd. You will also have to make
sure that the xinetd service itself is activated.

1

Generally in runlevels 3 and 5.
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3. Managing Available Fonts on your
System with DrakFont
•

Start : immediately starts the service, or restarts it (stop+start) if it is already
running;

•

Stop : immediately stops the service.

For both the Start and Stop buttons, a tool tip will show you the status of the
operation.

3. Managing Available Fonts on your System with DrakFont

This tool enables you to review the different font families, styles, and
sizes available on your system. It also allows the system administrator to install
new fonts.
The main window (see Figure 19.7, “DrakFont's Main Window” [279]) shows a
visual appearance of the currently selected font combination.
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3. Managing Available Fonts on your
System with DrakFont

Figure 19.7. DrakFont's Main Window
drakfont is made up of a number of windows which are accessible through the
buttons located at the bottom-left corner.
Options
Allows you to specify which applications and devices (such as printers) will
support the fonts. Select the ones you want support for and click on the OK
button.
Uninstall
Allows you to remove installed fonts, in order to save space for example. Use
this with great care, it could have side effects on your applications. You should
notably not remove fonts you did not install yourself.
Import
Allows you to manually add fonts found outside the Mandriva Linux distribution, on a local Windows® installation or from the Internet, for example. Supported font types are ttf, pfa, pfb, pcf, pfm, gsf. Clicking on the Add button
279

4. Setting your Machine's Date and Time
will open a standard dialog allowing you to specify the font file to import.
Once you've specified all the fonts you want to import, click on the Install
fonts button.
To select more than one font, double-click on the first font you wish to
select and it will be added to the Import Fonts window. Then doubleclick the other fonts you wish to install and the same action will occur.
When you are done click on the Close button and then on the Install
fonts button. Once the installation operation is done, make sure the new
fonts appear in the Family list.

4. Setting your Machine's Date and Time

This little tool enables you to set your system's correct internal date
and time.

Figure 19.8. Changing Date and Time
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5. Monitoring System Activity and Status
You can set the date on the left and the time on the right:
• To change the year, click on the little arrows on each side of the year; same
procedure to change the month. This updates the month view where you can
click on the current day in order to highlight it.
• We recommended that you check the time-zone settings for your geographical
location. Click on the Change Time Zone button and select the correct place
in the tree view.
Once you've chosen the time zone, a dialog will appear asking you whether
your hardware clock is set to GMT. Answer Yes if only GNU/Linux is installed
on your machine, No otherwise.
• To change the time, you can either move the hour, minute and second hands
of the analog clock, or change the numbers below it.
• If you have a permanent Internet connection and want your system to synchronize its internal clock with time servers on the Internet, put a check mark in the
Enable Network Time Protocol option and select a server in the Server pulldown list, preferably one near you. If you know the name or the IP address of
a local server you can also enter it manually in that field.
The NTP (Network Time Protocol) package needs to be installed. If
it isn't, a dialog will pop up and ask you whether you wish to install
it.
If you select the pool.ntp.org server, NTP will automatically choose
a server near to the time zone you selected.

When you're finished, click on OK to apply your settings or Cancel to close the
tool, which will discard your changes. If you want to return to your previous settings, click on Reset .

5. Monitoring System Activity and Status

This tool allows you to look for specific entries in various log files,
therefore making it easier to search for particular incidents or security threats.
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5.1. Browsing System Logs
Additionally a nifty wizard allows you to set up mail alerts to be warned
whenever the load is too high on your machine, or when a service is shut down.

5.1. Browsing System Logs

Figure 19.9. Browsing and Searching through System Logs
These are the steps to follow in order to browse or look for a specific event into
the system logs:
1.
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You must choose which specific words to match by filling the Matching (log
files contain the words) field and/or the but not matching (log files which
don't contain the words) field. At least one of the two fields must be filled.

5.2. Setting up Mail Alerts
2.

Then in the Choose file area select the file you want to perform the search on.
Simply check the corresponding box.
The Mandriva Linux Tools Log is filled by Mandriva Linux-specific
configuration tools, like those you find in the Mandriva Linux Control Center. Each time these tools modify the system configuration
they write a line in this log file.

3.

Optionally, you can restrict the search to a specific day. In that case, check the
Show only for the selected day box and choose the desired day from the calendar.

4.

When all is set up, click on the Search button. The results will appear in the
Content of the file area at the bottom.

Clicking on the Save button will open a standard dialog letting you save the search
results into a plain text (*.txt) file.

5.2. Setting up Mail Alerts
In order to facilitate server monitoring, Mandriva Linux supplies a simple tool
which sends automatic mail alerts whenever something goes wrong on your
server.
Clicking on the Mail alert button of the LogDrake main interface (see Figure 19.9,
“Browsing and Searching through System Logs” [282]) starts the wizard. First you're
asked whether you wish to configure or stop the mail alert system. Choose Configure the mail alert system entry in the pull-down list, and click Next .
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Figure 19.10. Setting up a Mail Alert: Services
The next step (see Figure 19.10, “Setting up a Mail Alert: Services” [284]) allows
you to select the services you wish to receive alerts from in case they stop working.
Simply check the service boxes which interest you, and go on to the next step.
The services listed are the ones present on your system. Here's a list of
the currently tracked ones:
• Postfix Mail Server;
• Webmin Service;
• FTP Server;
• BIND Domain Name Resolver;
• Apache World Wide Web Server;
• SSH Server;
• Samba Server;
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• Xinetd Service.

Figure 19.11. Setting up a Mail Alert: Load
Select the load you which you consider unacceptable by moving the Load slider
(see Figure 19.11, “Setting up a Mail Alert: Load” [285]). A high system load may
indicate that a process has gone out of control, or simply that there's a very high
demand on this machine. Therefore a service is suffering from it and is delayed.
As a rule of thumb, the load on your computer should not exceed 3 times the
number of processors you have on it.
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Figure 19.12. Setting up a Mail Alert: Recipient
Finally you need to tell the system to whom these alerts should be sent to (see
Figure 19.12, “Setting up a Mail Alert: Recipient” [286]). Provide an e-mail address
and the mail server (local or on the Internet) to relay the alerts to.
When the wizard is finished, an hourly check is set up to check for unavailable
services and the system's load. If needed a mail alert is sent to the alerts' recipient.

6. Access to the Console

This tool simply opens a virtual terminal console for the root user.
You can use it to issue any command, but be careful! There are no restrictions on
the actions you can take on your machine as root, and you could render your
machine unusable.
To learn how to use the command line interface, you should read Chapter 33, Introduction to the Command Line [441]. To exit the console, type exit or press Ctrl - D .
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7. Managing Users and Groups
UserDrake allows system administrators to easily add and remove users from the
system, to assign users to a group, and to manage user groups in the same manner.
In this section we will only focus on user management. Group management being similar.

7.1. The Interface
Launching UserDrake will display the main window (Figure 19.13, “The User List
in UserDrake” [287]) which lists the users currently defined on the system. You can
switch from users to groups by clicking on the Groups tab next to the Users tab.

Figure 19.13. The User List in UserDrake
All changes have immediate effect on your local user database. If the user list is
modified outside of UserDrake, you can refresh UserDrake's window by clicking
on the Refresh button.
If you make changes to an already logged in user, those changes won't
take effect until he or she logs out, and logs in again.
Available actions are:
Add User
Adds a new user to the system. We will detail this procedure in Section 7.2,
“Adding a New User” [288].
Add Group
Adds a new user group to the system.
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Edit
Allows you to change the parameters of the selected user or group. We will
detail editing user parameters in Section 7.2, “Adding a New User” [288]. In
the case of a group you will be able to assign or remove users from that group.
Delete
Removes the selected user or group from the system. A confirmation dialog
will be shown, and in the case of a user you will also be able to remove the
user's /home directory and mailbox.

7.2. Adding a New User
We created the non-privileged user Queen Pingusa at installation time, and now
we want to create a new user called Peter Pingus. Then we want to make them
both members of the fileshare group, so that they can share folders with other
users on the network (see Section 5, “Allowing Users to Share Folders” [312], custom
option).
Click on the Add User button, the dialog box to add a new user will pop up (see
Figure 19.14, “Adding a New User in the System” [289]). The only required field
is Login although we strongly recommend that you set up a password for this
new user: enter it in both the Password and Confirm Password fields. You can
also choose to add a comment in Full Name. Generally, this is the full name of the
user, but you can put whatever you want.
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Figure 19.14. Adding a New User in the System
We now have two users in our list. Select one of them with your mouse, and click
on the Edit button. The dialog box shown in Figure 19.15, “Adding Users to a
Group” [289] will pop up. It allows you to modify most available user parameters.

Figure 19.15. Adding Users to a Group
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8. Backing Up and Restoring your Files
The dialog is made of the following tabs:
User Data
Allows you to modify information provided when the user was created.
Account Info
Enables you to provide an expiration date for that account, after which the
user won't be able to connect to the system. This is useful for temporary accounts. It's also possible to temporary lock an account to prevent a user from
logging in. Finally, this tab allows you to change the icon associated with the
user.
Password Info
Allows you to provide a password expiration date, after which the user will
have to change his password.
Groups
Shows the list of available groups where you can select the groups to which
any user should belong.
For our users we just need to look for the fileshare entry and check the box associated to it. Then click on the OK button to make the changes effective.

8. Backing Up and Restoring your Files

This tool allows you to back up data present on your computer onto
different media and also to a remote machine over a network. Once the parameters
are set, you can run the backup periodically. Then, you can forget about it until
you wish to restore some files.
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8.1. A Practical Example Using the Wizard

Figure 19.16. Main Backup Wizard Window
You can access this tool by clicking on the Backups icon in Mandriva Linux Control
Center's System section. Click on the Wizard Configuration button to start the
wizard. After making your choices in each step click on Next .
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8.1.1. First Step: What to Backup

Figure 19.17. Selecting What to Backup
Select Backup System to include the /etc directory where all your current system
configuration files lie. This allows you to “transport” your system to a different
computer with little effort: only hardware-dependent configuration will have to
be revised.
The “system” backup does not include applications themselves (i.e. executable files, libraries). A priori this makes sense because it is likely that
you will have access to the system's installation media from which applications can be easily installed again on the target computer.
Select Backup Users to include all the files included in all of your users' /home
directories. Clicking on the Select user manually button lets you select individual
users and give you the following options:
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• Do not include the browser cache. Selecting this option is recommended due
to the very nature of the ever-changing browser's cache.
• Use Incremental/Differential Backups. Selecting this will preserve old backups.
Choosing Use Incremental Backups will only save files which have been
changed or added since the last backup operation. Choosing Use Differential
Backups will only save files which have been changed or added since the first
backup operation (also known as the “base” backup). This last option takes
more space than the first one, but allows you to restore the system “as it was”
at any given point in time for which a differential backup was made.

8.1.2. Second Step: Where to Store the Backup

Figure 19.18. Selecting Where to Store the Backup
All possible backup media are listed, along with a Configure button to change
media-dependent options:
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Hard Disk Drive
The local hard disk drive is used to prepare backups for all media except NFS
and direct to tape. You should not perform backups on your local hard disk
anyway, you should always backup on remote or removable media. You can
set the directory for storage and the limit of storage space. You can also set
how many days to keep incremental or differential backups in order to save
disk space.
Across the Network
To store the backup on a remote computer accessible using different methods.
You can set the connection parameters as well as the access method and its
options (if applicable). Please note that NFS backups are considered to be local
disk backups, even if they are effectively stored on a remote system.
On Tape
You can set the tape device if it's not detected automatically, and tape parameters such as writing directly on tape, whether or not to rewind, erase and eject
the tape.
Optical Media (CD-R)
This is our preferred media for the example, so click on its Configure button
to set the required parameters (see Figure 19.19, “Setting Optical Media Parameters” [295]).
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Figure 19.19. Setting Optical Media Parameters
If it isn't done automatically, use the Choose your CD/DVD device combo box to
set the CD/DVD device. Set the medium's type and size, multisession and erasing
options.
For multisession recordings, please bear in mind that the option to erase the medium is only effective for the 1st session and also that session-related information
recording takes some space out (20 to 30 MB) for each session, so the “real data”
storage space will actually be less than the medium's size.
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8.1.3. Third Step: Review and Store the Configuration

Figure 19.20. Review Configuration Parameters
The last wizard step shows a summary of the configuration parameters. Use the
Previous button to change any parameter you are not satisfied with. Click on Save
to store them. The backup set is now ready to be performed.
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8.1.4. Performing the Backup

Figure 19.21. Backup Progress Dialog
Click on Backup Now , make sure the corresponding media is ready (the recordable
CDs in our example), and then on Backup Now from configuration file to perform
the backup.
If the backup set size exceeds the medium's available capacity, the backup
operation might just fail. This is a known issue and it's being worked on.
As a work-around, please try to remove files from the backup set so its
size never exceeds the medium's available capacity.
A dialog (see Figure 19.21, “Backup Progress Dialog” [297]) will display the current
progress of the operation. Please be patient: the time it takes to back up depends
on many factors such as the size of the backup file set, the speed of the storage
option selected, and so on. Once the operation is finished a report is shown: look
for possible errors on it and take corrective measures if needed.
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8.2. Restoring Backups

Figure 19.22. Choosing the Restore Type to Perform
Make sure the media you want to restore the backup from is accessible and ready
and click on the Restore button. In our example we restore the whole backup so
on the restore dialog (Figure 19.22, “Choosing the Restore Type to Perform” [298])
click on Restore all backups and then on the Restore button to start the restoration
process.
Existing files in the target restoration directory (same location where the
backup was made from, by default) will be overwritten.
Feel free to investigate the other restore options if you want to restore part of a
backup instead of the full file set.
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8.3. Automating Periodic Backups
In the tool's main window, click on Advanced Configuration and then on the
When button. In the backup scheduling window (see Figure 19.23, “Daemon
Options Window” [299]) select Use daemon to define the schedule.

Figure 19.23. Daemon Options Window
You are then asked to specify the interval (or period) between each backup operation and the storage media. In our example we set up a customized calendar
(custom period selected) to perform a backup every Friday at a quarter to midnight
and store it on CD. You can also specify hourly (i.e.: performed 1 minute after the
hour), daily (i.e.: performed at 4:02AM), weekly (performed at 4:22AM) and
monthly (performed at 4:42AM) periods instead of custom.

8.4. Advanced Backup Wizard Configuration
Click on Advanced Configuration and then on the More Options button to set
more backup options (see Figure 19.24, “Miscellaneous Options Window” [300]).
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8.4. Advanced Backup Wizard Configuration

Figure 19.24. Miscellaneous Options Window
Use the Please choose the compression type pull down list to select the compression
used for your backups among tar (no compression), tar.gz (gzip compression)
and tar.bz2 (bzip2 compression: better but slower).
Select the Use .backupignore files option to have certain files excluded from the
backup. The .backupignore file should be present in every directory of the backup
file set where files are to be excluded. Its syntax is very easy: a one-file-per-line list
of the names of the files to exclude.
You can use the star (* = “matches any string”) and the question mark
(? = “matches one and only one character, regardless of what that character is”) in the .backupignore file to exclude sets of files. For example,
somename* matches all files whose names start with somename, and image00?.jpg matches files named image001.jpg, image009.jpg, image00a.jpg, image00h.jpg, etc.
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8.4. Advanced Backup Wizard Configuration
Select the Send mail report after each backup to option and fill the e-mail address
so the tool knows to whom to mail the backup operation report. Please bear in
mind that the system needs to have a working MTA (Mail Transport Agent) for
this option to be effective.
If you want to send the report to more than one recipient, you will have
to set up a mailing list, containing all those addresses, and fill the field
with the mailing list's post address.
Select the Delete Hard Drive tar files after backup to other media option to free
that space after performing the backup.

301

302

Chapter 20. Mount Points and Remote
Directories
1. Managing your Hard Drive Partitions with DiskDrake

Partitions are initially set up during the installation process. DiskDrake
allows you, to some extent, to resize your partitions, move them, etc. DiskDrake
can also deal with RAID devices and supports LVM but we will not discuss these
advanced uses here. Please refer to the Reference Manual to learn more about what
partitions are used for.
DiskDrake is very powerful and can therefore be a dangerous tool. Misuse
of it can very easily lead to data loss on your hard drive. Because of this
potential loss of data, you are strongly advised to take some protective
measures before using DiskDrake:
1.

Back up your data. Transfer it to another computer, ZIP disks, etc.

2.

Save your current partition table (the table describing the partitions
held on your hard drive(s)) to a floppy disk (see Section 1.2, “DiskDrake's action buttons” [305]).
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1.1. The Interface

Figure 20.1. DiskDrake's Main Window
DiskDrake enables you to configure each physical hard drive on your machine. If
you only have one IDE disk, you will see a single tab called hda below the filesystem types. If there is more than one drive, then each drive will have its own tab
and will be named according to the Linux name for that drive. DiskDrake will allow
you to manage the partitioning of each drive.
The window (see Figure 20.1, “DiskDrake's Main Window” [304]) is divided into
four zones:
• Top. The structure of your hard drive. When you launch DiskDrake it will
display the current structure of the drive. DiskDrake will update the display
as you make changes.
• Left. A menu relevant to the partition currently selected in the above diagram.
• Right. A description of the selected partition.
• Bottom. Buttons for making general actions. See next section.
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1.2. DiskDrake's action buttons
We will now review the actions available through the buttons at the bottom of the
window, and then describe a practical use case.

1.2. DiskDrake's action buttons
Clear all
Clicking on this button will clear all partitions on the current hard drive.
More
Displays a three button dialog allowing you to:
Save partition table . Allows you to save the current partition table to a file
on a disk (a floppy, for example). This may prove useful if a problem arises
(such as an error made during drive repartitioning).
Restore partition table . Allows you to restore the partition table as previously saved with Save partition table . Restoring a partition table may recover
your data as long as you do not reformat partitions, because the formatting
process will overwrite all your data.
Rescue partition table . If you lose your partition table and have no backup,
this function scans your hard drive to try and reconstruct the partition table.
Help
Display this documentation in a browser window.
Undo
Cancels last action. Most modifications done on your partitions are not made
permanent until DiskDrake warns you it will write the partition table. This
button therefore allows you to undo all of your modifications on partitions up
to last write.
Toggle to expert mode
This button allows you to access the expert mode functions (which are even
more dangerous if you are not sure what you are doing). Reserved for experts.
Done
Saves your changes and exits DiskDrake.

1.3. Resizing an Old Partition and Creating a New One
In this section, we are going to do a little exercise to demonstrate one of the more
useful features of DiskDrake. Let us imagine that you decide to use your machine
as an FTP server and you want to create a separate /var/ftp partition in order to
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1.3. Resizing an Old Partition and Creating a New One
host the FTP files. Note that doing this step-by-step tutorial will actually modify the
structure of your hard drive.
This is what the current /home partition looks like (see Figure 20.2, “The /home
Partition Before Resizing” [306]), before any modification. We are going to shrink
this partition in order to create free space for the new file system.
In order to perform the steps in this example, all users of your system
must be logged out, except root.
First of all, you need to unmount the /home partition by clicking on it and then
pressing the Unmount button.

Figure 20.2. The /home Partition Before Resizing
The next step, as you may have guessed, is to click on the Resize button. A dialog
will appear (see Figure 20.3, “Choosing a New Size” [307]) which will allow you
to choose the new size for the /home partition. Move the slider to reflect the new
size, then click on OK .
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1.3. Resizing an Old Partition and Creating a New One

Figure 20.3. Choosing a New Size
When this is done, you will notice that the graphic representation of your hard
drive has changed. The /home partition is smaller, and an empty space appears on
the right. Click on the empty space and then on the Create button which appears.
A dialog (see Figure 20.4, “Defining the New Partition” [307]) will let you choose
the parameters for the new partition. Set the size, choose the file system you want
to use (usually Journalized FS: ext3) and then enter the mount point for the
partition, which in our example will be /var/ftp.

Figure 20.4. Defining the New Partition
Figure 20.5, “The New Partition Table” [308] shows what our projected partition
table now looks like.
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2. Managing Removable Devices

Figure 20.5. The New Partition Table
The last step is to format (prepare to host files) the newly created partition. To
format the partition, click on its representation in the partitions picture, then on
the Format button. Confirm the writing of the partition table to disk, the formatting
of the partition and the update to the /etc/fstab file. You may be asked to reboot
the computer to make changes effective.

Figure 20.6. Confirming the Writing of the Partition Table

2. Managing Removable Devices

These tools enables system administrators to easily control most options which affect the behavior of removable devices such as floppy, CD and DVD
disks. Note that, by default, all removable devices are automatically made available
so users shouldn't have to manually mount media.
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2. Managing Removable Devices

Figure 20.7. Changing a Parameter
For each device the following properties may be changed:
• Mount point. The directory where the device's files will be accessible from.
You can either choose an entry in the list or type in your own path. If the directory does not exist, it will be automatically created.
• Options. Controls various device options, notably whether it is mounted
automatically (supermount) or not. Note that if the supermount option is selected, the two others (user and noauto) must not be selected.
• Type. Displays a list of file-system types. If you have a specific medium with
an uncommon file system on it, this is where you can tell Linux how to access
it.
Select the property you wish to change and click on OK . The corresponding dialog
will pop up in which you can change your settings. Then click on OK again. The
system will then ask you if you want to save the modifications in the /etc/fstab
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3. Importing Remote SMB Directories
file. By saying yes, you will not have to unmount and re-mount that device: it will
be done automatically

3. Importing Remote SMB Directories

This tool allows the system administrator to import remote shared
directories based on the SMB protocol (used mainly by Windows®) on the local
machine.
While users can individually access remote shares through their file managers, it
may be required in some cases to import a specific share for it to become immediately available for all users. We'll go through an example showing you how to
import a template directory from a Windows® machine.

Figure 20.8. Scanning the Whole Network
Clicking on the Search servers button scans the local network for machines which
currently share directories (including the local one). In our example, many servers
are available. We'll choose skywalker and we'll make it available locally for all
users.
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3. Importing Remote SMB Directories
Clicking on a machine's name will try to connect to it and browse for available
shares. If that machine has password-protected shares, a dialog will pop up asking
you to identify yourself.

Figure 20.9. Authenticating on a Remote Samba Server
Enter the correct Username, Password and Domain. The available shares on that
machine will then appear. Click on the little arrow on the left of the server icon to
show available shares.
If the machine you're connecting to has both public and password-protected shares, then canceling the password entry dialog will connect you
to that machine, but only to its public shares.

Figure 20.10. Choosing the Remote Directory to Import
Once a share is selected, a Mount point button appears. Clicking on it displays a
dialog where you can type the local directory name where remote files will be accessible.
Once this is done, two more buttons appear:
•

Mount . Makes the resource available locally. When this is done, users simply
have to point their file manager to the directory selected as the mount point to
get the files hosted by the server.

•

Options . Allows you to set a user name and password to access that SMB
mount point. Other permissions and advanced settings can also be set through
this button.
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4. Importing Remote NFS Directories

Also, the little icon in front of the shared directory

becomes

When you're finished configuring the access points for remote directories, click
on Done . A dialog box will appear asking you whether you wish to save your
modifications to the /etc/fstab file (where mount point information is usually
stored), or not. Click on Yes to make the shares configuration persistent between
sessions. Click on No to exit without saving your changes.

4. Importing Remote NFS Directories

This tool is exactly the same as the one mentioned in Section 3, “Importing Remote SMB Directories” [310], except that it controls file sharing through
the NFS protocol rather than SMB. Therefore it allows you to locally import shared
files from NFS-friendly machines. The interface is the same as the one described
in Importing Remote SMB Directories, and the effects are similar. Only the corresponding machines are different: UNIX® for NFS and Windows® for SMB.
Another difference is that there is no need to provide a password to access NFS
shares. The authentication mechanism is host-based.

5. Allowing Users to Share Folders

This tool enables you to share files with other users of your computer
network. File sharing can be done on heterogeneous systems such as GNU/Linux
and Windows®.
The file-sharing configuration is done in two simple steps: determining who can
export folders, and then which protocol to use. A 3rd step is necessary if you select
the Custom export option.
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5. Allowing Users to Share Folders

Figure 20.11. Controlling Exports
First of all, you must determine who will be able to share folders. Here are the
different available options:
• No sharing.

Prevents users from sharing data with others.

• Allow all users.

All users are allowed to share data with others.

• Custom. By choosing this option, only users within the same fileshare
group will be allowed to share data. If you choose this option, the fileshare
group will be created and, as a 3rd step, you will be prompted to run UserDrake
in order to add the allowed users to this group (see Section 7, “Managing Users
and Groups” [287]).
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Figure 20.12. Choosing the Export Protocol
Then you must choose which protocol to use for file sharing. Check one or both
of the following:
• SMB.

If you want your users to share files using Windows® systems.

• NFS. If you want your users to share files using UNIX® systems (such as
GNU/Linux).
Once you have checked the appropriate boxes, click on OK . The required packages
will be installed, if needed. If you uncheck a previously checked box, the corresponding service will be stopped.
Once users are allowed to share data, they can select the folders to be shared
through their preferred file manager (see Section 1.5, “File Sharing” [132]).

6. Setting up WebDAV Mount Points
WebDAV (Web-based Distributed Authoring and Versioning) is an extension to the HTTP protocol which allows you to create, move, copy, and delete resources on a remote web server. In practice, mounting a remote WebDAV repository
on your local machine will allow users to modify a remote web server's files as if
those files were local to the system.
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6. Setting up WebDAV Mount Points
Browse the WebDAV Resources [http://www.webdav.org/] pages to
learn more about this protocol.

Figure 20.13. Managing WebDAV Mounts Points
The first time you launch this tool the required packages will be installed if needed,
and only two buttons will be available. New , which allows you to define a new
mount point, the other one just Quit s the application. After you have defined
mount points, they will appear as new buttons at the top of the buttons list.
Clicking on a mount point button will take you to the mount point menu (see
Figure 20.14, “WebDAV Menu” [316]).
When you click on the New button you are asked for the URL of the web server.
Enter the complete URL of the web server, beginning with http:// or https://,
then click OK .
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6. Setting up WebDAV Mount Points

Figure 20.14. WebDAV Menu
You must now decide where the web server files will be accessible from. Select
the Mount point option and click OK . There you will be able to choose a local
directory or type in your own. If the selected mount point does not exist, it will be
created.
If the server requires authentication, do not forget to fill the username and password fields in the Options dialog. Then all you need to do is to actually mount
the remote repository by selecting Mount and clicking OK .
You will now be able to browse and modify files on the local mount point you
have defined and the changes will be immediately available on the web server.
To make your settings are persistent between sessions, remember to save modifications to the /etc/fstab file, as suggested when you quit the wizard.
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Chapter 21. Securing your System
1. Securing your Machine through DrakSec

draksec is a graphical interface to msec (which stands for Mandriva
Linux Security Tool). It allows you to change your system's security level and to
configure every option of msec's security features.
msec has two aspects: system behavior configuration and periodic checks of system
state. Each security level modifies the system configuration, making it more and
more secure, and verifying more and more security related aspects.

1.1. Setting your Security Level
This tool is only displayed in expert mode. Choose Options → Expert
mode from the menu and then access the Security section of Mandriva
Linux Control Center.
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1.1. Setting your Security Level

Figure 21.1. Choosing the Security Level of your System
Simply choose the security level you want from the Security Level pull-down list:
it will be effective as soon as you click on OK . Please read the help text regarding
security levels very carefully so that you know what setting a specific security level
implies.
If you wish to check which options are activated for each security level,
review the other tabs: Network Options, System Options and Periodic
Checks. Click on the Help button to display information about the options and their default values. If some of the default options don't suit
your needs, simply redefine them. See Section 1.2, “Customizing a Security Level” [319], for details.
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1.2. Customizing a Security Level
Put a check mark on the Security Alerts box to send by mail possible security issues
found by msec to the local user name or to the e-mail address defined in the Security
Administrator field.
We highly recommend you activate the security alerts option so that the
administrator is immediately informed of possible security issues. Otherwise the administrator will have to regularly check the relevant system
log files.

1.2. Customizing a Security Level
Clicking on each of the Options tabs (and the Periodic Checks one) lead you to
msec's list of security options. This allows you to define your own security level
based on the security level previously chosen.

Figure 21.2. Modifying Standard Options
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2. Controlling File Permissions with
DrakPerm
For each tab, there are two columns:
1.

Options List.

2.

Value.
menu:

All available options are listed.

For each option1 you can choose from the corresponding pull-down

• Yes.

Activate this option no matter what the default value is.

• No.

Deactivate this option no matter what the default value is.

• Default.
• Ignore.

Keep the default security level behavior.
Use this option if you don't wish this test to be performed.

• ALL, LOCAL, NONE. The meaning of these are option-dependent.
Please see the Help text available through the Help button for more information.
Clicking on OK accepts the current security level with custom options, applies it
to the system and exits the application.

2. Controlling File Permissions with DrakPerm
In Section 1, “Securing your Machine through DrakSec” [317], you saw how to
change your system's security level and customize the security checks associated
to those levels.

drakperm allows you to customize the permissions which should be
associated with each file and directory in your system: configuration files, personal
files, applications, etc. If the owners and permissions listed here don't match the
actual permissions of the system's files, then msec (which stands for Mandriva
Linux Security Tool) will change them during its hourly checks. These modifications
can help prevent possible security holes or intrusions.

1

The default security level setting is shown in the Help window.
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2. Controlling File Permissions with
DrakPerm
This tool is accessible only in expert mode. Choose Options → Expert
mode from the menu and then access the Security section of Mandriva
Linux Control Center.

Figure 21.3. Configuring File-Permission Checks
The list of files and directories which appears depends on the current system's security level as set by msec, along with their expected permissions for that security
level. For each entry (Path) exists a corresponding owner (User), owner group
(Group) and Permissions. In the drop-down menu, you can choose to display only
msec rules (System settings), your own user-defined rules (Custom settings) or
both as in the example shown in Figure 21.3, “Configuring File-Permission
Checks” [321].
You cannot edit system rules, as stated by the “Do not enter” sign on the
left. However you can override them by adding custom rules.
If you wish to add your own rules for specific files or modify the default behavior,
display the Custom settings list and click on the Add a rule button.
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2. Controlling File Permissions with
DrakPerm

Figure 21.4. Adding a File-Permissions Rule
Let's imagine your current security level is set to 3 (high). This means that only
the owners of the home directories can browse them. If you wish to share the
content of Queen's home directory with other users, you need to modify the permissions of the /home/queen/ directory.
msec only changes file permissions that are more permissive than the
one required by a certain security level. That means that for the change
above, the permissions must be changed by hand.
You can do this in Konqueror by modifying the permission properties
of your home directory, and checking the Apply changes to all sub-folders
and their contents option.
If you create more rules, you can change their priorities by moving them up and
down the rules list: use the Up and Down buttons on your custom rules to have
more control over your system's permissions.
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3. Securing your Internet Access via
DrakFirewall

3. Securing your Internet Access via DrakFirewall

This little tool allows you to set up a basic firewall on your machine.
It filters connection attempts made from the outside, and blocks unauthorized
ones. It's a good idea to run it just after installing your machine and before connecting to the Internet, therefore minimizing the risks of your machine being cracked.

Figure 21.5. The DrakFirewall Window
If checked, uncheck the Everything (no firewall) box, and then check the boxes
corresponding to the services you wish to make available to the outside world. If
you wish to authorize a service which isn't listed here, click on Advanced to
manually enter the port numbers to open.
The Advanced button opens an Other ports field where you can enter
any port to be opened to the outside world. Examples of port specifications are presented just above the input field: use them as a guide. It's
possible to specify port ranges by using the : syntax such as
24300:24350/udp.
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3. Securing your Internet Access via
DrakFirewall
Not checking a service in this list won't disallow you from connecting to it. It will
only prevent people from the Internet to connect to that service on your machine.
If you don't plan on hosting any service on your machine (common case for a
desktop machine) just leave all boxes unchecked.
On the other hand if you wish to disable the firewall and leave all services accessible
from the outside, check Everything (no firewall), but please bear in mind that this
is very insecure, and therefore not recommended.
Then clicking on OK will bring you to the next step, which consists of selecting
the network interface connected to the Internet.

Figure 21.6. The Internet Interface
Refer to the examples to determine the name of your interface to the Internet. If
you're unsure, you can check the system network configuration (see Section 1.3,
“Reconfigure Interfaces” [262]). You can finally click OK to install the required
packages, activate the firewall and enjoy your secure Internet connection.
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Chapter 22. Boot Options and Creating
Booting Devices
1. Configuring the Login Mode

This tool allows a user to be automatically logged into the system at
boot time, without a password being required.

Figure 22.1. Choosing the Login Mode
There are a few parameters:
1.

Graphical interface: if you wish to have the X Window System (graphical
display) started at boot time, check the Launch the graphical environment
when your system starts box. If you leave it unchecked, the text login will be
displayed and you will need to start the graphical environment manually.
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2. Changing your Boot-up Configuration
2.

Autologin: if you're the only person using your machine and nobody else has
access to it, you may choose to be automatically logged in at boot time. To do
so, select the Yes, I want to autologin with this (user, desktop) option. Then
choose the user you want to be logged on automatically in the Default user,
as well as the preferred Default desktop in the pull-down menus.

2. Changing your Boot-up Configuration

This tool allows you to configure the bootloader and the boot menu
entries.
Unless you're an expert, it's not recommended that you change these
settings as this may prevent you from booting your machine the next
time you try to power it on.

Figure 22.2. Choosing the Boot Mode
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2.1. Configuring the Bootloader

2.1. Configuring the Bootloader
You can choose between the GRUB and the LILO bootloader. Either one will allow
you to boot Mandriva Linux, it's just a question of taste.
Unless you know what you're doing, you shouldn't change the default Boot device
shown, since that's where the bootloader installs itself. If more than one OS is installed on your machine, it's a good idea to leave at least 5 seconds so that you can
easily select a different menu item than the default image.
The dialog finally shows a few options which can be useful depending on your
specific hardware.
Enable ACPI
Enable this option to allow better power management support if your hardware
is ACPI compatible. ACPI is often needed for new laptops which no longer
support APM.
Force No APIC
The IO-APIC [http://www.wlug.org.nz/APIC] is only really useful for multiprocessor systems. It may cause problems on single processor systems and
should be deactivated in that case by checking this box.
Force No Local APIC
The Local APIC can be used by Linux to program interruptions to wake up
threads. On multi-processor machines it can be used to send interrupts to another processor.
These relatively new APIC features are known to cause problems on some computers because of badly designed chip sets or poor support in Linux kernel drivers.
These problems can cause system freezes or incorrect device detection. So you may
need to deactivate them by checking the corresponding box.
Click on Advanced to be able wipe the contents of the /tmp directory (which might
hold some files you download from the Internet, for instance) and to tell Linux
how much RAM your machine uses should this prove to be an issue at boot time.

2.2. Managing Boot Entries
After clicking Next , the list of available entries at boot time is displayed; the default
one is marked by a star (*).
It's also possible to make an entry the default one by checking the Default checkbox in the Modify dialog.
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3. Customizing your Boot Theme

3. Customizing your Boot Theme

The Boot Theme utility enables you to change the default theme displayed at boot time, as well as a few other options.
• Choose one of the available boot modes in the pull-down menu (Figure 22.3,
“DrakBoot Theme Window” [328]).
• Uncheck the Display theme under console option if you want a clean, “traditional” console. This relates to those accessible through the Ctrl - Alt - Fn keys.

Figure 22.3. DrakBoot Theme Window
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3. Customizing your Boot Theme
The boot theme setting will have no effect if your system isn't set to boot using the
graphical mode. Please refer to Section 2, “Changing your Boot-up Configuration” [326], for more information on setting the boot mode.
If you only have one theme available, you may install the bootsplash-themes
package which you will find in contribs. Other themes are also available on the
web.
The Create new theme button allows you to fully customize an existing boot theme
or create a new boot theme from scratch. Adjust the parameters to your liking and
save it. It will then be accessible in the available Themes list.
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Chapter 23. Mandriva Online Services
Mandriva's convenient update service warns you about bug or security fixes specifically available for your machines. This service can also be configured to automatically install package updates so you don't have to run it manually.
The system is comprised of the following items:
Initial Configuration Wizard (see Section 1, “Initial Configuration” [331])
Enables you to register a new machine.
Web Management Interface (see Section 2, “The Web Management Interface” [334])
Allows you to manage all the hosts you maintain and to activate hosts so they
are taken into account for updates.
Applet (see Section 3, “Mandriva Online Applet” [337])
Informs you on the status of your updates, and allows you to launch the installation of updates when needed.
Take a look at the Mandriva Online FAQ [https://online.mandriva.com/page.
php?page=info] page to get further information about the Mandriva Online service.

1. Initial Configuration
The Mandriva Online wizard shows up when you boot your machine for the first
time. It allows you to create a new account or to register an existing one. To
manually launch the wizard from your user account, right-click on the Mandriva
Online applet icon on the panel and choose Configure Now! . You must provide
root's password.
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1. Initial Configuration

Figure 23.1. Existing or New Mandriva Online Account?
After clicking on Next , select the appropriate option (I already have an account
or I want to subscribe) and click Next .
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1. Initial Configuration

Figure 23.2. Authentication on Mandriva Online
Enter your login information and provide a name to identify your machine. This
is useful if you manage several computers with Mandriva Online.
The next step explains what information is collected on your computer. This information is required for the service to work correctly.
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2. The Web Management Interface

Figure 23.3. Uploading Your Configuration
Finally, choose your country so that automatic updates occur from the nearest
possible server. If your country is not listed, select the nearest one. Click on Next
and Finish to exit the wizard.
To complete your setup, you must activate this machine in your Mandriva
Online account.

2. The Web Management Interface
Access the Mandriva Online web administration interface [https://online.mandriva.
com/page.php?page=info] by right-clicking on the Mandriva Online applet on
the panel to activate your Mandriva Online account. Choose Online WebSite and
once you're on the website, provide your Mandriva Online email address and
password.
Please check out your personal space [https://my.mandriva.com] on the
My Mandriva Web site.
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2.1. Subscribing New Machines

Figure 23.4. Mandriva Online Hosts List

2.2. Host Management
Once you activate a host you can access its management interface by clicking on
the details icon.

Figure 23.5. Up-To-Date Mandriva Online Host
The available actions differ slightly according to whether your machine's packages
are up-to-date or not, but basically here are the actions you can perform:
Control email alerts
Change the mail-sending status to yes (by clicking on the link) to receive an
email when updates are available.
Control automatic scheduled updates
Change the auto-update status to yes (by clicking on the link) to have updates
for your machine automatically installed by the applet (see Section 3, “Mandriva
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2.3. Scheduling Updates
Online Applet” [337]) which regularly connects to the Internet to check for such
updates.
Check current packages
Click on the See link by the Installed packages or Errata(s) label.

2.3. Scheduling Updates
You can update your machine manually from the applet (see Section 3, “Mandriva
Online Applet” [337]); from the Web interface, you can check which updates are
available and choose which ones to install.

Figure 23.6. Outdated Mandriva Online Host
You must now select the packages to be updated. You can either schedule all
packages to be updated , or choose them one by one by clicking on the See link in
the Outdated packages field.
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3. Mandriva Online Applet

Figure 23.7. Select Packages to be Updated
Click on the advisory link (of the MDKA-year:number or MDKSA-year:number forms)
to obtain details about that update. Check the box for each package you want to
be updated on your machine. When this is done, click on Schedule Packages .
Once updates are selected, they are automatically installed next time the applet
connects to the Mandriva Online server, which occurs several times a day.

3. Mandriva Online Applet
The applet resides on your desktop panel. It informs you about update availability
and allows you to perform basic system maintenance tasks.
The applet icon can be in one of many states, depending on your machine's status:
The system is up-to-date. All is fine.
A standard program update is available for your installed packages.
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3. Mandriva Online Applet
A bugfix update is available for your installed packages.
A security update is available for your installed packages. It is highly recommended that you install security updates.
The applet is currently contacting the server, be patient.
This host isn't currently activated. Activate it using the Web interface (see
Section 2.1, “Subscribing New Machines” [335]).
The applet cannot connect to the server. Check your Internet connection.
The system is currently not configured or a configuration error was found.
Launch the configuration wizard (see Section 1, “Initial Configuration” [331])
to use Mandriva Online.
Click on the applet icon to open a dialog with action buttons, followed by the
current machine's status.

Figure 23.8. Mandriva Online Applet
Install updates
Manually launch the updates installer by opening Rpmdrake (see Section 3,
“Mandriva Linux Update” [214]).
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3. Mandriva Online Applet
Configure
Launch the wizard (see Section 1, “Initial Configuration” [331]). This can be
useful to resend your machine configuration to the server, for example if you
have upgraded your hardware.
Check updates
Manually connects to the server to check if updates are available. This is done
periodically by the applet, but if you have no permanent connection to the
Internet, it may be useful to manually check for updates when you are online.

339

340

Chapter 24. Controlling a Remote Machine
Being able to remotely control another machine offers many possibilities, from
remote technical assistance to teaching how an application works. In this chapter
we describe the configuration and usage of Rfbdrake, a tool to easily set up a virtual network computing environment under Mandriva Linux.

1. Concepts
Here are a few concepts:
Virtual Network Computing (VNC)
An environment which allows you to interact with a remote computer “as if
you were sitting in front of that computer”. The computers don't have to be
of the same type, nor do they have to be running the same OS: they only need
a working TCP/IP network connection.
Controlled Computer
This is the computer to be controlled without the need, or the possibility, to
be actually sitting at its console. It is remote from your location. Also called
the “server”.
Controlling Computer
This is the computer in front of which you're sitting, from where you interact
with the controlled (remote) computer. Also called the “viewer”.

2. Installation and Setup

Make sure the rfbdrake package is installed and then access Rfbdrake
through the Mandriva Linux Control Center: an Online Administration section is
accessible from which you can start the Remote Control of another machine
(Linux/Unix, Windows) utility1.

2.1. Controlled Computer Setup
In this section, we assume you can access Rfbdrake. If this is not the case (typically
remote administration tasks), then you need to:
1

You can also launch Rfbdrake by choosing Internet + Remote access → Virtual Network Connection
in the main menu.
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2.1. Controlled Computer Setup
1.

Make sure the tightvnc-server package is installed on the remote machine.

2.

Connect to the remote machine using ssh.

3.

If it's not already running, start the VNC server by executing vncserver in a
console. If this is the first time vncserver is run on the system with that user
account, then you have to enter the password clients will have to use to connect
and confirm it. The system informs you which display number clients have
to use. Run vncserver -kill :DISPLAY_NUMBER when you no longer need
the VNC server.

Then connect as a client to control the remote machine (see Section 2.2, “Controlling
Computer Setup” [343]).
For the machine that will act as the controlled (server) computer, select the Allow
control of my machine (linux server) option. Fill the Set Password field. This is
mandatory or Rfbdrake will complain. Please bear in mind that this password is
not related to the user's local/remote account password in any way.

Figure 24.1. Server Options
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2.2. Controlling Computer Setup

Once you click on the Launch server this icon indicates that the computer is
ready to accept incoming VNC connections. Closing it will stop the VNC server.
Right-click on it to access a pop-up menu with some options.
If the system to be controlled is behind a firewall, then you have to make
sure that port tcp/5900+N is opened in the firewall, where N is the VNC
server display number.

2.2. Controlling Computer Setup
On the machine which will act as the controller (viewer) computer, select the Want
to take control (linux client) option. Fill the Remote server Address pull-down list
with the IP address or hostname of the computer to be controlled. Fill the Display
Number field with the remote computer's display number, or leave it empty to
use the default (display number :0).

Figure 24.2. Viewer Options
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3. Connecting to a Windows® Terminal
Server
To access the VNC server, enter its related password in the Enter Password field.
Put a mark in the FullScreen check-box to have the remote computer's desktop
use all of the controller computer's screen. Otherwise the remote desktop will be
displayed in a window. Once you are satisfied with your settings, click on the
Connection button to access the remote computer.
®

3. Connecting to a Windows Terminal Server

Figure 24.3. Windows Terminal Services Options
Select the Windows Terminal Services option to connect to Terminal Services on
a Windows® machine. Fill the Windows Hostname pull-down list with the hostname of the Windows® machine or its IP address. Select a desktop size in the Screen
Size pull-down list and a language for the keyboard in the Keyboard Language
pull-down list. Click on the Connection button once you're satisfied with your
settings.
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4. Remote Control in Action

4. Remote Control in Action
Once you connect to the remote computer you see its desktop and you are able to
perform any action as if you were sitting in front of it.

Figure 24.4. Controlling a Remote Computer
The mouse cursor becomes a round point and the remote computer's
arrow-cursor will “follow” it. This can prove useful to keep track of where
the cursor is at any given time.
The limiting factor of the response time of the remote computer is the speed of the
link to it. For LAN connections (typically 100 Mbps), you will feel that you're really
in front of the remote computer. For Internet connections (typically between 56 Kbps
and 1-2 Mbps), don't expect “instantaneous” response from the controlled computer.
Once you've finished using the remote computer, you can disconnect from it by
closing the VNC viewer window. If you're using the full-screen mode, press the
F8 key and select the Quit viewer option from the menu which pops up.
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5. More Documentation

5. More Documentation
This short introduction to VNC has hopefully shown you some of the possibilities
of remotely controlling computers. The options are endless, please refer to the
TightVNC Documentation [http://www.tightvnc.com/docs.html] and to the VNC
Documentation [http://www.realvnc.com/documentation.html] web sites.
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Chapter 25. Synchronizing Directories
Between your Machines
This chapter introduces theory about the synchronization of directories and presents
practical examples using DrakSync, Mandriva Linux's graphical synchronization
tool.

1. Synchronization Types
1.1. As Local

Figure 25.1. As Local without Deleting Files
After the synchronization is done, the remote system will have the files it had before
plus all the files that the local system had and the remote system had not. All files
already existing on both systems which have been updated on the local system
will also be updated on the remote system (see Figure 25.1, “As Local without
Deleting Files” [347]). If the delete files option is used, then files already existing
on the remote system but not on the local system will be deleted from the remote
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1.1. As Local
system (see Figure 25.2, “As Local, Deleting Files” [348]): actually, it mirrors the
local system on the remote one.

Figure 25.2. As Local, Deleting Files
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1.2. As Remote

1.2. As Remote

Figure 25.3. As Remote without Deleting Files
After the synchronization process is completed, the local system will possess the
files it had before plus all the files which the remote system had and the local system
did not have. All files already existing on both systems which have been updated
on the remote system will also be updated on the locally modified system (see
Figure 25.3, “As Remote without Deleting Files” [349]). If the delete files option is
used, then files already existing on the local system but not on the remote one will
be deleted from the local system (see Figure 25.4, “As Remote, Deleting Files” [350]):
this mirrors the remote system on the local one.
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1.2. As Remote

Figure 25.4. As Remote, Deleting Files
For all synchronization types above, if a file is modified in the target
system, it will be replaced by the one on source system.
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1.3. As Both Local and Remote

1.3. As Both Local and Remote

Figure 25.5. As Both Local and Remote
After the synchronization process is done, both systems will contain the same files
(see Figure 25.5, “As Both Local and Remote” [351]).
If a file is modified on both systems, the remote file will be replaced by
the local system one.

2. DrakSync: Mandriva Linux's Graphical Sync Tool
You can install DrakSync by issuing urpmi draksync, as root, in a terminal window
or by using Rpmdrake.
Choose System + Archiving → DrakSync from the main menu to start DrakSync.
The first time DrakSync is launched no connections are set up and only the Add
Group button is enabled.
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2.1. DrakSync's Interface

2.1. DrakSync's Interface

Figure 25.6. DrakSync with some Connections Set up
Tool Bar. The bar containing buttons to perform the most common actions.
Please refer to Table 25.1, “DrakSync's Toolbar Buttons” [353].
Group Tabs. Every connection group defined has its own tab. Select the one
corresponding to the connection group you want to work with.
Connections List. Where all connections for the currently selected group tab
are listed. A little green arrow indicates the synchronization direction.
The following table shows the most important DrakSync interface buttons and
briefly explains the functions they provide.
Not all buttons may be enabled at all times. For example, the “Sync
Connection” button will be enabled only if a connection is selected in the
Connections list.
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2.2. Editing a Connection
Table 25.1. DrakSync's Toolbar Buttons
Button

Function
Adds a new connection group. You will need to enter a group
name in the dialog which pops up and click on OK . A new
tab labeled with the group name will appear. For example,
you can make one group for each machine you want to synchronize to or from.
Adds a new connection to the currently selected group. The
dialog to edit the connection will appear (see Figure 25.7,
“Editing the Connection Settings” [354]). Make one connection
for each directory you want to synchronize to or from on that
group.
Removes the currently selected group. All current connections
in that group will also be removed. A dialog will pop up
asking you for confirmation before removal.
Removes the currently selected connection. A dialog will pop
up asking you for confirmation before removal.
Changes settings for the currently selected connection. Please
refer to Section 2.2, “Editing a Connection” [353] for more
detailed information.
Starts synchronization of all defined connections in all groups.
Starts synchronization of all defined connections in the currently selected group.
Starts synchronization of the currently selected connection
inside the currently selected group.

2.2. Editing a Connection
Once a connection group is defined, clicking on the Add Connection button (or
selecting an existing connection and clicking on the Edit Connection button) will
show the connection properties dialog (see Figure 25.7, “Editing the Connection
Settings” [354]).
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2.2. Editing a Connection

Figure 25.7. Editing the Connection Settings
The Local section has settings for the local directory to synchronize to or from:
only the path to the directory is needed. The Remote section contains settings for
the remote directory to sync with. Fill the Host field with the host name or IP address of the remote machine, the User field with the account to log into on the remote machine, and the Directory field with the path of the remote directory to
synchronize with.
The Synchronization section contains settings for the synchronization's “direction”,
the protocol to use to connect to the remote machine, and a few miscellaneous
options.
The synchronization direction must be set to one of the following:
Copy most recent files
This corresponds to the synchronization type “As Both Local and Remote”.
Please refer to Section 1.3, “As Both Local and Remote” [351] for more information on what it implies for both local and remote files if you select this option.
Copy local files to remote
This corresponds to the synchronization type “As Local”. See Section 1.1, “As
Local” [347].
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2.3. Synchronize It
Copy remote files to local
This corresponds to the synchronization type “As Remote”. See Section 1.2,
“As Remote” [349].
The protocol must be set to one of the following:
Rsync over SSH (Secure SHell)
Uses rsync inside an ssh “tunnel” to connect to the remote host. Secure. This
is the recommended setting.
Click on the Upload public ssh key to remote host button to have
the ssh key sent to the remote host in order to simplify the login
process on the remote host. If you haven't generated a ssh identity,
you'll be asked to provide a pass phrase to generate one. This is
needed only once per host.
Rsync over RSH (Remote SHell)
Uses rsync inside an rsh “tunnel” to connect to the remote host. Insecure. If
rsh is not installed this option will not be available.
FTP (File Transfer Protocol)
Uses FTP and DrakSync's built-in synchronization algorithm to connect to the
remote host and synchronize directories. Insecure. This should be considered
the “last resort” if neither rsh nor ssh are installed on the machines.
The following are miscellaneous options:
Delete files
If you put a mark in this check box, files existing on one machine but not on
the other will be deleted. Use with care!
Remember password
If you put a mark in this check box (only enabled for the FTP protocol), DrakSync will save the password used to access the remote machine so you won't
have to type it again.

2.3. Synchronize It
We assume that you have a working network link between the local and
remote hosts. We also assume that you have a valid account on the remote
host.
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2.4. The WebSync Wizard
Select the connection you want to synchronize and click on the Sync Connection
button to start synchronization. Click on the Sync Group button to synchronize
the currently selected group. Click on the Synchronize All button (or press the
Ctrl - Y keys) to synchronize all connections in all groups.
If you see an error message a few seconds after the progress dialog appears, please read it, take corrective measures and try to launch the synchronization again.
Choose File → Save and Quit from the menu (or press the Ctrl - S keys) to quit
DrakSync, preserving all newly defined groups/connections and changes to the
existing ones.
Choose File → Quit Without Saving from the menu (or press the Ctrl - Q keys)
to quit DrakSync, ignoring all newly defined groups/connections and changes to
the existing ones. If you have defined connections and have synchronized them
before quitting DrakSync, the synchronized directories will be preserved even if
you choose to quit without saving. However, those connections will not be available
the next time you run DrakSync.

2.4. The WebSync Wizard
DrakSync provides a wizard to quickly setup a FTP synchronization. It was especially designed for people wishing to sync a local copy of a website with their
provider's web server.
You can access it from the menu: File → WebSync Wizard . It is made of two simple
steps which will add a new group (named My Websites) and connection to your
connections pool.

356

Chapter 26. Troubleshooting
This chapter guides you through some troubleshooting basics, that is: what to do
when everything goes wrong or, better yet, what to do to be prepared if something
goes wrong and then how to fix it.

1. Introduction
Making backup copies of your data, fixing little problems, recompiling the kernel,
installing software, and tweaking configuration files are not uncommon scenarios
in every day GNU/Linux life: even if you don't do it all the time, some day you
may want or need to. Those tasks can be managed without any hassle if you use
a little common sense and follow some practices and guidelines we discuss in this
chapter.
Many of the examples and tools presented in this chapter deal with the
command line. Usually, restoration of a damaged system to a working
state can only be done this way. We assume that you feel comfortable
enough using this powerful tool.
So, on to the basic things you need to have ready...

2. A Boot Disk
The very first thing you need when your system cannot boot from the hard disk
is a boot disk. It allows you to boot your system up and, in a matter of minutes,
enable you to undo what rendered your system unusable.

2.1. Using the Mandriva Linux CD Rescue Mode
To access Mandriva Linux's rescue mode (available on the first CD-ROM), boot
from the CD-ROM, and press the F1 key, then type rescue and hit Enter . The
system boots in rescue mode (see Figure 26.1, “Available Rescue Mode Actions” [358]).
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2.1. Using the Mandriva Linux CD Rescue
Mode

Figure 26.1. Available Rescue Mode Actions
You navigate through the actions with the arrow keys and execute the selected
action by pressing Enter . The actions available are:
Re-install Bootloader
Use this option to restore the Linux bootloader to the disk's MBR. The former
bootloader configuration will be activated again. This is handy, for example,
if you dual boot with Windows® and activated a virus which corrupted your
disk's MBR leading to an unbootable system.
Restore Windows Bootloader
Use this option to restore the Windows® bootloader to the disk's MBR. This
can be used to completely clean the Linux bootloader information and leave
Windows® only “as if Linux had never been installed”. Press Enter to perform
the action, or N followed by Enter to cancel the action.
You won't be able to boot Linux after performing this action. Note
however, that this doesn't erase the Linux partitions and system from
your harddisk.
Mount your partitions under /mnt
Use this option to mount all available partitions under the /mnt directory. Each
partition will be mounted in its own directory, with the same name it would
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3. Backup
have if mounted by the original system. This option is very useful when you
need to access data on your partitions, for example to back it up. You will
probably need to mount partitions before accessing the console, for example.
Go to Console
Use this option to access the console where you can perform further operations,
for example loading network card drivers, copying files, formatting partitions,
etc. A very basic Linux system is available with a few consoles which you can
switch between using the Alt - F<n> key sequence.
You can return to the rescue mode actions menu by issuing the rescue-gui command.
Once you have finished using the console you can issue the reboot command
to restart the system.
Reboot
Restarts the machine. Take the CD-ROM out if you want the system to boot
as usual. You won't be asked for confirmation, the system reboots immediately.
Doc: What's addressed by this Rescue?
Shows a few pages of help text, with brief explanations on what the rescue
mode addresses. Navigate through the pages using the Page Up and Page
Down or the arrow keys and press the Q key followed by the Enter key to
return to the rescue actions menu.

3. Backup
3.1. Why Backup?
Backing up your system is the only means of being able to repair it if it suffers
severe damage, if you accidentally delete some important system files, or if someone
breaks into your system and intentionally deletes some files. You should also back
up your personal data (compressed audio, images, office documents, e-mails, address book, etc.) to be safe.
You should make your backups using an appropriate medium and keep them in
a safe place. Such a place should be outside the place you usually work in, if possible. You can even have two backups, one on-site, and one outside. Generally
speaking, you should make sure that you will be able to restore those backups if
you want all this to be really useful.
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3.2. Preparing your System

3.2. Preparing your System
You probably have everything you need already installed in your system. You
should also keep a boot disk near at hand (you created one, didn't you?). Actually,
you can make backups using only tar and, optionally, a compression tool such as
gzip or bzip2. See an example in Section 3.6, “Backup Example Using tar” [361].
As an alternative, you can use specialized backup programs, such as Taper, Time
Navigator, Arkeia, or Mandriva Linux's own Drakbackup (please refer to Section 8,
“Backing Up and Restoring your Files” [290]).

3.3. What to Backup?
Well, this might be the single most difficult question every system administrator
asks himself when the time to backup comes. The answer depends on issues such
as: are you only backing up your personal data, your configuration files, or your
whole system? How much time or space is it going to take? Will you be restoring
your backup on the same machine/OS version, or on a different one?
Since this is a troubleshooting chapter, we try to focus on making a backup which
allows you to quickly restore your system to the state it was before that terrible
thing which rendered it unusable happened. Of course, you need to make a backup
of your personal data if you don't want to lose it.
As a rule of thumb, you should back up the following directories: /etc, /home,
/root and /var. If you do a complete backup of these directories, you have saved
not only your system configuration, but your data as well. Please bear in mind
that a backup can take a long time to complete, but it's the safest bet.
A more sophisticated scheme would be to backup only those files which have
changed, skipping the ones which haven't. This will take more planning time, but
will lead to quicker backups (and quicker restores, too). They will also be “easier”
to port from one machine/OS version to another.
To summarize, back up all the configuration files of the programs you use and all
of the configuration files you have changed. Also back up all your personal (and
your system's users) data files. You won't regret it.

3.4. Where to Back Up?
The other big question to answer. This depends on how much you want to back
up, how fast you want to make your backups, how easy it is to access the backup
media, and a large list of etceteras.
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3.5. When to Back Up?
Generally speaking, you need media that is at least as large as the amount of information you want to back up, and fast enough so the whole process won't take
forever to complete.
Available backup media options vary in capacity, reliability, and speed. You can
combine backup media according to your backup strategy, for example: tapes and
CD-R/DVD+RW, hard disk and tapes, hard disk and CD-R/DVD+RW, etc., but
bear in mind that your backup software may or may not support all of these options.

3.5. When to Back Up?
There are many policies for backup schedules. We discuss a few in this chapter
but remember that these are not mandatory, nor the best ones, nor the only ones.
These are just guidelines you may want to follow in rolling out your own backup
schedule.
The many backup strategies out there depend on the media you use, on how often
your data changes, and on how critical that data is to you or your organization.
For example, one strategy states that you should make a full backup each weekend,
and an incremental (changed data only) backup every day. Then make a full backup
every month and store that one in at least two places. This strategy might prove
useful for a company, but not for a personal computer. For your personal backups
you can think of something like this: make a weekly backup of your files on your
disk drive and each month transfer those backups to CD-R/DVD+RW or tape.

3.6. Backup Example Using tar
Next, we introduce you to a little backup script which uses tar and bzip2 to make
a compressed backup of the list of directories you provide. Please read the script's
comments for tips on its usage.
You need read permission on the files, and read and execute permissions
on the directories you are going to back up. Otherwise the backup operation will fail.
#!/bin/bash
# Create a compressed backup of all the directories specified and put the
# resulting file in a directory of your choice.
BACKUP_DIRS="$HOME /etc /var"
BACKUP_FILENAME=`date '+%b%d%Y'`
BACKUP_DEST_DIR="/backups"
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4. Restore
# Uncomment the following line for GZipped backups, comment for
# BZipped backups
#tar cvzf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.gz $BACKUP_DIRS
# We do a BZipped backup here...
# Comment the following line for GZipped backups, uncomment for
# BZipped backups
tar cvjf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.bz2 $BACKUP_DIRS

Use BACKUP_DIRS to specify the directories you want to include in the backup and
BACKUP_DEST_DIR to specify the destination directory where the backup is going
to be stored. Make the script executable: open a terminal and run chmod 700
backup.sh.
Of course, you can always move the resulting tar.bz2 or tar.gz file to any media
you want later. You can even backup directly to the media you want by mounting
it and changing the variable BACKUP_DEST_DIR of the script accordingly. Feel free
to enhance this script and make it as flexible as you want.
To restore the backups made this way, please look at Section 4.1, “Restore Example
Using tar” [362].

4. Restore
The restoration of a backup depends on which program, media, and schedule you
used to make it. We won't cover all the restore cases, but only mention that in order
to recover your settings and data files, make sure that you restore the files and/or
directories to the same places they were in when you made the backup.

4.1. Restore Example Using tar
Now, we introduce a little script to restore the backup we made with tar using the
script introduced earlier in Section 3.6, “Backup Example Using tar” [361].
You need write permissions on the files and directories you are going to
restore. Otherwise the restore operation will fail.
#!/bin/bash
# Extract a compressed backup of all the directories specified
# putting the backed up files into their original places.
BACKUP_SOURCE_DIR="/backups"
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4.2. Making a Recovery CD-ROM
RESTORE_FILENAME=$1
# Uncomment the following line if you are restoring GZipped
# backups
#tar xvzf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME
# Restore a BZipped backup here...
tar xvjf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME

As you can see, this script is simple enough. All we have to do is to pass it the file
name of the backup we want to restore as a parameter (just the file name, not the
full path), and it restores the backed up files into their original locations. Make
sure the script is executable: open a terminal and run chmod 700 restore.sh.

4.2. Making a Recovery CD-ROM
There is a way to be prepared in case of “total disaster”, and that is by making a
full backup of your system. Programs such as mkCDrec can be very useful to get
you up and running in a matter of minutes. You can find it, together with its documentation on the mkCDrec web site [http://mkcdrec.ota.be].
mkCDrec allows you to do multiple-CD-ROM volumes, disk cloning (copying the
full contents of a disk or partition to another with similar characteristics — at least
the same size), and many more.
In order to restore a system with mkCDrec you only have to boot with the first
CD-ROM of the multiple-CD-ROM volume and then follow the on-screen instructions.

5. Problems Arising at Boot Time
It could happen that your system hangs during boot up. If so, don't panic, just
keep reading.
The next sections are not introduced in any particular order.

5.1. System Hanging During Boot
If your system hangs during Rebuilding RPM database or Finding module dependencies, just press Ctrl - C . This allows the system to skip this step and continue
to boot. Once booted, execute rpm --rebuilddb as root if the system hang was at
the Rebuilding RPM database phase. If the system hang was at the Finding
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5.2. Filesystem Check on Boot Fails
module dependencies phase you have most likely been through a kernel upgrade,
but haven't done it correctly. Check if the files in the /boot and /lib/modules
directories match the current kernel version (i.e., have the current version number
attached).
If the boot process hangs at RAMDISK: Compressed image found at block 0 you
have a corrupted initrd image. Either try to boot another boot entry or boot an
emergency system and remove or change the initrd= section in /etc/lilo.conf

5.2. Filesystem Check on Boot Fails
The information below applies to ext2 and ext3 filesystems only. If you
use a different filesystem, please check its documentation.
If, for any reason, you didn't shut your box down properly, the system runs a
routine filesystem check during the next boot. Sometimes it may fail to do this on
its own and asks for the root password and drops you to a console. Execute e2fsck
-py [device] where [device] is the name of the partition on which the automatic
check failed. The -p switch tells e2fsck to make all the necessary repairs without
asking, -y assumes you answer yes to all questions. When the check and repair
phase is over, press Ctrl - D to leave the emergency console. The system will reboot.
If you get this error regularly, there may be bad blocks on your disk. Execute e2fsck
-c [device] to find out. This command automatically marks any bad blocks and
prevents the filesystem from storing data in these blocks. e2fsck checks the file
system automatically only if it hasn't been unmounted properly during the previous
system shutdown; or if the maximal mount count has been reached. To force a
check, use the -f option.
The verification for bad blocks on a disk should only be done on unmounted file systems, and can take a long time to complete.

5.3. X Doesn't Start
If you boot into X by default and have managed to break your X configuration
somehow, and cannot enter X anymore, you can log into a console and use XFdrake
to reconfigure X. You can also boot into a different runlevel, fix X's configuration
with XFdrake and reboot into X.

5.3.1. Booting Into a Different Run Level
The default run level GNU/Linux boots to is defined in the /etc/inittab file.
Look for an entry like id:5:initdefault:. To boot into run level 3 (the console),
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6. Bootloader Issues
you have to define that run level on the boot prompt. Under LILO, press the Esc
key once and type linux init 3. Under GRUB, press the E key twice, add init
3, press the Enter key and then the B key to boot.
For a more detailed description about run levels, please refer to Chapter 37, The
Start-Up Files: init sysv [493].

5.3.2. Configuring X From The Console
To reconfigure X using XFdrake from the console, simply type XFdrake as root.
Using XFdrake is no different to the graphical environment except that you won't
have nice icons and may not be able to use the mouse pointer. To move down you
have to press the right or down arrow keys on your keyboard; to move up press
the left or up keys on your keyboard. You can also use the Tab key to move
between the different options/buttons. The text on the currently selected button/option will be highlighted with a different color. Press the Enter key to activate it.
Please refer to Section 2, “Controlling the Graphical Configuration” [225] for instructions on its usage.

6. Bootloader Issues
6.1. Bootloader Reinstall
It may happen that you make a mistake and wipe your disk's MBR (Master Boot
Record), or some misbehaving program erases it, or you dual boot with Windows®
and catch a virus which suppresses it. So, you think you won't be able to boot your
system anymore, right? Wrong! There are many ways to recover the boot record.
To recover your bootloader you need a boot disk. Without a boot disk of some kind
you might be completely lost, unless you made a backup of your MBR, see Section 6.2, “Backing Up and Restoring the MBR” [366].
Reboot your computer using the boot disk. What you do next varies according
whether you use LILO or GRUB. No matter which bootloader you use, all the
commands you must execute need to be run as root.

6.1.1. With LILO
If you use LILO, you only need to issue the following at the command prompt:
/sbin/lilo. This command reinstalls LILO on your disk's boot sector and fixes the
problem.
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6.1.2. With GRUB
If you use GRUB things are a little bit different to that of LILO.
In the following example we assume that you are trying to install GRUB
in the MBR of your first IDE drive, and that the file stage1 is in the
/boot/grub/ directory.
First, invoke GRUB's shell by issuing the grub command. Once there, issue the
following command: root (hd0,0). This will tell GRUB that the files it needs are in
the first partition (0) of your first hard disk (hd0). Then issue the following command: setup (hd0). This installs GRUB in the MBR of your first hard disk. That's
it!
You can also try to use grub-install /dev/hda to install GRUB on your first hard
drive's MBR, but the method described above is the preferred one.

6.1.3. Some Considerations for Dual-Booting Systems
Windows 9x, NT, 2000 and XP upgrades. If you run a dual-boot system, be very
careful to always have a GNU/Linux boot disk prepared. If you don't have a boot
disk, and you (re)install Windows® (all versions) you won't be able to boot
GNU/Linux after the Windows® upgrade because Windows® rewrites the MBR
without any warning at all.

6.2. Backing Up and Restoring the MBR
To make a backup copy of your hard disk's MBR, insert a blank floppy in your
floppy disk drive and issue the following:
# dd if=/dev/hda of=/dev/fd0/mbr.bin bs=512 count=1

If you want to restore a backed up copy of your hard disk's MBR, insert the floppy
containing it into your floppy disk drive and issue the following:
# dd if=/dev/fd0/mbr.bin of=/dev/hda bs=512

The above examples assume that the MBR of your first IDE hard disk
(/dev/hda) is backed up to a file named mbr.bin on your first floppy
diskette drive (/dev/fd0) and should be run as the root user.
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7. Filesystem Issues
7.1. Repairing a Damaged Superblock
The information below only applies to ext2 and ext3 filesystems. If you
use a different filesystem, please check its documentation.
The superblock is the first block of each ext2FS/ext3FS partition. It contains important data about the file system, such as its size, free space, etc. (it is similar to the
method used by FAT partitions). A partition with a damaged superblock cannot
be mounted. Fortunately, ext2FS/ext3FS keeps several superblock backup copies
scattered over the partition.
Boot your system with a boot disk. The backup copies' location depends on the
block size of the filesystem. For filesystems with 1 KB block sizes it is at the beginning of each 8 KB (8192 bytes) block. For filesystems with 2 KB sizes it is at the
beginning of each 16 KB (16384 bytes) block, and so on. You can use the mke2fs n [your_disk_device_name] command to find out at which byte positions the superblock copies are. Assuming a 1 KB block size, the first backup copy is in byte
number 8193. To restore the superblock from this copy, execute e2fsck -b 8193
/dev/hda4; change hda4 accordingly to reflect the name of your damaged partition.
If that block also happens to be damaged, try the next one at byte number 16385,
and so on until you find a suitable one. Reboot your system to activate the changes.

7.2. Recovering Deleted Files
We discuss ways of recovering deleted files and directories. Please bear in mind
that recovery tools are not magical, and they will only work depending on how
recently you deleted the file(s) you are trying to recover.
You might be wondering how to recover files you accidentally deleted. There are
some utilities designed for GNU/Linux's ext2 filesystem which allow you to recover
deleted files and directories. However they won't recover the files you deleted a
few months ago because of disk usage, space marked as “free” will have been
overwritten. So the best way to protect against accidental or not so accidental deletions is by making backups.
There are not (as yet) tools to recover files deleted on reiserfs file systems.
Keep in touch with the ReiserFS home page [http://www.namesys.com]
for the latest news about it.
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One recovery tool is Recover. It's an interactive tool. You can find it in the contribs
CD-ROM or on the Rpmfind web site [http://www.rpmfind.net]. Once you have
the RPM, install it. Then run it with recover and answer the questions it asks you.
The questions help you to set a time span to look for deleted files and directories
to minimize the time it takes to do the search1.
Once the tool finishes its search, it asks you where you want to save the recovered
files and directories. Pick a directory of your choice, and you have all the files and
directories recovered into it. Note that you won't be able to recover the file names,
just their contents, but you can inspect them or try to rename them with different
names until you get the right one. This is better than nothing.
There are also mini-HOWTOs related to “undeletion” for ext2, look at Ext2fsUndeletion [http://www.tldp.org/HOWTO/mini/Ext2fs-Undeletion.
html] and undeletion of whole directory structures [http://www.tldp.
org/HOWTO/mini/Ext2fs-Undeletion-Dir-Struct/index.html].

8. Recovering from a System Freeze
When stuck in a “freeze”, your computer doesn't respond to commands anymore
and input devices such as keyboard and mouse seem to be blocked. This is a worstcase scenario and could mean that you have a very severe error in either your
configuration, your software or your hardware. We will show you how to deal
with this annoying situation.
In the case of a system freeze, your top priority should be trying to shutdown your
system properly. We assume you are running under X. So try these steps consecutively:
1.

Try to kill the X server by pressing the Ctrl - Alt - Backspace keys.

2.

Try to switch to another console by pressing the Ctrl - Alt - Fn keys (where n
is the console number, from 1 to 6). If you succeed, login as root and issue
the command: kill -15 $(pidof X) or the command kill -9 $(pidof X), if the
first command shows no effect. Check with top to see if X is still running.

3.

If you are part of a local network, try to use ssh to connect into your machine
from another. It is advisable to ssh into the remote machine as an unprivileged
user and then use the su command to become root.

1

You can search for all deleted files too by appending the -a option, but it takes much longer...
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4.

If the system doesn't respond to any of these steps, you have to go through
the SysRq (System Request) sequence. The SysRq sequence involves pressing
and holding three keys at once: the left Alt key, the SysRq key (labeled Print
Screen on older keyboards) and a letter key.
a.

Alt - SysRq - R puts the keyboard in “raw” mode. Now try pressing
Alt - Ctrl - Backspace again to kill X. If that doesn't work, carry on.

b.

Alt - SysRq - S attempts to write all unsaved data to disk (“sync” the disk).

c.

Alt - SysRq - E sends a termination signal to all processes, except for init.

d.

Alt - SysRq - I sends a kill signal to all processes, except for init.

e.

Alt - SysRq - U attempts to re-mount all mounted filesystems read-only.
This removes the “dirty flag” and prevents a filesystem check upon reboot.

f.

Alt - SysRq - B reboots the system. You might just as well press the “reset”
button on your machine.
Remember that this is a sequence, i.e. you have to press one combination after the other in the right order: Raw, Sync, tErm, kIll, Umount,
reBoot2. Read the kernel documentation for more information on
this feature.

5.

If none of the above helps, cross your fingers and press the “reset” switch on
your machine. If you are lucky, GNU/Linux will just run a disk check upon
reboot.

By all means, try to find out what causes these lockups because they can do severe
damage to the filesystem. You might also want to consider using one of the
journaling filesystems included in Mandriva Linux: ext3, reiserfs, etc. which handle
such failures more gracefully. However, replacing ext2FS with reiserfs requires
reformatting your partitions. You can use tune2fs -j /dev/hdaN to convert the
filesystem in the Nth partition of the first IDE disk from ext2FS to ext3FS.

9. Killing Misbehaving Apps
Well, this one is not so hard after all. You have many ways to do it. You can do it
by finding the PID of the program which stopped responding, and then using the
2

Mnemonic phrase: “Raising Skinny Elephants Is Utterly Boring”
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kill command to terminate it, or you can use the xkill tool or other graphical tools
such as the ones that show the process tree.

9.1. From the Console
The first thing to do to terminate a misbehaving program is to find its PID, or
process ID. To do so, execute the following from a console: ps aux | grep mozillafirefox-bin, supposing that Firefox is the misbehaving program. You will get
something like the following, which tells you among other things that Firefox was
started by user peter and that its PID is 3505:
peter
3505 1.7 5.0 82208 25804 ?
Sl
09:30
/usr/lib/mozilla-firefox-1.0.6/mozilla-firefox-bin

0:01 →

Now that we have the PID of the misbehaving program, we can execute the kill
command to terminate it. So we execute the following: kill -9 3505, and that's it!
Firefox is killed. Note that this is only to be used when the program doesn't respond
to your input anymore. Do not use it as a standard means of exiting from applications.
Actually, we sent the KILL signal to the process number 3505. The kill command
accepts other signals besides KILL, so you can have greater control over your processes. For more info, see kill(1), as well as Chapter 36, Process Control [487].

9.2. Using Graphical Monitoring Tools
You can also use the graphical process' status tools (such as KPM, KSySGuard,
and GTOP to name a few) which allow you to point to the process name and with
one click send that process a signal or just kill that process.
If you are using KDE, you can press the Ctrl - Alt - Esc keys: the pointer
changes to a skull with crossed bones and you can simply click on the
window of the misbehaving application to kill it.

10. Miscellaneous
Some considerations on newer hardware such as legacy-free systems, nVidia® and
ATI 3D® graphics accelerator cards, winmodems and other things that don't fit in
the preceding sections.
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10.1. Legacy-Free Systems
Hardware manufacturers have recently introduced what they call “legacy-free
systems”, mainly on laptops3, but there are also legacy-free desktop computers.
This basically means that the BIOS has been considerably reduced to allow you
only to choose which media to boot from. Mandriva Linux will be able to configure
everything properly.

10.2. nVidia and ATI 3D Graphics Cards
Computers with nVidia or ATI graphics cards need a patched kernel to be able to
use OpenGL hardware 3D acceleration on OpenGL-compatible applications. If
you own a Mandriva Linux –– PowerPack Edition™, the kernel should have been
installed by DrakX. If this is not your case, please obtain and install the corresponding packages. You can visit nVidia's web site [http://www.nvidia.com] and ATI's
web site [http://www.ati.com] and download the appropriate drivers, or you can
download the RPM packages from Mandriva Club [http://club.mandriva.com].
Then run Mandriva Linux Control Center and re-configure X from there.

10.3. Winmodems
winmodems are also called controller-less modems or software modems. Support
for these peripherals is improving. Drivers do exist, but most of them are in binary
form and available only for newer kernel versions.
If you have a PCI modem, look at the output of cat /proc/pci run as the root user
from a terminal window. It tells you the device's I/O port and IRQ. Then use the
setserial command (for our example, the I/O address is 0xb400, the IRQ is 10 and
the modem is the 4th serial device) as follows:
setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Then try to query your modem using minicom or kppp. If it doesn't work, you
may have a software modem. If it does work, create the /etc/rc.d/rc.setserial
file and place the appropriate setserial command line in it.
If you happen to have a software modem in your machine, and you have a Mandriva Club account, you might find an RPM package that supports your modem
(try searching on the ltmodem package for instance). You should also take a look
at the web site of your modem's manufacturer and at the linmodems [http://

3
Refer to the great Linux on Laptops [http://www.linux-laptop.net] web site for more information on
your laptop make/model.
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linmodems.org/] and the Winmodems are not modems [http://start.at/modem/]
web sites.

10.4. My Computer is “slow”
If you notice your computer is really slow, or significantly slower than with other
GNU/Linux versions, you might overcome this “problem” by disabling ACPI
support. To do so, add the following to your /etc/lilo.conf file:
append="acpi=off"

If the file already has an append= line, only add acpi=off at its end. Running lilo
-v as root and rebooting your computer will make the changes effective.

10.5. Alternative System Install Methods
You might need to install your Mandriva Linux system using an alternative installation method, for example over the network, or from external storage devices. You
will need an alternative floppy boot disk. The CD-ROM contains all of the image
files and utility programs needed to create a floppy boot disk. The floppy boot
disk images are in the CD-ROM's /install/images directory.
The following is a list of different images and their respective installation methods:
cdrom.img
To install from a local IDE or SCSI CD-ROM drive.
network.img and network_drivers.img
To install from an NFS, FTP, HTTP repository on your local LAN or from one
via the Internet. The network configuration of the machine on which you wish
to install may be manual or automatic. Please make sure that you make both
floppies.
pcmcia.img
Use this image if the installation medium is reached through a PCMCIA card
(network, CD-ROM, etc.).
Some PCMCIA devices use common network drivers. If the PCMCIA
device does not work, try again with network.img and network_drivers.img.
hd_grub.img
Use this image if you want to perform the installation from a hard disk. You
need to copy the contents of the CD onto the hard drive (either on a FAT,
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ext2FS, ext3FS or ReiserFS partition). On the hd_grub customization site [http:
//qa.mandriva.com/hd_grub.cgi] you will find a little tool which may prove
helpful to customize your boot floppy.
all.img
This image contains all of the boot floppy images above, and more. If your
machine supports booting from USB, you can transfer this image to a USB key
and boot the installation from it.
Transferring the all.img to a USB key will erase all of the USB key
contents. Back up first, and use with care.

10.5.1. Creating a Boot Disk With Windows
To do so, use the rawwrite program. You will find it in the CD-ROM's dosutils/
directory.
You may have noticed that there is a DOS version of the same program called
rawrite. In fact, this is the original version of the program. rawwrite is a graphical
front-end to it.
Start the program as shown in Figure 26.2, “The Rawwrite Program” [374].
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Figure 26.2. The Rawwrite Program
Select the boot image to be copied and the target device. In almost every case, the
target device is the A: drive (the first floppy disk drive).
Then insert an empty disk into your chosen floppy drive and click on the Write
button. When completed click on Exit : you now have a floppy boot disk to install
your Mandriva Linux distribution.

10.5.2. Creating a Floppy Boot Disk From GNU/Linux
If GNU/Linux is already installed on your machine (another version on another
machine, etc.), carry out the following steps:
1.

Mount the CD-ROM, if needed. Let's suppose that the mount point is
/mnt/cdrom.

2.

Log in as root (to do so, open a terminal window, run the su command and
enter root's password).

3.

Insert an empty diskette into the floppy drive and type:
$ dd if=/mnt/cdrom/install/images/cdrom.img of=/dev/fd0 bs=512
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Once this operation is completed, your floppy boot disk will be ready for use.
Replace /dev/fd0 with /dev/fd1 if you are using the second floppy
drive and, of course, the name of the image with the one you want.

4.

If you want to create a USB boot key, connect an empty USB key to the machine
and type:
dd if=/mnt/cdrom/install/images/all.img of=/dev/sdb

Replace /dev/sdb by your USB key's device name. Once this operation is done,
your USB boot key will be ready for use.

11. Troubleshooting Documentation Resources
11.1. Mailing Lists
Mailing lists still remain very popular in spite of the multiplicity of other means
of communication. Almost every piece of GNU/Linux software has its own mailing
list geared towards users, developers, announcements, etc.
You can also consult the mailing lists of Mandriva Linux-related project [http://
www.mandriva.com/community/resources/newsgroups].
We cannot give you a complete list of addresses but bear in mind that it's quite
often the best means to get in touch with the top experts on a particular subject.
Some advice, however:
• Don't post questions which are off topic. Carefully read the guidelines which
are often sent when you first subscribe or where you found the address of the
list. We also recommend that you read the E-mail Etiquette [http://www.
iwillfollow.com/email.htm] also known as the Netiquette, which will give you
a few hints on getting started. If you have spare time, you may also consider
reading the corresponding RFCs [http://www.rfc-editor.org/].
IMPORTANT: remember to always keep the first e-mail you receive
from a mailing list since it normally tells you how to unsubscribe if
you end up needing to leave the list;
• Respect the general rules applicable to e-mail: in particular, do not send HTML
messages: text only;
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• Mailing lists usually have archives: check them out! Your question may have
been debated just before you subscribed to the list;

11.2. Newsgroups
Before asking for help on newsgroups, it is advisable to find out if your problem
has already been covered (or solved) on Google Groups™ [http://groups.google.
com/]. If nothing is relevant to your question, then go to a newsgroup entirely
devoted to Mandriva Linux [news:alt.os.linux.mandriva]. You may also join many
other groups in the comp.os.linux.* “hierarchy”:
• comp.os.linux.setup [news:comp.os.linux.setup]: questions about Linux configuration (devices, configuration of applications) and resolution of miscellaneous
problems.
• comp.os.linux.misc [news:comp.os.linux.misc]: whatever doesn't fit in any
other group.
• and others...
Before posting to one of these groups, make sure you have done your homework
and read the available documentation on your specific issue. If you have not, you
will most likely get the following answer: RTFM. And nothing more!

12. Mandriva Linux's Specific Troubleshooting Tools
Each administration tool (the ones started from Mandriva Linux Control Center)
is a potential trouble fixing tool. You can use all these tools to revert configuration
changes, to add or remove software, to update your system with the latest fixes
from Mandriva, etc.
If you think you have found a bug in any of our tools, please feel free to submit a
bug report using Drakbug, our automated bug report tool, see Section 3, “The
Drakbug Reporting Tool” [206] for more information.

13. General Guidelines for Solving a Problem under Mandriva Linux
Here are the different means available to you in your problem-solving quest. Try
the first option and only then, if that does not work, try the second, and so on.
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13.1. Search the Internet
The various Internet sites previously mentioned are excellent starting points. They
deal with general and very specific aspects of your potential problems. Finally, try
a general search engine such as Google™ or, as mentioned above, the Linux-specific
Google™ search engine. And do not hesitate to use the Advanced search [http://
www.google.com/advanced_search] option with very detailed questions, such as
the error message you are receiving.

13.2. Mailing Lists and Newsgroups Archives
The previous searches may lead you to general answers which hide the results of
your specific question amongst many other answers. To refine your search, you
can try the following.
First, try to find a list which seems specifically geared to your problem, then perform
a search in its archive pages.

Example
You've noticed some strange behavior while trying to use GRUB
with a minix partition.
One of the results of a search using the “grub mailing list”
keywords in Google™ is a link to the GRUB mailing list archive
[http://mail.gnu.org/archive/html/bug-grub/]. It even offers a
search engine, which when searched for “Minix” leads you directly
to a patch.
Note that not all archives have an embedded search engine. However, using Google™ as an example, you can
easily use the advanced field domain to limit your search
to the specific site hosting the archive. This strategy may
also be used to exclude sites which keep returning
garbage.
For a newsgroups search, Google Groups™ [http://groups.google.com/] maintains
an archive of an amazingly large number of newsgroup channels.

13.3. Questions to Mailing Lists and Newsgroups
See the related sections above: Section 11.1, “Mailing Lists” [375] and Section 11.2,
“Newsgroups” [376]. Reading How To Ask Questions The Smart Way [http://
www.catb.org/~esr/faqs/smart-questions.html] may be of great help.
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13.4. Directly Contacting the Person in Charge
Use this option as a very last resort and in really extreme situations — unless you
want to offer your collaboration! Software developers generally receive mountains
of e-mails, so your anguished question on the use of the cd command will most
likely... be ignored!
The addresses will be found either on the home page of a project's site or in the
software documentation.
A last word: do not underestimate your neighbors' skills or those of your local
LUG (Linux Users Group). And please, do not throw your computer through the
window. If your problem isn't fixed today, it may be tomorrow...

13.5. Mandriva Business Services
Finally, when facing a really challenging situation, corporate users (especially)
might consider hiring one of Mandriva's consultants to address their specific needs.
This is one of the strong suits of open-source products: we have the source, we
have the power! Therefore, almost any problem, no matter how complex, specific
or high level, may be solved right in the heart of the software.
You might also want to customize your Linux environment to meet very precise
goals. For example, you could use Mandriva Linux as a custom routing application
on special devices. Know that Mandriva consulting services [http://www.
mandriva.com/enterprise/products/] can help you.

14. Final Thoughts
As you have seen there are many more ways to recover from an emergency than
by re-installing the whole system again4. Sure, you need a little expertise in applying
some of the techniques described in this chapter, but with a little practice you will
gain such expertise. However, we hope that you will never need to really master
these techniques ... although it does not hurt to know them. We hope that the instructions and examples given will be useful when you are in need. Good luck
recovering from an emergency!

4

The usual way to fix things in some other operating systems...
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Part 6. Introduction to Linux
Command-Line Basics
The following parts of the manual are aimed at those wishing to better understand
their Mandriva Linux system, and who want to exploit its huge capabilities. After
reading them, we hope that you will be at ease with daily administration of a
GNU/Linux box. Here's an overview of the parts it contains, along with a brief
description of each chapter.
• In the first part we introduce you to the GNU/Linux system. We discuss its
architecture, the main file systems available and some of the more peculiar aspects such as the /proc file system.
In Chapter 27, Basic UNIX® System Concepts [381] we talk about the UNIX®
paradigm while speaking more specifically of the GNU/Linux world. We discuss the standard file-manipulation utilities as well as some useful features
provided by the shell. Then comes a complementary chapter (Chapter 28,
Disks and Partitions [395]) in which we explain how hard disks are managed
under GNU/Linux. We also deal with hard disk partitioning.
We explore the organization of the file tree in Chapter 29, File-Tree Organization [401]. UNIX® systems tend to grow very large, but every file has its place
in a specific directory. After reading this chapter, you will know where to look
for files depending on their role in the system.
The next chapter deals with file systems (Chapter 30, The Linux File System [407]).
After a presentation of the available ones, we discuss file types and additional
concepts and utilities such as inodes and pipes. The following chapter
(Chapter 31, The /proc File System [421]) introduces a special (and virtual)
GNU/Linux file system called /proc.
• The second part (Linux in Depth [431]) deals with more practical topics. We
talk about the relationship between file systems and mount points, how to use
the command line in your daily tasks, how to edit configuration files with light
and powerful editors, and more.
We cover the topics of file systems and mount points (Chapter 32, File Systems
and Mount Points [433]) by defining both terms, as well as explaining them with
real life examples.

Then we tackle the command-line interface (Chapter 33, Introduction to the
Command Line [441]). We discuss file-handling utilities such as the mkdir and
touch commands, and how to move, delete and copy files and directories in
the file system. We also speak about file attributes and how to handle them
with commands such as chown and chgrp. We then tackle shell globbing patterns, redirections and pipes, command-line completion, as well as basic job(s)
control.
The next chapter covers text editing (Chapter 34, Text Editing: Emacs and VI [455]).
As most UNIX® configuration files are text files, you will eventually want or
need to edit them in a text editor. You will learn how to use two of the most
famous text editors in the UNIX® and GNU/Linux worlds: the mighty Emacs,
written by Richard M. Stallman, and good-old Vi, written in 1976 by Bill Joy.
You should then be able to perform basic maintenance on your system. The
following two chapters present practical uses of the command line (Chapter 35,
Command-Line Utilities [467]), and process control (Chapter 36, Process Control [487]) in general.
The next chapter (Chapter 37, The Start-Up Files: init sysv [493]) presents the
Mandriva Linux boot-up procedure, and how to use it efficiently. We talk about
init (the process which allows your system to boot) and different run levels
you may wish to use (especially for maintenance tasks). We also briefly explain
how to use drakxservices to manage services (see Section 2, “Configuring StartUp Services” [276], for more details).
Next we explain how to securely access a remote system (with ssh) to perform
maintenance tasks, to run programs on it, and more (Chapter 38, Secure Remote
Access [497]). We give you a quick overview of the connection scheme and then
we describe a basic server/client ssh setup. We also discuss the usage of scp.
We close out this book with a chapter dedicated to package management using
the command line (Chapter 39, Package Management From The Command
Line [501]). In it we show you how to use the urpmi utility along with its counterpart, urpme. We also explain how to manage media sources.

®

Chapter 27. Basic UNIX System Concepts
The name “UNIX®” may be familiar to you. You may even use a UNIX® system
at work, in which case this chapter may be of less interest.
For those of you who have never used a UNIX® system, reading this chapter is
absolutely necessary. Understanding the concepts which will be introduced here
will answer a surprisingly large number of questions commonly asked by beginners
in the GNU/Linux world. Similarly some of these concepts will likely help you
solve many of the problems you may encounter in the future.

1. Users and Groups
Since they have a direct influence on all other concepts, this section will introduce
the concepts of users and groups which are extremely important.
Linux is a true multiuser system, and in order to use your GNU/Linux machine,
you must have an account on the machine. When you created a user during installation, you actually created an account. In case you don't remember, you were
prompted for the following items:
• the user's “real name” (which could actually be whatever you want);
• a login name;
• and a password.
The two most important parameters here are the login name (commonly abbreviated
to login) and the password. You must have both of these in order to access the
system.
When you create a user, a default group is also created. Later on, we will see that
groups are useful when you want to share files with other people. A group may
contain as many users as you wish, and it is very common to see such a separation
in large systems. For example, at a university, you could have one group per department, another group for teachers, and so on. The opposite is also true: a user
may be a member of one or more groups. A math teacher, for example, could be
a member of the teachers' group and also of his math students' group.
Now that we've covered the background information, let us look at how to actually
log in.
If the graphical interface is automatically started on boot up, your start-up screen
will look like Figure 27.1, “Graphical Mode Login Session” [382].
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Figure 27.1. Graphical Mode Login Session
In order to log in, you must first select your account from the list. A new dialog
will be displayed, prompting you for your password . Note that you will have to
type in your password blindly, because the characters will be echoed on screen as
stars (*) instead of the characters you type in the password field. You may also
choose your session type (window manager). Once you're ready, press the Login
button.
If you are in console or “text” mode, you will be presented with something similar
to the following:
Mandriva Linux release 2006.0 (CodeName) for i586
Kernel 2.6.12-6mdk on an i686 / tty1
[machine_name] login:

To log in, type your login name at the login: prompt and press Enter . Next, the
login program (called login) will display a Password: prompt and wait for you
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to enter your password. Like the graphic mode login, the console login will not
echo the characters you are typing on the screen, but there will be no stars either.
Note that you can log in several times with the same account on additional consoles
and under X. Each session you open is independent of the others, and it is even
possible to open several X sessions at the same time (although this is not recommended since it consumes a lot of resources). By default, Mandriva Linux has six
virtual consoles in addition to the one reserved for the graphical interface. You can
switch to any of them by pressing the Ctrl - Alt - F<n> key sequence, where <n> is
the number of the console that you want to switch to. By default, the graphical
interface is on console number 7. Therefore, to switch to the second console, you
would press the Ctrl , Alt and F2 keys.
During the installation, DrakX also prompted you for the password of a very special
user: root. This is the system administrator who will most likely be yourself. For
your system's security, it is very important for the root account to be always protected by a good and hard-to-guess password!
If you regularly log in as root, it can be very easy to make a mistake which could
render your system unusable: one single mistake can do it. In particular, if you
did not set a password for the root account, then any user can alter any part of
your system (and even other operating systems on your machine!). Obviously this
is not a good idea.
It is worth mentioning that internally, the system does not identify you by your
login name. Instead, it uses a unique number assigned to the name: the User ID
(UID) . Similarly every group is identified by its Group ID (GID) and not by its
name.

2. File Basics
Compared to Windows® and most other operating systems, files are handled very
differently under GNU/Linux. In this section we will cover the most obvious differences. For more information, please read Chapter 30, The Linux File System [407].
The major differences result directly from the fact that Linux is a multiuser system:
every file is the exclusive property of one user and one group. One thing we didn't
mention about users is that every one of them possesses a personal directory (called
the home directory). The user is the owner of this directory and all files created in
it. Also note that these have an associated group as well and it is the primary group
that the user belongs to. As it was mentioned before (see Section 1, “Users and
Groups” [381]), a user may be in more than one group at the same time.
However, this would not be very useful if that were the only notion of file ownership. As the file owner, a user may set permissions on files. These permissions dis383

2. File Basics
tinguish between three user categories: the owner of the file, every user who is a
member of the group associated with the file (also called the owner group) but who
is not the owner, and others, which includes every other user who is neither the
owner nor a member of the owner group.
There are three different permissions:
1.

Read permission (r): enables a user to read the contents of a file. For a directory,
the user can list its contents (i.e. the files in this directory).

2.

Write permission (w): allows modification of a file's content. For a directory,
the write permission allows a user to add or remove files from this directory,
even if he is not the owner of these files.

3.

eXecute permission (x): enables a file to be executed (normally only executable
files have this permission set). For a directory, it allows a user to traverse it,
which means going into or through that directory. Note that this is different
to the read access: you may be able to traverse a directory but still be unable
to read its content!

Every permission combination is possible. For example, you can allow only yourself
to read the file and forbid access to all other users. As the file owner, you can also
change the owner group (if and only if you're a member of the new group).
Lets take the example of a file and a directory. The display below represents entering the ls -l command from the command line:
$ ls -l
total 1
-rw-r----drwxr-xr-$

1 queen
2 peter

users
users

0 Jul
1024 Jul

8 14:11 a_file
8 14:11 a_directory/

The results of the ls -l command are (from left to right):
• The first ten characters represent the file's type and the permissions associated
with it. The first character is the file's type: if it's a regular file, you will see a
dash (-). If it's a directory, the leftmost character will be a d. There are other
file types, which we'll discuss later on. The next nine characters represent permissions associated with that file. The nine characters are actually three groups
of three permissions. The first group represents the rights associated with the
file owner; the next three apply to all users belonging to the owner group; and
the last three apply to others. A dash (-) means that the permission is not set.
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• Next comes the number of links for the file. Later on we'll see that the unique
identifier of a file is not its name, but a number (the inode number), and that it's
possible for one file on disk to have several names. For a directory, the number
of links has a special meaning, which will also be discussed a bit further.
• The next piece of information is the name of the file owner followed by the
name of the owner group.
• Finally, the size of the file (in bytes) and its last modification time are displayed,
with the name of the file or directory itself as the last item on the line.
Lets take a closer look at the permissions associated with each of these files. First
of all, we must strip off the first character representing the type, and for the file
a_file, we get the following rights: rw-r-----. Here's a breakdown of the permissions.
• The first three characters (rw-) are the owner's rights, which in this case is
queen. Therefore, queen has the right to read the file (r), to modify its content
(w) but not to execute it (-).
• the next three characters (r--) apply to any user who is not queen but who is
a member of the users group. They will be able to read the file (r), but will not
be able to write nor execute it (--).
• the last three characters (---) apply to any user who is not queen and is not a
member of the users group. Those users don't have any rights on the file at
all, for them the file will be “invisible”.
For the a_directory directory, the rights are rwxr-xr--, so:
• peter, as the directory owner, can list files contained inside (r), add to or remove
files from that directory (w), and may traverse it (x).
• Each user who isn't peter, but is a member of the users group, will be able to
list files in this directory (r), but not remove or add files (-), and will be able
to traverse it (x).
• Every other user will only be able to list the contents of this directory (r). Because they don't have wx permissions, they won't be able to write files or enter
the directory.
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There is one exception to these rules: root. root can change attributes (permissions,
owner and group owner) of all files, even if he's not the owner, and could therefore
grant ownership of the file to himself! root can read files on which he has no read
permissions, traverse directories which he would normally have no access to, and
so on. And if root lacks a permission, he only has to add it. root has complete
control over the system, which involves a certain amount of trust in the person
wielding the root password.
Lastly, it's worth noting the differences between file names in the UNIX® and the
Windows® worlds. For one, UNIX® allows for a much greater flexibility and has
fewer limitations.
• A file name may contain any character, including non-printable ones, except
for the ASCII character 0, which denotes the end of a string, and / , which is
the directory separator. Moreover, because UNIX® is case sensitive, the files
readme and Readme are different, because r and R are considered two different
characters on UNIX®-based systems.
• As you may have noticed, a file name does not have to include an extension,
unless that's the way you prefer to name your files. File extensions don't
identify the content of files under GNU/Linux, nor almost any other operating
system. So-called “file extensions” are quite convenient though. The period (.)
under UNIX® is just one character among others, but it also has one special
meaning. Under UNIX®, file names beginning with a period are “hidden files”1,
which also includes directories whose names start with a .
However it's worth noting that many graphical applications (file managers, office applications, etc.) actually use file extensions to recognize
their files. It is therefore a good idea to use file-name extensions for those
applications which support them.

3. Processes
A process defines an instance of a program being executed and its environment. We
will only mention the most important differences between GNU/Linux and Windows® here (please refer to Chapter 36, Process Control [487] for more information).
The most important difference is directly related to the user concept: each process
is executed with the rights of the user who launched it. Internally, the system
1

By default, hidden files won't be displayed in a file manager, unless you tell it to. In a terminal, you
must type the ls -a command to see all hidden files besides normal files. Essentially, they hold configuration information. From your home/ directory, take a look at .mozilla or .openoffice to see an
example.
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identifies processes with a unique number, called process ID, or PID. From this
PID, the system knows who (that is, which user) has launched the process and a
number of other pieces of information, and the system only needs to verify the
process' validity. Lets take our a_file example. peter will be able to open this file
in read-only mode, but not in read-write mode because the permissions associated
with the file forbid it. Once again the exception to this rule is root.
Because of this, GNU/Linux is virtually immune to viruses. In order to operate,
viruses must infect executable files. As a user, you don't have write access to vulnerable system files, so the risk is greatly reduced. Generally speaking, viruses are
very rare in the UNIX® world. There are only a few known viruses for Linux, and
they are harmless when executed by a normal user. Only one user can damage a
system by activating these viruses: root.
Interestingly enough, anti-virus software does exist for GNU/Linux, but mostly
for DOS/Windows® files! Why are there anti-virus programs running on
GNU/Linux which focus on DOS/Windows®? More and more often, you will see
GNU/Linux systems acting as file servers for Windows® machines with the help
of the Samba software package (see the Sharing Files and Printers chapter of the
Server Administration Guide).
Linux makes it easy to control processes. One way is with “signals”, which allow
you to suspend or kill a process by sending it the corresponding signal. However,
you are limited to sending signals to your own processes. With the exception of
root, Linux and UNIX®-based systems do not allow you to send signals to a process
launched by any other user. In Chapter 36, Process Control [487], you will learn how
to obtain the PID of a process and how to send it signals.

4. A Short Introduction to the Command Line
The command line is the most direct way to send commands to your machine. If
you use the GNU/Linux command line, you will soon find that it is much more
powerful and capable than other command prompts you may have encountered
previously. This power is available because you have access, not only to all X applications, but also to thousands of other utilities in console mode (as opposed to
graphical mode) which don't have graphical equivalents, with their many options
and possible combinations, which would be hard to access in the form of buttons
or menus.
Admittedly most people require a little help to get started. If you're not already
working in console mode and are using the graphical interface, the first thing to
do is to launch a terminal emulator. Access the main menu and you will find
emulators in the System + Terminals menu. Choose the one you want, for example
Konsole or RXvt . Depending on your user interface, there may also be an icon
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which clearly identifies it on the panel (Figure 27.2, “The Terminal Icon on the
KDE Panel” [388]).

Figure 27.2. The Terminal Icon on the KDE Panel
When you launch this terminal emulator, you are actually using a shell. This is
the name of the program which you interact with. You will find yourself in front
of the prompt:
[queen@localhost queen]$

This assumes that your user name is queen and that your machine's name is localhost (which is the case if your machine is not part of an existing network). Following the prompt there is space for you to type your commands. Note that when
you're root, the prompt's $ character becomes a # (this is true only in the default
configuration, since you may customize all such details in GNU/Linux). In order
to become root, type su after launching a shell.
[queen@localhost queen]$ su
# Enter the root password; (it will not be echoed to the screen)
Password:
# exit (or Ctrl-D) will take you back to your normal user account
[root@localhost queen]# exit
[queen@localhost queen]$

When you launch a shell for the first time, you normally find yourself in your
home/ directory. To display the name of the directory you are currently in, type
pwd (which stands for Print Working Directory):
$ pwd
/home/queen

Next we will look at a few basic commands which are very useful.

4.1. cd: Change Directory
The cd command is just like the DOS one, with extras. It does just what its acronym
states, changes the working directory. You can use . and .., which respectively
stand for the current and parent directories. Typing cd alone will take you back
to your home directory. Typing cd - will take you back to the last directory you
visited. And lastly, you can specify peter's home directory by typing cd ~peter (~
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on its own means your own home/ directory). Note that as a normal user, you
cannot usually get into another user's home/ directory (unless they explicitly authorized it or if this is the default configuration on the system), unless you are
root, so lets become root and practice:
$ su Password:
# pwd
/root
# cd /usr/share/doc/HOWTO
# pwd
/usr/share/doc/HOWTO
# cd ../FAQ-Linux
# pwd
/usr/share/doc/FAQ-Linux
# cd ../../../lib
# pwd
/usr/lib
# cd ~peter
# pwd
/home/peter
# cd
# pwd
/root

Now, go back to being a normal user again by typing exit and pressing the Enter
key (or simply by pressing Ctrl - D ).

4.2. Some Environment Variables and the echo Command
All processes have their environment variables and the shell allows you to view
them directly with the echo command. Some interesting variables are:
1.

HOME: this environment variable contains a string which represents the path
to your home directory.

2.

PATH: it contains the list of all directories in which the shell should look for
executable files when you type a command. Note that unlike DOS, by default,
a shell will not look for commands in the current directory!

3.

USERNAME: this variable contains your login name.

4.

UID: this one contains your user ID.
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5.

PS1: determines what your prompt will display, and is often a combination
of special sequences. You may read the bash(1) manual page for more information by entering the man bash command in a terminal.

To have the shell print a variable's value, you must put a $ in front of its name.
Here's an example with the echo command:
$ echo Hello
Hello
$ echo $HOME
/home/queen
$ echo $USERNAME
queen
$ echo Hello $USERNAME
Hello queen
$ cd /usr
$ pwd
/usr
$ cd $HOME
$ pwd
/home/queen

As you can see, the shell substitutes the variable's value before it executes the
command. Otherwise, our cd $HOME example would not have worked. In fact,
the shell first replaced $HOME with its value (/home/queen) so the line became cd
/home/queen, which is what we wanted. The same thing happened with the echo
$USERNAME example.
If one of your environment variables doesn't exist, you can create them
temporarily by typing export ENV_VAR_NAME=value. Once this is
done, you can verify it has been created:
$ export USERNAME=queen
$ echo $USERNAME
queen

4.3. cat: Print the Contents of One or More Files to the Screen
Nothing much to say, this command does just that: it prints the contents of one or
more files to the standard output, normally the screen:
$ cat /etc/fstab
# This file is edited by fstab-sync - see 'man fstab-sync' for details
/dev/hda2 / ext3 defaults 1 1
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/dev/hdc /mnt/cdrom auto umask=0022,user,iocharset=utf8,noauto,ro,exec,users →
0 0
none /mnt/floppy supermount →
dev=/dev/fd0,fs=ext2:vfat,--,umask=0022,iocharset=utf8,sync 0 0
none /proc proc defaults 0 0
/dev/hda3 swap swap defaults 0 0
$ cd /etc
$ cat modprobe.preload
# /etc/modprobe.preload: kernel modules to load at boot time.
#
# This file should contain the names of kernel modules that are
# to be loaded at boot time, one per line. Comments begin with
# a `#', and everything on the line after them are ignored.
# this file is for module-init-tools (kernel 2.5 and above) ONLY
# for old kernel use /etc/modules
nvidia-agp
$ cat shells
/bin/bash
/bin/csh
/bin/sh
/bin/tcsh

4.4. less: a Pager
The name is a play on words related to the first pager ever used under UNIX®
called more. A pager is a program which allows a user to view long files page by
page (more accurately, screen by screen). The reason that we discuss less rather
than more is that less is more intuitive. You should use less to view large files
which will not fit on a single screen. For example:
less /etc/termcap

To browse through this file, use the up and down arrow keys. Press Q to quit.
less can do far more than just that: press H for help to display the various options
available.

4.5. ls: Listing Files
The ls (LiSt) command is equivalent to the dir command in DOS, but it can do
much much more. In fact, this is largely because files can do more too. The command syntax for ls is:
ls [options] [file|directory] [file|directory...]
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If no file or directory is specified on the command line, ls will list files in the current
directory. Its options are numerous, so we will only describe a few of them:
• -a: lists all files, including hidden files. Remember that in UNIX®, hidden files
are those whose names begin with a .; the -A option lists “almost” all files,
which means every file the -a option would print except for “.” and “..”
• -R: lists recursively, i.e. all files and sub-directories of directories entered on
the command line.
• -h: if the file size is shown, it is in a human readable format, next to each file.
It means that you'll see file sizes using suffixes like “K”, “M” and “G”, for example “234K” and “132M”. Please also note that sizes are referred in a power
of 2, not a power of 10. It means that 1K is really 1024 bytes instead of 1000
bytes.
• -l: prints additional information about the files such as the permissions associated to it, the owner and owner group, the file's size and the last-modification
time.
• -i: prints the inode number (the file's unique number in the file system, see
Chapter 30, The Linux File System [407]) next to each file.
• -d: treats directories on the command line as if they were normal files rather
than listing their contents.
Here are some examples:
• ls -R: recursively lists the contents of the current directory.
• ls -ih images/ ..: lists the inode number and the size, in human-readable format,
for each file in the images/ directory as well as in the parent directory of the
current one.
• ls -l images/*.png: lists all files in the images/ directory whose names end with
.png, including the file .png, if it exists.

4.6. Useful Keyboard Shortcuts
There are a number of shortcuts available, their primary advantage being that they
may save you a lot of typing time. This section assumes you're using the default
shell provided with Mandriva Linux, bash, but these keystrokes might work with
other shells too.
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First: the arrow keys. bash maintains a history of previous commands which you
can view with the up and down arrow keys. You can scroll up to a maximum
number of lines defined in the HISTSIZE environment variable. In addition, the
history is persistent from one session to another, so you won't lose all the commands
you typed in previous sessions.
The left and right arrow keys move the cursor left and right on the current line,
allowing you to edit your commands. But there's more to editing than just moving
one character at a time: Ctrl - A and Ctrl - E , for example, will take you to the beginning and the end of the current line. The Backspace and Del keys work as expected. Ctrl - K will delete from the position of the cursor to the end of line, and
Ctrl - W will delete the word before the cursor (so will Alt - Backspace ).
Typing Ctrl - D on a blank line will let you close the current session, which is much
shorter than having to type exit. Ctrl - C will interrupt the currently running
command, except if you were in the process of editing your command line, in
which case it will cancel the editing and put you back to the prompt. Ctrl - L clears
the screen. Ctrl - Z temporarily stops a task, it suspends it. This shortcut is very
useful when you forget to type the “&” character after typing a command. For instance:
$ xpdf MyDocument.pdf

Hence you cannot use your shell anymore since the foreground task is allocated
to the xpdf process. To put that task in the background and restore your shell,
simply type Ctrl - Z and then enter the bg command.
Finally, there are Ctrl - S and Ctrl - Q , which are used to suspend and restore
output to the screen. They are not used often, but you might type Ctrl - S by mistake
(after all, S and D are close to each other on the keyboard). So, if you get into the
situation where you're typing but you can't see any characters appearing on the
Terminal, try Ctrl - Q . Note that all the characters you typed between the unwanted
Ctrl - S and Ctrl - Q will be printed to the screen all at once.
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Chapter 28. Disks and Partitions
This chapter contains information for those who simply wish to know more about
the technical details underlying their system. It will give a complete description
of the PC partitioning scheme. Therefore it will be most useful if you are planning
to manually configure your hard drive partitions.

1. Structure of a Hard Disk
A disk is physically divided into sectors. A sequence of sectors can form a partition.
Roughly speaking, you can create as many partitions as you wish, up to 67 (3
primary partitions and a secondary partition containing up to 64 logical partitions
inside): each partition is regarded as a single hard drive.

1.1. Sectors
To simplify, a hard disk is merely a sequence of sectors, which are the smallest
data unit on a hard disk. The typical size of a sector is 512 bytes. The sectors on a
hard disk of “n” sectors are numbered from “0” to “n-1”.

1.2. Partitions
The use of multiple partitions enables you to create many virtual hard drives on
your real physical drive. This has many advantages:
• Different operating systems use different disk structures (called file systems):
this is the case with Windows® and GNU/Linux. Having multiple partitions
on a hard drive also allows you to install various operating systems on the
same physical drive.
• For performance reasons, an operating system may prefer different drives with
various file systems on them because they may be used for completely different
things. One example is GNU/Linux which requires a second partition called
Swap. The latter is used by the virtual memory manager as virtual memory.
• Even if all of your partitions use the same file system, it may prove useful to
separate the different parts of your OS into different partitions. A simple configuration example would be to split your files into two partitions: one for your
personal data, and another one for your programs. This allows you to update
your OS, completely erasing the partition containing the programs while
keeping the data partition safe.
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• Because physical errors on a hard disk are generally located on adjacent sectors,
not scattered across the disk, distributing your files across different partitions
could limit data loss if your hard disk is physically damaged.
Normally, the partition type specifies the file system which the partition is supposed
to contain. Each operating system might recognize some partition types, but not
others. Please see Chapter 32, File Systems and Mount Points [433], and Chapter 30,
The Linux File System [407], for more information.

1.3. Defining the Structure of Your Disk
1.3.1. The Simplest Way
This scenario would imply only two partitions: one for the Swap space, the other
one for the files1, called root and labelled as /.
A rule of thumb is to set the swap partition size to twice the size of your
RAM memory (i.e.: if you have 128 MB of RAM memory the swap size
should be of 256 MB). However for large memory configurations (512
MB or more), this rule isn't critical, and smaller sizes are acceptable.
Please bear in mind that the swap partition's size may be limited depending on which platform you are using. For example it is limited to 2GB in
x86, PowerPC and MC680x0; to 512MB on MIPS; to 128GB on Alpha and
to 3TB on Ultrasparc. Bear in mind also that the larger the swap partition,
the greater the amount of OS resources (notably RAM memory) needed
to manage it.

1.3.2. Another Common Scheme
Separate data from programs. To be even more efficient, one usually defines more
partitions to separate the system and programs from the data. The system partition
will contain the programs required to start your system and to perform basic
maintenance.
Therefore we could define four partitions:
Swap
A Swap partition whose size is roughly twice the size of physical RAM.

1

The default file system used by Mandriva Linux is called ext3
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Root: /
The most important partition. Not only does it contain critical data and programs for the system, it also acts as a mount point for other partitions (see
Chapter 32, File Systems and Mount Points [433]).
The needs of the root partition in terms of size are not great, 400MB is generally
enough. However, if you plan to install commercial applications, which are
often located in the /opt directory, you will need to increase the size of the
root partition accordingly. Alternatively, you could create a separate partition
for /opt.
Static data: /usr
Most packages install the majority of their executables and data files under
the /usr directory. The advantage of creating a separate partition is that it allows you to easily share it with other machines over a network.
The recommended size depends on the packages you wish to install, and can
vary from 100MB for a very lightweight installation, to several GB for a full
installation. A compromise of two or three GB (depending on your disk size)
is usually sufficient.
Home directories: /home
This directory contains the personal directories for all of the users hosted on
your machine. The partition size depends on the number of users hosted and
their needs.
Another solution is to not create a separate partition for the /usr files: /usr could
simply be a directory inside the root (/) partition, however you would need to increase the size of your root (/) partition accordingly.
Finally, you could also only create the Swap and root (/) partitions, in case you're
not sure what you want to do with your computer. In this case, your /home directory
would be located on the root partition, as would the /usr and the other directories.

1.3.3. Exotic Configurations
When setting up your machine for specific uses –– such as a web server or a firewall –– the needs are radically different to that of a standard desktop machine. For
example, a FTP server will probably need a large separate partition for /var/ftp,
while the /usr directory could be relatively small. In these situations, you're encouraged to carefully think about your needs before even beginning the installation
process.
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It is possible to resize most partitions; if you do need to resize them or
to use a different partition scheme, without the need to reinstall your
system and without losing your data. Please consult Section 1, “Managing
your Hard Drive Partitions with DiskDrake” [303].
With some practice, you'll even be able to move a crowded partition to
a brand new hard drive.

2. Conventions for Naming Disks and Partitions
GNU/Linux uses a logical method to name partitions. First, when numbering the
partitions, it ignores the file-system type of any partition you may have. Second,
it names the partitions according to the disk on which they are located. This is how
the disks are named:
• The primary master and primary slave IDE devices (whether they be hard
disks, CD-ROM drives or anything else) are called /dev/hda and /dev/hdb respectively.
• On the secondary interface, the master is called /dev/hdc and the slave is
/dev/hdd.
• If your computer contains other IDE interfaces (for example, the IDE interface
present on some Soundblaster™ cards), the disks will be called /dev/hde,
/dev/hdf, etc. You may also have additional IDE interfaces if you have RAID
controllers.
• SCSI disks are called /dev/sda, /dev/sdb, etc., in the order of their appearance
on the SCSI chain (depending on the increasing IDs). The SCSI CD-ROM drives
are called /dev/scd0, /dev/scd1, always in the order of their appearance on
the SCSI chain.
If you have SATA IDE disks, the SCSI naming scheme applies.

The partitions are named after the disk on which they're found, in the following
way (in our example, we've used partitions on a primary master IDE disk but the
same applies to all other types of disks):
• The primary (or extended) partitions are named /dev/hda1 through /dev/hda4,
when present.
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• Logical partitions, if any, are named /dev/hda5, /dev/hda6, etc. in the order
of their appearance in the table of logical partitions.
So GNU/Linux will name the partitions as follows:
First Primary Partition
/dev/hda1
Primary Master IDE Hard Disk (/dev/hda)

First Primary Partition
/dev/hdb1

Second Primary Partition
/dev/hdb2

Primary Slave IDE Hard Disk (/dev/hdb)

Figure 28.1. First Example of Partition Naming under GNU/Linux
Primary Partition
/dev/hda1

Extended Partition (/dev/hda2)
/dev/hda5

/dev/hda6

1st Logical Partition

2nd Logical Partition

Primary Master IDE Hard Disk (/dev/hda)

First Primary Partition
/dev/hdb1

Second Primary Partition
/dev/hdb2

Primary Slave IDE Hard Disk (/dev/hdb)

Figure 28.2. Second Example of Partition Naming under GNU/Linux
With this knowledge in hand, you should be able to name your various partitions
and hard disks when you need to manipulate them. You'll also see that GNU/Linux
399

2. Conventions for Naming Disks and
Partitions
names the partitions even if it doesn't know how to manage them initially (it ignores
the fact that they're not native GNU/Linux partitions).
Mandriva Linux now uses udev (refer to the udev FAQ [http://www.
kernel.org/pub/linux/utils/kernel/hotplug/udev-FAQ] for more information). It ensures full compatibility with the scheme described above
and with standards like the Linux Standards Base Project [http://www.
linuxbase.org/]. Each device is dynamically added to the system as soon
as it becomes available or needed.
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Nowadays, a UNIX® system is big, very big. This is especially true of GNU/Linux:
the amount of software available would make for an unmanageable system if no
guidelines for the location of files in the tree existed.
The acknowledged standard is the FHS (Filesystem Hierarchy Standard) for which
version 2.3 was released in January 2004. The document which describes the
standard is available on the Internet in different formats on The Pathname web
site [http://www.pathname.com/fhs/]. This chapter will only provide a brief
summary, but it should be enough to show you which directory is likely to contain
a given file, or where a given file should be placed.

1. Shareable/unshareable, Static/Variable Data
Data on a UNIX® system can be classified according to the following criteria:
shareable data may be common to several computers in a network, while unshareable cannot. Static data must not be modified in normal use, while variable data
may be. As we explore the tree structure, we will classify the different directories
into each of these categories.
These classifications are only a recommendation. It's not mandatory to
follow them, but adopting these guidelines will greatly help you manage
your system. Also, bear in mind that the static/variable distinction only
applies to general system usage, not its configuration. If you install a
program, you will obviously have to modify “normally” static directories,
such as /usr.

2. The root Directory: /
The root directory contains the entire system hierarchy. It cannot be classified since
its sub-directories may or may not be static or shareable. Here is a list of the main
directories and sub-directories, with their classifications:
• /bin: essential binary files. It contains the basic commands which will be used
by all users and which are necessary for the operation of the system: ls, cp, login,
etc. Static, unshareable.
• /boot: contains the files required by the GNU/Linux bootloader (GRUB or
LILO for Intel, yaboot for PPC, etc). It may or may not contain the kernel, but
if the kernel isn't located in this directory then it must be in the root directory.
Static, unshareable.
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• /dev: system device files (dev for DEVices). Some files contained by /dev are
mandatory, such as /dev/null, /dev/zero, and /dev/tty. Static, unshareable.
• /etc: contains all configuration files specific to the computer. This directory
cannot contain binary files. Static, unshareable.
• /home: where all the personal directories of the system's users are located. This
directory may or may not be shared (some large networks make it shareable
via NFS). Your favorite application's (like e-mail readers or browsers) configuration files are located in this directory and start with a period (“.”). For instance,
the Mozilla configuration files lie in the .mozilla directory. Variable, shareable.
• /lib: it contains libraries which are essential to the system; it also stores kernel
modules in the /lib/modules/KERNEL_VERSION sub-directory. It contains all
libraries required by the binaries in the /bin and /sbin directories. The optional
ld* execution time linker/loader as well as the dynamically-linked C library
libc.so must also reside in this directory. Static, unshareable.
• /mnt: directory containing the mount points for temporarily-mounted file systems such as /mnt/cdrom, /mnt/floppy, etc. The /mnt directory is also used to
mount temporary directories (a USB card will be mounted in /mnt/removable,
for instance). Variable, unshareable.
• /opt: contains packages not essential for system operation. It is reserved for
add-on packages; packages such as Adobe Acrobat Reader are often installed
into /opt. The FHS recommends that static files (binaries, libraries, manual
pages, etc.) installed in the /opt structure be placed in /opt/package_name and
the specific configuration files in /etc/opt.
• /root: home directory for root. Variable, unshareable.
• /sbin: contains system binaries essential for system start-up. Most of these files
can only be executed by root. A normal user may run them, but they might
not do anything. Static, unshareable.
• /tmp: directory intended to contain temporary files which certain programs
may create. Variable, unshareable.
• /usr: explained in more detail in Section 3, “/usr: The Big One” [403]. Static,
shareable.
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• /var: location for data which may be modified in real time by programs (such
as mail servers, audit programs, print servers, etc.). Variable. Its various subdirectories may be shareable or unshareable.

3. /usr: The Big One
The /usr directory is the main application-storage directory. The binary files in
this directory are not required for system start-up or maintenance, so the /usr
hierarchy may be, and often is, located on a separate file system. Because of its
(usually) large size, /usr has its own hierarchy of sub-directories. We will mention
just a few:
• /usr/X11R6: the entire X Window System hierarchy. All binaries and libraries
required for the operation of X (including the X servers) must be located here.
The /usr/X11R6/lib/X11 directory contains all aspects of X's configuration
which do not vary from one computer to another. Specific configurations for
each computer should go in /etc/X11.
• /usr/bin: contains the majority of the system's binaries. Any binary program
which isn't necessary for the maintenance of the system and isn't a system administration program must be located in this directory. The only exceptions
are programs you compile and install yourself, which must be located in
/usr/local.
• /usr/lib: contains all the necessary libraries to run programs located in
/usr/bin and /usr/sbin. There is also a /usr/lib/X11 symbolic link pointing
to /usr/X11R6/lib/X11, the directory which contains the X Window System
libraries (but only if X is installed)1.
• /usr/local: this is where you must install any applications you compile from
source. The installation program should create the necessary hierarchy.
• /usr/share: this directory contains all read-only, architecture-independent
data required by applications in /usr. Among other things, you will find zone
and location information (zoneinfo and locale).
Let's also mention the /usr/share/doc and /usr/share/man directories, which
respectively contain application documentation and the system's manual pages.

1

Please note that Mandriva Linux now uses Xorg instead of X Window System as the default X Window
system.
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The /var directory contains all operative data for programs running on the system.
Unlike the working data in /tmp, this data must be kept intact in the event of a
reboot. There are many sub-directories, and some are very useful:
• /var/log: contains the system's log files which you may read to troubleshoot
your system (/var/log/messages and /var/log/kernel/errors to only name
those two).
• /var/run: used to keep track of all processes utilized by the system since it was
booted, enabling you to act on them in the event of a system runlevel change
(see Chapter 37, The Start-Up Files: init sysv [493]).
• /var/spool: contains the system's working files waiting for some kind of action
or processing. For example, /var/spool/cups contains the print server's
working files, while /var/spool/mail contains the mail server's working files
(for example, all mail arriving and leaving your system).

5. /etc: Configuration Files
/etc is one of UNIX® systems' most essential directories because it contains all the
host-specific configuration files. Never delete it to save space! Likewise, if you want
to extend your tree structure over several partitions, remember that /etc must not
be put on a separate partition: it is needed for system initialization and must be
on the root partition at boot time.
Here are some important files:
• passwd and shadow: these are text files which contain all system users and their
encrypted passwords. You will only see shadow if shadow passwords are used,
which happens to be the default installation option for security reasons.
• inittab: this is the configuration file for init which plays a fundamental role
in starting up the system. Please refer to Section 5.3.1, “Booting Into a Different
Run Level” [364].
• services: this file contains a list of existing network services.
• profile: this is the shell system-wide configuration file. Its settings can be
overridden by shell-specific configuration files. For example, .bashrc for the
bash shell.
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• crontab: the configuration file for cron, the program responsible for periodic
execution of commands.
Certain sub-directories exist for programs which require a large number of configuration files. This applies to the X Window System, for example, which stores all
of its configuration files in the /etc/X11 directory.
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Chapter 30. The Linux File System
Your GNU/Linux system is contained on your hard disk within a file system. In
this chapter we will discuss the various aspects of file systems available on
GNU/Linux, as well as the possibilities they offer.

1. Comparing a Few File Systems
During installation, you can choose different file systems for your partitions, so
they will be formatted using different algorithms.
Unless you are a specialist, choosing a file system is not obvious. We will take a
quick look at a few current file systems, all of which are available with Mandriva
Linux.

1.1. Different Usable File Systems
1.1.1. Ext2
The Second Extended File System (its abbreviated form is ext2FS or simply ext2)
has been GNU/Linux's default file system for many years. It replaced the Extended
File System (that's where the “Second” comes from). ext2 corrects certain problems
and limitations of its predecessor.
ext2 respects the usual standards for UNIX®-type file systems. Since its inception,
it was destined to evolve while still offering great robustness and good performance.
Caution: It needs to be unmounted to be resized.

1.1.2. Ext3
As its name suggests, the Third Extended File System is ext2's successor. It is
compatible with the latter but enhanced by incorporating journaling.
One of the major flaws of “traditional” file systems like ext2 is their low tolerance
to abrupt system breakdowns (power failure or crashing software). Generally
speaking, once the system is restarted, these types of events involve a very long
examination of the file system's structure and attempts to correct errors, which
sometimes results in an extended corruption. This corruption could cause partial
or total loss of saved data.
Journaling answers this problem. To simplify, let's say that what we are doing is
storing the actions (such as the saving of a file) before really performing them. We
could compare this functionality to that of a boat captain who uses a log book to
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note daily events. The result: an always coherent file system. And if problems occur,
the verification is very rapid and the eventual repairs, very limited. Therefore the
time spent in verifying a file system is proportional to its actual use and not related
to its size.
So ext3 offers journaling file system technology while keeping ext2's structure,
ensuring excellent compatibility. This makes it very easy to switch from ext2 to
ext3 and back again.
As with ext2, it needs to be unmounted to be resized.

1.1.3. ReiserFS
Unlike ext3, reiserfs was written from scratch. It is a journalized file system like
ext3, but its internal structure is radically different because it uses binary-tree
concepts inspired by database software and also has a variable block size, making
it optimal for use with several (thousands or hundreds of thousands of) small files.
It also performs well with big files, making it suitable for various uses.
It can be resized “on the fly”, without unmounting the file system.

1.1.4. JFS
JFS is the journalized file system designed and used by IBM. Proprietary and closed
at first, IBM decided to open it to access to the free software movement. Its internal
structure is similar to that of reiserfs.
It can not be resized on GNU/Linux.

1.1.5. XFS
XFS is the journalized file system designed by SGI and also used with the Irix operating system. Proprietary and closed at first, SGI decided to open it to access by
the free software movement. Its internal structure has lots of different features,
such as support for real-time bandwidth, extents, and clustered file systems (but
not in the free version).
With GNU/Linux it can be resized for a bigger size only. You can't reduce
it. Resizing can only be made with a mounted filesystem.
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Table 30.1. File System Characteristics
Ext2

Ext3

Stability

Excellent

Very Good Good

Medium Good

Tools to restore
erased files

Yes (complex)

Yes (complex)

No

No

Fast

Very fast Very fast Very fast

Reboot time after Long, even very
crash
long

ReiserFS JFS

XFS
No

Status of the data Generally speak- Very good Mediuma Very
in case of a crash ing, good, but
good
high risk of partial
or total data loss

Very
good

ACL support

Yes

Yes

Yes

No

No

a

It is possible to improve results on crash recovery by journaling the data and not just the metadata,
adding the option data=journal to /etc/fstab.

The maximum size of a file depends on many parameters (i.e. the block size for
ext2/ext3), and is likely to evolve depending on the kernel version and architecture.
In kernel 2.6.X the block device limit can be extended using a kernel compiled with
Large Block Device support enabled (CONFIG_LBD=y). For more information, consult
Adding Support for Arbitrary File Sizes to the Single UNIX Specification [http://
www.unix.org/version2/whatsnew/lfs.html], Large File Support in Linux [http:
//www.suse.com/~aj/linux_lfs.html], and Large Block Devices [http://www.
gelato.unsw.edu.au/IA64wiki/LargeBlockDevices]. With this and a file system
which supports it you can reach up to many TB without special file-system tricks
as is done by JFS for the file-system size.

1.3. And Performance Wise?
It is always very difficult to compare performance between file systems. All tests
have their limitations and the results must be interpreted with caution, comparisons
done a couple of months or weeks ago are already too old. Let's not forget that
today's hardware (specially concerning hard drive capacities and hard disk controller performance) has greatly leveraged the differences between the different
file systems.
Each system offers advantages and disadvantages. In fact, it all depends on how
you use your machine. A simple desktop machine will be happy with ext2. For a
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server, a journalized file system such as ext3 is preferred. reiserfs, perhaps because
of its genesis, is more suited to a database server. JFS is preferred in cases were
file system throughput is the main issue. XFS is interesting if you need any of its
advanced features. For “normal” use, these four file systems give approximately
the same results and all of them have different options to tune the file system for
a particular use. Please refer to the file system's documentation for more information.

2. Everything is a File
We introduced the file ownership and permissions access concepts, but really understanding the UNIX® file system (and this also applies to Linux's file systems)
requires that we redefine the concept of “What is a file”.
Here, “everything” really means everything. A hard disk, a partition on a hard
disk, a parallel port, a connection to a web site, an Ethernet card: all these are files.
Even directories are files. Linux recognizes many types of files in addition to the
standard files and directories. Note that by file type here, we do not mean the type
of content of a file: for GNU/Linux and any UNIX® system, a file, whether it be a
PNG image, a binary file or whatever, is just a stream of bytes. Differentiating files
according to their contents is left to applications.

2.1. The Different File Types
When you issue ls -l, the character before the access rights identifies the file type.
We have already seen two types of files: regular files (-) and directories (d). You
can also find other types if you wander through the file tree and list the contents
of directories:
1.

Character mode files: they are either special system files (such as /dev/null,
which we have already discussed), or peripherals (serial or parallel ports),
which share the trait that their contents (if they have any) are not buffered
(meaning they are not kept in memory). Such files are identified by the letter
c.

2.

Block mode files: these files are peripherals, and unlike character files, their
contents are buffered. For example, some files in this category are: hard disks,
partitions on a hard disk, floppy drives, CD-ROM drives and other storage
devices. Files like /dev/hda, /dev/sda5 are examples of block-mode files. Such
files are identified by the letter b.

3.

Symbolic links: these files are very common and heavily used in the Mandriva
Linux system start-up procedure (see Chapter 37, The Start-Up Files: init
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sysv [493]). As their name implies, their purpose is to link files in a symbolic
way, which means that they are files whose content is the path to a different
file. They may not point to an existing file. They are very frequently called
soft links, and such files are identified by the letter l.
4.

Named pipes: in case you were wondering, yes, these are very similar to pipes
used in shell commands, but with the difference that these actually have
names. However they are very rare and it's not likely that you will see one
during your journey into the file tree. Such files are identified by the letter p.
See Section 4, ““Anonymous” Pipes and Named Pipes” [413].

5.

Sockets: this is the file type for all network connections, but only a few of them
have names. What's more, there are different types of sockets and only one
can be linked, but this is way beyond the scope of this book. Such files are
identified by the letter s.

Here is a sample of each file:
$ ls -l /dev/null /dev/sda /etc/rc.d/rc3.d/S20random /proc/554/maps \
/tmp/ssh-queen/ssh-510-agent
crw-rw-rw1 root
root
1,
3 May 5 1998 /dev/null
brw-rw---1 root
disk
8,
0 May 5 1998 /dev/sda
lrwxrwxrwx
1 root
root
16 Dec 9 19:12 /etc/rc.d/rc3.d/
S20random -> ../init.d/random*
pr--r--r-1 queen queen
0 Dec 10 20:23 /proc/554/maps|
srwx-----1 queen queen
0 Dec 10 20:08 /tmp/ssh-queen/
ssh-510-agent=
$

2.2. Inodes
Inodes are, along with the “Everything Is a File” paradigm, a fundamental part of
any UNIX® file system. The word inode is short for “Information NODE”.
Inodes are stored on disk in an inode table. They exist for all types of files which
may be stored on a file system, including directories, named pipes, character-mode
files and so on. Which leads to this other famous sentence: “The inode is the file”.
Inodes are how UNIX® identifies a file in a unique way.
No, you didn't misread that: in UNIX®, you do not identify a file by its name, but by
its inode number1. The reason for this is that the same file may have several names,
1

Important: note that inode numbers are unique per file system, which means that an inode with the same
number can exist on another file system. This leads to the difference between on-disk inodes and inmemory inodes. While two on-disk inodes may have the same number if they are on two different file
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or even no name. In UNIX®, a file name is just an entry in a directory inode. Such
an entry is called a link. Let us look at links in more detail.

3. Links
The best way to understand what links are is to look at an example. Let's create a
(regular) file:
$ pwd
/home/queen/example
$ ls
$ touch a
$ ls -il a
32555 -rw-r--r-- 1 queen queen 0 Aug

6 19:26 a

The -i option of the ls command prints the inode number, which is the first field
on the output. As you can see, before we created file a, there were no files in the
directory. The other field of interest is the third one, which is the number of file
links (well, inode links, in fact).
The touch a command can be separated into two distinct actions:
• creation of an inode, to which the operating system has given the number 32555,
and whose type is the one of a regular file;
• creation of a link to this inode, named a, in the current directory
(/home/queen/example). Therefore the /home/queen/example/a file is a link
to the inode numbered 32555, and it's currently the only one: the link counter
shows 1.
But now, if we type:
$ ln a b
$ ls -il a b
32555 -rw-r--r-32555 -rw-r--r-$

2 queen queen 0 Aug
2 queen queen 0 Aug

6 19:26 a
6 19:26 b

We create another link to the same inode. As you can see, we didn't create a file
named b. Instead, we just added another link to the inode numbered 32555 in the
same directory, and attributed the name b to this new link. You can see on the ls
-l output that the link counter for the inode is now 2 rather than 1.
systems, in-memory inodes have a unique number right across the system. One solution to obtain
uniqueness, for example, is to hash the on-disk inode number against the block device identifier.
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Now, if we do:
$ rm a
$ ls -il b
32555 -rw-r--r-$

1 queen queen 0 Aug

6 19:26 b

We see that even though we deleted the “original file”, the inode still exists. But
now, the only link to it is the file named /home/queen/example/b.
Therefore a file in UNIX® has no name; instead, it has one or more link(s) in one
or more directories.
Directories themselves are also stored in inodes. Their link count coincides with
the number of sub-directories within them. This is due to the fact that there are at
least two links per directory: the directory itself (represented by the entry .) and
its parent directory (represented by ..). So a directory with two sub-directories
will have at least four links: ., .. and links for each sub-directory.
Typical examples of files which are not linked (i.e.: have no name) are network
connections. You will never see the file corresponding to your connection to the
Mandriva Linux web site [http://www.mandrivalinux.com] in your file tree, no
matter which directory you look in. Similarly, when you use a pipe in the shell,
the inode corresponding to the pipe exists, but it is not linked. Temporary files are
another example of inodes without names. You create a temporary file, open it,
and then remove it. The file exists while it's open, but nobody else can open it (as
there is no name to open it). This way, if the application crashes, the temporary
file is removed automatically.

4. “Anonymous” Pipes and Named Pipes
Let's get back to the example of pipes, as it is quite interesting and is also a good
illustration of the links notion. When you use a pipe in a command line, the shell
creates the pipe for you and operates so that the command before the pipe writes
to it, while the command after the pipe reads from it. All pipes, whether they be
anonymous (like the ones used by the shells) or named (see below) act like FIFOs
(First In, First Out). We've already seen examples of how to use pipes in the shell,
but let's take another look for the sake of our demonstration:
$ ls -d /proc/[0-9] | head -5
/proc/1/
/proc/2/
/proc/3/
/proc/4/
/proc/5/
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One thing that you will not notice in this example (because it happens too fast for
one to see) is that writes on pipes are blocking. This means that when the ls command writes to the pipe, it is blocked until a process at the other end reads from
the pipe. In order to visualize the effect, you can create named pipes, which unlike
the pipes used by shells, have names (i.e.: they are linked, whereas shell pipes
are not)2. The command to create a named pipe is mkfifo:
$ mkfifo a_pipe
$ ls -il
total 0
169 prw-rw-r-- 1 queen queen 0 Aug 6 19:37 a_pipe|
#
# You can see that the link counter is 1, and that the output shows
# that the file is a pipe ('p').
#
# You can also use ln here:
#
$ ln a_pipe the_same_pipe
$ ls -il
total 0
169 prw-rw-r-- 2 queen queen 0 Aug 6 19:37 a_pipe|
169 prw-rw-r-- 2 queen queen 0 Aug 6 19:37 the_same_pipe|
$ ls -d /proc/[0-9] >a_pipe
#
# The process is blocked, as there is no reader at the other end.
# Type Control Z to suspend the process...
#
[1]+ Stopped
ls -F --show-control-chars --color=auto -d →
/proc/[0-9] >a_pipe
#
# ...Then put in into the background:
#
$ bg
[1]+ ls -F --show-control-chars --color=auto -d /proc/[0-9] >a_pipe &
#
# now read from the pipe...
#
$ head -5 <the_same_pipe
#
# ...the writing process terminates
#
/proc/1/
/proc/2/
2

Other differences exist between the two kinds of pipes, but they are beyond the scope of this book.
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/proc/3/
/proc/4/
/proc/5/
[1]+ Done
/proc/[0-9] >a_pipe
$

ls -F --show-control-chars --color=auto -d →

Similarly, reads are also blocking. If we execute the above commands in the reverse
order, we will see that head blocks, waiting for some process to give it something
to read:
$ head -5 <a_pipe
#
# Program blocks, suspend it: C-z
#
[1]+ Stopped
head -5 <a_pipe
#
# Put it into the background...
#
$ bg
[1]+ head -5 <a_pipe &
#
# ...And give it some food :)
#
$ ls -d /proc/[0-9] >the_same_pipe
/proc/1/
/proc/2/
/proc/3/
/proc/4/
/proc/5/
[1]+ Done
head -5 <a_pipe
$

You can also see an undesired effect in the previous example: the ls command has
terminated before the head command took over. The consequence is that you were
immediately returned to the prompt, but head executed later and you only saw
its output after returning.

5. Special Files: Character Mode and Block Mode Files
As already stated, such files are either created by the system or peripherals on
your machine. We also mentioned that the contents of block mode character files
were buffered, while character mode files were not. In order to illustrate this, insert
a floppy into the drive and type the following command twice:
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$ dd if=/dev/fd0 of=/dev/null

You should have observed the following: the first time the command was launched,
the entire content of the floppy was read. The second time you executed the command, there was no access to the floppy drive at all. This is because the content of
the floppy was buffered the first time you launched the command — and you did
not change anything on the floppy between the two instances.
But now, if you want to print a big file this way (yes it will work):
$ cat /a/big/printable/file/somewhere >/dev/lp0

The command will take as much time, whether you launch it once, twice or fifty
times. This is because /dev/lp0 is a character mode file, and its contents are not
buffered.
The fact that block mode files are buffered has a nice side effect: not only are reads
buffered, but writes are buffered too. This allows for writes to the disks to be
asynchronous: when you write a file on disk, the write operation itself is not immediate. It will only occur when the Linux kernel decides to execute the write to
the hardware. Of course, if you need it can be overridden for a certain filesystem;
take a look at the sync and async options at the mount(8) man page and also at
Section 7, “File Attributes” [418] for more details.
Finally, each special file has a major and minor number. On a ls -l output, they appear in place of the size, as the size for such files is irrelevant:
$ ls -l /dev/hdc /dev/lp0
brw-rw---- 1 queen cdrom 22, 0 Feb 23 19:18 /dev/hdc
crw-rw---- 1 root root 6, 0 Feb 23 19:17 /dev/lp0

Here, the major and minor of /dev/hdc are 22 and 0, whereas for /dev/lp0, they
are 6 and 0. Note that these numbers are unique per file category, which means
that there can be a character mode file with major 22 and minor 0, and similarly,
there can be a block mode file with major 6 and minor 0. These numbers exist for
a simple reason: it allows the kernel to associate the correct operations to these
files (that is, to the peripherals these files refer to): you don't handle a floppy drive
the same way as, say, a SCSI hard drive.

6. Symbolic Links, Limitation of “Hard” Links
Here we have to face a very common misconception, even among UNIX® users,
which is mainly due to the fact that links as we have seen them so far (wrongly
called “hard” links) are only associated with regular files (and we have seen that
it is not the case — since even symbolic links are “linked”). But this requires that
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we first explain what symbolic links (“soft” links, or even more often “symlinks”)
are.
Symbolic links are files of a particular type whose sole content is an arbitrary string,
which may or may not point to an existing file. When you mention a symbolic link
on the command line or in a program, in fact, you access the file it points to, if it
exists. For example:
$ echo Hello >myfile
$ ln -s myfile mylink
$ ls -il
total 4
169 -rw-rw-r-1 queen
416 lrwxrwxrwx
1 queen
$ cat myfile
Hello
$ cat mylink
Hello

queen
queen

6 Dec 10 21:30 myfile
6 Dec 10 21:30 mylink -> myfile

You can see that the file type for mylink is l, for symbolic Link. The access rights
for a symbolic link are not significant: they will always be rwxrwxrwx. You can also
see that it is a different file from myfile, as its inode number is different. But it
refers to it symbolically, therefore when you type cat mylink, you will in fact print
the contents of the myfile file. To demonstrate that a symbolic link contains an
arbitrary string, we can do the following:
$ ln -s "I'm no existing file" anotherlink
$ ls -il anotherlink
418 lrwxrwxrwx
1 queen
queen
-> I'm no existing file
$ cat anotherlink
cat: anotherlink: No such file or directory
$

20 Dec 10 21:43 anotherlink

But symbolic links exist because they overcome several limitations encountered
by normal (“hard”) links:
• You cannot create a link to an inode in a directory which is on a different file
system to the said inode. The reason is simple: the link counter is stored in the
inode itself, and inodes cannot be shared between file systems. Symlinks allow
do this;

417

7. File Attributes
• You cannot link directories to avoid creating loops in the file system. But you
can make a symlink point to a directory and use it as if it were actually a directory.
Symbolic links are therefore very useful in several circumstances, and very often,
people tend to use them to link files together even when a normal link could be
used instead. One advantage of normal linking, though, is that you do not lose the
file if you delete the “original one”.
Lastly, if you observed carefully, you know what the size of a symbolic link is: it
is simply the size of the string.

7. File Attributes
The same way that FAT has file attributes (archive, system file, invisible, readonly), a GNU/Linux file system has its own, but they are different. We will briefly
go over them here for the sake of completeness, but they are very seldom used.
However, if you really want a secure system, read on.
There are two commands for manipulating file attributes: lsattr and chattr. You
probably guessed it, lsattr “LiSts” attributes, whereas chattr “CHanges” them.
These attributes can only be set on directories and regular files. The following are
some of the attributes possible, for a complete list please refer to chattr(1):
1.

A (“no Access time”): if a file or directory has this attribute set, whenever it is
accessed, either for reading or for writing, its last access time won't be updated.
This can be useful, for example, on files or directories which are often accessed
for reading, especially since this parameter is the only one which changes on
an inode when it is open read-only.

2.

a (“append only”): if a file has this attribute set and is open for writing, the
only operation possible will be to append data to its previous contents. For a
directory, this means that you can only add files to it, but not rename or delete
any existing file. Only root can set or clear this attribute.

3.

d (“no dump”): dump is the standard UNIX® utility for backups. It dumps
any file system for which the dump counter is 1 in /etc/fstab (see chapter
Chapter 32, File Systems and Mount Points [433]). But if a file or directory has
this attribute set, unlike others, it will not be taken into account when a dump
is in progress. Note that for directories, this also includes all sub-directories
and files under it.

418

7. File Attributes
4.

i (“immutable”): a file or directory with this attribute set can not be modified
at all: it cannot be renamed, no further link can be created to it3 and it cannot
be removed. Only root can set or clear this attribute. Note that this also prevents changes to access time, therefore you don't need to set the A attribute
when i is set.

5.

s (“secure deletion”): when a file or directory with this attribute is deleted,
the blocks it was occupying on disk are overwritten with zeroes.

6.

S (“Synchronous mode”): when a file or directory has this attribute set, all
modifications on it are synchronous and written to the disk immediately.

For example, you may want to set the i attribute on essential system files in order
to avoid bad surprises. Also, consider the A attribute on man pages: this prevents
a lot of disk operations and, in particular, can save some battery life on laptops.

3

Be sure to understand what “adding a link” means, both for a file and a directory!
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Chapter 31. The /proc File System
The /proc file system is specific to GNU/Linux. It is a virtual file system, so the
files that you will find in this directory do not actually take up any space on your
hard drive. It is a very convenient way to obtain information about the system,
especially since most files in this directory are human readable (well, with a little
help). Many programs actually gather information from files in /proc, format it
in their own way and then display the results. There are a few programs which
display information about processes (top, ps and friends) which do exactly that.
/proc is also a good source of information about your hardware, and just like the
programs which display processes, quite a few programs are just interfaces to the
information contained in /proc.
There is also a special subdirectory, /proc/sys. It allows you to display kernel
parameters and to change them, with the changes taking effect immediately.

1. Information About Processes
If you list the contents of the /proc directory, you will see many directories where
the name of the directory is a number. These are the directories containing information on all processes currently running on the system:
$ ls -d /proc/[0-9]*
/proc/1/
/proc/302/
/proc/127/ /proc/317/
/proc/2/
/proc/339/
/proc/250/ /proc/385/
/proc/260/ /proc/4/
/proc/275/ /proc/402/
/proc/290/ /proc/433/
/proc/3/
/proc/450/

/proc/451/
/proc/452/
/proc/453/
/proc/454/
/proc/455/
/proc/463/
/proc/487/
/proc/491/

/proc/496/
/proc/497/
/proc/5/
/proc/501/
/proc/504/
/proc/505/
/proc/509/
/proc/554/

/proc/556/
/proc/557/
/proc/558/
/proc/559/
/proc/565/
/proc/569/
/proc/594/
/proc/595/

/proc/633/
/proc/718/
/proc/755/
/proc/760/
/proc/761/
/proc/769/
/proc/774/

Note that as a user, you can (logically) only display information related to your
own processes, but not those of other users. So, login as root and see what information is available from process 1, which is the init process and is the one responsible
for starting up all other processes:
$ su
Password:
# cd /proc/1
# ls -l
total 0
-r-------- 1 root root 0 Aug 15 18:14 auxv
-r--r--r-- 1 root root 0 Aug 15 18:14 cmdline
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lrwxrwxrwx
-r-------lrwxrwxrwx
dr-x------rw-r--r--r--r--r--rw-------r--r--r--rw-r--r--r--r--r-lrwxrwxrwx
-rw-------r--r--r--r--r--r--r--r--r-dr-xr-xr-x
-r--r--r-#

1
1
1
2
1
1
1
1
1
1
1
1
1
1
1
3
1

root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root

root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root

0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0

Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug
Aug

15
15
15
15
15
15
15
15
15
15
15
15
15
15
15
15
15

18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14
18:14

cwd -> //
environ
exe -> /sbin/init*
fd/
loginuid
maps
mem
mounts
oom_adj
oom_score
root -> //
seccomp
stat
statm
status
task/
wchan

Each directory contains the same entries. Here is a brief description of some of the
entries:
1.

cmdline: this (pseudo-)file contains the entire command line used to invoke
the process. It is not formatted: there are no spaces between the program and
its arguments, and there is no newline at the end of the line. To view it, you
could use: perl -ple 's,\00, ,g' cmdline.

2.

cwd: this symbolic link points to the current working directory (hence the
name) of the process.

3.

environ: this file contains all the environment variables defined for this process, in the VARIABLE=value form. Similar to cmdline, the output is not
formatted at all: no newlines separate the different variables, and there is no
newline at the end. One way to view it: perl -ple 's,\00,\n,g' environ.

4.

exe: this is a symlink pointing to the executable file corresponding to the
process being run.

5.

fd: this subdirectory contains the list of file descriptors currently opened by
the process. See below.

6.

maps: when you print the content of this named pipe (with cat for example),
you can see the parts of the process' address space which are currently mapped
to a file. From left to right, the fields are: the address space associated to this
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mapping, the permissions associated to this mapping, the offset from the beginning of the file where the mapping starts, the major and minor number (in
hexadecimal) of the device on which the mapped file is located, the inode
number of the file, and finally the name of the file itself. When the device is 0
and there's no inode number or filename, this is an anonymous mapping. See
mmap(2).
7.

root: this is a symbolic link which points to the root directory used by the
process. Usually, it will be /, but see chroot(2).

8.

status: this file contains various information about the process: the name of
the executable, its current state, its PID and PPID, its real and effective UID
and GID, its memory usage, and other information. Note that the stat and
statm files are obsolete. The information they contained is now stored in
status.

If we list the contents of the fd directory for a randomly chosen process we obtain
this:
# ls -l /proc/8141/fd/
total 4
lrwx------ 1 peter peter
lrwx------ 1 peter peter
lrwx------ 1 peter peter
l-wx------ 1 peter peter
#

64
64
64
64

Aug
Aug
Aug
Aug

4
4
4
4

09:05
09:05
09:05
09:05

0
1
2
3

->
->
->
->

/dev/tty1
/dev/tty1
/dev/tty1
/home/peter/seti32/lock.sah

In fact, this is the list of file descriptors opened by the process. Each opened
descriptor is shown by a symbolic link, where the name is the descriptor number,
and which points to the file opened by this descriptor1. Note the permissions on
the symlinks: this is the only place where they make sense, as they represent the
permissions with which the file corresponding to the descriptor has been opened.

2. Information on the Hardware
Apart from the directories associated with the different processes, /proc also
contains a myriad of information on the hardware present in your machine. A list
of files from the /proc directory shows the following:

1

If you remember what was described in Section 4, “Redirections and Pipes” [448], you know what
descriptors 0, 1 and 2 stand for. Descriptor 0 is the standard input, descriptor 1 is the standard output
and descriptor 2 is the standard error.
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$ ls -d [a-z]*
acpi/
diskstats
asound/
dma
buddyinfo driver/
bus/
execdomains
cmdline
fb
config.gz filesystems
cpuinfo
fs/
crypto
ide/
devices
interrupts
$

iomem
ioports
irq/
kallsyms
kcore
keys
key-users
kmsg
loadavg

locks
mdstat
meminfo
misc
modules
mounts@
mtrr
net/
partitions

pci
scsi/
self@
slabinfo
splash
stat
swaps
sys/
sysrq-trigger

sysvipc/
tty/
uptime
version
vmstat

For example, if we look at the contents of /proc/interrupts, we can see that it
contains the list of interrupts currently used by the system, along with the peripheral
which uses them. Similarly, ioports contains the list of input/output address
ranges currently busy, and lastly dma does the same for DMA channels. Therefore,
in order to track down a conflict, look at the contents of these three files:
$ cat interrupts
CPU0
0:
543488
2:
0
5:
109
7:
1
8:
0
9:
3432
10:
52855
11:
7538
12:
1386
14:
20
15:
5908
NMI:
0
LOC:
0
ERR:
0
MIS:
0
$ cat ioports
0000-001f : dma1
0020-0021 : pic1
0040-0043 : timer0
0050-0053 : timer1
0060-006f : keyboard
0070-0077 : rtc
0080-008f : dma page reg
00a0-00a1 : pic2
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XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC
XT-PIC

timer
cascade
ohci_hcd:usb2, eth1
parport0
rtc
acpi, NVidia CK8
ehci_hcd:usb3, eth0
libata, ohci_hcd:usb1
i8042
ide0
ide1
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00c0-00df
00f0-00ff
0170-0177
01f0-01f7
0376-0376
0378-037a
037b-037f
03c0-03df
03f6-03f6
03f8-03ff
0778-077a
0970-0977
0970-0977
09f0-09f7
09f0-09f7
0b70-0b73
0b70-0b73
0bf0-0bf3
0bf0-0bf3
0cf8-0cff
4000-407f
4000-4003
4004-4005
4008-400b
4020-4027
4080-40ff
4080-40ff
4200-427f
4200-427f
4280-42ff
4280-42ff
4400-447f
4400-447f
4480-44ff
44a0-44af
5000-503f
5000-503f
5100-513f
5100-513f
9000-9fff
9000-907f
9000-907f
ac00-ac0f
ac00-ac0f
b000-b07f

:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:

dma2
fpu
ide1
ide0
ide1
parport0
parport0
vesafb
ide0
serial
parport0
0000:00:0b.0
sata_nv
0000:00:0b.0
sata_nv
0000:00:0b.0
sata_nv
0000:00:0b.0
sata_nv
PCI conf1
motherboard
PM1a_EVT_BLK
PM1a_CNT_BLK
PM_TMR
GPE0_BLK
motherboard
pnp 00:00
motherboard
pnp 00:00
motherboard
pnp 00:00
motherboard
pnp 00:00
motherboard
GPE1_BLK
motherboard
pnp 00:01
motherboard
pnp 00:01
PCI Bus #02
0000:02:07.0
0000:02:07.0
0000:00:0b.0
sata_nv
0000:00:0b.0

425

2. Information on the Hardware
b000-b07f
b800-b8ff
b800-b8ff
bc00-bc7f
bc00-bc7f
c000-c007
c000-c007
c400-c41f
f000-f00f
f000-f007
f008-f00f

:
:
:
:
:
:
:
:
:
:
:

sata_nv
0000:00:06.0
NVidia CK8
0000:00:06.0
NVidia CK8
0000:00:04.0
forcedeth
0000:00:01.1
0000:00:09.0
ide0
ide1

$cat dma
3: parport0
4: cascade
$

Or, more simply, use the lsdev command, which gathers information from these
files and sorts them by peripheral, which is undoubtedly more convenient.2:
$ lsdev
Device
DMA
IRQ I/O Ports
-----------------------------------------------0000:00:01.1
c400-c41f
0000:00:04.0
c000-c007
0000:00:06.0
b800-b8ff bc00-bc7f
0000:00:09.0
f000-f00f
0000:00:0b.0
0970-0977 09f0-09f7 0b70-0b73 0bf0-0bf3 ac00-ac0f →
b000-b07f
0000:02:07.0
9000-907f
9000-907f
cascade
4
2
CK8
9
dma
0080-008f
dma1
0000-001f
dma2
00c0-00df
eth0
10
eth1
5
forcedeth
c000-c007
fpu
00f0-00ff
GPE0_BLK
4020-4027
GPE1_BLK
44a0-44af
i8042
12
ide0
14 01f0-01f7 03f6-03f6
f000-f007
ide1
15 0170-0177 0376-0376
f008-f00f
2

lsdev is part of the procinfo package
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keyboard
0060-006f
motherboard
4000-407f 4080-40ff 4200-427f 4280-42ff 4400-447f →
4480-44ff 5000-503f 5100-513f
NVidia
b800-b8ff
bc00-bc7f
ohci_hcd:usb1
11
parport0
3
7 0378-037a 037b-037f 0778-077a
PCI
0cf8-0cff 9000-9fff
pic1
0020-0021
pic2
00a0-00a1
PM1a_CNT_BLK
4004-4005
PM1a_EVT_BLK
4000-4003
PM_TMR
4008-400b
pnp
4080-40ff
4200-427f
4280-42ff
4400-447f →
5000-503f
5100-513f
rtc
8 0070-0077
sata_nv
0970-0977
09f0-09f7
0b70-0b73
0bf0-0bf3 →
ac00-ac0f
b000-b07f
serial
03f8-03ff
timer
0
timer0
0040-0043
timer1
0050-0053
vesafb
03c0-03df
$

An exhaustive listing of files would take too long, but here's the description of
some of them:
• cpuinfo: this file contains, as its name says, information on the processor(s)
present in your machine.
• modules: this file contains the list of modules currently used by the kernel,
along with the usage count for each one. In fact, this is the information used
by the lsmod command which displays it in a more readable form.
• meminfo: this file contains information on memory usage at the time you print
its contents. The free command will display the same information in a easierto-read format.
• apm: if you have a laptop, displaying the contents of this file allows you to see
the state of your battery. You can see whether the AC is plugged in, the charge
level of your battery, and if the APM BIOS of your laptop supports it (unfortunately this is not the case for all laptops), the remaining battery life in minutes,
etc. The file isn't very readable by itself, therefore you want to use the apm
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command instead, which gives the same information in a human readable
format.
Note that modern computers now provide ACPI support instead of APM. See
below.
• bus: this subdirectory contains information on all peripherals found on different
buses in your machine. The information is usually not readable, and for the
most part it is reformatted with external utilities: lspcidrake, lspnp, etc.
• acpi: several of the files and directories provided in this directory are interesting
especially for laptops, where you can select several power-saving options. Note
that it is easier to modify those options using a higher level application, such
as the ones included in the acpid kapacity packages.
The most interesting entries are:
battery
Shows how many batteries are in the laptop, and related information as
current remaining life, maximum capacity, etc.
button
Allows you to control actions associated to “special” buttons such as power,
sleep, lid, etc.
fan
Displays the state of the fans on your computer, whether they are running
or not, and enables you to start/stop them according to certain criteria.
The amount of control of the fans in your machine depends on the
motherboard.
processor
There is one subdirectory for each of the CPUs in your machine. Control
options vary from one processor to another. Mobile processors have more
features enabled, including:
• possibility to use several power states, balancing between performance
and power consumption;
• possibility to use clock rate change in order to reduce the amount of
CPU power consumption;
Note that there are several processors that do not offer these possibilities.
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thermal_zone
Information about how hot your system/processor is running.

3. Display and change kernel parameters
The role of the /proc/sys subdirectory is to report different kernel parameters,
and to allow you to interactively change some of them. As opposed to all other
files in /proc, some files in this directory can be written to, but only by root.
A list of directories and files would take too long to describe, mostly because the
content of the directories are system-dependent and that most files will only be
useful for very specialized applications. However, here are two common uses of
this subdirectory:
1.

Allow routing: even if the default kernel from Mandriva Linux is able to route,
you must explicitly allow it to do so. For this, you just have to type the following command as root:
$ echo 1 >/proc/sys/net/ipv4/ip_forward

Replace the 1 with a 0 if you want to forbid routing.
2.

Prevent IP spoofing: IP spoofing consists of making one believe that a packet
coming from the outside world comes from the interface by which it arrives.
This technique is very commonly used by crackers 3. You can make the kernel
prevent this kind of intrusion. Type:
$ echo 1 >/proc/sys/net/ipv4/conf/all/rp_filter

and this kind of attack becomes impossible.
These changes will only remain in effect while the system is running. If the system
is rebooted, then the values will go back to their defaults. To reset the values to
something other than the default at boot time, you can take the commands that
you typed at the shell prompt and add them to /etc/rc.d/rc.local so that you
avoid typing them each time. Another solution is to modify /etc/sysctl.conf,
refer to sysctl.conf(5) and to sysctl(8) for more information.

3

But not hackers!

429

430

Part 7. Linux in Depth

Chapter 32. File Systems and Mount Points
As we have seen in Chapter 28, Disks and Partitions [395], all the files of the system
are organized in a single tree. And actually each time we want to access a removable
device such as a CD-ROM or a remote location on a file server, its content will be
literally “grafted” on some branch of the tree.

Figure 32.1. Mount Points Illustrated
Figure 32.1, “Mount Points Illustrated” [433] shows this: the root, made of a
GNU/Linux partition contains another linux partition for /home/ but also a Windows® one, a remote share from a file server (either Windows® or UNIX®), and a
USB key. Nowadays many devices can be mounted on a GNU/Linux filesystem,
including almost all existing filesystem types, WebDAV and even exotic things
such as Googletm mail...
In order to better grasp the concepts around mount points, we base this chapter
on a practical case. Suppose you have just purchased a brand new hard disk with
no partitions on it. Your Mandriva Linux partition is completely full, and as you
need more space, you decide to move a whole section of the tree structure1 to your
new hard disk. Because your new disk has a large capacity, you decide to move
your biggest directory to it: /usr.
1

Our example assumes that the whole tree is contained in a single partition.
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We will use this example along this chapter starting Section 2, “Partitioning a Hard
Disk, Formatting a Partition” [436], but first a bit of theory.

1. Principles
Every hard disk may be divided into partitions, and each one contains a file system.
While Windows® assigns a letter to each of these file systems (well, actually only
to those it recognizes), GNU/Linux has a unique tree structure of files, and each
file system is mounted at one location in that tree structure.
Just as Windows® needs a C: drive, GNU/Linux must be able to mount the root
of its file tree (/) on a partition which contains the root file system. Once the root is
mounted you can mount other file systems in the tree structure at various mount
points within the tree. Any directory below the root structure can act as a mount
point, and you can mount the same file system several times on different mount
points.
This allows for great configuration flexibility. For example if you were to configure
a web server, it's fairly common to dedicate an entire partition to the directory
which contains the web server's data. The directory which usually contains the
data is /var/www and acts as the mounting point for the partition. Also, a big /home
partition should be considered if you plan on downloading a large amount of
software, store many work or personal documents and photos, music files, etc..
You can see in Figure 32.2, “A Not Yet Mounted File System” [435] and Figure 32.3,
“File System Is Now Mounted” [435] how the system looks before and after
mounting the file system.
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/
/

/home

/usr

/var
/cgi−bin

/html

/icons

/var/www

File system containing files
of directory "/var/www"
(not yet mounted)

Root file system
(already mounted)
Figure 32.2. A Not Yet Mounted File System
/

/home

/usr

/var

/var/www

/var/www/cgi−bin

/var/www/html

/var/www/icons

Figure 32.3. File System Is Now Mounted
As you can imagine, this offers a number of advantages: the tree structure will always be the same, whether it's on a single file system or extended over several
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dozen. This flexibility allows you to move a key part of the tree structure to another
partition when space becomes scarce, which is what we are going to do here.
There are two things you need to know about mount points:
1.

The directory which acts as a mount point must exist.

2.

And this directory should preferably be empty: if a directory chosen as a mount
point already contains files and sub-directories, these will simply be “hidden”
by the newly mounted file system. The files will not be deleted, but they will
not be accessible until you free the mount point.
It's actually possible to access the data “hidden” by the newly mounted
file system. You simply need to mount the hidden directory with the
--bind option. For example, if you just mounted a directory in /hidden/directory/ and want to access its original content in /new/directory, you would have to run:
mount --bind /hidden/directory/ /new/directory

2. Partitioning a Hard Disk, Formatting a Partition
There are two things to keep in mind as you read through this section: a hard disk
is divided into partitions, and each of these partitions hosts a file system. Your
brand new hard disk has neither, so we begin with partitioning. In order to proceed,
you must be root.
First you have to know the hard disk's “name” (i.e.: what file it is designated as).
Suppose the new drive is set up as the slave on your primary IDE interface. In that
case, it will be known as /dev/hdb.2. Please refer to Section 1, “Managing your
Hard Drive Partitions with DiskDrake” [303], to learn more about partitioning.
DiskDrake will also create the file systems for you, so once the partitioning and
file system creation steps are complete, we can proceed.

3. The mount and umount Commands
Now that the file system has been created, you can mount the partition. Initially,
it will be empty, since the system hasn't had access to the file system to add files
to it. The command to mount file systems is mount, and its syntax is as follows:
mount [options] <-t type> [-o mount options] <device> <mounting point>
2
Determining the name of a disk is explained in Section 2, “Conventions for Naming Disks and Partitions” [398].
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In this case we want to temporarily mount our partition on /mnt/new (or any other
mount point you have chosen: remember that the mount point must exist). The
command for mounting our newly created partition is:
$ mount -t ext3 /dev/hdb1 /mnt/new

The -t option is used to specify what type of file system the partition is supposed
to host. The file systems you will most frequently encounter are ext2FS (the
GNU/Linux file system) or ext3FS (an improved version of ext2FS with journaling
capabilities), VFAT (for almost all DOS/Windows® partitions: FAT 12, 16 or 32),
NTFS (for newer versions of Windows®) and ISO9660 (CD-ROM file system). If
you don't specify any type, mount will try guessing which file system is hosted
by the partition by reading the superblock.
The -o option is used to specify one or more mounting options. The options appropriate for a particular file system will depend on the file system being used. Refer
to the mount(8) man page for more details.
Now that you've mounted your new partition, it's time to copy the entire /usr
directory onto it:
$ (cd /usr && tar cf - .) | (cd /mnt/new && tar xpvf -)

Now that the files are copied, we can unmount our partition. To do this, use the
umount command. The syntax is simple:
umount <mount point|device>

So to unmount our new partition we can type:
$ umount /mnt/new

or:
$ umount /dev/hdb1

Sometimes it may happen that a device (usually the CD-ROM) is busy.
If this happens most users would solve this problem by rebooting their
computer. For example if umount /dev/hdc fails, then you could try the
“lazy” umount. The syntax is fairly simple:
umount -l <mount point|device>

This command disconnects the device and closes all open handles to the
device when possible. Usually you can eject the disc using the eject
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<mount point|device> command. So if the eject command does nothing
and you don't want to reboot, use lazy unmounting.
Since this partition is going to “become” our /usr directory, we need to tell the
system. To do this, we edit the /etc/fstab file. It makes it possible to automate
the mounting of certain file systems, especially at system start-up. It contains a
series of lines describing the file systems, their mount points and other options.
Here's an example of such a file:
/dev/hda2 / ext3 defaults 1 1
/dev/hdd /mnt/cdrom auto umask=0022,user,iocharset=utf8,noauto,ro,exec,users →
0 0
/dev/fd0 /mnt/floppy supermount →
dev=/dev/fd0,fs=ext2:vfat,--,umask=0022,iocharset=utf8,sync 0 0
/dev/hda1 /mnt/windows ntfs umask=0,nls=utf8,ro 0 0
none /proc proc defaults 0 0
/dev/hda3 swap swap defaults 0 0

Each line consists of:
• the device hosting the file system;
• the mount point;
• the type of file system;
• the mounting options;
• the dump utility backup flag;
• fsck's (FileSystem ChecK) checking order.
There is always an entry for the root file system. The Swap partitions are special
since they're not visible in the tree structure, and the mount point field for those
partitions contains the swap keyword. As for the /proc file system, it will be described in more detail in Chapter 31, The /proc File System [421]. Another special file
system is /dev/pts.
Also note that your system might have entries added and removed automatically
from this file. This is done by fstab-sync, a command which receives special events
from the Hardware Abstraction Layer (HAL) system, and manipulates the
/etc/fstab file. Take a look at the fstab-sync(8) man page for more details.
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Coming back to our file-system change, at this point we have moved the entire
/usr hierarchy to /dev/hdb1 and we want this partition to be mounted as /usr at
boot time. To accomplish this, add the following entry anywhere in the /etc/fstab
file:
/dev/hdb1 /usr ext3 defaults 1 2

Now the partition will be mounted every time your system boots, and will be
checked for errors if necessary.
If your partition isn't of type ext3FS you will have to change it to the
correct type. Common options are ext2 and reiserfs. Also note that the
last field has a value of 2. This means it will be checked after all other
entries with a value of 1, and after other file systems with the same priority on the same hard disk which appear before it in /etc/fstab. Only
the root (/) partition should have a value of 1.
There are two special options: noauto and users. The noauto option specifies that
the file system should not be mounted at start-up, and is mounted only when you
tell it to. The users option specifies that any user can mount and unmount the file
system. These two options are typically used for the CD-ROM and floppy drives.
There are other options, and /etc/fstab has a man page (fstab(5)) you can read
for more information.
One advantage of using /etc/fstab is that it simplifies the mount command
syntax. To mount a file system described in the file, you can either reference the
mount point or the device. To mount a floppy disk, you can type:
$ mount /mnt/floppy

or:
$ mount /dev/fd0

To finish our partition moving example, let's review what we have already done.
We copied the /usr hierarchy and modified /etc/fstab so that the new partition
will be mounted at start-up. But for the moment, the old /usr files are still in their
original place on the drive, so we need to delete them to free up space (which was,
after all, our initial goal).
• To do so, you first need to switch to single user mode by issuing the telinit 1
command on the command line. It will stop all services and prevent users from
connecting to the machine.
439

3. The mount and umount Commands
• Next, we delete all files in the /usr directory. Remember that we are still referring to the “old” directory, since the newer, larger one, is not yet mounted. rm
-Rf /usr/*.
• Finally, we mount the new /usr directory: mount /usr.
And that's it. Now, go back to multi-user mode (telinit 3 for standard text mode
or telinit 5 for the graphical mode), and if there's no further administrative work
left, you should now log off from the root account.

440

Chapter 33. Introduction to the Command
Line
In Chapter 27, Basic UNIX® System Concepts [381] you were shown how to launch
a shell. In this chapter, we will show you how to work with it.
The shell's main asset is the number of existing utilities: there are thousands of
them, and each utility is devoted to a particular task. We will only look at a (very)
small number of these utilities here. One of UNIX®'s greatest assets is the ability
to combine these utilities, as we shall see later.

1. File-Handling Utilities
In this context, file handling means copying, moving and deleting files. Later, we
will look at ways of changing file attributes (owner, permissions).

1.1. mkdir, touch: Creating Empty Directories and Files
mkdir (MaKe DIRectory) is used to create directories. Its syntax is simple:
mkdir [options] <directory> [directory ...]

Only one option is worth noting: the -p option. It does two things:
1.

it will create parent directories if they did not exist previously. Without this
option, mkdir would just fail, complaining that these directories do not exist;

2.

it will return silently if the directory you wanted to create already exists.
Similarly, if you did not specify the -p option, mkdir will send back an error
message, complaining that the directory already exists.

Here are some examples:
• mkdir foo: creates a directory foo in the current directory;
• mkdir -p images/misc docs: creates the misc directory in the images directory.
First, it creates the latter if it does not exist (-p); it also creates a directory named
docs in the current directory.
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1.2. rm: Deleting Files or Directories
Initially, the touch command was not intended for creating files but for updating
file access and modification times1. However, touch will create the files listed as
empty files if they do not exist. The syntax is:
touch [options] file [file...]

So running the command:
touch file1 images/file2

will create an empty file called file1 in the current directory and an empty file
file2 in directory images, if the files did not previously exist.

1.2. rm: Deleting Files or Directories
The rm command (ReMove) is equivalent to the DOS commands del and deltree,
but has more options. Its syntax is as follows:
rm [options] <file|directory> [file|directory...]

Options include:
• -r, or -R: delete recursively. This option is mandatory for deleting a directory,
empty or not. However, you can also use rmdir to delete empty directories.
• -i: request confirmation before each deletion. Note that by default in Mandriva
Linux, rm is an alias to rm -i, for safety reasons (similar aliases exist for cp and
mv). Your mileage may vary as to the usefulness of these aliases. If you want
to remove them, you can create an empty ~/.alias file which will prevent
setting system wide aliases. Alternatively you can edit your ~/.bashrc file to
disable some of the system wide aliases by adding this line: unalias rm cp
mv
• -f, the opposite of -i, forces deletion of the files or directories, even if the user
has no write access on the files2.
Some examples:

1

In UNIX®, there are three distinct timestamps for each file: the last file access date (atime), i.e. the date
when the file was last opened for read or write; the date when the inode attributes were last modified
(ctime); and finally, the date when the content of the file was last modified (mtime).
2
It is enough for the user to have write access to the directory to be able to delete files in it, even if he is
not the owner of the files.
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• rm -i images/*.jpg file1: deletes all files with names ending in .jpg in the images
directory and deletes file1 in the current directory, requesting confirmation
for each file. Answer y to confirm deletion, n to cancel.
• rm -Rf images/misc/ file*: deletes, without requesting confirmation, the whole
directory misc/ in the images/ directory, together with all files in the current
directory whose names begin with file.
Using rm deletes files irrevocably. There is no way to restore them! (Well,
actually there are several ways to do this but it is no trivial task and
usually a preparation of the system prior to the deletion is involved.) Do
not hesitate to use the -i option to ensure that you do not delete something by mistake.

1.3. mv: Moving or Renaming Files
The syntax of the mv (MoVe) command is as follows:
mv [options] <file|directory> [file|directory ...] <destination>

Note that when you move multiple files the destination has to be a directory. To
rename a file you simply move it to the new name.
Some options:
• -f: forces the operation. No warnings are given if an existing file is to be overwritten.
• -i: the opposite. Asks the user for confirmation before overwriting an existing
file.
• -v: verbose mode, report all changes and activity.
Some examples:
• mv -i /tmp/pics/*.png .: move all files in the /tmp/pics/ directory whose names
end with .png to the current directory (.), but request confirmation before
overwriting any files already there.
• mv foo bar: rename file foo to bar. If a bar directory already existed, the effect
of this command would be to move file foo or the whole directory (the directory
itself plus all files and directories in it, recursively) into the bar directory.
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• mv -vf file* images/ trash/: move, without requesting confirmation, all files in
the current directory whose names begin with file, together with the entire
images/ directory to the trash/ directory, and show each operation carried
out.

1.4. cp: Copying Files and Directories
cp (CoPy) is equivalent to the DOS commands copy and xcopy but has more options.
Its syntax is as follows:
cp [options] <file|directory> [file|directory ...] <destination>

Here are the most common options cp has:
• -R: recursive copy; mandatory for copying a directory, even an empty directory.
• -i: request confirmation before overwriting any files which might be overwritten.
• -f: the opposite of -i, replaces any existing files without requesting confirmation.
• -v: verbose mode, displays all actions performed by cp.
Some examples:
• cp -i /timages/* images/: copies all files in the /timages/ directory to the images/ directory located in the current directory. It requests confirmation if a
file is going to be overwritten.
• cp -vR docs/ /shared/mp3s/* mystuff/: copies the whole docs directory, plus
all files in the /shared/mp3s directory to the mystuff directory.
• cp foo bar: makes a copy of the foo file with the name bar in the current directory.

2. Handling File Attributes
The series of commands shown here are used to change the owner or owner group
of a file or its permissions. We looked at the different permissions in Chapter 27,
Basic UNIX® System Concepts [381].
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2.1. chown, chgrp: Change the Owner or Group of One or More
Files
The syntax of the chown (CHange OWNer) command is as follows:
chown [options] <user[:group]> <file|directory> [file|directory...]

The options include:
• -R: recursive. To change the owner of all files and sub-directories in a given
directory.
• -v: verbose mode. Displays all actions performed by chown; reports which
files have changed ownership as a result of the command and which files have
not been changed.
• -c: like -v, but only reports which files have been changed.
Some examples:
• chown nobody /shared/book.tex: changes the owner of the /shared/book.tex
file to nobody.
• chown -Rc queen:music *.mid concerts/: changes the ownership of all files in
the current directory whose name ends with .mid and all files and sub-directories in the concerts/ directory to user queen and group music, reporting only
files affected by the command.
The chgrp (CHange GRouP) command lets you change the group ownership of a
file (or files); its syntax is very similar to that of chown:
chgrp [options] <group> <file|directory> [file|directory...]

The options for this command are the same as for chown, and it is used in a very
similar way. Thus, the command chgrp disk /dev/hd* changes the ownership of
all files in directory /dev with names beginning with hd to group disk.

2.2. chmod: Changing Permissions on Files and Directories
The chmod (CHange MODe) command has a very distinct syntax. The general
syntax is:
chmod [options] <change mode> <file|directory> [file|directory...]
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But what distinguishes it is the different forms that the mode change can take. It
can be specified in two ways:
1.

In octal. The owner user permissions then correspond to figures with the form
<x>00, where <x> corresponds to the permission assigned: 4 for read permission, 2 for write permission and 1 for execute permission. Similarly, the owner
group permissions take the form <x>0 and permissions for “others” the form
<x>. Then, all you need to do is add together the assigned permissions to get
the right mode. Thus, the permissions rwxr-xr-- correspond to 400+200+100
(owner permissions, rwx) +40+10 (group permissions, r-x) +4 (others' permissions, r--) = 754; in this way, the permissions are expressed in absolute terms.
This means that previous permissions are unconditionally replaced;

2.

with expressions. Here permissions are expressed by a sequence of expressions
separated by commas. Hence an expression takes the following form: [category]<+|-|=><permissions>.
The category may be one or more of:
• u (User, permissions for owner);
• g (Group, permissions for owner group);
• o (Others, permissions for “others”).
If no category is specified, changes will apply to all categories. A + sets a permission, a - removes the permission and a = sets the permission to be exactly
what was passed on the command line. Finally, the permission is one or more
of the following:
• r (Read);
• w (Write) or;
• x (eXecute).

The main options are quite similar to those of chown and chgrp:
• -R: changes permissions recursively.
• -v: verbose mode. Displays the actions carried out for each file.
• -c: like -v but only shows files affected by the command.
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Examples:
• chmod -R o-w /shared/docs: recursively removes write permission for others
on all files and sub-directories in the /shared/docs/ directory.
• chmod -R og-w,o-x private/: removes write permission for group and others
for the whole private/ directory, and removes the execution permission for
others, recursively.
• chmod -c 644 misc/file*: changes permissions of all files in the misc/ directory
whose names begin with file to rw-r--r-- (i.e. read permission for everyone
and write permission only for the owner), and reports only files affected by
this command.

3. Shell Globbing Patterns
You probably already use globbing characters without knowing it. When you specify
a file in Windows® or when you look for a file, you use * to match a random string.
For example, *.txt matches all files with names ending with .txt. We also used
it heavily in the last section. But there is more to globbing than just *.
When you type a command like ls *.txt and press Enter , the task of finding which
files match the *.txt pattern is not done by the ls command, but by the shell itself.
This requires a little explanation about how a command line is interpreted by the
shell. When you type:
$ ls *.txt
readme.txt

recipes.txt

the command line is first split into words (ls and *.txt in this example). When
the shell sees a * in a word, it will interpret the whole word as a globbing pattern
and will replace it with the names of all matching files. Therefore, the command,
just before the shell executes it, has become ls readme.txt recipe.txt, which gives
the expected result. Other characters make the shell react this way too:
• ?: matches one and only one character, regardless of what that character is;
• [...]: matches any character found in the brackets. Characters can be referred
to either as a range of characters (i.e. 1-9) or discrete values, or even both. Example: [a-zBE5-7] will match all characters between a and z, a B, an E, a 5, a
6 or a 7;
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• [!...]: matches any character not found in the brackets. [!a-z], for example,
will match any character which is not a lowercase letter3;
• {c1,c2}: matches c1 or c2, where c1 and c2 are also globbing patterns, which
means you can write {[0-9]*,[acr]} for example.
Here are some patterns and their meanings:
• /etc/*conf: all files in the /etc directory with names ending in conf. It can
match /etc/inetd.conf, /etc/conf.linuxconf, and also /etc/conf if such a
file exists. Remember that * can also match an empty string.
• image/{cars,space[0-9]}/*.jpg: all file names ending with .jpg in directories
image/cars, image/space0, (...), image/space9, if those directories exist.
• /usr/share/doc/*/README: all files named README in all of /usr/share/doc's
immediate sub-directories. This will make /usr/share/doc/mandriva/README
match, for example, but not /usr/share/doc/myprog/doc/README.
• *[!a-z]: all files with names which do not end with a lowercase letter in the
current directory.

4. Redirections and Pipes
4.1. A Little More About Processes
To understand the principle of redirections and pipes, we need to explain a notion
about processes which has not yet been introduced. Most UNIX® processes (this
also includes graphical applications but excludes most daemons) use a minimum
of three file descriptors: standard input, standard output and standard error. Their
respective numbers are 0, 1 and 2. In general, these three descriptors are associated
with the terminal from which the process was started, with the input being the
keyboard. The aim of redirections and pipes is to redirect these descriptors. The
examples in this section will help you better understand this concept.

3
Beware! While this is true for most languages, this may not be true for your own language setting
(locale). This depends on the collating order. On some language configurations, [a-z] will match a,
A, b, B, (...), z. And remember the fact that some languages have accentuated characters too...
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4.2. Redirections
Imagine, for example, that you wanted a list of files ending with .png4 in the images
directory. This list is very long, so you may want to store it in a file in order to look
through it at your leisure. You can enter the following command:
$ ls images/*.png 1>file_list

This means that the standard output of this command (1) is redirected (>) to the
file named file_list. The > operator is the output redirection operator. If the redirection file does not exist, it is created, but if it does exist, its previous contents
are overwritten. However, the default descriptor redirected by this operator is the
standard output and does not need to be specified on the command line. So you
can write more simply:
$ ls images/*.png >file_list

and the result will be exactly the same. Then you could look at the file using a text
file viewer such as less.
Now, imagine you want to know how many of these files exist. Instead of counting
them by hand, you can use the utility called wc (Word Count) with the -l option,
which writes on the standard output the number of lines in the file. One solution
is as follows:
$ wc -l 0<file_list

and this gives the desired result. The < operator is the input redirection operator,
and the default redirected descriptor is the standard input one, i.e. 0, and you
simply need to write the line:
$ wc -l <file_list

Now suppose you want to remove all the file “extensions” and put the result in
another file. One tool for doing this is sed (Stream EDitor). You simply redirect the
standard input of sed to the file_list file and redirect its output to the result file,
i.e. the_list:
$ sed -e 's/\.png$//g' <file_list >the_list

4

You might think it is crazy to say “files ending with .png” rather than “PNG images”. However, once
again, files under UNIX® only have an extension by convention: extensions in no way define a file type.
A file ending with .png could perfectly well be a JPEG image, an application file, a text file or any
other type of file. The same is true under Windows® as well!
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and your list is created, ready for you to view at your leisure with any viewer.
It can also be useful to redirect standard errors. For example, you want to know
which directories in /shared you cannot access: one solution is to list this directory
recursively and to redirect the errors to a file, while not displaying the standard
output:
$ ls -R /shared >/dev/null 2>errors

which means that the standard output will be redirected (>) to /dev/null, a special
file in which everything you write is discarded (i.e. the standard output is not
displayed) and the standard error channel (2) is redirected (>) to the errors file.

4.3. Pipes
Pipes are in some ways a combination of input and output redirections. The principle is that of a physical pipe, hence the name: one process sends data into one
end of the pipe and another process reads the data at the other end. The pipe operator is |. Let us go back to the file list example above. Suppose you want to find
out directly how many corresponding files there are without having to store the
list in a temporary file, you would then use the following command:
$ ls images/*.png | wc -l

which means that the standard output of the ls command (i.e. the list of files) is
redirected to the standard input of the wc command. This then gives you the desired
result.
You can also directly put together a list of files “without extensions” using the
following command:
$ ls images/*.png | sed -e 's/\.png$//g' >the_list

or, if you want to consult the list directly without storing it in a file:
$ ls images/*.png | sed -e 's/\.png$//g' | less

Pipes and redirections are not restricted solely to text which can be read by human
beings. For example, the following command sent from a Terminal:
$ xwd -root | convert - ~/my_desktop.png

will send a screen shot of your desktop to the my_desktop.png 5 file in your personal directory.
5

Yes, it will indeed be a PNG image (however, the ImageMagick package needs to be installed).
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5. Command-Line Completion
Completion is a very handy function, and all modern shells (including bash) have
it. Its role is to give the user as little work to do as possible. The best way to illustrate
completion is to give an example.

5.1. Example
Suppose your personal directory contains the file_with_very_long_name_impossible_to_type file, and you want to look at it. Suppose you also have, in the
same directory, another file called file_text. You are in your personal directory,
so type the following sequence:
$ less fi<TAB>

(i.e., type less fi and then press the Tab key). The shell will then expand the
command line for you:
$ less file_

and also give the list of possible choices (in its default configuration, which can be
customized). Then type the following key sequence:
$ less file_w<TAB>

and the shell will extend the command line to give you the result you want:
$ less file_with_very_long_name_impossible_to_type

All you need to do then is press the Enter key to confirm and read the file.
Use the q key to exit the file viewer.

5.2. Other Completion Methods
The Tab key is not the only way to activate completion, although it is the most
common one. As a general rule, the word to be completed will be a command
name for the first word of the command line (nsl<TAB> will give nslookup), and
a file name for all the others, unless the word is preceded by a “magic” character
like ~, @ or $, in which case the shell will try to complete a user name, a machine
name or an environment variable name respectively6. There is also a magic char6

Remember: UNIX® differentiates between uppercase and lowercase. The HOME environment variable
and the home variable are not the same.
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acter for completing a file name (/) and a command to recall a command from the
history (!).
The other two ways to activate completion are the sequences Esc - <x> and
Ctrl - X - <x> , where <x> is one of the magic characters already mentioned.
Esc - <x> will attempt to come up with a unique completion. If it fails, it will
complete the word with the largest possible sub-string in the choice list. A beep
means either that the choice is not unique, or simply that there is no corresponding
choice. The sequence Ctrl - X - <x> displays the list of possible choices without attempting any completion. Pressing the Tab key is the same as successively pressing
Esc - <x> and Ctrl - X - <x> , where the magic character depends on the context.
Thus, one way to see all the environment variables defined is to type the sequence
Ctrl - X - $ on a blank line. Another example: if you want to see the man page for
the nslookup command, you simply type man nsl then Esc - ! , and the shell will
automatically complete the command to man nslookup.

6. Starting and Handling Background Processes: Job
Control
You have probably noticed that when you enter a command from a Terminal, you
normally have to wait for the command to finish before the shell returns control
to you. This means that you have sent the command in the foreground. However,
there are occasions when this is not desirable.
Suppose, for example, that you decide to copy a large directory recursively to another. You have also decided to ignore errors, so you redirect the error channel to
/dev/null:
cp -R images/ /shared/ 2>/dev/null

Such a command can take several minutes until it is fully executed. You then have
two solutions: the first one is violent, and means stopping (killing) the command
and then doing it again when you have the time. To do this, press Ctrl - C : this
will terminate the process and take you back to the prompt. But wait, don't do it
yet! Read on.
Suppose you want the command to run while you do something else. The solution
is then to put the process into the background. To do this, press Ctrl - Z to suspend
the process:
$ cp -R images/ /shared/ 2>/dev/null
# Type C-z here
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[1]+
$

Stopped

cp -R images/ /shared/ 2>/dev/null

and there you are again at the prompt. The process is then on standby, waiting for
you to restart it (as shown by the Stopped keyword). That, of course, is what you
want to do, but in the background. Type bg (for BackGround) to get the desired
result:
$ bg
[1]+ cp -R images/ /shared/ 2>/dev/null &
$

The process will then start running again as a background task, as indicated by
the & (ampersand) sign at the end of the line. You will then be back at the prompt
and able to continue working. A process which runs as a background task, or in
the background, is called a background job.
Of course, you can start processes directly as background tasks by adding an &
character at the end of the command. For example, you can start the command to
copy the directory in the background by writing:
$ cp -R images/ /shared/ 2>/dev/null &

If you want, you can also restore this process to the foreground and wait for it to
finish by typing fg (ForeGround). To put it into the background again, type the sequence Ctrl - Z , bg.
You can start several jobs this way: each command will then be given a job number.
The shell command jobs lists all the jobs associated with the current shell. The
job preceded by a + sign indicates the last process begun as a background task. To
restore a particular job to the foreground, you can then type fg <n> where <n> is
the job number, i.e. fg 5.
Note that you can also suspend or start full-screen applications this way, such as
less or a text editor like Vi, and restore them to the foreground when you want.

7. A Final Word
As you can see, the shell is very comprehensive and using it effectively is a matter
of practice. In this relatively long chapter, we have only mentioned a few of the
available commands: Mandriva Linux has thousands of utilities, and even the most
experienced users do not make use of them all.
There are utilities for all tastes and purposes: you have utilities for handling images
(like convert mentioned above, but also GIMP batch mode and all pixmap handling
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utilities), sound (Ogg Vorbis encoders, audio CD players), CD writing, e-mail
clients, FTP clients and even web browsers (like lynx or links), not to mention all
the administration tools.
Even if graphical applications with equivalent functions do exist, they are usually
graphical interfaces built over these very same utilities. In addition, command-line
utilities have the advantage of being able to operate in non-interactive mode: you
can start writing a CD and then log off the system with the confidence that the
writing will take place (see the nohup(1) man page or the screen(1) man page).
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Chapter 34. Text Editing: Emacs and VI
As stated in the introduction, text editing1 is a fundamental feature when using a
UNIX® system. The two editors we are going to take a quick look at are a little
difficult to use initially, but once you understand the basics, each one can prove
to be a powerful tool. This is particularly because of the numerous edit modes
available which provide specific editing features for a great variety of file types
(Perl, C++, XML, etc.).

1. Emacs
Emacs is probably the most powerful text editor in existence. It can do absolutely
everything and is infinitely extensible through its built-in lisp-based programming
language. With Emacs, you can move around the web, read your mail, take part
in Usenet newsgroups, make coffee, and so on. This is not to say that you will learn
how to do all of that in this chapter, but you will get a good start with opening
Emacs, editing one or more files, saving them and quitting Emacs.
If, after reading this, you wish to learn more about Emacs, you can have a look at
this Tutorial Introduction to GNU Emacs [http://www.lib.uchicago.edu/keith/
tcl-course/emacs-tutorial.html].

1.1. Short Presentation
Invoking Emacs is done as follows on the command line:
emacs [file1] [file2...]

Emacs will open every file entered as an argument into a separate buffer. If more
than two files are specified at the command line, the window will be automatically
split in two and there will be one part of it with the last file specified while the
other part shows a list of available buffers. If you start Emacs without specifying
any files on the command line you will be placed into a buffer called *scratch*.
If you are in X, menus will be available and usable with the mouse, if you're on
text mode, you can still access the menus with the F10 key, but in this chapter we
will concentrate on working strictly with the keyboard and without any menus.

1
“To edit text” means to modify the content of a file containing only letters, digits, and punctuation
symbols. It contains no layout information such as fonts, quadding, etc. Such files may be e-mail messages, source code, documents, or even configuration files.
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1.2. Getting Started
It's now time to get some hands-on experience. For our example, let us start by
opening two files, file1 and file2. If these files do not exist, they will be created
as soon as you write something in them:
$ emacs file1 file2

By typing that command, the following window will be displayed:

Figure 34.1. Editing Two Files at Once
As you can see, two buffers have been created. A third one is also present at the
bottom of the screen (where you see (New file)). That is the mini-buffer. You
cannot access this buffer directly. You must be invited by Emacs during interactive
entries. To change the current buffer, type Ctrl - X - O . You type text just as in a
“normal” editor, deleting characters with the Del or Backspace key.
To move around, you can use the arrow keys, or you could use the following key
combinations: Ctrl - A to go to the beginning of the line, Ctrl - E to go to the end
of the line, Alt - < or Ctrl - Home to go to the beginning of the buffer and Alt - >
or Ctrl - End to go to the end of the buffer. There are many other combinations,
even ones for each of the arrow keys 2.
2

Emacs has been designed to work on a great variety of machines, some of which do not have arrow
keys on their keyboards. This is even more true of Vi.
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1.3. Handling buffers
Once you are ready to save your changes to disk, type Ctrl - X Ctrl - S , or if you
want to save the contents of the buffer to another file, type Ctrl - X Ctrl - W . Emacs
will ask you for the name of the file that the contents of the buffer should be written
to. You can use completion to do this by pressing the Tab key just like with bash.

1.3. Handling buffers
If you want, you can switch to displaying a single buffer on the screen. There are
two ways of doing this:
• If you are in the buffer that you want to hide: type Ctrl - X 0 .
• If you are in the buffer which you want to keep on the screen: type Ctrl - X 1 .
There are two ways of restoring a buffer back to the screen:
• type Ctrl - X B and enter the name of the buffer you want, or
• type Ctrl - X Ctrl - B . This will open a new buffer called *Buffer List*. You
can move around this buffer using the sequence Ctrl - X O , then select the
buffer you want and press the Enter key, or else type the name of the buffer
in the mini-buffer. The buffer *Buffer List* returns to the background once
you have made your choice.
If you have finished with a file and you want to get rid of the associated buffer,
type Ctrl - X K . Emacs will then ask you which buffer it should close. By default,
this will be the buffer you are currently in. If you want to get rid of a buffer other
than the one suggested, enter its name directly or press Tab : Emacs will open yet
another buffer called *Completions* giving the list of possible choices. Confirm
the choice with the Enter key.
You can also restore two visible buffers to the screen at any time. To do this type
Ctrl - X 2 . By default, the new buffer created will be a copy of the current buffer
(which enables you, for example, to edit a large file in several places “at the same
time”). To move between buffers, use the commands that were previously mentioned.
You can open other files at any time, using Ctrl - X Ctrl - F . Emacs will prompt
you for the file name and you can again use completion if you find it more convenient.
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1.4. Copy, Cut, Paste, Search
Suppose you find yourself in the following situation: Figure 34.2, “Emacs, before
copying the text block” [458].

Figure 34.2. Emacs, before copying the text block
First off, you will need to select the text you want to copy. In this example we want
to copy the entire sentence. The first step is to place a mark at beginning of the
area. Assuming the cursor is in the position where it is in Figure 34.2, “Emacs, before
copying the text block” [458], the command sequence would be Ctrl - Space
( Control + space bar). Emacs will display the message Mark set in the mini-buffer.
Next, move to the beginning of the line with Ctrl - A . The area selected for copying
or cutting is the entire area located between the mark and the cursor's current position, so in this case it will be the entire line of text. There are two command sequences available: Alt - W (to copy) or Ctrl - W (to cut). If you copy, Emacs will
briefly return to the mark position so that you can view the selected area.
Finally, go to the buffer where you want the text to end up and type Ctrl - Y . This
will give you the following result:
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1.5. Quit emacs

Figure 34.3. Copying Text with emacs
In fact, what you've done is copy text to Emacs's kill ring. This kill ring contains all
of the areas copied or cut since Emacs was started. Any area just copied or cut is
placed at the top of the kill ring. The Ctrl - Y sequence only “pastes” the area at
the top. If you want to access any of the other areas, press Ctrl - Y then Alt - Y
until you get to the desired text.
To search for text, go to the desired buffer and type Ctrl - S . Emacs will ask you
what string it should search for. To continue a search with the same string in the
current buffer, just type Ctrl - S again. When Emacs reaches the end of the buffer
and finds no more occurrences, you can type Ctrl - S again to restart the search
from the beginning of the buffer. Pressing the Enter key ends the search.
To search and replace, type Alt - % . Emacs asks you what string to search for, what
to replace it with, and asks for confirmation for each occurrence it finds.
To Undo, type Ctrl - X U or Ctrl - Shift - - which will undo the previous operation.
You can undo as many operations as you want.

1.5. Quit emacs
The shortcut to quit Emacs is Ctrl - X Ctrl - C . If you have not saved your changes,
Emacs will ask you whether you want to save your buffers or not.
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2. Vi: the ancestor
Vi was the first full-screen editor in existence. It is one of the main programs UNIX®
detractors point to, but also one of the better arguments of its defenders: while it
is complicated to learn, it is also an extremely powerful tool once you get into the
habit of using it. With a few keystrokes, a Vi user can move mountains, and other
than Emacs, few text editors can make the same claims.
The version supplied with Mandriva Linux is in fact Vim, for VI iMproved, but we
will refer to it as Vi throughout this chapter.
If you wish to learn more about Vi, you can have a look at this Hands-On Introduction to the Vi Editor [http://www.library.yale.edu/wsg/docs/vi_hands_on/] or
at the Vim home page [http://www.vim.org/].

2.1. Insert Mode, Command Mode, ex Mode...
To begin using Vi we use the same sort of command line as we did with Emacs.
So let us go back to our two files and type:
$ vi file1 file2

At this point, you will find yourself looking at a window resembling the following
one:

Figure 34.4. Starting position in VIM
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2.2. Handling Buffers
You are now in command mode in front of the first opened file. In this mode you
cannot insert text into a file. To do so you must switch to insert mode.
Here are some shortcuts to inserting text:
Please note that keyboard shortcut combinations must be typed exactly
as shown, Vi distinguishes between capital and lowercase letters in
commands, so the a command is not the same as the A one.
•

a and i : to insert text after and before the cursor ( A and I insert text at the
end and at the beginning of the current line);

•

o and O : to insert text below and above the current line.

In insert mode, you will see the string --INSERT-- appear at the bottom of the
screen (so you know which mode you are in). This is the only mode which will
allow you to insert text. To return to command mode, press the Esc key.
In insert mode, you can use the Backspace and Del keys to delete text as you go
along. The arrow keys will allow you to move around within the text in Command
mode and Insert mode. In command mode, there are also other key combinations
which we will look at later.
ex mode is accessed by pressing the : key in command mode. A : will appear at
the bottom left of the screen with the cursor positioned after it. Vi will consider
everything you type up to the Enter key as an ex command. If you delete the
command and the : you typed in, you will be returned to command mode and
the cursor will go back to its original position in the text.
You have command completion available while on ex mode, type the
first letters of the command and press the Tab key to complete it.
To save changes to a file type :w in command mode. If you want to save the contents
of the buffer to another file, type :w <file_name>.

2.2. Handling Buffers
To move, in the same buffer, between the files whose names were passed on the
command line, type :next to move to the next file and :prev to move to the previous file. You can also use :e <file_name>, which allows you to either change to
the desired file if it is already open, or to open another file. You may also use
completion.
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2.3. Editing Text and Move Commands
As with Emacs, you can have several buffers displayed on the screen. To do this,
use the :split command.
To change buffers, type Ctrl - w j to go to the buffer below or Ctrl - w k to go to
the buffer above. You can also use the up and down arrow keys instead of j or k .
The :close command hides a buffer and the :q command closes it.
You should be aware that if you try to hide or close a buffer without saving the
changes, the command will not be carried out and Vi will display this message:
No write since last change (use ! to override)
In this case, do as you are told and type :q! or :close!.

2.3. Editing Text and Move Commands
Apart from the Backspace and Del keys in edit mode, Vi has many other commands for deleting, copying, pasting, and replacing text in command mode. All
the commands shown hereafter are in fact separated into two parts: the action to
be performed and its effect. The action may be:
•

c : to replace (Change). The editor deletes the requested text and goes back into
insert mode after this command.

•

d : to delete (Delete);

•

y : to copy (“Yank”). We will look at this in the next section.

•

. : repeats last action.

The effect defines which group of characters the command acts upon.
•

h , j , k , l : one character left, down, up, right3

•

e , b , w : to the end, beginning of the current word and the beginning of the
next word.

•

^ , 0 , $ : to the first non-blank character of the current line, the beginning of
the current line, and the end of current line.

• f<x>: go to next occurrence of character <x>. For example, fe moves the cursor
to the next occurrence of the character e.
3

A shortcut for dl (delete one character forward) is x ; a shortcut for dh (delete one character back) is
X ; dd deletes the current line.
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• /<string>, ?<string>: to the next and previous occurrence of string or regexp
<string>. For example, /foobar moves the cursor to the next occurrence of
the word foobar.
•

{ , } : to the beginning, to the end of current paragraph;

•

G , H : to end of file, to beginning of screen.

Each of these “effect” characters or move commands can be preceded by a repetition
number. For G , (“Go”) this references the line number in the file. Based on this
information, you can make all sorts of combinations.
Here are some examples:
• 6b: moves 6 words backwards;
• c8fk: delete all text until the eighth occurrence of the character k then go into
insert mode;
• 91G: goes to line 91 of the file;
• d3$: deletes up to the end of the current line plus the next two lines.
While many of these commands are not very intuitive, the best method to remember
the commands is to practice them. But you can see that the expression “move
mountains with a few keys” is not much of an exaggeration.

2.4. Cut, Copy, Paste
Vi contains a command which we have already seen for copying text: the y command. To cut text, simply use the d command. There are 27 memories or buffers
for storing text: an anonymous memory and 26 memories named after the 26
lowercase letters of the English alphabet.
To use the anonymous memory you enter the command “as is”. So the command
y12w will copy the 12 words after the cursor into anonymous memory4. Use d12w
if you want to cut this area.
To use one of the 26 named memories, enter the sequence "<x> before the command,
where <x> gives the name of the memory. Therefore, to copy the same 12 words
into the memory k, you would write "ky12w, or "kd12w to cut them.

4

But only if the cursor is positioned at the beginning of the first word!
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To paste the contents of the anonymous memory, use the commands p or P (for
Paste), to insert text after or before the cursor. To paste the contents of a named
memory, use "<x>p or "<x>P in the same way (for example "dp will paste the
contents of memory d after the cursor).
Let us look at an example:

Figure 34.5. VIM, before copying the text block
To carry out this action, we will:
• recopy the first 6 words of the sentence into memory r (for example): "ry6w5;
• go into the buffer file2, which is located below: Ctrl - w j ;
• paste the contents of memory r before the cursor: "rp.
We get the expected result, as shown in Figure 34.6, “VIM, after having copied the
text block” [465].

5

y6w literally means: “Yank 6 words”.
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Figure 34.6. VIM, after having copied the text block
Searching for text is very simple: in command mode, you simply type / followed
by the string to search for, and then press the Enter key. For example, /party will
search for the string party from the current cursor position. Pressing n takes you
to the next occurrence, and if you reach the end of the file, the search will start
again from the beginning. To search backwards, use ? instead of / .

2.5. Quit Vi
The command to quit is :q (in fact, this command actually closes the active buffer,
as we have already seen, but if it is the only buffer open, you will quit Vi). There
is a shortcut: most of the time you edit only one file. So to quit, you will use:
• :wq or :x to save changes and quit (a quicker solution is Z Z ), or
• :q! to quit without saving.
You should note that if you have several buffers, :wq will only write the active
buffer and then close it.

3. A last word...
Of course, we have said much more here than was necessary (after all, the first
aim was to edit a text file), but hopefully we have been able to show you some of
the possibilities of each of these editors. There is a great deal more to be said about
them, as witnessed by the number of books dedicated to each of these editors.
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3. A last word...
Take the time to absorb all this information, opt for one of them, or learn only as
much as you think necessary. But at least you know that when you want to go
further, you can.
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Chapter 35. Command-Line Utilities
The purpose of this chapter is to introduce a number of command-line tools which
may prove useful for everyday use.
One of the primary strengths of GNU/Linux is the use of simple tools to achieve
complex tasks. We have shown you how to tie commands together and how to
clean the output to make it more visible (see Section 4, “Redirections and
Pipes” [448]). Now it is time to learn about some useful tools which will give you
a lot more of control and productivity.
This chapter is meant as an exercise in order for you to fully grasp each command's
function and use. Therefore each command will be illustrated by an example. Don't
be afraid to stop and consult the manual page for any of these commands. At the
bottom of each section you will see “SEE ALSO” sections which cross-reference
you to other interesting commands. You have a new place to explore on your
GNU/Linux system!

1. File Operations and Filtering
Most command-line work is done on files. In this section we will show you how
to watch and filter file content, how to take required information from files using
a single command, and how to easily sort a file's content.

1.1. cat, tail, head, tee: File-Printing Commands
These commands have almost the same syntax: command_name [option(s)] [file(s)],
and may be used in a pipe. All of them are used to print part of a file according to
certain criteria.
The cat utility concatenates files and prints the results to the standard output,
which is usually the screen of your computer. This is one of the most widely used
commands. For example you can use:
# cat /var/log/mail/info

to print the content of a mailer daemon log file to the standard output1. The cat
command has a very useful option (-n) which allows you to print the line numbers.

1
Some examples in this section are based on real work and server log files (services, daemons, etc.).
Make sure syslogd (which allows the logging of a daemon activity), and the corresponding daemon
(in our case Postfix) are running, and that you work as root. Of course, you can always apply our examples to other files.
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1.1. cat, tail, head, tee: File-Printing Commands
Some files such as daemon log files (if they are running) are usually huge in size2
and printing them completely on the screen is not very useful. Generally speaking
you only need to see some lines of the file. You can use the tail command to do so.
The following command will print, by default, the last 10 lines of the
/var/log/mail/info file:
# tail /var/log/mail/info

Files such as logs usually vary dynamically because the daemon associated to that
log constantly adds actions and events to the log file. To interactively watch these
changes you can take advantage of the -f option:
# tail -f /var/log/mail/info

In this case all changes in the /var/log/mail/info file will be printed on screen
immediately. Using the tail command with option -f is very helpful when you
want to know how your system works. For example, looking through the
/var/log/messages log file, you can keep up with system messages and various
daemons.
If you use tail with more than one file it will print the name of the file on a line by
itself before printing its contents. It also works with the -f option and is a valuable
addition to see how different parts of the system interact.
You can use the -n option to display the last n lines of a file. For example, to display
the last 2 lines, you would issue:
# tail -n2 /var/log/mail/info

Just as for other commands, you can use different options at the same time. For
example, using both -n2 and -f at the same time, you start with the two last lines
of the file and keep on seeing new lines as they are written to the log file.
The head command is similar to tail, but it prints the first lines of a file. The following command will print, by default, the first 10 lines of the /var/log/mail/info
file:
# head /var/log/mail/info

As with tail you can use the -n option to specify the number of lines to be printed.
For example, to print the first two, issue:

2

For example, the /var/log/mail/info file contains information about all sent mails, messages about
fetching mail by users with the POP protocol, etc.
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# head -n2 /var/log/mail/info

You can also use these commands together. For example, if you wish to display
only lines 9 and 10, you can use a command where the head command will select
the first 10 lines from a file and pass them through a pipe to the tail command.
# head /var/log/mail/info | tail -n2

The last part will then select the last 2 lines and will print them to the screen. In
the same way you can select line number 20, starting from the end of the file:
# tail -n20 /var/log/mail/info |head -n1

In this example we tell tail to select the file's last 20 lines and pass them through
a pipe to head. Then the head command prints to the screen the first line of the
data obtained.
Lets suppose we want to print the result of the last example to the screen and save
it to the results.txt file. The tee utility can help us. Its syntax is:
tee [option(s)] [file]

Now we can change the previous command this way:
# tail -n20 /var/log/mail/info |head -n1|tee results.txt

Lets take yet another example. We want to select the last 20 lines, save them to
results.txt, but print on screen only the first of the 20 selected lines. Then we
should type:
# tail -n20 /var/log/mail/info |tee results.txt |head -n1

The tee command has a useful option (-a) which enables you to append data to
an existing file.
In the next section we will see how we can use the grep command as a filter to
separate Postfix messages from other messages coming from different services.

1.2. grep: Locating Strings in Files
Neither the name nor the acronym (“General Regular Expression Parser”) is very
intuitive, but what it does and its use are simple: grep looks for a pattern given as
an argument in one or more files. Its syntax is
grep [options] <pattern> [one or more file(s)]
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If several files are mentioned, their names will precede each matching line displayed
in the result. You can use the -h option to prevent displaying these names or you
can use the -l option to get nothing but the matching file names. The pattern is a
regular expression, even though most of the time it consists of a simple word. The
most frequently used options are the following:
• -i: make a case insensitive search (i.e. ignore differences between lower and
uppercase);
• -v: invert search. display lines which do not match the pattern;
• -n: display the line number for each line found;
• -w: tells grep that the pattern should match a whole word.
So let's go back to analyze the mailer daemon's log file. We want to find all lines
in the /var/log/mail/info file which contain the postfix pattern. Then we type
this command:
# grep postfix /var/log/mail/info

If we want to find all lines which do NOT contain the postfix pattern, we would
use the -v option:
# grep -v postfix /var/log/mail/info

The grep command can be used in a pipe.
Let's suppose we want to find all messages about successfully sent mails. In this
case we have to filter all lines which were added to the log file by the mailer daemon
(contains the postfix pattern) and they must contain a message about successful
sending (status=sent)3:
# grep postfix /var/log/mail/info |grep status=sent

In this case grep is used twice. It is allowed, but not very elegant. The same result
can be achieved by using the fgrep utility. fgrep is actually a simpler method to
call grep -F. First we need to create a file containing patterns written out one to a
line. Such a file can be created this way (we use patterns.txt as the file name):
# echo -e 'status=sent\npostfix' >./patterns.txt

3

Although it is possible to filter just by the status pattern please stay with us as we want to show you
a new command with this example.
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1.3. Regular Expressions and Filtering
egrep
Check the results with the cat command. \n is a special pattern which means “new
line”.
Then we call the next command where we use the patterns.txt file and the fgrep
utility instead of “double calling” of grep:
# fgrep -f ./patterns.txt /var/log/mail/info

The file ./patterns.txt may contain as many patterns as you wish. For example,
to select messages about successfully sent mails to peter@mandriva.com, it would
be enough to add this e-mail address into our ./patterns.txt file by running this
command:
# echo 'peter@mandriva.com' >>./patterns.txt

It is clear that you can combine grep with tail and head. If we want to find messages
about the second-to-last e-mail sent to peter@mandriva.com we would type:
# fgrep -f ./patterns.txt /var/log/mail/info | tail -n2 | head -n1

Here we apply the filter described above and place the result in a pipe for the tail
and head commands. They select the last but one value from the data.

1.3. Regular Expressions and Filtering egrep
With grep we are stuck with patterns and fixed data. How would we find all emails sent to each and every employee of “ABC Company”? Listing all their emails would not be an easy task since we might end up missing someone or having
to dig in the log file by hand.
As with fgrep, grep has a shortcut to the command grep -E: egrep. It takes regular
expressions instead of patterns, providing us with a more powerful interface to
“grep” text.
Besides what we mentioned in Section 3, “Shell Globbing Patterns” [447] while
talking about globbing patterns, here are some additional regular expressions:
• [:alnum:] (all letters plus all digits), [:alpha:] (all uppercase and lowercase
letters) and [:digit:] (all digits) can be used instead of defining the classes
of characters yourself. They have an additional bonus: they include internationalized characters and respect the localization of the system.
• [:print:] represents all characters which can be printed on screen.
• [:lower:] and [:upper:] represent all lowercase and uppercase letters.
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1.3. Regular Expressions and Filtering
egrep
There are more classes available and you can see all of them in egrep(1). The above
are the most commonly used ones.
A regular expression may be followed by one of several repetition operators:
?
The preceding item is optional, that is: it is matched zero times or once, but
not more than once.
*
The preceding item will be matched zero or more times.
+
The preceding item will be matched one or more times.
{n}
The preceding item is matched exactly n times.
{n,}
The preceding item is matched n or more times.
{n,m}
The preceding item is matched at least n times, but not more than m times.
If you put a regular expression inside parenthesis you can recover it later. Lets say
that you specified the [:alpha:]+ expression. It might represent a word. If you
want to detect words which occur twice you can put this inside parenthesis and
reuse it with \1 if it is the first group. You can have up to 9 of these “memories”.
$ echo -e "abc def\nabc abc def\nabc1 abc1\nabcdef\nabcdabcd\nabcdef abcef" →
> testfile
$ egrep "([[:alpha:]]+) \1" testfile
abc abc def
$

The [ and ] characters are part of the group name so we have to include
them to use that class of characters. The first [ says that we will be using
a group of characters, the second is part of the name of the group, and
then there are the corresponding closing ] characters.
The only line returned is the one which exclusively matched two groups of letters
separated by a space. No other group matched the regular expression.
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You can also use the | character to match the expression to the left of the | or one
to the right of it. It is an operator which joins those expressions. Using the same
testfile created above, you can try looking for expressions which contain only
double words or contains double words with numbers:
$ egrep "([[:alpha:]]+) \1|([[:alpha:][:digit:]]+) \2" testfile
abc abc def
abc1 abc1
$

Note that for the second group using parenthesis we had to use \2, otherwise it
would not match with what we wanted. A more efficient expression would be, in
this particular case:
$ egrep "([[:alnum:]]+) \1" testfile
abc abc def
abc1 abc1
$

Finally to match certain characters you have to “escape” them, preceding them
with a backslash. Those characters are: ?, +, {, |, (, ) and of course \. To match
those you have to write: \?, \+, \{, \|, \(, \), and \\.
This simple trick might help to prevent you typing repeated words in “your your”
text.
Regular expressions on all tools should follow these, or very similar, rules. Taking
some time to understand theses rules will help a lot with other tools such as sed.
sed allows you to manipulate text, changing it using regular expressions as rules
amongst other things.

1.4. wc: Counting Elements in Files
The wc command (Word Count) is used to count the number of lines, words and
characters in files. It can also compute the length of the longest line. Its syntax is:
wc [option(s)] [file(s)]

The following options are useful:
• -l: print the number of lines;
• -w: print the number of words;
• -m: print the total number of characters;
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• -c: print the number of bytes;
• -L: print the length of the longest line in the text.
The wc command prints the number of lines, words and characters by default.
Here are some usage examples:
If we want to find the number of users in our system, we can type:
$ wc -l /etc/passwd →

If we want to know the number of CPU's in our system, we write:
$ grep "model name" /proc/cpuinfo |wc -l

In the previous section we obtained a list of messages about successfully sent mails
to e-mail addresses listed in our ./patterns.txt file. If we want to know how
many messages it contains, we can redirect our filter's results in a pipe to the wc
command:
# fgrep -f ./patterns.txt /var/log/mail/info | wc -l

1.5. sort: Sorting File Content
Here is the syntax of this powerful sorting utility4:
sort [option(s)] [file(s)]

Let's consider sorting on part of the /etc/passwd file. As you can see this file is
not sorted:
$ cat /etc/passwd

If we want to sort it by login field. Then we type:
$ sort /etc/passwd

The sort command sorts data in ascending order starting by the first field (in our
case, the login field) by default. To sort data in descending order, use the -r option:
$ sort -r /etc/passwd

Every user has his or her own UID written in the /etc/passwd file. The following
command sorts a file in ascending order using the UID field:
4

We will only discuss sort briefly here. Whole books can be written about its features.
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$ sort /etc/passwd -t":" -k3 -n

Here we use the following sort options:
• -t":": tells sort that the field separator is the ":" symbol;
• -k3: means that sorting must be done on the third column;
• -n: says that the sort is to occur on numerical data, not alphabetical.
The same can be done in reverse:
$ sort /etc/passwd -t":" -k3 -n -r

Note that sort has two other important options:
• -u: perform a strict ordering: duplicate sort fields are discarded;
• -f: ignore case (treat lowercase characters the same way as uppercase ones).
Finally, if we want to find the user with the highest UID we can use this command:
$ sort /etc/passwd -t":" -k3 -n |tail -n1

where we sort the /etc/passwd file in ascending order according to the UID column,
and redirect the result through a pipe to the tail command. The latter will print
out the first value of the sorted list.

2. find: Finding Files According to Certain Criteria
find is a long-standing UNIX® utility. Its role is to recursively scan one or more
directories and find files which match a certain set of criteria in those directories.
Even though it is very useful, the syntax is truly obscure, and using it requires a
little practice. The general syntax is:
find [options] [directories] [criterion1] ... [criterionN] [action]

If you do not specify any directory, find will search the current directory. If you
do not specify criteria, this is equivalent to “true”, thus all files will be found. The
options, criteria and actions are so numerous that we will only mention a few of
each here. Here are some options:
• -xdev: do not search on directories located on other file systems.
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• -mindepth <n>: descend at least n levels below the specified directory before
searching for files.
• -maxdepth <n>: search for files which are located at most n levels below the
specified directory.
• -follow: follow symbolic links if they link to directories. By default, find does
not follow links.
• -daystart: when using tests related to time (see below), take the beginning of
current day as a time stamp instead of the default (24 hours before current
time).
A criteria may be one or more of several atomic tests. Some useful tests are:
• -type <file_type>: search for a given type of file. file_type can be one of:
f (regular file), d (directory), l (symbolic link), s (socket), b (block mode file),
c (character mode file) or p (named pipe).
• -name <pattern>: find files whose names match the given pattern. With this
option, the pattern is treated as a shell globbing pattern (see Section 3, “Shell
Globbing Patterns” [447]).
• -iname <pattern>: like -name, but ignore case.
• -atime <n>, -amin <n>: find files which have last been accessed n days ago
(-atime) or n minutes ago (-amin). You can also specify <+n> or <-n>, in which
case the search will be done for files accessed at most or at least n days/minutes
ago.
• -anewer <a_file>: find files which have been accessed more recently than file
a_file.
• -ctime <n>, -cmin <n>, -cnewer <file>: same as for -atime, -amin and
-anewer, but applies to the last time that the contents of the file were modified.
• -regex <pattern>: same as -name, but pattern is treated as a regular expression.
• -iregex <pattern>: same as -regex, but ignoring case.
There are many other tests, refer to find(1) for more details. To combine tests, you
can use one of:
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• <c1> -a <c2>: true if both c1 and c2 are true; -a is implicit, therefore you can
type <c1> <c2> <c3> if you want all c1, c2 and c3 tests to match.
• <c1> -o <c2>: true if either c1 or c2 are true, or both. Note that -o has a lower
precedence than -a, therefore if you want to match files which match criteria c1
or c2 and also match criterion c3, you will have to use parentheses and write
( <c1> -o <c2> ) -a <c3>. You must escape (deactivate) parentheses, as
otherwise they will be interpreted by the shell!
• -not <c1>: inverts test c1, therefore -not <c1> is true if c1 is false.
Finally, you can specify an action for each file found. The most frequently used
are:
• -print: just prints the name of each file on the standard output. This is the
default action.
• -ls: prints on the standard output the equivalent of ls -ilds for each file found.
• -exec <command_line>: executes command command_line on each file found.
The command line command_line must end with a ;, which you must escape
so that the shell does not interpret it. The file position is marked with {}. See
the usage examples.
• -ok <command>: same as -exec but asks for confirmation for each command.
The best way to consolidate all of the options and parameters is with some examples. We want to find all directories in the /usr/share directory. We would
type:
find /usr/share -type d

Suppose you have an HTTP server. All your HTML files are in /var/www/html,
which is also your current directory. You want to find all files whose contents have
not been modified for a month. Because you have pages from several writers, some
files have the html extension and some have the htm extension. You want to link
these files in the /var/www/obsolete directory. You would type5:
find \( -name "*.htm" -o -name "*.html" \) -a -ctime -30 \
-exec ln {} /var/www/obsolete \;

5

Note that this example requires that /var/www and /var/www/obsolete be on the same file system!
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This is a fairly complex example, and requires a little explanation. The criterion is
this:
\( -name "*.htm" -o -name "*.html" \) -a -ctime -30

which does what we want: it finds all files whose names end either in .htm or
.html (“ \( -name "*.htm" -o -name "*.html" \)”), and (-a) which have not
been modified in the last 30 days, which is roughly a month (-ctime -30). Note
the parentheses: they are necessary here, because -a has a higher precedence. If
there weren't any, all files ending with .htm would have been found, plus all files
ending with .html and which haven't been modified for a month, which is not
what we want. Also note that parentheses are escaped from the shell: if we had
put ( .. ) instead of \( .. \), the shell would have interpreted them and tried
to execute -name "*.htm" -o -name "*.html" in a sub-shell... Another solution
would have been to put parentheses between double quotes or single quotes, but
a backslash here is preferable as we only have to isolate one character.
And finally, there is the command to be executed for each file:
-exec ln {} /var/www/obsolete \;

Here too you have to escape the ; character from the shell. Otherwise the shell
would interpret it as a command separator. If you happen to forget, find will
complain that -exec is missing an argument.
A last example: you have a huge directory (/shared/images) containing all kinds
of images. You regularly use the touch command to update the times of a file
named stamp in this directory, so that you have a time reference. You want to find
all JPEG images which are newer than the stamp file, but because you got the images
from various sources, these files have extensions jpg, jpeg, JPG or JPEG. You also
want to avoid searching in the old directory. You want this file list to be mailed
to you, and your user name is peter:
find /shared/images -cnewer
\
/shared/images/stamp
\
-a -iregex ".*\.jpe?g"
\
-a -not -regex ".*/old/.*" \
| mail peter -s "New images"

Of course, this command is not very useful if you have to type it each time, and
you would like it to be executed regularly. A simple way to have the command
run periodically is to use the cron daemon as shown in the next section.
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3.1. crontab: Reporting or Editing your crontab File
crontab allows you to execute commands at regular time intervals with the added
bonus that you don't have to be logged in. crontab will have the output of your
command mailed to you. You can specify the intervals in minutes, hours, days,
and even months. Depending on the options, crontab will act differently:
• -l: print your current crontab file;
• -e: edit your crontab file;
• -r: remove your current crontab file;
• -u <user>: apply one of the above options for user <user>. Only root can do
this.
Let's start by editing a crontab file. If you type crontab -e, you will be in front of
your favorite text editor if you have set the EDITOR or VISUAL environment variable,
otherwise Vi will be used. A line in a crontab file is made of six fields. The first
five fields are time intervals for minutes, hours, days in the month, months and
days in the week. The sixth field is the command to be executed. Lines beginning
with a # are considered as comments and will be ignored by crond (the program
which is responsible for executing crontab files). This format is a little different
for the system crontab, in /etc/crontab. There, the sixth field is the user name
that should be used to start the program on the seventh field. It should be used
for administrative tasks only, and for running jobs of users which exist only to
enhance the system safety (such as an anti-virus user or a user that was created to
run a database server). Here is an example of crontab:
In order to print this out in a readable font, we had to break up long lines.
Therefore, some chunks must be typed on a single line. When the \
character ends a line, it means that line is to be continued. This convention
works in Makefile files and in the shell, as well as in other contexts.
# If you don't want to be sent mail, just comment
#
out the following line
#MAILTO="your_email_address"
#
# Report every 2 days about new images at 2 pm,
#
from the example above - after that, "retouch"
#
the "stamp" file. The "%" is treated as a

479

3.2. at: Scheduling a command, but Only
Once
#
newline, this allows you to put several
#
commands in a same line.
0 14 */2 * * find /shared/images
\
-cnewer /shared/images/stamp
\
-a -iregex ".*\.jpe?g"
\
-a -not -regex
\
".*/old/.*"%touch /shared/images/stamp
#
# Every Christmas, play a melody :)
0 0 25 12 * mpg123 $HOME/sounds/merryxmas.mp3
#
# Every Tuesday at 5pm, print the shopping list...
0 17 * * 2 lpr $HOME/shopping-list.txt

There are several ways to specify intervals other than the ones shown in this example. You can specify a set of discrete values separated by commas (1,14,23) or
a range (1-15), or even combine both of them (1-10,12-20), optionally with a step
(1-12,20-27/2). Now it's up to you to find useful commands to put in it!

3.2. at: Scheduling a command, but Only Once
You may also want to launch a command at a given day, but not regularly. For
example, you want to be reminded of an appointment, today at 6pm. You run X,
the X11R6-contrib package is installed, and you would like to be notified at 5:30pm,
for example, that you must go. at is what you want here:
$ at 5:30pm
# You're now in front of the "at" prompt
at> xmessage "Time to go now! Appointment at 6pm"
# Type CTRL-d to exit
at> <EOT>
job 1 at 2005-02-23 17:30
$

You can specify the time in different ways:
• now + <interval>: means, well, now, plus an interval (Optional. No interval
specified means just now). The syntax for the interval is <n>
(minutes|hours|days|weeks|months). For example, you can specify now +
1 hour (an hour from now), now + 3 days (three days from now) and so on.
• <time> <day>: fully specify the date. The <time> parameter is mandatory. at is
very liberal in what it accepts: you can type 0100, 04:20, 2am, 0530pm, 1800, or
one of three special values: noon, teatime (4pm) or midnight. The <day>
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parameter is optional. You can specify this in different ways as well: 12/20/2001
for example, which stands for December 20th, 2001, or, the European way,
20.12.2001. You may omit the year, but then only the European notation is
accepted: 20.12. You can also specify the month in full letters: Dec 20 and 20
Dec are both valid.
at also accepts different options:
• -l: prints the list of currently queued jobs; the first field is the job number. This
is equivalent to the atq command.
• -d <n>: remove job number <n> from the queue. You can obtain job numbers
from atq. This is equivalent to atrm <n>.
As usual, see the at(1) manpage for more options.

4. Archiving and Data Compression
4.1. tar: Tape ARchiver
Just like find, tar is a long standing UNIX® utility, so its syntax is a bit special. The
syntax is:
tar [options] [files...]

Here is a list of some options. Note that all of them have an equivalent long option,
but you will have to refer to tar(1), as we will not list them here.
The initial dash (-) of short options is now deprecated with tar, except
after a long option.
• c: used in order to create new archives.
• x: used to extract files from an existing archive.
• t: lists files from an existing archive.
• v: enhances verbosity. Lists files which are added to an archive or extracted
from an archive. If in conjunction with the t option (see above), it outputs a
long listing of files instead of a short one.
• f <file_name>: creates an archive with name file_name, extracts from archive
file_name or lists files from archive file_name. If this parameter is omitted,
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the default file will be /dev/rmt0, which is generally the special file associated
with a streamer. If the file parameter is - (a dash), the input or output (depending
on whether you create an archive or extract from one) will be associated to the
standard input or standard output.
• z: tells tar that the archive to create should be compressed with gzip, or that
the archive to extract from is compressed with gzip.
• j: same as z, but the program used to compress is bzip2.
• p: when extracting files from an archive, preserve all file attributes, including
ownership, last access time and so on. Very useful for file system dumps.
• r: appends the list of files given on the command line to an existing archive.
Note that the archive to which you want to append files must not be compressed!
• A: appends archives given on the command line to the one submitted with the
f option. Similar to r, the archives must not be compressed in order for this to
work.
There are many, many, many other options, so please refer to tar(1) for the entire
list. See, for example, the d option.
Let's proceed with an example. Say you want to create an archive of all images in
the /shared/images directory, compressed with bzip2, named images.tar.bz2
and located in your /home directory. You would then type:
#
# Note: you must be in the directory from which
#
you want to archive files!
#
$ cd /shared
$ tar cjf ~/images.tar.bz2 images/

As you can see, we used three options here: c told tar we wanted to create an
archive, j to compress it with bzip2, and f ~/images.tar.bz2 that the archive
was to be created in our home directory, and we want its name to be images.tar.bz2. We may want to check if the archive is valid now. We can do this
by listing its files:
#
# Get back to our home directory
#
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$ cd
$ tar tjvf images.tar.bz2

Here we told tar to list (t) files from the images.tar.bz2 archive (f images.tar.bz2), warned that this archive was compressed with bzip2 (j), and that
we wanted a long listing (v). Now, say you have erased the images directory.
Fortunately your archive is intact and you now want to extract it back to its original
place, in /shared. But as you don't want to break your find command for new
images, you need to preserve all file attributes:
#
# cd to the directory where you want to extract
#
$ cd /shared
$ tar jxpf ~/images.tar.bz2

And here you are!
Now, let's say you want to extract the images/cars directory from the archive,
and nothing else. Then you can type this:
$ tar jxf ~/images.tar.bz2 images/cars

If you try to back up special files, tar will take them as what they are, special files,
and will not dump their contents. So yes, you can safely put /dev/mem in an archive.
It also deals correctly with links, so do not worry about this either. For symbolic
links, also look at the h option in the manpage.

4.2. bzip2 and gzip: Data Compression Programs
We have already discussed these utilities when dealing with tar. Unlike WinZip®
on Windows®, archiving and compressing are done using two separate utilities:
tar for archiving, and the two programs which we will now introduce for compressing data: bzip2 and gzip. You might also use a different compression tool, programs
such as zip, arj or rar also exist for GNU/Linux (but they are rarely used).
At first, bzip2 was written as a replacement for gzip. Its compression ratios are
generally better, but on the other hand, it requires more resources while working.
However gzip is still used for compatibility with older systems.
Both commands have a similar syntax:
gzip [options] [file(s)]
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If no file name is given, both gzip and bzip2 will wait for data from the standard
input and send the result to the standard output. Therefore, you can use both
programs in pipes. Both programs also have a set of common options:
• -1, ..., -9: set the compression ratio. The higher the number, the better the
compression, but better also means slower.
• -d: decompress file(s). This is equivalent to using gunzip or bunzip2.
• -c: dump the result of compression/decompression of files given as parameters
to the standard output.
By default both gzip and bzip2 erase the file(s) that they have compressed
(or uncompressed) if you don't use the -c option. You can avoid doing
this in bzip2 by using the -k option. gzip has no equivalent option.
Now some examples. Let's say you want to compress all files ending with .txt in
the current directory using bzip2 with maximum compression. You would type:
$ bzip2 -9 *.txt

Now you want to share your image archive with someone, but he does not have
bzip2, only gzip. You don't need to decompress the archive and re-compress it,
you can just decompress to the standard output, use a pipe, compress from
standard input and redirect the output to the new archive. Like this:
bzip2 -dc images.tar.bz2 | gzip -9 >images.tar.gz

You could have typed bzcat instead of bzip2 -dc. There is an equivalent for gzip
but its name is zcat, not gzcat. You also have bzless for bzip2 files and zless for
gzip if you want to view compressed files directly instead of having to decompress
them first. As an exercise, try and find the command you would have to type in
order to view compressed files without decompressing them, and without using
bzless or zless.

5. Many, Many More...
There are so many commands that a comprehensive book about them would be
the size of an encyclopedia. This chapter hasn't even covered a tenth of the subject,
yet you can do much with what you learned here. If you wish, you may read some
manual pages: sort(1), sed(1) and zip(1L) (yes, you are right: you can extract or
make .zip archives with GNU/Linux), convert(1), and so on. The best way to get
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accustomed to these tools is to practice and experiment with them, and you will
probably find a lot of uses for them, even quite unexpected ones. Have fun!
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Chapter 36. Process Control
We have already seen in Section 3, “Processes” [386] what a process is. We will
now learn how to list processes and their characteristics, and how to manipulate
them.

1. More About Processes
It is possible to monitor processes and to tell them to terminate, pause, continue,
etc. To understand the examples we are going to examine, it is helpful to know a
bit more about these processes.

1.1. The Process Tree
As with files, all processes which run on a GNU/Linux system are organized in a
tree form. The root of this tree is init, a system-level process which is started at
boot time. The system assigns a number (PID, Process ID) to each process in order
to uniquely identify processes. They also inherit the PID of their parent process
(PPID, Parent Process ID). init is its own father: the PID and PPID of init is 1.

1.2. Signals
Every process in UNIX® can react to signals sent to it. There are 64 different signals
which are identified either by their number (starting from 1) or by their symbolic
names (SIGx, where x is the signal's name). The 32 “higher” signals (33 to 64) are
real-time signals and are beyond the scope of this chapter. For each of these signals,
the process can define its own behavior, except for two signals: signal number 9
(KILL) and number 19 (STOP).
Signal 9 terminates a process irrevocably without giving it the time to terminate
properly. This is the signal you send to a process which is stuck or exhibits other
problems. A full list of signals is available using the kill -l command.

2. Information on Processes: ps and pstree
These two commands display a list of processes currently running on the system,
according to the criteria you set. pstree has a cleaner output when compared to
ps -f.

2.1. ps
Running ps without arguments will show only processes initiated by you and attached to the terminal you are using:
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$ ps
PID TTY
18614 pts/3
20173 pts/3

TIME CMD
00:00:00 bash
00:00:00 ps

As with many UNIX® utilities, ps has a handful of options, the most common of
which are:
• a: displays processes started by all users;
• x: displays processes with no control terminal or with a control terminal different
to the one you are using;
• u: displays for each process the name of the user who started it and the time at
which it was started.
There are many other options. Refer to the ps(1) manual page for more information.
The output of ps is divided into different fields: the most interesting one is the PID
field which contains the process identifier. The CMD field contains the name of the
executed command. A very common way of invoking ps is as follows:
$ ps ax | less

This gives you a list of all processes currently running so that you can identify one
or more processes which are causing problems, and subsequently terminate them.

2.2. pstree
The pstree command displays processes in the form of a tree structure. One advantage is that you can immediately see the processes' parents: when you want to
kill a whole series of processes and if they are all parents and children, you can
simply kill the parent. You will want to use the -p option to display the PID of
each process, and the -u option to show the name of the user who started it. Because
the tree structure is generally quite long, you should invoke pstree in the following
way:
$ pstree -up | less

This gives you an overview of the whole process tree structure.
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3.1. kill, killall
These two commands are used to send signals to processes. The kill command
requires a process number as an argument, while killall requires a process name.
Both of these commands can optionally receive the signal number of the signal to
be sent as an argument. By default, they both send the signal 15 (TERM) to the relevant process(es). For example, if you want to kill the process with PID 785, enter
the command:
$ kill 785

If you want to send it signal 19 (STOP), enter:
$ kill -19 785

Suppose instead that you want to kill a process where you know the command
name. Instead of finding the process number using ps, you can kill the process by
its name. If the process name is “mozilla” you could issue the command:
$ killall -9 mozilla

Whatever happens, you will only kill your own processes (unless you are root)
so you do not need to worry about other users' processes if you are running on a
multi-user system, since they will not be affected.

3.2. Mixing ps and kill: top
top is a program which simultaneously fulfills the functions of ps and kill, and is
also used to monitor processes in real-time giving information about CPU and
memory usage, running time, etc., as shown in Figure 36.1, “Monitoring Processes
with top” [490].
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Figure 36.1. Monitoring Processes with top
The top utility is entirely keyboard controlled. You can access help by pressing h .
Its most useful commands are the following:
•

k : this command is used to send a signal to a process. top will then ask you
for the process' PID followed by the number or the name of the signal to be
sent (TERM or 15 by default);

•

M : this command is used to sort processes by the amount of memory they take
up (field %MEM);

•

P : this command is used to sort processes by the CPU time they take up (field
%CPU): this is the default sorting method;

•

u : this one is used to display a given user's processes. top will ask you which
one. You need to enter the user's name, not his UID. If you do not enter any
name, all processes will be displayed;

•

i : by default, all processes, even sleeping ones, are displayed. This command
ensures that only processes currently running are displayed (processes whose
STAT field shows R, Running) and not the others. Using this command again
takes you back to showing all processes.

•

r : this command is used to change the priority of a selected process.
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Every process in the system is running with defined priorities, also called “nice
value”, which may vary from -20 (highest priority) to 19 (lowest priority). If not
defined, every process will run with a default priority of 0 (the “base” scheduling
priority). Processes with greater priority (lower nice value, down to -20) will be
scheduled to run more often than others which have less priority (up to 19), thus
granting them more processor cycles. Regular users may only lower the priority
of processes they own within a range of 0 to 19. The super-user (root) may set the
priority of any process to any value.

4.1. renice
If one or more processes use too many system resources, you can change their
priorities instead of killing them. To do so, use the renice command. Its syntax is
as follows:
renice priority [[-p] pid ...] [[-g] pgrp ...] [[-u] user ...]

where priority is the value of the priority, pid (use option -p for multiple processes) is the process ID, pgrp (use the -g option if there is more than one) is the
process group ID, and user (-u for more than one) is the user name of the process'
owner.
Let's suppose you have a process running with PID 785, which is performing a
long and complex scientific calculation, and while it is working you want to play
a game for which you need to free system resources. Then you would type:
$ renice +15 785

In this case your process could potentially take longer to complete but will not
take CPU time from other processes.
If you are the system administrator and you see that some user is running too
many processes and they are using too many system resources, you can change
that user's processes priority with a single command:
# renice +20 -u peter

After this, all of peter's processes will have the lowest priority and will not obstruct
any other processes launched by other users.
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4.2. nice
Now that you know that you can change the priority of processes, you may wish
to run a command with a defined priority. For this, use the nice command.
In this case you need to specify your command as an option to nice. Option -n is
used to set priority value. By default nice sets a priority of 10.
For example, you want to create an ISO image of a Mandriva Linux installation
CD-ROM:
$ dd if=/dev/cdrom of=~/mandriva1.iso

On some systems with a standard IDE CD-ROM, the process of copying large
volumes of information can use too many system resources. To prevent the copying
from blocking other processes, you can start the process with a lower priority by
using this command:
$ nice -n 19 dd if=/dev/cdrom of=~/mandriva1.iso
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Chapter 37. The Start-Up Files: init sysv
The System V start-up scheme is inherited from AT&T UNIX® and is one of the
traditional UNIX® schemes to start up the system. It is responsible for starting or
stopping services to bring the system into one of the default system states. Services
range from basic user authentication to local graphical server or Internet services.

1. In the Beginning Was init
When the system starts, and after the kernel has configured everything and
mounted the root file system, it executes /sbin/init1. init is the father of all of the
system's processes and is responsible for taking the system to the desired run level.
We will look at runlevels later on (see Section 2, “Runlevels” [494]).
The init configuration file is called /etc/inittab and has its own manual page
(inittab(5)), so we will only document a few of the possible configuration values.
The first line which should be the focus of your attention is this one:
si::sysinit:/etc/rc.d/rc.sysinit

This line tells init that /etc/rc.d/rc.sysinit is to be run once the system has been
initialized (si stands for System Init). To determine the default runlevel, init will
then look for the line containing the initdefault keyword:
id:5:initdefault:

In this case, init knows that the default runlevel is 5. It also knows that to enter
level 5, it must run the following command:
l5:5:wait:/etc/rc.d/rc 5

As you can see, the syntax for each runlevel is similar.
init is also responsible for restarting (respawn) some programs which cannot be
started by any other process. For example, each of the login programs which run
on the six virtual consoles are started by init2. The second virtual console is identified this way:

1
Which is why putting /sbin on a file system other than the root one would be a very bad idea. The
kernel has not mounted any other partitions at this point, and therefore would not be able to find
/sbin/init.
2
If you do not want six virtual consoles, you may add or remove some by modifying this file. If you
wish to increase the number of consoles, you can have up to a maximum of 64. But don't forget that X
also runs on a virtual console, so leave at least one console free for X.
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2. Runlevels
2:2345:respawn:/sbin/mingetty tty2

2. Runlevels
All files related to system start-up are located in the /etc/rc.d directory. Here is
the list of the files:
$ ls /etc/rc.d
init.d/ rc0.d/
rc*
rc1.d/

rc2.d/
rc3.d/

rc4.d/
rc5.d/

rc6.d/
rc.alsa_default*

rc.local*
rc.modules*

rc.sysinit*

As already stated, rc.sysinit is the first file run by the system. It is responsible
for setting up the basic machine configuration: keyboard type, configuration of
certain devices, file-system checking, etc.
Then the rc script is run with the desired runlevel as an argument. As we have
seen, the runlevel is a simple integer, and for each runlevel <x> defined, there must
be a corresponding rc<x>.d directory. In a typical Mandriva Linux installation,
you might therefore see that there are six runlevels:
• 0: complete machine stop.
• 1: single-user mode. To be used in the event of major problems or system recovery.
• 2: multi-user mode, with no network.
• 3: Multi-user mode, with networking
• 4: unused.
• 5: like runlevel 3, but launches the graphical login interface.
• 6: restart.
Let's take a look at the content of the rc3.d directory:
$ ls /etc/rc.d/rc3.d/
K09dm@
S12syslog@ S24messagebus@
S40atd@
S91dictd-server@
S01udev@
S13partmon@ S25haldaemon@
S55sshd@
S92lisa@
S03iptables@
S15cups@
S25netfs@
S56ntpd@
S95kheader@
S05harddrake@ S17alsa@
S29numlock@
S56rawdevices@ S99local@
S10network@
S18sound@
S33nifd@
S75keytable@
S11shorewall@ S20xfs@
S34mDNSResponder@ S90crond@
$

494

2.1. Configuring Services on Run Levels
As you can see, all the files in this directory are symbolic links, and they all have
a very specific form. Their general form is:
<S|K><order><service_name>

The S means Start service, and K means Kill (stop) it. The scripts are run in ascending
numerical order, and if two scripts have the same number, the ascending alphabetical order will apply. We can also see that each symbolic link points to a given
script located in the /etc/init.d directory (other than the local script which is
responsible for controlling a specific service).
When the system goes into a given runlevel, it starts by running the K links in order:
the rc command looks at where the link is pointing, then calls up the corresponding
script with a single argument: stop. It then runs the S scripts using the same
method, except that the scripts are called with a start parameter.
So, without discussing all the scripts, we can see that when the system goes into
runlevel 3, it first runs the K09dm command, (i.e. /etc/init.d/dm stop). Next, it
runs all the S scripts: first S01udev, which in turn calls /etc/init.d/udev start, then
S03iptables, and so on.
Armed with this information, you can create your own complete runlevel in a few
minutes (using runlevel 4, for instance), or prevent a service from starting or
stopping by deleting the corresponding symbolic link.

2.1. Configuring Services on Run Levels
You can also use the chkconfig command to add, remove, activate or deactivate
services from given run levels. Use chkconfig --add service_name to add (activate)
the service service_name to all supported3run levels and chkconfig --del service_name to remove (deactivate) the named service from all run levels.
Issue chkconfig --list to see which services are available, their names,
and their status in all defined run levels.
Issuing chkconfig --levels 35 sshd on will activate the SSH server (sshd) on run
levels 3 and 5, while issuing chkconfig --levels 3 sound off will remove sound
support from run level 3. If you omit the --levels levels_list parameter, the
named service will be activated or deactivated on run levels 2, 3, 4 and 5. Note
however, that you could end up enabling services on run levels without proper
support for those services, so it's better to specify the run levels to be affected.
3
“Supported” run levels mean that, for example, network-related services will not be added to run
level 2, which doesn't support networking.

495

2.2. Controlling Services On a Running
System

2.2. Controlling Services On a Running System
Services can be controlled on a running system with the service command
whether or not they are configured to be run on a particular run level. Its syntax
is as follows:
service service_name action

Where service_name is the name of the service to control as listed by chkconfig
--list, and action is one of:
start
Starts the named service. Please note that most services will warn you when
they are already started and you pretend to start them again: use restart instead, see below.
stop
Stops the named service. Please note that all users connected to this service
will be automatically disconnected when you stop the service.
restart
Stops and then starts the named service. It is the equivalent of running service
service_name stop && service service_name start. Please note that all users
connected to this service will be automatically disconnected when you restart
the service.
other actions that are service-dependent
Different services support different actions (the previous ones are supported
by all services). For example reload to reload the service's configuration file
without restarting the service; force-stop to force shutdown of the service;
status to be informed of the service's status; etc. Run service service_name
to be informed of all actions supported by the named service.
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Chapter 38. Secure Remote Access
System administrators need to connect to physically distant machines in order to
edit configuration files, control services, run programs, etc. telnet was used to access
remote systems, however it is an insecure solution. Since all communications take
place over the public (and inherently insecure) Internet, system administrators
need a secure remote access solution. ssh (which stands for Secure SHell) lets you
access remote machines in a secure way, encrypting all communications.

Figure 38.1. SSH Connection Schema

1. SSH Server Setup
By “server” we mean the machine you will be connecting to. Simply make sure
that the openssh-server package is installed, and that the sshd service is running1.
The basic SSH server setup allows users to access (or “ssh into”) a machine,
provided they have an account on it. If you want to restrict SSH access to a given
list of users, edit the /etc/ssh/sshd_config file and add or modify a line to look
like the following:
AllowUsers queen peter@192.168.0.*

1

Issue the service sshd start command to start it right away. The SSH service is configured to be launched
at boot time.
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2. SSH Client Setup
The above example will only allow users queen and peter to connect through SSH
into the machine; peter will only be allowed access from a machine in the
192.168.0. (local) network.
Users will have to connect with their normal accounts and then use the su command
to become root. To allow users to connect as root directly through SSH, change
the line PermitRootLogin no to PermitRootLogin yes. Please bear in mind that
this setting, though convenient, is not very secure.
Please refer to sshd(8) and sshd_config(5) for more information on SSH server
options and setup.

2. SSH Client Setup
By “client” we mean the machine you will be connecting from. Simply make sure
that the openssh-clients package is installed.
Type ssh username@remote_machine to connect to the remote_machine system
with the username account. You will be asked for your password on the remote
system. Enter it and you'll be granted access as if you were sitting at that remote
system's console.
Whether you connect to one or many machines (common scenario for system administrators), the password prompt step can be bypassed by using SSH keys. Use
the ssh-keygen command to generate your SSH key, and then the ssh-copy-id
username@remote_machine command to copy your key over to the remote machines. When you issue the ssh-copy-id command you will be asked to enter your
password on the remote system, but only once per system. Now you can SSH
directly into the remote machines without being asked for your password.
For this mechanism to work, you have to run the ssh-add command and
enter your passphrase — created when you generated your SSH keys —
each time you begin your session on the client machine.
If you get a message stating that the connection to your authentication
agent could not be opened, run the eval `ssh-agent` command (note the
backquotes) before running ssh-add.

3. Copying Files to or From The Remote System
To transfer files to a remote system running an SSH server use the scp command,
which stands for Secure CoPy. Its syntax is as follows:
scp [options] local_path [user@]remote_host:[full_path_on_the_remote_host]
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3. Copying Files to or From The Remote
System
If you don't specify the user@ part, then your login on the client machine will be
used. If you omit the path on the remote machine, the file will be copied on the
user's home directory on the remote system. Note that the colon (:) separates the
user name and the machine specification from the path on the remote machine.
To transfer files from the remote system to the local machine the syntax is as follows:
scp [options] [user@]remote_host:full_path_on_the_remote_host local_path

If the source path specifies a directory, then the -r (recursive) option is mandatory.
Please refer to scp(1) for more information on scp's options.
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Chapter 39. Package Management From
The Command Line
Rpmdrake applications are merely graphical interfaces to the powerful urpmi
command line tools. For those wishing to manage their packages via the command
line (useful if you are working remotely, for example) we present the most useful
commands.

1. Installing and Removing Packages
This is done with two simple commands:
urpmi <package_name>
With this command the package_name will be installed if it exists. If the package
contains the package_name string it will also work. If more than one package
matches, you will see a numbered list of potential matches: just type the
number of the one you are interested in and tap Enter .
If the package you are trying to install has dependencies (other packages it
needs to function correctly) its list will be displayed. Review it and press the
Y key to install all packages.
urpme <package_name>
This command will remove the package package_name. If other installed
packages depend on the one you are trying to remove, a list will be presented
along with the reason why they will have to be removed. Review the list and
press the Y key to remove all packages.
Both urpmi and urpme support the --auto option to install or remove
packages by handling the dependencies automatically.
Consult the urpmi(8) and urpme(8) man pages for more information about these
commands' options.

2. Media Management
Software media are the different “sources” where you can install packages from.
There must be at least one medium defined for urpmi to work. Predefined media
include the ones you used to install your system (network, CD, DVD, etc.). You
should define other media to install bugfixes and security updates. Adding and
removing media is easy, but the syntax must be strictly respected.
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2.1. Adding New Media

2.1. Adding New Media
urpmi.addmedia <name> <URL>

This command allows you to add a new medium either from a local drive, a removable device (CD/DVD), or from the network through the HTTP, FTP, NFS, ssh or
rsync protocols. The URL syntax varies for each of these media so you are encouraged to consult the urpmi.addmedia(8) man page before using it.
If you are adding a new update medium, use the --update option on
your urpmi.addmedia command line.
You can use online resources such as the Easy Urpmi Page [http://easyurpmi.
zarb.org/] if you don't know where to find media containing useful applications
specially packaged for your Mandriva Linux system. The Mandriva Club [http:/
/club.mandriva.com/] site also provides the Urpmi media [http://club.mandriva.
com/modules.php?name=Mirrors-list] module for test and contribution packages.
The Mandriva Club media list is only available to its members.

2.2. Removing Media
urpmi.removemedia <name>

This command will simply remove the medium name. If you cannot remember the
medium's name, issuing urpmi.removemedia alone on the command line will list
all defined media.

2.3. Updating Media
urpmi.update <name>

This command scans the named medium and updates the package list associated
with it. This is useful for media which change often, such as the security and
bugfix updates ones. Use the -a option to rescan all the defined media.

2.4. Media Order
The order in which media are defined in the /etc/urpmi/urpmi.cfg file is important because it dictates the medium from which packages will be installed when
there is more than one media providing a given package: packages will be installed
from the first listed medium which contains them.
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3. Tricks and Recipes
When adding network media, they'll be added before removable and
local media. This is mainly because networked media is expected to have
more up-to-date packages than removable or local ones.

3. Tricks and Recipes
3.1. Synthesized vs. Complete Lists
When adding media, there are two options for the list of packages: synthesized or
complete. Use the --probe-synthesis option to try to find and use a synthesized
list of packages, or the --probe-hdlist to try to find and use a complete one.
Synthesized lists are smaller in size, making them more suited for users with slower
network connections. However they are more limited when looking for information
on packages.

3.2. Finding the Package which Contains a Specific File
You know you need a specific file on your system but you don't know which
package provides it. Issue urpmf <file_name> and any packages, installed or not,
which contain the file_name file will be displayed.
If you use the synthesized lists, urpmf can only search for files on already
installed packages.
You can even provide only a partial name. For example urpmf salsa will return a
list of all packages which contain a file whose name contains the word salsa.
[root@test queen]# urpmf salsa
kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa-1.1.2.so
kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa.la
kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa.so

3.3. Updating Packages
This command will update the named package:
urpmi.update -a && urpmi --update <package_name>

This command will automatically update all the packages which need it as Mandriva Update would do it:
urpmi.update -a && urpmi --update --auto-select --auto
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3.3. Updating Packages
If you don't have any medium specifically configured as an update medium, you
have to omit the --update option in the urpmi commands above.
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Part 8. Configuration Wizards for
Common Services
Introduction to Server Wizards and Masqueraded Clients
In the server section of this manual, we first talk about two issues: Mandriva Linux
specific server wizards, as well as the configuration of masqueraded clients.
Introducing Server Wizards
This Chapter 40, Server Configuration Wizards [507] chapter will help you easily
configure servers such as DNS (Domain Name Server), DHCP (Dynamic Host
Configuration Protocol), Samba, HTTP, FTP, etc. using GUI-based wizards.
Masquerading Clients
We show you how to configure other machines on a local network in
Chapter 41, Configuring Masqueraded Clients [529], so that they can connect to
a Mandriva Linux server acting as a gateway to the outside world. The information in this chapter covers multiple platforms and architectures.

Chapter 40. Server Configuration Wizards
1. Foreword
The Mandriva Linux configuration wizards are designed to configure servers located between a local network and the Internet. They give you the ability to make
configurations quickly and efficiently for most common services in a local network,
as well as Internet web and FTP services. In this chapter, we assume your network
is as shown in Figure 40.1, “An Example of an Internal Network” [507], and that
Mandriva Linux is installed on the server. Configuring and bringing up the Internet
connection is beyond the scope of this chapter (Section 1, “Network and Internet
Connection Management” [253]).

Figure 40.1. An Example of an Internal Network
The server configuration wizards are available through the Control Center when
the drakwizard package is installed. New categories appear in the Mandriva Linux
Control Center, so wizards are organized as follows:
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1. Foreword
Wizards noted as “Expert mode only” below are only accessible when
the expert mode is toggled on ( Options → Expert mode ).
Sharing
• FTP server (Section 7, “FTP Server Configuration” [518]): configure where
your FTP server should be reachable from.
• Samba server (Section 5, “Samba Server Configuration” [514]): if the server
is to act as a file or print server for Windows® machines, this wizard helps
you set up public shared files and printers, and announce their names to
the Windows® network.
• Web server (Section 6, “Web Server Configuration” [517]): we show you
how to set up your GNU/Linux box as a web server, and how to make it
reachable;
• HTTP and NFS installation server (Section 8, “Installation Server Wizard” [521]): to allow your network client machines to be installed from the
server, making CDs and DVDs obsolete. Expert mode only.
Network Services
• DHCP server (Section 2, “DHCP Server Configuration” [509]): your server
can assign IP addresses dynamically to machines on the network.
• DNS server (Section 3, “DNS Server Configuration” [511]): to configure
name resolution for machines inside and outside the private network.
• Proxy server (Section 12, “Proxy Server Configuration” [524]): configure
your server to act as a web proxy cache. This speeds up web browsing
while limiting the bandwidth usage on the Internet.
• Time server (Section 13, “Time Configuration” [526]): your machine can
also supply time to other machines using the NTP protocol (Network Time
Protocol).
Authentication
• Switching authentication scheme: to set up the local users authentication
method: local, LDAP, NIS, Windows Domain. Expert mode only.
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2. DHCP Server Configuration
• NIS server (Section 9, “NIS and Autofs Servers Wizard” [522]): to set up the
Network Information System, centralizing users authentication and home
directories.
• LDAP server (Section 10, “LDAP Configuration Wizard” [522]): to set up a
simple LDAP repository to be used as authentication mechanism.
Groupware
• News server (Section 11, “News Server Configuration” [524]): you can make
your server act as a local mirror of an external news server.
• Mail server (Section 4, “Configuring Mail with Postfix Server” [511]): configure your mail domain for sending and receiving mail to and from the
outside world.
• Groupware server: This wizard enables you to easily configure the Kolab
server, enabling individuals from within an organization to share contacts,
calendar, appointments, etc.
You can access the wizards individually by clicking on the corresponding button.
In this chapter we describe wizards for the most common services in no particular
order. Note that the required packages are installed by the wizard if they are not
already available.
For experienced users: wizards are limited to configuring class C networks, and only the basic configuration is handled for each service. This
should be enough for most situations, but if you wish for a more finetuned configuration, you must edit the configuration files by hand or by
using another administration tool such as Webmin.

2. DHCP Server Configuration
DHCP stands for Dynamic Host Configuration Protocol. This protocol allows for
machines connecting to your local network to be automatically assigned all relevant
network parameters such as an IP address, the addresses of the name servers and
the address of the gateway.
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2. DHCP Server Configuration

Figure 40.2. DHCP Server Address Range
All you have to do is specify the range of addresses1 that you want to have available
via DHCP, as shown in Figure 40.2, “DHCP Server Address Range” [510]. If your
server has more than one NIC, you are asked which interface the DHCP server
must listen for requests on: choose the one connected to your LAN. If you wish
that client computers can access the Internet, you need to provide here the IP address of the gateway. In case the DHCP server is also the gateway for your LAN
fill it with the server's LAN address (for example: 192.168.0.1).
Check the Enable PXE option if you want your machine to act as an installation server for multiple machines on your LAN.

1
Addresses outside this range are available for machines which need static addresses. Those machines
can then be listed in the DNS configuration (Section 3, “DNS Server Configuration” [511]).
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3. DNS Server Configuration

3. DNS Server Configuration
DNS stands for “Domain Name System”. It allows you to specify a machine by its
name instead of its IP address. This wizard allows you to setup a basic DNS server,
master or slave.
Make sure you have a FQDN host name set for your system, otherwise the DNS
wizard will refuse to start. Please refer to Section 1, “Network and Internet Connection Management” [253], for information on how to set the system's host name.
You are given the option to run one of the following wizards:
Master DNS Server
Setup your machine as a plain DNS server. The first step allows you to provide
the address of an external DNS server to which the requests that the local
server cannot answer will be forwarded. It is generally the address of your
ISP's DNS server.
During the second step you can specify domain names for lookups. For example
if you request the IP of a machine called kenobi, the server adds the domain
names you add here to perform the request.
Slave DNS Server
Setup your machine as the slave server of another, master, DNS server. You
only need to supply the IP address of the master server for the slave to mirror.
Then clients can be configured to query both servers: if the master fails, the
slave takes relay.
Add Host in DNS
If your machine is a master DNS server, you'll be able to declare all the machines with static addresses on your network so that the DNS server can answer
requests about them.
Remove Host in DNS
This is used to remove a DNS entry previously entered with Add Host in DNS.
Both the Add Host in DNS and Remove Host in DNS wizards only work
if your machine is set up as a master DNS server.

4. Configuring Mail with Postfix Server
This wizard helps you configure your internal and outgoing mail. When configured,
this SMTP server will allow users of your local network to send internal and external mail through it. Likewise, if your server is referenced on the Internet public
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4. Configuring Mail with Postfix Server
DNS as a MX server for your domain name, then it also receives and manages mail
from the Internet addressed to users of your domain. In this case, make sure you
open the corresponding ports in your firewall.
Your server network parameters must not be provided by DHCP for
Postfix to work properly.
The first step consists of choosing whether you intend to use an external SMTP
relay or not. If you can use one provided by your ISP then choose Relay mail
server in the drop-down list. Otherwise, choose Main mail server. In the procedure
below only the second step differs from one configuration to the other.
1.

Global Postfix Configuration
Smtpd banner
The banner your server advertises when talking to other servers or clients.
Hostname
The name of your server.
Domain
The domain handled by this mail server.
Origin
The domain name that locally-posted mail appears to come from, and that
locally posted mail is delivered to.

2.

Relay (for Relay mail server only)
Relay host
This is where you define the mail server of the ISP responsible for relaying
your outgoing messages.
Relay domains
What destination domains (and subdomains thereof) this system relays
mail to. Mails sent to a domain other than the local domain that are not
part of the relay domains are rejected (to prevent spam).
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4. Configuring Mail with Postfix Server
3.

Main server Configuration (for Main mail server only)
helo required
For security reasons you might require remote clients to identify themselves before starting communication. Choose yes in that case.
Disable verify command
The verify command can be used by a client to verify a specific user is
actually handled by a mail server. You can disable it to prevent email
harvesting by spammers.
Masquerade domains
This field is used to masquerade the domain from which internal mail
appears to come from. For example: foo.example.com example.com directs Postfix to masquerade toot@foo.example.com to toto@example.com.

4.

Message options
A few options affecting message handling you can leave at their default values.
Maximal queue life
If a message cannot be delivered after this delay it is sent back as undeliverable.
Message size limit
Messages larger than this size (bytes) are rejected.
Delay warning time
If a message cannot be delivered, the sender will receive a warning after
this number of hours.

5.

Network Configuration
inet interfaces
The network interface addresses that this mail system receives mail on.
By default only the local interface is listened on. Specify all to receive
mail on all network interfaces.
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5. Samba Server Configuration
my destination
The list of domains that are delivered via the local mail delivery transport.
The SMTP server validates recipient addresses and rejects non-existent
recipients.
my networks
The list of “trusted” SMTP clients who have more privileges than
“strangers”. In particular, “trusted” SMTP clients are allowed to relay
mail through Postfix. Specify a list of network addresses or network/netmask patterns, separated by commas and/or whitespace.
If a parameter is not clear to you, please refer to the Postfix Configuration Parameters [http://www.postfix.org/postconf.5.html].

5. Samba Server Configuration
Samba allows GNU/Linux to act as a file and/or printer server for Windows®
machines. Even though this wizard can help configure primary and backup domain
controllers, we will concentrate here on the most common, standalone server
configuration.
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5. Samba Server Configuration

Figure 40.3. Choose the Work Group for your Shares
Now you must enter the work group for which these shares will be available
(Figure 40.3, “Choose the Work Group for your Shares” [515]). You can either create
a new work group or choose an existing one, but if you don't know what to do,
please refer to your system administrator.
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5. Samba Server Configuration

Figure 40.4. Naming your Samba Server
Then you will have to specify the name by which your Mandriva Linux server will
be known to Windows® machines, as shown in Figure 40.4, “Naming your Samba
Server” [516]. You may choose whatever name you want.
Finally you can adjust the log facility parameters. Keep the default unless you have
specific needs.
When the Samba server is configured you can run drakwizard sambashare from
a command line as root to create new shares and manage existing ones.
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6. Web Server Configuration

6. Web Server Configuration

Figure 40.5. Defining Where your Web Server Should Be Visible from
This wizard will simply let you specify if your web server will be disabled, visible
from the local network, from the external network (generally the Internet) or from
both. Check the appropriate boxes as shown in Figure 40.5, “Defining Where your
Web Server Should Be Visible from” [517].
If your server network parameters are provided by DHCP the web
server might not function properly if set to be visible from the Internet.
The second step allows you to enable the feature which gives users the option to
maintain their own web sites, available from the http://servername/~user/ URL.
The directory where they store their sites can also be changed if this option is
checked.
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7. FTP Server Configuration
The last step allows you to specify the directory where the files to be served by the
server will be stored, known as the Document Root. To begin creating your web
site, simply put the files in the chosen directory. You can connect to your web site
as soon as the wizard is finished through the http://localhost/ URL.

7. FTP Server Configuration

Figure 40.6. Defining Where your FTP Server Should Be Visible from
If your server network parameters are provided by DHCP the FTP server
might not function properly if set to be visible from the Internet.
This wizard resembles the one used to configure a web server: It will let you specify
whether FTP should be disabled, visible from the local network, from the external
network, or both. A sample window is shown in Figure 40.6, “Defining Where
your FTP Server Should Be Visible from” [518].
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7. FTP Server Configuration

Figure 40.7. FTP Server Configuration
This is the basic FTP server configuration, you are advised to provide an email
address for the administrator so that he can receive alert messages.
Admin e-mail
Enter the address to which messages regarding the FTP server should be sent.
Permit root login
Check this box if you wish the root user to be allowed to login into the FTP
server. If the FTP authentication is made in clear text, this option is not recommended.
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7. FTP Server Configuration

Figure 40.8. FTP Server Options
You are then allowed to configure a few options:
FTP Port
The standard FTP port is 21, if you specify something else here FTP clients
have to be configured accordingly.
Chroot home user
By checking this option, users who log into the FTP server will be “boxed inside” their home directories.
Allow FTP resume
If your server is likely to host large files, it might be prudent to allow users to
resume downloads.
Allow FXP
Check this option if you want your server to be able to exchange files with
other FTP servers. Please note that the FXP protocol is not very secure.
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8. Installation Server Wizard
To begin populating your anonymous FTP server, simply put the files in the
/var/ftp/pub/ directory. You can connect to your FTP server as soon as the wizard
is finished through the ftp://localhost/pub URL. Home directories are also accessible by default with local password authentication. If queen wants to access
her home directory she has to use the ftp://queen@localhost URL.

8. Installation Server Wizard
You are performing lots of installations and are tired of changing CDs? This wizard
is for you. It configures your machine to act as an installation server, so new machines can get all needed packages directly on the network, either for initial installation or for maintenance.

Figure 40.9. Copying Installation Sources
Specify the location to copy the CDs or DVD from, and a place on your disk where
the files are to be stored.
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9. NIS and Autofs Servers Wizard

9. NIS and Autofs Servers Wizard
Run this wizard if you wish to centralize your users' authentication and home
directories. Doing so allows users to connect from any machine on the local network
and have access to their own environment.

Figure 40.10. Setting NIS Server Parameters
Simply fill in the fields as directed by wizard. When configuration is done, NIS
users can login from any machine on the network that is setup to connect on your
NIS server. Additionally, those users have their home directories automatically
mounted locally.

10. LDAP Configuration Wizard
This simple wizard allows you to setup the basic configuration of a LDAP server,
and add users to it. This is useful to quickly setup a LDAP-based authentication
mechanism.
The first time you run the wizard, you are presented the server configuration dialog.
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10. LDAP Configuration Wizard

Figure 40.11. LDAP Server Configuration
When the configuration is set and the server launched, running the wizard again
will suggest some options:
Show Ldap configuration
Shows current server configuration, useful to configure possible LDAP clients.
Delete Ldap configuration
Removes current server configuration and stops the server.
Add user in Ldap server
Starts a little wizard which allows you to add new users inside the users directory.
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11. News Server Configuration

11. News Server Configuration
This wizard will configure a news gateway: your server will be able to fetch
newsgroups from an external news server (usually your ISP's, named something
like news.domain.of.your.isp) and make them visible to your internal network.
Therefore the first step is to specify which external news server you want to use.
Then you need to specify the interval (in hours) between each refresh. You need
to find a balance here: specifying too high an interval might make your server's
news obsolete rapidly while specifying too low an interval might elevate your
server's (inter)network load considerably. Of course, all will depend on the traffic
of the news sites being mirrored and on the Internet connection speed of your
server.

12. Proxy Server Configuration
A proxy server is very useful for a local network accessing many web pages across
a slow, or relatively slow, connection. It maintains a cache of most visited pages
so that they don't need to be retrieved again from the Internet if requested by different users. Squid is the proxy server used.
First of all you need to choose a port for the proxy to listen to requests on. Users
will have to configure their web browsers to use this port as the proxy port and
your server name as the proxy server.

524

12. Proxy Server Configuration

Figure 40.12. Choose the Cache Size
Depending on your machine's available memory, you can allocate more or less to
the Proxy. The bigger the memory cache, the fewer disk accesses on the server.
Depending on your available disk size you can allocate more or less room for
cached pages. The more the space, the less accesses to the Internet. The wizard
will choose appropriate values for your system, if in doubt just accept the proposed
ones.
In the next step, some access levels are available for clients wishing to use the
proxy:
• All. There is no restriction, all computers are granted access to the cache.
This setting is not very secure and thus not recommended.
• Local Network. Only machines on the local network can access the proxy.
This is the recommended setting.
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13. Time Configuration
• localhost.

Only the local machine, the server, can access its own proxy.

Figure 40.13. Restrict Access to a Particular Sub-network
If you have previously chosen the Local Network access policy, you can choose
to restrict even more the access to a particular subnetwork or domain. The wizard
will detect your LAN's network address and will offer it by default: make modifications if needed.
Finally, if your server itself has access to another larger proxy connected to the
Internet, you can choose to Define an upper level proxy to which requests will be
forwarded. If so, the next step will ask you for the name and port of that server.

13. Time Configuration
This wizard lets you set up a time server, using the NTP protocol, for your internal
network. When you have set up the external time servers your own server will
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13. Time Configuration
use to correct its internal clock, machines on your local network will be able to get
the correct time from your server.

Figure 40.14. Choosing your Time Servers
Choose the time servers to query, in order of preference. It is advisable to keep the
default suggested ones, otherwise choose servers which are geographically close
to you. By default the time zone will be set to the one you have chosen during the
server's installation.
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Chapter 41. Configuring Masqueraded
Clients
This chapter will show you how to make different operating systems use a Mandriva Linux box with masquerading set up as a gateway to the outside world. The
configuration tests proved successful on many operating systems and architectures.
Basically, any OS that has a working TCP/IP stack will work.
We will show you how to configure a few operating systems. If you are worried
that your OS might not be supported, a simple way to proceed is to “just tell the
OS which machine to use as a gateway”. Note that our main focus here is the
gateway side of the network, we won't touch on DNS, file sharing or connection
schemes problems. Thus, for this chapter to be of any use to you, you need a wellconfigured local network. Refer to your system's documentation to set it up properly, paying special attention to the DNS settings.
What follows assumes that you have a class C network: your different machines
all have IP addresses like 192.168.0.x, with a netmask set to 255.255.255.0, and
use eth0 as the network interface. We also take for granted that your gateway's
IP address is 192.168.0.1, and that your machines can each “talk” to the gateway
(you can test the latter with the ping command or its equivalent in your environment).

1. Linux Box
1.1. For Any Linux Box
Here, you need to edit a configuration file. The method is different when automatic
IP configuration is used.
Automatic IP configuration
Open the network interface configuration file (on a Mandriva Linux machine
it is /etc/sysconfig/network-scripts/ifcfg-eth0, it may be different on
yours) and make sure the BOOTPROTO parameter reads BOOTPROTO=dhcp.
Manual Configuration
You need to edit the network configuration file (on a Mandriva Linux machine
it is/etc/sysconfig/network, it may be different on yours). Open it with your
usual text editor, then add the following lines (adjusting values if necessary):
GATEWAYDEV=eth0
GATEWAY=192.168.0.1
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1.2. On a Mandriva Linux Box
You may now restart your Linux network layer. On a Mandriva Linux system this
is done by executing, as root, service network restart or /etc/init.d/network restart
from a terminal window.

1.2. On a Mandriva Linux Box
Just put the correct parameters into the Manage Connections tool in Mandriva
Linux Control Center's Network & Internet section to set the configuration automatically. Refer to Network and Internet Connection Management of the Starter Guide.
You can choose to configure all network parameters manually or automatically
(using DHCP).

Figure 41.1. Manually Specifying Network Parameters in drakconnect
If you have a DHCP server on your local network, simply choose the DHCP entry.
If you have a static IP address for your machine, enter it into the first field after
making sure that the static entry is selected. Also fill the Netmask and Gateway
fields according to your network configuration, as shown in Figure 41.1, “Manually
Specifying Network Parameters in drakconnect” [530].
Once you have applied your changes, your network is properly configured and
ready to run. The configuration is now permanent.
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2. Windows XP Box

2. Windows XP Box
We assume that you already have a configured network connection. Figure 41.2,
“Setting up the Gateway with Windows XP” [531] shows the different steps to get
to the desired dialog.

Figure 41.2. Setting up the Gateway with Windows XP
Here are the actions to step from one window to another:
1.

On the desktop, right-click on the My network places icon, and select Properties in the menu that appears.

2.

In the Network Connections window, do the same with the connection linked
to the network where the gateway is located.

3.

In the next dialog, select the Internet Protocol (TCP/IP) entry and click the
Properties button.
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3. Windows 95 or Windows 98 Box
4.

In this dialog, you can choose to select the Obtain an IP address automatically
option if you have a DHCP server on your network. Then, all other network
parameters should also be automatically configured. If you prefer to manually
set up network parameters, select the Use the following IP address option
and fill in the associated fields.

3. Windows 95 or Windows 98 Box

Start by going in the Control Panel ( Start + Settings → Control Panel )
and find the network icon. Double-click on it: the network configuration panel
comes up.
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3. Windows 95 or Windows 98 Box

Figure 41.3. The Network Configuration Panel under Windows 9x
In the displayed list, you should find a protocol named TCP/IP and bound to your
LAN adapter. If not, you will have to refer to your system documentation to find
out how to install it. Select it and click on the Properties button.
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3. Windows 95 or Windows 98 Box

Figure 41.4. The TCP/IP Configuration Panel under Windows 9x
This window will enable you to set up your TCP/IP parameters. Your system administrator will tell you if you have a static IP address or if you are using DHCP
(automatic network parameters). Click on the Gateway tab.
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4. Windows NT or Windows 2000 Box

Figure 41.5. The Gateway Configuration Panel under Windows 9x
The rest is child's play! Fill in the blanks with your gateway's IP address (i.e.
192.168.0.1, in our example). Click the Add and then on the OK buttons.
You will need to reboot your computer, of course. Once this is done, check to see
if you can reach the rest of the world.

4. Windows NT or Windows 2000 Box
To configure these OSes, follow these simple steps:
1.

Go to Control Panel + Network → Protocols .
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4. Windows NT or Windows 2000 Box

Figure 41.6. The Protocol Configuration Panel under Windows NT/2000
2.
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First, select the TCP/IP Protocol in the list of network protocols. Then, click
on the Properties button, and select the network card connected to the local
network (see Figure 41.7, “The Network Software Panel under Windows
NT/2000” [537]). In this example, we show a configuration with DHCP: the
Obtain an IP address from a DHCP server option is selected.

4. Windows NT or Windows 2000 Box

Figure 41.7. The Network Software Panel under Windows NT/2000
If this is your case, you just need to confirm these choices and reboot. Otherwise, proceed as follows.
3.

To set network parameters manually, begin by selecting the Specify an IP
address option (see Figure 41.8, “The TCP/IP Configuration Panel under
Windows NT/2000” [538]).
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4. Windows NT or Windows 2000 Box

Figure 41.8. The TCP/IP Configuration Panel under Windows NT/2000
Select the appropriate adapter, and specify, if not already entered, the IP address and network mask.
4.

Fill in the Default Gateway field with 192.168.0.1 (the address of the Linux
box sharing the connection in our example).

5.

Finally, you will need to specify the DNS servers you use in the DNS tab as
shown in Figure 41.9, “The DNS Configuration Panel under Windows
NT/2000” [539].
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4. Windows NT or Windows 2000 Box

Figure 41.9. The DNS Configuration Panel under Windows NT/2000
You must also provide a host name and an associated domain name.
Unless you know exactly what you are doing, proceed with utmost care
with the following steps:
• leave the Automatic DHCP configuration field blank unless you have
a DHCP server somewhere on your network;
• leave all the WINS Server fields blank as well unless you have one
or more WINS servers;
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5. DOS Box Using the NCSA Telnet
Package
• do not place a check in the Enable IP Forwarding field unless your
NT/2000 machine is used for routing and, once again, you know exactly what you are doing;
• Disable DNS for Windows Name Resolution and Enable LMHOSTS
lookup.
Click on OK in the dialog boxes which then appear and restart your computer to
test the configuration.

5. DOS Box Using the NCSA Telnet Package
In the directory which hosts the NCSA package, you will find a file called config.tel. Edit it with your favorite editor and add the following lines:
name=default
host=your_linux_host_name
hostip=192.168.0.1
gateway=1

Change your_linux_host_name to the real host name of your Linux gateway.
Now save the file, try to telnet your Linux box, then to a machine somewhere out
there...

6. Windows for Workgroups 3.11
The TCP/IP 32b package should already be installed. Go to the Main + Windows
Setup + Network Setup → Drivers menu entry and select Microsoft TCP/IP-32
3.11b in the Network Drivers section, then click Setup.
From here, the procedure is quite similar to the one described in Section 4, “Windows NT or Windows 2000 Box” [535].

7. MacOS Box
7.1. MacOS X
The configuration consists of setting the correct parameters for the Ethernet interface
connected to your gateway.
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7.1. MacOS X

Figure 41.10. MacOS X Dock
First of all, you need to open the System Preferences window by clicking on its
icon on the system dock.

Figure 41.11. MacOS X System Preferences
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7.1. MacOS X

7.1.1. With an Automatic DHCP Configuration

Figure 41.12. Automatic Configuration of Internet Access For MacOS X
In the dialog that appears, Select the Built-In Ethernet or the interface actually
connected to the gateway, and then select Using DHCP in the TCP/IP tab as shown
in Figure 41.12, “Automatic Configuration of Internet Access For MacOS X” [542].
Then click on Apply Now , and if all goes well, the Router field should now show
the IP of your gateway.

7.1.2. For a Manual Configuration
If you do not have a DHCP server on your local network, follow this procedure:
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7.1. MacOS X

Figure 41.13. Manual Configuration of Internet Access For MacOS X
In the dialog that appears fill the fields as shown here:
• Configure: Manually;
• IP address: 192.168.100.34 (The client machine IP address);
• Subnet Mask: 255.255.255.0 (The local network subnet mask);
• Router Address: 192.168.100.1 (the address of the gateway server);
• DNS Servers: 192.168.100.11; 192.168.100.14 (The IP addresses of the DNS
servers)
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7.2. MacOS 8/9
The name server's addresses may be the addresses of the internal DNSs
or those of your Internet Service Provider's servers.
When this is done, click on Apply Now , and if all goes well, you should be able
to surf the Internet.

7.2. MacOS 8/9
First of all, you need to open the TCP/IP Control Panel as shown below in the
Apple menu.

544

7.2. MacOS 8/9

Figure 41.14. Accessing The TCP/IP Control Panel

7.2.1. With an Automatic DHCP Configuration
If you have configured your firewall to be a DHCP server, follow this procedure,
otherwise go to the next section.
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7.2. MacOS 8/9

Figure 41.15. Automatic Configuration of Internet Access For MacOS
In the dialog which appears, fill the fields as shown here:
• Connect via: Ethernet;
• Configure: Using DHCP server;
• DHCP Client ID: 192.168.0.1.

7.2.2. For a Manual Configuration
If you do not have a DHCP server on your local network, follow this procedure:
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7.3. MacTCP

Figure 41.16. Manual Configuration of Internet Access For MacOS
In the dialog that appears fill the fields as shown here:
• Connect via: Ethernet;
• Configure: Manually;
• IP address: 192.168.0.248;
• Subnet Mask: 255.255.255.0;
• Router Address: 192.168.0.1;
• Name Servers Addresses: 192.168.0.10; 192.168.0.11
• Search Domain: myco.com
The name server's addresses may be the addresses of the internal DNS
or those of your Internet Service Provider's servers.

7.3. MacTCP
1.

In the MacTCP control panel, select the Ethernet network driver (caution, it's
not EtherTalk) then click the More... button.
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8. OS/2 Warp Box
2.

Under Gateway Address, enter the address of the Linux box sharing the
connection (192.168.0.1 in our example).

3.

Click OK to save the settings. You may have to restart your system to test
these settings.

8. OS/2 Warp Box
The TCP/IP protocol should already be installed. If not, install it.
1.

Go to Programs, then TCP/IP (LAN), then TCP/IP Settings.

2.

Under Routing, choose Add. In Type, select default.

3.

Fill the Router address field with the address of your Linux box sharing the
Internet connection (192.168.0.1 in our example).

4.

Now close the TCP/IP control panel, answer Yes to all questions, then reboot
your system before testing the settings.
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Part 9. In-Depth Configuration of
Common Services
Introduction to Service Configuration
This part details the most common services a system administrator may need for
both Internet and intranet uses. We document the most common packages for midsized companies. Almost every service is configured using Webmin.

1. Introduction to Webmin
The Webmin tool allows you to administer your machines remotely through a web
interface using only a web browser which supports the HTTPS (HTTP over SSL)
protocol. This facilitates easy and in-depth remote administration, while ensuring
security.
This makes Webmin ideal for system administrators because all major platforms
have web browsers which meet or exceed the above requirements. Moreover,
Webmin has its own “web server” so it doesn't need 3rd party software (such as a
web server) to work. Everything is included.
Webmin's modular architecture allows you to write your own configuration
modules if you need to. It comes with modules for all the services described here,
as well as many more. In this part we mostly concentrate on network services, but
you will see that almost every part of your system can be configured and administered with Webmin

1.1. Accessing and Using the Interface
First of all, make sure the webmin package is installed. You should also make sure
it's running through the drakxservices application. Once this is done, you can access
it through any web browser, either locally or from another machine in the same
local network. Point your browser to https://ServerNameOrIP:10000 to access
the interface. Accept the certificate to display the login screen. Enter the root login
and password, and click on Login to access the main Webmin screen.

Figure 257. Webmin Interface
The interface presents tabs or sections, each tab giving access to a number of
modules specializing in a particular configuration aspect of the machine.
As a useful exercise, you should now go to the IP Access Control option of the
Webmin Configuration module.

Figure 258. Webmin Access Control
Note that if your server is accessible from the Internet, this step is mandatory to
narrow the possibility of people tampering with your system. Of course that doesn't
prevent you from setting up a firewall through Mandriva Linux Control Center,
Webmin (Networking, Linux Firewall) or any other firewall setup application.

Select the Only allow from listed addresses option. Then list all the machines
and/or networks allowed to connect to Webmin in the text field, one entry per
line. For increased security also check Resolve hostnames on every request.

1.2. Getting Help
Many module parameter names are available as hyperlinks. Clicking on them
opens a pop-up window containing on-disk help concerning that parameter. It
may give the meaning, the syntax to use and possibly examples.
Also, most modules present a Search Docs link on the upper-right corner of the
screen. Clicking on the link launches a search on the module's name in local documents, Googletm [http://www.google.com], HOWTO documents, Package documentation, and more. This way you have instant access to relevant documents for
the module you are currently configuring. You can have access to the search form
and options in the System+System Documentation module.
The Webmin home site [http://www.webmin.com/index2.html] also offers various
resources, including a link to Joe Cooper's very good The Book of Webmin [http:
//www.swelltech.com/support/documentation.html].
Finally, at the end of each service chapter, we include a list of interesting resources
to get additional information on the configuration of that particular service.

2. Services
The services covered in this part are:
• Domain Name System (DNS). We discuss the BIND name server in Chapter 42,
BIND DNS Server [553].
• Internet/Intranet web site hosting (HTTP). The Apache web server is discussed
in Chapter 43, Internet and Intranet Web Server [565].
• The mail management (SMTP) chapter (Chapter 44, Postfix Mail Server [575])
focuses on sending mail with the Postfix mail server.
• We talk about mail delivery services using the POP and IMAP protocols with
the IMAP mail server (see Chapter 45, Mail Delivery Services: Pop and IMAP [583]).
• Sharing resources such as files and printers is the main topic of the next chapter
(Chapter 46, Resource Sharing [587]), using NFS, Samba or ProFTPD FTP server.
• We document the server part of the Kroupware groupware solution in
Chapter 47, The Kolab Server [599].

• We detail the usage of the MySQL database server in the next chapter
(Chapter 48, MySQL Database Server [613]).
• Distributed user management or home hosting (NIS) is the main subject of the
final chapter of the services configuration section (Chapter 49, NIS Client and
Server [619]).

Chapter 42. BIND DNS Server
A DNS server allows you to associate an IP address to a name and vice versa. For
example: www.mandriva.com (“Name”) is currently associated to 212.85.150.181
(“Address”). To make a comparison, a name server acts somewhat like a telephone
directory: you provide it a name and it gives you the number which allows you
to connect to your correspondent. However this mechanism is generally transparent
to the end user: he never needs to remember or type IP addresses thanks to the
DNS servers.
In this chapter we briefly show you how to configure the global server options,
and how to declare new zones (basically domain names) to be handled by your
DNS server. This means other machines on the local network, and possibly on the
Internet, will be able to access the machines and services associated to your own
domain names.
The Webmin BIND DNS Server module creates and edits domains, DNS records
and BIND options for the 8.x and 9.x releases. BIND (Berkeley Internet Name Domain) is an implementation of the Domain Name System (DNS) protocol and
provides an open, redistributable reference implementation of the major components of the Domain Name System.
BIND is very useful for simple configurations, but there are a few differences
between the 8.x and 9.x releases. However, you must be careful with this Webmin
module because not all BIND 9.x options are supported yet. Therefore if you try
to use the advanced options, you have to look at the log files more carefully than
with the other Webmin modules to make sure BIND works properly.
In this chapter we cover the configuration of a DNS server for local
queries. We don't explicitly cover the configuration of a public name
server.

1. Installation and Initialization
Make sure the bind package is installed.
At this point Mandriva Linux allows you to automatically configure your
name server in a very specific case. If you don't wish to serve your own
specific domains with your name server, but just want it to act as a forwarder for local network clients, you can simply install the cachingnameserver package. It will build a basic BIND configuration, allowing
your server to answer local DNS requests for Internet addresses. The
server must have access to the Internet.
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1. Installation and Initialization
Once this package is installed, start the server by issuing the service
named restart command as root. You can now configure your local
machines (Section 2.6, “Configuring the Client” [560]) to make DNS requests on your server.
In order to use the Webmin module, you have to select the Servers category and
then the BIND DNS Server button (with the number 8 in the icon).

Figure 42.1. Creating a Primary Bind Configuration File
The first time you open this module, and provided you have not configured BIND
beforehand, you have to choose which kind of usage you plan for your name
server.
Setup nameserver for internal non-Internet use only
Select this option if you plan to use the name server solely to serve requests
from the local network for machines also located in the local network. This is
only useful if your network isn't connected to the Internet.
Setup as an Internet name server, and download root server information
Select this option if your server is meant to answer requests from or to the Internet, and if the server currently has access to the Internet.
Setup as an Internet name server, but use Webmin's older root server information
Select this option if your server is meant to answer requests from or to the Internet, and if the server currently does not have access to the Internet.
Then click on Create Primary Configuration File and Start Nameserver to follow
on with the configuration.
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2. Step-by-Step Configuration Example
The main screen is divided into two parts: the Global Server Options and the Existing DNS zone, which allows you to access each zone already defined and represented by an icon, as well as to create new zones.
Whenever you change parameters, whether in global server options or
in zones, don't forget to click the Apply Changes button for the server
to reload the configuration.

2. Step-by-Step Configuration Example
If you chose to set up your nameserver as an Internet nameserver, there is already
one Existing DNS Zone: the Root Zone. It's used by the DNS server to contact the
root servers on the Internet so it can resolve domain names not handled by your
own DNS server. Unless your DNS server is used on an internal network (no access
to the Internet) or if you're forwarding all queries to another server, you should
not delete this root zone.

2.1. Basic Server Configuration and Security
Several parameters can be adjusted to optimize and secure your DNS server.

2.1.1. Defining DNS Forwarders
The Forwarding and Transfers screen allows you to list nearby nameservers to
which requests will be forwarded if the local server cannot reply directly.

Figure 42.2. DNS Forwarders
In the Servers to forward queries to field, you should list the IPs of other possible
nameservers in your local network, and at least two Internet nameservers: your
ISP's. This is likely to lower the server load and accelerate response time.
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2.2. Setting up Basic DNS Zones

2.1.2. Securing the Server
The Addresses and Topology screen permits you to define which addresses the
server will listen on. It's safer to listen only on internal interfaces if the server isn't
meant to answer outside requests.

Figure 42.3. DNS Addresses to Listen on
In the first Addresses field, enter the list (separated by spaces) of the server addresses on which the DNS server will listen to queries on. Requests made through
other addresses will be ignored.
Of course this measure doesn't prevent you from setting up a firewall
which is nowadays mandatory for every security-conscious network installation.

2.2. Setting up Basic DNS Zones
In order to use each network service properly, you need to create zones for each
of the domains the server will deal with. Now let's concentrate on the Existing
DNS Zones part. If you chose for your DNS server to act as an Internet
nameserver at service initialization (Figure 42.1, “Creating a Primary Bind Configuration File” [554]), the Root Zone has already been created. It allows your
nameserver to answer queries concerning public Internet names by forwarding
them to the appropriate servers on the Internet.
First you need to create a minimal Master 127.0.0 zone to describe the loopback
network. This is useful for security reasons and to use the server as a caching
server. This is done in two simple steps: reverse master zone creation and host
configuration. Click on the Create master zone link in the main screen.
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2.3. Setting up Specific DNS Zones

Figure 42.4. Creating a Forward Master Zone
Select Reverse Zone type, and fill the Domain name / Network field with the
local host network address: 127.0.0 (no final dot). Use localhost as Master
server and root@localhost (or whatever you like) as administrator Email Address.
Clicking on Create to save your configuration.
You are then directed to the corresponding Edit Master Zone screen. Click on the
Reverse Address Icon.

Figure 42.5. Creating a localhost Reverse Record
Fill the Address and Hostname fields to match your localhost configuration. Then
click on Create . Your local zone is now created and you can forget about it. Click
on the Return to zone list link to go back to the main screen.

2.3. Setting up Specific DNS Zones
We now have the two basic zones: Root and 127.0.0. Our next task is to create a
new master zone which will describe all of our local network machines. Select
Create master zone and complete the page with your own values, as shown in
Figure 42.6, “Creating a New Master Zone” [558].
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2.3. Setting up Specific DNS Zones

Figure 42.6. Creating a New Master Zone
A new page with many icons is displayed: most of them can be ignored if you
don't need advanced configuration. You can add all network machine names
through this page, but first, you should create the reverse part of your master zone.
In fact, a DNS zone is composed of two parts: one for name-to-address conversion
(i.e.: forward), and another one for address-to-name conversion (i.e.: reverse).
Then, select Return to the zone list and choose Create a master zone once more
but this time, you must change the selection from Forward to Reverse. Instead of
entering your domain name, enter the network class: for a 192.168.1.0/24 network,
you should write 192.168.1.

Figure 42.7. Creating a Reverse Master Zone
Remember to click on the Create button. Your zone is now ready to host new records for machines or services of our local network.
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2.4. Recording your Network's Computers

2.4. Recording your Network's Computers
This is the only step you have to repeat each time you add a new machine in your
network. All other parameters are configured only once, as long as your network
doesn't change and you don't add other DNS servers.
Return to zone list and now your Existing DNS Zones should show four zones.

Figure 42.8. All DNS zones
Click on the mydomain.test zone, and then on the Address icon. This is where
you actually define all the existing machine names in your network and record
their IP addresses.
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2.5. Starting the Service

Figure 42.9. Adding Machine Names
You can now add as many machine Names as your IP class allows (254 machine
names in our example). Click on Create to add the new record, and you are then
prompted to fill a new one. Note that the Update reverse? option is selected by
default. With this option, the Reverse part of your DNS is updated automatically.

2.5. Starting the Service
We created a very simple, yet complete DNS service. To start it and load the new
configuration, Return to zone list and click on the Apply Changes button.
Webmin checks the parameters you enter so it shouldn't be possible to provide
BIND with a corrupt configuration. However if the button is replaced by a new
one named Start Name Server, then the server didn't start because of a configuration
error. In this case, you should read Section 3, “Advanced Configuration and
Troubleshooting” [561].

2.6. Configuring the Client
To use your local network to resolve Internet addresses, you have to configure the
client to access the DNS. This can be done either through the Mandriva Linux
Control Center network configuration tool, or through Webmin: go to the Network-
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3. Advanced Configuration and
Troubleshooting
ing tab and click on the Network Configuration icon. Then, select the DNS Client
and type your DNS's IP if it's a remote client, or 127.0.0.1 if you're on the server.

Figure 42.10. Configuring the Client

3. Advanced Configuration and Troubleshooting
3.1. How to Debug
If the service didn't start, you should look at the /var/log/messages file to read
the debug output of BIND. If you don't find the error, you can use the namedcheckconf and named-checkzone programs to check your configuration.
With the bind-utils package, you can use many utilities and especially the dig
command to to perform advanced queries on DNS servers. For example to query
your local server about machine2.mydomain.test, you could run:
$ dig machine2.mydomain.test @127.0.0.1
; <<>> DiG 9.2.3 <<>> machine2.mydomain.test @127.0.0.1
;; global options: printcmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 3287
;; flags: qr aa rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: 1, ADDITIONAL: 0
;; QUESTION SECTION:
;machine2.mydomain.test.

IN

A

;; ANSWER SECTION:
machine2.mydomain.test. 38400

IN

A

192.168.1.12

;; AUTHORITY SECTION:
mydomain.test.

IN

NS

mycomputer.mydomain.test.

38400

;; Query time: 14 msec
;; SERVER: 127.0.0.1#53(127.0.0.1)
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;; WHEN: Fri Jan 23 14:11:10 2004
;; MSG SIZE rcvd: 81

3.2. Declaring your Mail Server
If your mail server is meant to handle addresses for your own domains, handled
by your own DNS server, then this mail server should be declared in your domain
configuration. This way, other mail servers know which machine is responsible
for delivering messages addressed to users of your domain.
In the main screen of your domain's zone, click on the Mail Server icon.

Figure 42.11. Declaring a Mail Server
Fill the Name field with the domain served by the mail server (the same as the
zone domain) and write the server name in the Mail Server field. Make sure this
name is also defined as a local domain machine if it's part of the local network.
Repeat this operation for each of the mail servers.
The domain Name in this form must be terminated by a dot as in our
example.
The Priority field (useful when you have more than one mail server for
the same domain) defines the order in which servers should be contacted
should the ones of highest priority (lower priority number) be unreachable.

3.3. More Documentation
An extensive chapter is dedicated to BIND in Joe Cooper's The Book of Webmin
[http://www.swelltech.com/support/webminguide/ch08.html]. Explanations
for almost every available options in Webmin's BIND are included.
If you want to learn more about BIND, we strongly recommend you read the BIND
9 Administrator Reference Manual [http://www.bind9.net/Bv9ARM.html] which
is available locally on your machine: click on Search docs in the upper-right corner
of Webmin's BIND DNS Server page. It shows many local and Internet related
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3.3. More Documentation
links. Note that the Reference Manual is available in HTML if you click on bind9.3.1/html/Bv9ARM.html. This manual is also available in PDF format [http://
www.nominum.com/content/documents/bind9arm.pdf]. Finally don't hesitate
to browse the official BIND web site [http://www.bind9.net/].
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Chapter 43. Internet and Intranet Web
Server
Apache allows you or your organization to host web sites and serve web pages to
client browsers such as Firefox. Apache can serve static or dynamic sites using a
number of technologies like PHP, SSL, etc.

1. Installation
The first step is to check that the Apache web server is installed on your computer.
If it isn't please use Rpmdrake or type urpmi apache-mpm-prefork in a terminal
to install it.
Mandriva Linux's highly modular distribution of Apache allows you to have
support only for the technologies you need, no more no less. The module's package
names are apache-mod_xxx, where xxx is the name of the module in question.
Make sure you also install the corresponding modules you need.
The server configuration is done through the Apache Webserver button which is
in the Servers category.
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2. Configuration Example

Figure 43.1. Apache Module's Start-Up Screen
You can host several different sites on a single Apache server: this feature is known
as “Virtual Servers”. Your “main site” is the Default Server . Global Configuration
options apply to all virtual servers. Each virtual servers' options are found in the
Virtual Servers section. We will defer global options to Section 3, “Advanced
Configuration” [569].
Apache's configuration files are stored in the /etc/httpd/conf/ directory. The
main Apache options you need to set are located in the /etc/httpd/conf/httpd.conf file and can be accessed by clicking on Default Server .
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2.1. Default Server General Options

Figure 43.2. Networking and Addresses Options Section
In the Networking and Addresses section you can specify the webmaster's e-mail
address in the Server admin email address field. To avoid “false” requests on your
web server, set the Lookup hostnames option to Yes and the Use hostname supplied by browser to No (see Figure 43.2, “Networking and Addresses Options
Section” [567]).
Activating the hostname lookups in order to make your web site(s) more
secure has its penalty: performance. A DNS lookup is performed each
time a request is made to your web server.
Accesses, errors and other operations are logged in files under the /var/log/httpd/
directory. Logging options are available under the Log Files section: where to log
to (the centralized system log, a specific log file or program), the format for the log
entries, etc. Feel free to investigate the different options.
Now click on the Document Options icon.
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Figure 43.3. Document Options Section
The Document root is the path to the directory containing the web pages and their
associated files. Directory options contains some options like the ability to execute
a CGI program (Execute CGI programs) or to automatically generate an index of
files in a directory if no explicit index exists (Generate directory indexes).
If your web site's structure is large, a few directories deep and you want to simplify
navigation, you can create aliases in the Aliases and Redirects section.

Figure 43.4. Aliases and Redirections Section
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2.2. Common Technologies Specific Options
The example in Figure 43.4, “Aliases and Redirections Section” [568] shows how
to let point your browser to http://www.example.com/morestuff instead of http://www.example.com/foo/bar/again/and/more. The second part of the screen
is dedicated to redirections, which let you redirect a part of your web address to
a specific web page or directory.

2.2. Common Technologies Specific Options
2.2.1. CGI
If you plan to use Common Gateway Interface programs, the CGI Programs section
lets you specify which directory contains your CGI scripts, and configure some
variables passed to the executables. The default settings allow you to directly use
your CGI scripts in your web site.

2.2.2. SSL
SSL provides encrypted communications facilities which makes access to your
site(s) secure. You can enable SSL by simply installing the apache-mod_ssl.
Your site(s) will then be ready to use encrypted communications channels with
SSL, using the https:// prefix instead of http://.
At the time of writing, the standard version of Apache only support one
SSL-enabled site per IP address. Should you need to host several secured
sites on the same IP address, you need to install the apache-ssl package
instead. However note that the architecture of this server (notably configuration files wise) differs from the default server.

2.2.3. PHP
Simply install the apache-mod_php package for your PHP pages to be interpreted.

2.3. Per-Directory Options
If you click on a directory name under this part of the server configuration you
can specify general options for that directory. For example, you can configure
specific Mime Types for your site's download directory, Access Control for a
specific directory, etc.

3. Advanced Configuration
The options discussed in this section are accessible from the Webmin Apache
module indes.
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3.1. Processes and Limits

Figure 43.5. Limiting the Number of Apache Processes
You can fine-tune Apache's usage of your systems' resources by imposing limits
on the number of initial instances of Apache (Initial server processes) and the
maximum number of processes those are going to start, if needed (Maximum spare
server processes); the number of clients per process (Maximum requests per
server process) and the header's size (Maximum headers in request, Maximum
request header size and Maximum request line size).

3.2. Networking and Addresses

Figure 43.6. Changing the Ports Apache Listens On
Figure 43.6, “Changing the Ports Apache Listens On” [570] shows how you can
specify the ports Apache listens on for both regular (80 by default, 8080 in the example) and encrypted sessions (443 by default, 4433 in the example).
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3.3. Controlling Access With Basic Authentication
Authentication usually involves a username and a password, but can include any
other method of demonstrating identity. You can control access to certain parts
(directories) of your site(s) using a password file which acts as an authoritative
listing of usernames and passwords. Here's the procedure to implement such a
mechanism:
1.

Create a passwords list file and fill it.

2.

Protect a specific directory by creating special configuration directives for that
directory, which refers to the passwords file.

Let's imagine you need to control access to the /var/www/html/restricted/ directory.
To create the passwords file, type htpasswd -c -m path_to_the_password_file
username in a console, as root. The -c is used only the first time to create the file.
# htpasswd -c -m /etc/httpd/.htpass queen
New password: verySecret
Re-type new password: verySecret
Adding password for user queen

The above example creates the /etc/httpd/.htpass file containing the password
(verySecret) for user queen. Of course, verySecret will be encrypted.
To minimize security risks, it's a good idea to store the generated password file outside of the documents directory and make sure its file-access
rights are as tight as possible.
Once you have the password file populated, you must instruct Apache to use it.
Enter the server which is meant to serve your protected directory ( Default Server
for example) in Apache's main screen (Figure 43.1, “Apache Module's Start-Up
Screen” [566]). A little form enables to create per-directory options at the bottom
of the server screen.

Figure 43.7. Per-Directory Options Directive
571

3.4. Handling Multiple Domains With
One Web Server
Once this is done, a new icon Directory /var/www/html/restricted appears in
the Per-Directory Options section. Click on it and then on the Access Control
button of the page. You can then fill the form using the example shown in Figure 43.8, “Per-Directory Options” [572] as a guide. Click on the Save button to record
your settings.

Figure 43.8. Per-Directory Options

3.4. Handling Multiple Domains With One Web Server
When setting up virtual hosts, the first one catches all requests which
don't match other virtual hosts.
Using the Virtual servers section, you can directly set up a multi-domain web
server using the form at the bottom.
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3.4. Handling Multiple Domains With
One Web Server

Figure 43.9. Creating a New Virtual Server Based on an Existing One
For example, your company owns the foo.com and bar.net domains. You just
have to specify the document root (where your site's files are stored), and the name
of the virtual server. If you manage multiple sites, you can copy configuration
directives from other virtual servers (see Figure 43.9, “Creating a New Virtual
Server Based on an Existing One” [573]). This can save you lots of time.
We are doing here “Name based virtual hosts”, meaning that we are
hosting different servers on the same IP address. For this to work, you
need to add a special directive in Apache's main configuration file with
the following command:
# echo "NameVirtualHost *:80" >> /etc/httpd/conf/httpd.conf

Don't forget to restart the server by clicking on the Apply Changes button.
Of course your nameserver (Chapter 42, BIND DNS Server [553]) must be
configured so that when clients request the virtual host name
(www.foo.com), they are directed to the machine which hosts your web
server.
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4. More Documentation
Each virtual server possesses similar options to the ones described in the preceding
sections, but they all share a common Apache parent process.

4. More Documentation
Joe Cooper dedicates a long chapter to Apache in The Book of Webmin [http://
www.swelltech.com/support/webminguide/ch07.html]. You will find explanations
for almost every option available in the Webmin's Apache module, though it might
be a little outdated.
Browsing the Apache Documentation Project [http://httpd.apache.org/
docs-project/] is also a good idea. If you install the apache-doc RPM, you can alternatively access Apache documentation on your own installation under the
/usr/share/doc/apache-doc-*/ directory, or by browsing to http://localhost/manual/.
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Chapter 44. Postfix Mail Server
With Postfix, you can set up and configure a mail server to send and receive mail.
This server can communicate directly with other mail servers on the Internet
through the SMTP protocol. With the right configuration, Postfix can handle all
mail sent to your company's domain.

1. SMTP Server Functions
An SMTP (Simple Mail Transfer Protocol) server can be compared to a postal
sorting office. The office receives letters from the neighborhood, and sorts them:
if a letter is addressed to someone else in the neighborhood, it's stored in his or
her mailbox. Otherwise the letter is sent to the postal office corresponding to the
recipient's address. The same happens for letters relayed by another post office.
The operations of a standard Postfix mail server are very similar: it receives e-mail
from the local network users and from other mail servers which have identified
your mail server as responsible for handling the e-mail addressed to a specific
domain name. The server reads the recipient address, and then:
• If the domain name corresponds to the one locally served, the mail is stored
on the corresponding local mailbox. Then users pick up their messages through
a mail client. The actual delivery of the messages to the user is done through
another protocol (Chapter 45, Mail Delivery Services: Pop and IMAP [583]).
• Otherwise the server looks on the Internet for the server responsible for handling
that domain name's addresses, and forwards the message to it.

2. Installation
Make sure the postfix package is installed on your system.
The server configuration is done through the Postfix Configuration button which
is located in the Servers category.
If the mail server is to receive messages for a specific domain from other
servers, it must be marked as such in the DNS configuration, either on
your local DNS server (Chapter 42, BIND DNS Server [553]) or at your
registrar's.
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3. Step-by-Step Configuration Example
Each Postfix option in the Webmin module is documented. Just click on
the option's name and a pop-up window appears, explaining the relevant
option.

Figure 44.1. Postfix Start-Up Screen
Postfix's configuration files are stored in the /etc/postfix directory. The main
options to configure are located in the /etc/postfix/main.cf file and can be
configured by clicking on the General Options icon.
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Figure 44.2. Postfix's Main Configuration Screen
In this section we must configure the following main options:
• What domain to use in outbound mail. This option concerns outgoing mail.
You should specify the mail domain. Leave it as Use domainname if the computer's domain name has the same value as your mail domain name.
• What domains to receive mail for. This parameter deals with incoming mail.
You should specify the mail domains for which this server is responsible. Set
it to Whole domain if the computer's domain name has the same value as your
mail domain name. Otherwise select the third radio button and enter the commaseparated list of handled domains, as well as all the names the server could
have, including $myhostname and localhost.$mydomain.
• Send outgoing mail via host. This option is useful if you access the Internet
through an ISP which provides you with a mail server. If this is the case, you
can choose to use it as a relay to dispatch your own messages to their actual
recipients. That will reduce the load of your server but you must trust your
ISP's integrity. Then provide the name of your ISP's mail server: smtp.provider.net for example.
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• Internet hostname of this mail system. This parameter specifies the Internet
hostname of this mail system. The default is to use the Fully-Qualified Domain
Name (FQDN). For example, gateway.example.com. Leave the “Default
(provided by system)” value if your hostname looks like computer_name.mx_domainname.
•

Local internet domain name . This option specifies the local Internet domain
name. The default is to use $myhostname minus the first component. For our
example it would be example.com. Leave the “Default (provided by system)”
value if your hostname looks like computer_name.mx_domainname.

•

Local networks . This parameter is used to identify which machines are trusted
for relaying through your mail server. Messages coming from those machines
and directed to other servers on the Net will be accepted and forwarded without
restrictions. Typical values, for example, are 192.168.1.0/24, 127.0.0.0/8.
This means that you allow relaying from the localhost and systems for which
the addresses are in the 192.168.1.1-254 range. Please be sure to specify the
correct networks to avoid becoming a spam victim.

Back to the module index, the Mail Aliases section helps you configure the mail
redirection to valid existing mailboxes. As you can see in the table, many default
aliases exist which all converge, possibly after various hops, to the postfix address.
We recommend that you add an alias for this address to point to your personal
account or address, in order for messages sent to one of the defined aliases (including root messages for system alerts) are actually forwarded to you instead of being
stored locally in the postfix user's mailbox.

Figure 44.3. Defining a New Mail Alias
To conclude with general server configuration, it may be interesting to check the
General resource control page. Two options are interesting:
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Max size of a message
Configures the maximum size (in bytes) of e-mail accepted by Postfix. This
number is the size of the whole message, including the headers and any attachments. Consider that mail software encodes non-text attachments, so the total
size of a message is actually greater than the on-disk size of attachments.
Max size of bounced message
If Postfix cannot deliver mail to its final destination, it sends a non-delivery
notification message to the original sender. This notification contains the cause
of the error and a configurable amount of text from the original message. This
parameter indicates how much text (in bytes) should be included.

4. Advanced Configuration
Here are some of the more interesting General options ones. If you want to keep
trace of all the e-mails which pass through the server, put an address in the Address
that receives bcc of each message field. You can also specify the Time in hours
before sending a warning for non-delivery. The other options are system-specific,
don't change these parameters unless you fully understand their meaning.

4.1. Address Mapping
In the Canonical mapping section, you can specify mapping table files which are
used to rewrite e-mail headers managed by Postfix. For example, in the Address
mapping lookup tables field, you could associate the name of employees with their
e-mail address: John.Doe@example.com and jdoe@example.com.

4.2. Virtual Domains User Mapping
If you're serving more than one mail domain with your mail server, you may need
to configure the Virtual domains section. Indeed if you handle mails for both the
pingus.org and icy.org domains, e-mails sent to peter@pingus.org and
peter@icy.org are delivered to the same peter mailbox. If this is actually the same
person, it's not a problem. But if they're two different persons, the messages must
be delivered to two different mail accounts.
First you need to specify the Domain mapping lookup tables . You must type
hash:/etc/postfix/virtual and click on Save and Apply . Next create a new
mapping by clicking on New mapping . For example, e-mails addressed to
peter@icy.org to be redirected to local user icypeter, instead of peter.
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Figure 44.4. Postfix: Configuring Virtual Domains
This way you can redirect mail to any local user, users of any other domain or
server, and even whole domains to a single user.

4.3. More Miscellaneous Options
The Local delivery section contains options to help you configure e-mail handling
after Postfix receives them.
In the SMTP server options section, you can prevent receiving spam mail by
configuring the DNS domains for blacklist lookups field. Some Internet servers
run public DNSs with blacklisted hosts. These mail hosts relay spam mail. Configuring this option allows Postfix to look in these databases before accepting e-mail.
All Postfix responses at the bottom of the page should be kept to the default values.
If LDAP is installed on your system, you could access and configure options in
the LDAP lookups section.
You can use the Address rewriting and masquerading section to hide all hosts
inside a domain behind their mail gateway, and to make it appear as if the mail
comes from the gateway itself instead of from individual machines. Note that this
option is activated by default.

4.4. Mailbox Access
Finally you may have noted the User mailboxes section which allows you to browse
local mailboxes to possibly perform maintenance tasks on them by manipulating
messages.
It may be interesting to have access to a user's messages if he has problems accessing
his mailbox, or to remove huge attachments which overload the server's disk.
When using this feature, bear in mind your system administrator ethics
and your user's rights. Don't abuse your rights by reading other users'
messages.
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5. Extra Documentation
Joe Cooper's The Book of Webmin [http://www.swelltech.com/support/
webminguide/ch10.html] contains a long chapter dedicated to Postfix. You will
find explanations for almost all options available in Webmin's Postfix module.
It's also a good idea to browse the Postfix Documentation pages [http://www.
postfix.org/docs.html]. Alternatively, you may access the Postfix documentation
on your own installation in /usr/share/doc/postfix-*/.
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Chapter 45. Mail Delivery Services: Pop
and IMAP
By using POP (Post Office Protocol) and IMAP (Internet Message Access Protocol),
users can access their electronic mailboxes and get their e-mails to read them on
their machines.

1. Foreword and Installation
If you did a standard Mandriva Linux installation, mail access servers (POP3 or
IMAP) are launched on demand: when a connection is made to the POP or IMAP
ports, the appropriate program to answer that request is launched.
A POP3 user fetches messages on his computer and reads them with a mail reader
such as KMail or Evolution, while the IMAP protocol allows users to leave their
messages on the server and manage them remotely, making it ideal for mobile
users. However since messages can consume a lot of disk space, system administrators should regularly check their servers or set up quota policies.
Make sure the imap package is installed.

2. Step-by-Step Configuration Example
It's better to configure only the services which you need to use and to close others:
know if your users need POP, IMAP, or both.
Click on the Extended Internet Services icon in the Networking category for the
program to list all the accessible services on your computer which are managed
by xinetd. These services can be up (activated) or down (stopped).
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Figure 45.1. Start-up Screen of the xinetd Module
Both POP and IMAP have a secure protocol associated with them: POP3S and
IMAPS which encrypt data flow. If your users access their e-mail through the Internet it's safer to use these secured services and to deactivate others. Make sure
the clients they use actually support those secure protocols.
The imap package automatically activates the POP service with standard options.
Click on a service name to activate or deactivate it and to configure it.
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3. Advanced Configuration

Figure 45.2. POP3 Configuration Module
In Service enabled? select the Yes option for the service to be accessible. You can
then restrict access to it in the Service access control section. Select the Only listed
hosts option and enter the IP addresses of computers allowed to retrieve mail in
the Allow access from box.
Save your changes and click on Apply changes so the xinetd daemon applies the
new configuration.
This configuration screen is the same for all services managed with xinetd.

3. Advanced Configuration
There are many other options which are not mandatory for a standard configuration. In the Service network options section, the Bind to address and Port number
options allow you to force the daemon to listen on a specific address-and-port pair.
If you have many network interfaces and you want mail traffic to pass only through
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3. Advanced Configuration
a specific one, you can specify it in this section by entering that interface's IP address.
In the Service program options section, you can choose to redirect all your requests
to another computer. In Service handled by, select the Redirect to host option and
enter the IP address and port of the machine to which you want requests to be redirected to. The Run as user and Run as group options both allow the service to
be run as a specific user.
xinetd allows you to set up specific limits for each service. The Max concurrent
servers option specifies the maximum number of daemon instances which can be
running at the same time. Maximum connection per second specifies the number
of connection requests the server can handle. If the maximum is rexached, then
the Delay if maximum is reached option specifies the time interval until that instance of the service daemon will be reachable again. In the POP3 example, you
can specify that only three POP3 servers can be launched and respond to five
connection requests per second. This can be useful to minimize server overloading.
The last useful option is Nice level for server, which indicates the program's system
priority. If various services are available on the same server and some are more
critical than others, this option allows you to tell the system to assign more resources
to the more critical processes. The Nice level is at O by default and you may choose
values between -20 (the highest priority) and 19 (the lowest). If you consider the
POP3 service to be of less importance with respect to the other services hosted on
your server, then you could assign it a nice level of 10 for example.
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Chapter 46. Resource Sharing
1. Samba: Integrating Linux in a Windows Network
The Samba server allows you to easily integrate a Mandriva Linux computer in a
mixed GNU/Linux & Windows® network. Through Samba, your computer can
appear in other people's network neighborhood and act as a Windows® server
sharing files and printers, remote user accounts etc.

1.1. Installing Samba
Make sure the samba-server package is installed.
The server configuration is done through the Samba Windows File Sharing configuration button located under the Servers category.

1.2. Step-by-Step Configuration Example

Figure 46.1. The Samba Module's Main Window
Samba's configuration files are stored in the /etc/samba directory. The main Samba
options you need to set are located in the /etc/samba/smb.conf file and are accessed by clicking on Windows Networking .
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1.2. Step-by-Step Configuration Example
Samba automatically reloads its configuration every minute, so there's
no need to constantly restart the Samba server for your changes to the
settings to be effective.

1.2.1. General Settings

Figure 46.2. Configuring The Common Networking Options
Define a Workgroup for your server (ENGINEERING in our example). You can also
set the Server name and the Server aliases. You can set the Samba server to be the
WINS server of your network with the WINS mode option1. Set Security to User
level and validate your choices by clicking on Save (see Figure 46.2, “Configuring
The Common Networking Options” [588]).

1.2.2. Authentication Method

Figure 46.3. Setting The Authentication Method for Windows 95 Clients

1

You shouldn't mix Windows® and Samba WINS servers on your network.
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1.2. Step-by-Step Configuration Example
If you have Windows® 95 clients on your network, click on the Authentication
button and change the Use encrypted passwords? option to No as shown in Figure 46.3, “Setting The Authentication Method for Windows 95 Clients” [588].

Figure 46.4. Synchronize Samba and Unix Users
If there are no Windows® 95 clients on your network click on the Configure automatic Unix and Samba user synchronisation link, put a check mark in all options
as shown in Figure 46.4, “Synchronize Samba and Unix Users” [589] and then click
on the Apply button.
To add the current Linux users on your system as Samba users, click on the Convert
Unix users to Samba users link, make your changes to the settings or accept the
default ones, and click on the Convert Users button. After adding users, you
should click on Edit Samba users and passwords to modify and/or remove unwanted users.
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1.2. Step-by-Step Configuration Example

1.2.3. Adding Shares

Figure 46.5. Configuring a Public Share
To create a public share where any user can read and write files, click on the Create
a new file share link and fill the form like the one shown in Figure 46.5, “Configuring a Public Share” [590]. Then click on the share name (Public in our example)
and on the Security and Access Control button changing the Writable? and Guest
Access? options to Yes. Save your changes and repeat the process to add other
shared folder entries, setting access control appropriately.
Please bear in mind that all directories configured as shares will have to have
proper Linux access rights in order to be readable/browsable/writable by Windows® users.
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1.3. Advanced Configuration
1.3.1. Share Access

Figure 46.6. Limiting Access
Select a share to be edited in the share list and click on the Security and Access
Control button. Use the Hosts to allow and Hosts to deny options to specify a
space-separated list of the IP addresses of the hosts allowed to connect, or not, to
this share. If you set the Limit to possible list? option to Yes, then you must fill
the Possible users and Possible groups fields with a space-separated list of the
users/groups in question. See Figure 46.6, “Limiting Access” [591] for an example.

1.3.2. Default Printer

Figure 46.7. Printer Share Default Options
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1.4. Extra Documentation
Even if all the Samba server's printers are available, you might want to set the
Printer Share Defaults (see Figure 46.7, “Printer Share Default Options” [591]). Use
the Unix Printer pull-down list to select the default printer and specify whether
the printer will be available or not, the spooling directory (leave blank for default),
a comment and security and access control options. Click on Save when you are
satisfied with your settings.

1.4. Extra Documentation
Browsing the Samba Documentation [http://samba.org/samba/docs/] is a good
idea. If you installed the samba-doc RPM, you can alternatively access Samba
documentation on your own installation in the /usr/share/doc/samba-doc-*/
directory.

2. Resource Sharing: FTP
ProFTPD allows you to create and set up an FTP server. With the latter, your
company can share files with people connected to the Internet (or to your Intranet).
Depending on your configuration, they could also upload files on to your server.

2.1. Installation
Make sure that the proftpd package is installed.
The server's configuration is done through Webmin's ProFTPD Server module
located under the Servers category.

2.2. Configuration Examples
Using FTP is insecure because login names and passwords are not encrypted while transferring them to the server. Use non-anonymous FTP
connections with logins and passwords only within trusted networks.
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2.2. Configuration Examples

Figure 46.8. ProFTPD Module's Start-Up Screen
ProFTPD's configuration files are stored in the /etc/proftpd.conf file. ProFTPD's
default configuration only allows users of your system with valid accounts to
connect via FTP. In the following sections we present common FTP server configuration examples.
Like Apache, ProFTPD can be used to host several FTP sites on a single server by
means of virtual servers. Global Configuration options will apply to all virtual
servers. Each virtual servers' options are found in the Virtual Servers section.
The default values are already good for most configurations, so please
do not change them unless you know what you are doing.
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2.2.1. Simple Anonymous FTP Server
Simply install the proftpd-anonymous package. It adds a configuration file with
everything needed for anonymous connections to the FTP server.
To test the anonymous FTP server access:
1.

Connect to the hostname or IP of the FTP server using your favourite FTP
client.

2.

Enter anonymous as the login name and your e-mail address as the password.

3.

If all went well, all files located in the ftp user directory root (the /var/ftp
directory) and its subdirectories will be available for anonymous downloads.

2.2.2. Anonymous FTP Server With Uploads Directory
If you want to enable people to upload their files, you need to create a special place
for those files to be stored. Let us add that functionality to our server.
Type the following in a terminal, as root, to create the storage space and change
its access rights and owner.
# mkdir /var/ftp/uploads
# chown ftp:ftp /var/ftp/uploads
# chmod g+w /var/ftp/uploads

Click on the Default server link and then on the Anonymous FTP button. Fill the
Directory path field of the Add per-directory options for.. table with uploads/*
and click on the Create button.
We want users from our trusted network to read and store data in this directory.
The following per-command options must be set:
• Enter STOR in the Add per-command options for table and click on the Create
button, then click on Access Control and fill the form with the values as shown
in Figure 46.9, “Access Control For Commands in the Directory Page” [595].
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Figure 46.9. Access Control For Commands in the Directory Page
In our example we allow anonymous storage of files into this directory only
for network 192.168.0. and deny from any other networks. You can also allow/deny access for certain hostnames, IP addresses, users and groups of users.
• Click on the Return to per-directory options link and create the READ command
and follow the instructions above, but this time to allow/deny reading of the
uploads/* directory.
Return to the main menu and click on the Apply Changes button to restart the
FTP server. All files located in the /var/ftp/uploads/ directory will be available
for anonymous uploads and downloads.
You can repeat the above test procedure, but for the /var/ftp/uploads directory.

2.3. Advanced Configuration
Here is a list of useful options to configure:
• Under the Miscellaneous section of any of the virtual servers you can change
the Server administrator's email address (ftp_admin@company.net, for example),
and the Server name displayed to users (for example Main FTP server of my
Company).
• Under the Networking Options section you may change the value of Maximum
concurrent logins from the default (10) to an unlimited number or the number
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of connections you specify2. You can also set the Login error message to a
meaningful value, for example: Sorry, max %m users connected -- try
again later., where %m will be replaced by the number set before. You can
also set the port that virtual server listens to (21 for the main server).
• Under the Files and Directories section you can specify the Initial login directory. This is the default root directory and can be used to put users into a restricted environment. You can also use Limit users to directories to restrict all users
to their home directories or to a directory of your choice.
You can always use Edit Config files in the main screen of the ProFTPD module
(see Figure 46.8, “ProFTPD Module's Start-Up Screen” [593]) if you need to edit
ProFTPD's configuration file by hand.

2.4. More Documentation
Browse the ProFTPd Documentation [http://www.proftpd.org/docs/] where
you'll also find configuration examples.

3. NFS: Exporting Directories To UNIX/Linux Hosts
NFS allows you to easily export directories of your computer to others through
the network, thus enabling file sharing between several users. This type of sharing
is easier to set up than Samba, but it is only used on GNU/Linux and UNIX® systems. NFS is very insecure and must be used only in a secure local network.

3.1. Installation
Make sure that the nfs-utils and nfs-utils-clients packages are installed.

3.2. Configuration Example
Exported directories configuration is done using the NFS Exports button. You
will find it under the Networking category. Click on the Add a new export link
to create a new export.
Simply click on a parameter you do not understand and a help window
explaining that parameter will pop-up.

2

Setting this value to 0 will result in the denial of all connections to the FTP server.

596

3.3. Accessing the Exported Directories

Figure 46.10. Adding a New NFS-exported Directory
The new export creation window (see Figure 46.10, “Adding a New NFS-exported
Directory” [597]) is divided in two sections. Under Export details you should select
NFS Version 3, to ensure optimum compatibility. Then specify the Directory to
export and where you want to Export to. By default, the export is accessible to
Everyone, this should be changed to the sub-network you actually use (for example:
192.168.1.0/255.255.255.0) or a netgroup.
Under Export security you can restrict the access to your exported directories even
more. For example, you can choose which UIDs and GIDs to trust, whether to allow
read only or read/write access, etc.
Once you are satisfied with your settings, click on the Save button to return to the
main NFS exports configuration screen. You will now see the export entry you just
added. You can add more exports or edit the existing ones by clicking on the
proper link in the Exported to.. column. Click on the Apply Changes button to
make the exported directories available to clients.

3.3. Accessing the Exported Directories
You will have to configure the client computer(s) to mount the NFS-exported directories created. The settings vary from one OS to another, we will concentrate
here on a Mandriva Linux client configuration.
The simplest way is to use the Mandriva Linux Control Center Set NFS mount
points subsection of the Mount Points section.
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You can also do it the Webmin way by entering the Disk and Network Filesystems
interface into the System section. There you will be able to Add mount of type
Network filesystem (nfs)

3.4. Extra Documentation
Joe Cooper dedicates a chapter to NFS exports in The Book of Webmin [http://
www.swelltech.com/support/webminguide/ch13.html#exports]. Though based
on an old version of Webmin it might prove to be an interesting read.
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Chapter 47. The Kolab Server
1. Introduction
Kolab is the server part of Kroupware, the KDE groupware solution. Kolab stores
synchronization information such as addresses, calendar information and files
which are useful to groups of users. Information stored by the Kolab server may
be accessed using Kontact, the client part of the Kroupware project. Kontact is a
combination of KMail, KOrganizer, KAddressbook, KNotes, KPilot and KNode.
This chapter will give a technical overview of the Kolab server, then explain its
installation, configuration and administration. User information for the Kontact
client can be found in Mandriva Linux's Starter Guide. Information on the Kroupware project can be found on the Kroupware web site [http://kroupware.kde.org].

2. Overview
The Kolab administration interface is hosted on the enhanced Apache HTTP
server. Login on to the administration module is only possible using a secure
connection.
Kolab allows three levels of users:
• user. Can change personal user data.
• maintainer. User rights plus administrative rights over users, groups and shared
folders.
• administrator. Maintainer rights plus rights to the whole LDAP tree, rights to
toggle legacy services and view logs.
All user level login to the Kolab administration module using the same web interface. After the login has been authenticated using LDAP credentials, the user is
presented with the choice of web forms permitted at his level. All new users are
automatically created as regular users.
The LDAP server is hosted on the same physical machine as Kolab. All data used
by Kolab, both user and configuration, is stored on the LDAP server, which is
configured using the Kolab bootstrap script, kolab_bootstrap -b. By regularly
backing up LDAP data on a separate machine it is possible to restore the state of
the Kolab server even after a hardware disaster.
Kolab uses a special account manager, created at installation time for administrative
users to manipulate all possible data on the LDAP server. Maintainers and users
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have different access rights to the LDAP tree. This means a potential security attacker, gaining control of the Apache server would not be able to manipulate account data on the machine so long as the manager password is unknown.

3. Installation
To install the Kolab server, use Rpmdrake (see Rpmdrake: Package Management in
the Starter Guide) from the Mandriva Linux Control Center. You can also issue the
urpmi --auto kolab-server command, on a terminal as root, to install it.
When Kolab is installed, the server has to be configured. This is done by launching
the /usr/sbin/kolab_bootstrap -b script. The script will configure the LDAP server
used to store Kolab configuration information and user data. While initializing the
server, kolab_bootstrap will ask you to provide a password for the LDAP server
manager account. You must keep this information, this account doubles as the
Kolab administrator account and is used to login to the administration interface
for the first time.
You will need a valid DNS entry for your hostname, as well as a valid
MX record for your maildomain. If you only use /etc/hosts, you will
be able to access most of the features, but you won't be able to receive
mail from the outside. One solution could be to use fetchmail or a similar
utility to retrieve mail from an outside POP server, but the ideal solution
is to have your own domain name and fixed IP address accessible from
the outside.
When the bootstrap script has run, issue the service kolab-server start command
to starte the Kolab server. Kolab is now running and ready for the first login.
In order to configure the Kontact client to work in conjunction with Kolab, you
need essential LDAP connection information which you'll find in the /etc/openldap/slapd.conf file. For example:
# grep suffix /etc/openldap/slapd.conf
suffix
"dc=kolab,dc=yourdomain,dc=com"

Gives you the Base DN string: dc=kolab,dc=yourdomain,dc=com. Then for user
peter, the Bind DN string will be cn=peter,dc=kolab,dc=yourdomain,dc=com.

4. The Kolab Administration Interface
All users log in to the Kolab administration module using the same web interface.
If your Internet browser is on the same machine as the Kolab server, this will be
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found at https://localhost/kolab/. If you are logging in over the network the
URL would be https://hostname/kolab/.
Since we're using a dummy, self-signed SSL certificate, your browser
will complain that the “certificate failed the authenticity test”. Don't
worry, this is normal. Simply click Continue , then Accept forever and
you're set. Depending on your DNS configuration, you may have to do
this step twice.
The first login to the Kolab server has to be done using the manager account whose
password was chosen when the kolab_bootstrap script was run. Once logged in
the administrator can create Kolab user, maintainer and administrator accounts.
For more information on how this is done, see Section 4.2, “Maintainers” [604].
If the LDAP database is already populated, the administrator can view
the existing user information. Existing LDAP users will not be able to
log in to the Kolab administration module automatically. Kolab users
have to be created explicitly using the administration module.
Once a new account is created, it is active. The Kolab user can log into the administration module.
After logging into the administration module, users are presented with the Kolab
welcome page. A list of web forms available to the user is presented on the lefthand frame. The following sections explain the forms available for the different
user types and the information necessary to use them correctly.

4.1. Users
Members of the regular groupware users group have the right to:
• modify personal user data;
• add an additional e-mail address for his/her account;
• activate a vacation messaging service;
• activate an e-mail forwarding service.
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Figure 47.1. The Kolab Server User Interface
The vacation message service and e-mail forwarding services are mutually
exclusive. The user has to explicitly deactivate one service to activate the
other.

4.1.1. Changing User Data
Members of the regular users group cannot:
• change their user name;
• change their unique user identification (UID);
• change their primary e-mail address;
to change user data.
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Figure 47.2. Modify Existing User Data
1.

Login to the Kolab Administration Interface.

2.

Click My User Settings in the left-hand panel of the Kolab administration interface.

3.

In the Modify Existing User web form change the user information desired.

4.

Click OK .

4.1.2. Activate Vacation Settings
On the occasions when a user is on vacation and cannot or will not check their email, it is helpful to inform other users who are to be contacted in their absence.
This can be done using the Kolab vacation message service.
To activate the Kolab vacation service:
1.

Login to the Kolab administration interface.

2.

Click My User Settings in the left-hand panel of the Kolab administration interface.
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3.

Click Vacation . The User Vacations Settings page will open.

4.

Select the duration of your vacation in the drop-down combo box.

5.

Type the message you wish to be shown to other users in the Vacation text
box.

6.

Click OK .

4.1.3. Activate E-mail Forward Settings
Kolab supplies an e-mail forwarding service to assist on occasions when users are
on external missions or vacation and cannot contact the standard e-mail of their
organization but have the option to use a different e-mail address. When the email forwarding service is activated, e-mails are forwarded to the desired address.
Optionally a copy of these e-mails can be stored on the organizations e-mail server.
To activate the Kolab e-mail forwarding service:
1.

Login to the Kolab administration interface.

2.

Click My User Settings in the left hand panel of the Kolab Administration
Interface.

3.

Click Forward E-Mail and the User Forward Settings page will open.

4.

Type the address the e-mail is to be forwarded to.

5.

If you wish to keep a copy of your e-mail on the local server, click the Keep
check-box.

6.

Click OK .

4.2. Maintainers
The role of the maintainer group is to administer users and shared folders on the
Kolab server. The following rights are available to maintainers in addition to basic
user rights:
• add, modify and delete Kroupware users;
• add, modify and delete address-book users, that is to say those users in the
LDAP directory who are not registered on the Kolab server;
• add modify and delete shared folders.
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Activities related to the maintainer groups basic user rights are documented in Section 4.1, “Users” [601].

Figure 47.3. The Kolab Server Maintainer Interface

4.2.1. Kroupware Users
Kroupware users are fully registered Kolab users and profit from all Kolab
groupware services. Kolab maintainers can manage Kroupware user data and
create new address-book users.
Creating New Users.
To add a new user:
1.

Click Create New User in the Users section of the left-hand frame.

2.

Fill in the necessary user information in the Create New User web form.

3.

Click OK .
Select the Addressbook check-box to allow the Kroupware user address
information to be visible in the address book.

Managing Existing Users
When a member of the maintainers group clicks the Users button on the left handframe of the Kolab administration interface, an alphabetical list of all current
Kroupware users is presented in the right-hand side. For each user there is a choice
to modify or delete the user.
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• To modify user information, click the Modify button. This will lead you to the
Modify Existing User web page. This page is explained in the Users section
(see Section 4.1, “Users” [601]).
• To delete a user, click the Delete button.

4.2.2. Address-Book Users
Address-book users are users which exist in the LDAP directory but are not registered Kolab users. The latter can access their address-book data; Kolab maintainers can manage address-book user data and create new address-book users.
Creating New Users

Figure 47.4. The Create New Address Book Form
To add a new address-book user:
1.

Click Create new VCard in the Users section of the left-hand frame.

2.

Fill in the necessary user information in the Create New Address Book Entry
web form.

3.

Click OK .
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Managing Existing Users
When a member of the maintainers group clicks the Addressbook button on the
left-hand side of the Kolab administration module, an alphabetical list of all current
address-book users will be presented in the right-hand frame. For each user there
is a choice to modify or delete the user.

Figure 47.5. The Manage Address Book Users Table
The following actions can be done on the Manage Address Book Users form:
• To modify user information:
1.

Click the Modify button.

2.

In the Modify Address Book Users page change the information desired.

3.

Click OK .

• To delete a user, click the Delete button.

4.2.3. Managing Shared Folders
Maintainers can reconfigure existing shared folders and create new shared folders.
Creating New Shared Folders

Figure 47.6. The Create New Shared Folder Form
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To add a new shared folder:
1.

Click Add Folder in the Shared Folder section of the left-hand frame.

2.

Fill in the necessary user information in the Create New Shared Folder web
form.

3.

Click OK .

Configuring Shared Folders
When a member of the maintainers group clicks the Shared Folder button on the
left-hand frame of the Kolab administration module, an alphabetical list of all
current shared folders is presented in the right-hand frame. For each folder there
is a choice for it to be modified or deleted.
• To modify a folder:
1.

Click the Modify button.

2.

In the Modify Shared folder page change the information desired.

3.

Click OK .

• To delete a folder, click the Delete button.

4.3. Administrators
The administrator group has full control over all objects on the LDAP server and
non secure legacy services such as FTP, HTTP, IMAP and POP3. Administrators
can fulfill all the functions of the maintainers group. In addition being able to add,
modify or delete groupware users, address-book users and shared folders, administrators have the following rights:
• add, modify or delete accounts for users in the maintainer and administrator
groups;
• change server settings (hostname and mail domain);
• toggle non secure legacy services (FTP, HTTP, IMAP and POP3).
Activities related to the Administrator groups maintainer and basic user
rights are documented in Section 4.1, “Users” [601], and Section 4.2,
“Maintainers” [604].
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4.3.1. Managing Maintainer Accounts
Administrators have the right to modify or delete and existing maintainer account
and add a new maintainer account.
Creating New Maintainers
To add a new maintainer:
1.

Click Add Maintainer in the Maintainer section of the left hand frame.

2.

Fill in the necessary user information in the web form.

3.

Click OK .

Managing Existing Maintainers
When a member of the administrators group clicks the Maintainers button on the
left-hand frame of the Kolab administration module, an alphabetical list of all
current maintainer users is presented in the right-side frame. For each user there
is a choice to modify or delete the user.

Figure 47.7. The Manage Maintainers Table
• To modify maintainer information:
1.

Click the Modify button for the maintainer required.

2.

This will open the Modify Existing User page.

3.

Update the information desired.

4.

Click OK .
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• To delete a maintainer, click the Delete button.

4.3.2. Creating New Administrators
It is always safer to have at least one back-up administrator for any server. Kolab
allows the creation of multiple administrators.

Figure 47.8. The Create New Administrator Form
To add a new administrator:
1.

Click Administrator in the left-hand pane of the administration module.

2.

Click Add Administrator .

3.

Fill in the new administrator information.

4.

Click OK .

4.3.3. Changing Server Settings
Members of the administer group can change the hostname and domain name of
the e-mail domain on the host server.
Changes in these settings can directly affect the mail transport system
and can result in e-mail delivery problems.
To change server settings click Server in the left-hand frame of the administration
module, fill in the necessary information as shown in the screen shot below and
click OK .
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Figure 47.9. The Server Settings Form

4.3.4. Toggling Services
The Kolab administrator has the right to enable or disable the following services
on the host machine:
• POP3;
• POP3/TLS service (TCP port 995);
• IMAP/TLS service (TCP port 993);
• FTP free-busy service;
• HTTP free-busy service.
To enable or disable the service required, click on Services in the left-hand pane
of the administration module. You will see the following web form.
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Figure 47.10. The Services Form
In the form you can see the status of the different services. To activate or deactivate,
click the required URL in the action column.
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Chapter 48. MySQL Database Server
Databases are responsible for storing data (mainly text and numbers) and delivering
it back in an efficient manner. They are generally used by other applications which
need to quickly access data to process or display it.
MySQL is a true multiuser, multithreaded SQL (Structured Query Language)
database server. MySQL is a client/server implementation which consists of a
server daemon (mysqld) and many different client programs and libraries. The
main goals of MySQL are speed, robustness and ease of use.

1. Getting Started
We cover basic MySQL configuration and usage through the Webmin interface.
Make sure that the MySQL package is installed.
The MySQL Database Server configuration button is in the Servers index. If you
just installed MySQL, you will be asked to start it: click on the Start MySQL
Server button.
If you get an error when trying to start or stop the server, open the
Module Config tab, and make sure the Command to start/stop MySQL
server actually uses the /etc/rc.d/init.d/mysqld command.
In the main screen notice that there are three default databases ( mysql , test and
tmp ). You should not modify, nor erase them.
Your first task is to set up the administrator's password. This is mandatory to prevent
other users on the machine from having unlimited access to the database. To do so, click
on the User Permissions icon then perform the following operation for the root
links in the users table.
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Figure 48.1. Setting the Administrator's Password
Select the Set to option of the Password line and enter the password for the administrator. Confirm your changes by clicking on the Save button. Once you set the
password, you have to reconnect to the MySQL server, go to the Module Index
tab and enter root as the user name and the password you've just set.
For security reasons, network access to the MySQL database is disabled
by default. If you need applications outside of the system on which
MySQL is installed to access the database, remove the /etc/sysconfig/mysqld file from your system.
In some cases, local applications are doing network requests to query
the database, and are therefore blocked even though the application is
actually running on the same machine.

2. Creating a User for the Database
A database user has nothing to do with a UNIX user. Therefore you have to manage
them differently. From the index page of the MySQL Database Server component,
click on User Permissions and then on Create new user. The database users may
have specific permissions, which are all listed in that window. Select from the list
the permissions that the user will be granted from the specified host.
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Figure 48.2. Creating a MySQL User
For security reasons don't leave the Hosts value set to Any. Do specify the hostname(s) from which the user is to be granted access to the MySQL database.

3. Creating a Database
Let's create the database which will hold our tables and data. Click on Create a
new database from the main page and write in a name for your database.

Figure 48.3. Creating a MySQL Database
You can add a first table to that new database and define up to four fields in that
table at this point. For our example we decided to do that in the next step. Note
that if you intend to use your database with a third-party application, such as a
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web frontend, everything you need should be available at this step: a user and its
password plus a running database, ready to store data.

4. Creating a Table
Once the database is created, it is possible to define its structure manually with
Webmin. Click on its icon to access the Edit Database page. Note that there are no
tables for the moment, but from this step we can Create a new table , Drop Database (delete it) or Backup Database . You can also Execute SQL directly by entering
SQL commands or uploading an SQL command file. You can select the number
of fields the new table should contain (4 by default) before clicking on the Create
a new table button.
In the Create Table page, you must write the table's name and the field parameters.

Figure 48.4. Creating a MySQL Table
If you want to modify the table parameters or add new fields, click on the table's
name from the Edit Database page.
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Figure 48.5. Modifying a MySQL Table
From here you can either modify or delete an existing field, or create a new one,
view the table's data or delete ( Drop Table ), the whole table and its data.

5. Managing Data in a Table
We created everything needed to start filling the MySQL database. There are a
number of client programs you can use to connect to the MySQL server as well as
many programs which use such databases. You can also use Webmin to manage
your data. In the Edit Table page, click on the View Data button to add, modify,
or remove data.

Figure 48.6. Managing your Data

6. More Documentation
You will find an extensive set of documents on the MySQL web site [http://www.
mysql.com/documentation/], including documentation translated into many
languages.
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Chapter 49. NIS Client and Server
To simplify user management on your local network, you can centralize network
information such as user name and password lists on a NIS (Network Information
System) domain.
With NIS users can connect on any computer using the same login and password.
Information sharing allows you to distribute files such as /etc/passwd,
/etc/shadow or /etc/hosts to share machine passwords or aliases. To distribute
the data, you have to configure a Resource Sharing server such as NFS (see Section 3, “NFS: Exporting Directories To UNIX/Linux Hosts” [596]) or Samba (see
Section 1, “Samba: Integrating Linux in a Windows Network” [587]) and use autofs
(Section 4, “Importing homes with autofs” [621]).

1. Installation
First, you need to check that the ypserv server is installed on your computer. If it
isn't use the rpmdrake application or type urpmi ypserv in a terminal to install it.
The configuration of the NIS server is done in two steps: the first one is the configuration of the NIS tables 1 of the server; the second step is the configuration of
each client.
• On the server, you need to install the ypserv RPM package.
• For each client, install portmap, yp-tools and ypbind.
To use Webmin's NIS Client and Server module, you must select the Networking
category, then click on NIS Client and Server .

2. Step-by-Step Configuration
2.1. NIS Server
After clicking on the NIS Server icon you need to configure the NIS domain using
your domain name (such as mydomain.test). Then choose the NIS tables to
serve. For our example, we selected the passwd, group and shadow files (use the
Ctrl key to select several files in the list).

1

The NIS tables are the files you chose to export.
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Figure 49.1. NIS Server
You don't need to modify the file description in the Master NIS files section. On
the NIS Client and Server menu, the NIS Tables icon allows you to modify the
tables which are served. The Server Security icon allows you to select the clients
you want to serve.

2.2. NIS Client
For each client, go to the NIS module and enter the NIS client configuration screen.
You have to configure the NIS domain name parameter with the domain name
used by the server. You must also enter its IP address. That's all.

Figure 49.2. NIS Client

3. Advanced Client Configuration
Amongst all the exported data, some may be redundant with regard to the local
configuration. You can choose the priority to be allocated to every source (local,
NIS or other). To do so, use the Client Services button on each NIS client. It allows
you to choose the preferred order to search for data. For example, you can choose
to resolve the host's addresses using:
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4. Importing homes with autofs
1.

the /etc/hosts file;

2.

the NIS hosts served (if you selected it in the NIS table);

3.

and finally (if the client cannot resolve any more), use the DNS server.

To verify that the client communicates with the server, you can use the ypcat
passwd command to read the password data served by the server.

4. Importing homes with autofs
If you export your user's directories (using NFS for example), and if you configure
the autofs service on your NIS client, users' home directories are automatically
mounted when they log onto the client. This way everybody can automatically log
on every client, and have all their personal data and configuration files available
to them.
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Part 10. Applied Theory
Security, Network and Troubleshooting Issues
To help you deal with more complex issues, we added the following three chapters
to complete your Mandriva Linux know-how.
• The chapter which discusses security (Chapter 50, Security Under
GNU/Linux [625]) is a must read for any system administrator. Even though you
can make your Mandriva Linux system quite secure with default tools, efficient
security can only be achieved through active administration, taking care of
physical, logical and global system security. This chapter will help you choose
the appropriate security policy for your systems, the right means to secure your
network infrastructure, how to determine if your system has been altered or
compromised, and more.
• The networks' configuration and some concepts of the TCP/IP protocol — the
most commonly used ones — are tackled in (Chapter 51, Networking Overview [685]. Whenever possible pointers to information about other network
protocols is provided.
• In an effort to try to fight Murphy's law, we wrote the troubleshooting chapter
(Chapter 26, Troubleshooting [357]) to save you sleepless nights. It also covers
disaster prevention, so don't read this part when it's already too late!

Chapter 50. Security Under GNU/Linux
This document is a general overview of the security issues that the administrators
of GNU/Linux systems face. It covers general security philosophy and a number
of specific examples of how to better secure your GNU/Linux system against intruders. Also included are pointers to security-related material and programs.
The original document has been adapted to the Mandriva Linux distribution, removing some parts, changing others, etc.

1. Preamble
This chapter is based on a HOWTO by Kevin Fenzi and Dave Wreski. The Linux
Documentation Project [http://www.tldp.org] hosts the original document.

1.1. Copyright Information
This document is copyrighted (c) 1998 - 2000 Kevin Fenzi and Dave Wreski.
Modifications from v2.0, 11 June 2002, (C)opyright 2000-2004 Mandriva
and distributed under the following terms:
• Linux HOWTO documents may be reproduced and distributed in whole or in
part, in any medium, physical or electronic, as long as this copyright notice is
retained on all copies. Commercial redistribution is allowed and encouraged;
however, the authors would like to be notified of any such distributions.
• All translations, derivative works, or aggregate works incorporating any Linux
HOWTO documents must be covered under this copyright notice. That is, you
may not produce a derivative work from a HOWTO and impose additional
restrictions on its distribution. Exceptions to these rules may be granted under
certain conditions; please contact the Linux HOWTO coordinator at the address
given below.
• If you have questions, please contact the Linux HOWTO coordinator Tim
Bynum [mailto:tjbynum@metalab.unc.edu].

1.2. Introduction
This chapter covers some of the main issues which affect GNU/Linux security.
General philosophy and net-born resources are also discussed.
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2. Overview
A number of other HOWTO documents overlap with security issues, and those documents have been pointed to wherever appropriate.
This chapter is not meant to be an up-to-date exploits document. Large numbers
of new exploits happen all the time. This chapter will tell you where to look for
such up-to-date information, and will give you some general methods to prevent
such exploits from taking place.

2. Overview
This chapter will attempt to explain some procedures and commonly-used software
to help your GNU/Linux system be more secure. It is important to discuss some
of the basic concepts first, and create a security foundation, before we get started.

2.1. Why Do we Need Security?
In the ever-changing world of global data communications, inexpensive Internet
connections, and fast-paced software development, security is becoming more and
more of an issue. Security is now a basic requirement because global computing
is inherently insecure. As your data goes from point A to point B on the Internet,
for example, it may pass through several other points along the way, giving other
users the opportunity to intercept, or worst, make alterations. Even other users on
your system may maliciously transform your data into something you did not intend. Unauthorized access to your system may be obtained by intruders, also
known as “crackers”, who could then use advanced knowledge to impersonate
you, steal information from you, or even deny you access to your own resources.
See Eric Raymond's How to Become a Hacker [http://www.catb.org/~esr/faqs/
hacker-howto.html] if you're wondering what the difference between a “hacker”
and a “cracker” is.

2.2. How Secure Is Secure?
First, bear in mind that no computer system can ever be completely secure. All
you can do is make it increasingly difficult for someone to compromise your system.
For the average home GNU/Linux user, not much is required to keep the casual
cracker at bay. However, for high profile GNU/Linux users (banks, telecommunications companies, etc.), much more work is required.
Another factor to take into account is that the more secure your system is, the more
intrusive your security becomes. You need to decide where in this balancing act
your system will still be usable, and yet secure for your purposes. For instance,
you could require everyone dialing into your system to use a call-back modem to
call them back at their home number. This is more secure, but if someone is not at
home, it makes it difficult for them to log in. You could also set up your GNU/Linux
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system with no network, nor connection to the Internet, but this limits its usefulness.
If you are a medium-to-large-size site, you should establish a security policy stating
how much security is required by your site and what auditing is in place to check
it. You can find a well-known security policy example at faqs.org [http://www.
faqs.org/rfcs/rfc2196.html]. It contains a great framework for establishing a security
policy for your company.

2.3. What Are You Trying to Protect?
Before you attempt to secure your system, you should determine what level of
threat you have to protect against, what risks you should or should not take, and
how vulnerable your system is as a result. You should analyze your system to
know what you're protecting, why you're protecting it, what value it has, and who
has responsibility for your data and other assets.
• Risk is the possibility that an intruder may be successful in attempting to access
your computer. Can an intruder read or write files, or execute programs that
could cause damage? Can they delete critical data? Can they prevent you or
your company from getting important work done? Don't forget: someone
gaining access to your account, or your system, can also impersonate you.
Additionally, having one insecure account on your system can result in your
entire network being compromised. If you allow a single user to log in using
a .rhosts file, or to use an insecure service, such as tftp, you risk an intruder
getting “his foot in the door”. Once the intruder has a user account on your
system, or someone else's system, it can be used to gain access to another system,
or another account.
• Threat is typically from someone with motivation to gain unauthorized access
to your network or computer. You must decide who you trust to have access
to your system, and what level of threat they might pose.
There are several types of intruder, and it is useful to keep their different
characteristics in mind as you are securing your systems.
• The Curious – This type of intruder is basically interested in finding out what
type of system and data you have.
• The Malicious – This type of intruder is out to either bring down your systems, or deface your web page, or otherwise force you to spend time and
money recovering from the damage he has caused.
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• The High-Profile Intruder – This type of intruder is trying to use your system
to gain popularity and infamy. He might use your high-profile system to
advertise his abilities.
• The Competition – This type of intruder is interested in what data you have
on your system. It might be someone who thinks you have something that
could benefit him, financially or otherwise.
• The Borrowers – This type of intruder is interested in setting up shop on your
system and using its resources for their own purpose. He typically will run
chat or IRC servers, porn archive sites, or even DNS servers.
• The Leapfrogger – This type of intruder is only interested in using your system
to get access to other systems. If your system is well connected or a gateway
to a number of internal hosts, you may well see this type trying to compromise your system.
• Vulnerability describes how well-protected your computer is from another
network, and the potential for someone to gain unauthorized access.
What's at stake if someone breaks into your system? Of course the concerns of
a dynamic PPP home user will be different from those of a company connecting
their machine to the Internet, or another large network.
How much time would it take to retrieve/recreate any data that was lost? An
initial time investment now can save ten times more time later if you have to
recreate data that was lost. Have you checked your backup strategy and verified
your data lately?

2.4. Developing a Security Policy
Create a simple, generic policy for your system that your users can readily understand and follow. It should protect the data you are safeguarding as well as the
privacy of the users. Some things to consider adding are: who has access to the
system (Can my friend use my account?), who is allowed to install software on
the system, who owns what data, disaster recovery, and appropriate use of the
system.
A generally-accepted security policy starts with the phrase:
“That which is not permitted is prohibited.”
This means that unless you grant access to a service for a user, that user should
not be using that service until you do grant access. Make sure the policies work
on your regular user account. Saying, “Ah, I cannot figure out this permissions
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problem, I'll just do it as root”, can lead to security holes that are very obvious,
and even ones which haven not been exploited yet.
rfc1244 [http://www.faqs.org/rfcs/rfc1244.html] is a document that describes
how to create your own network security policy.
rfc1281 [http://www.faqs.org/rfcs/rfc1281.html] is a document that shows a security policy example with detailed descriptions of each step.
To see what some real-life security policies look like, you can take a look at the
COAST policy archive [ftp://coast.cs.purdue.edu/pub/doc/policy].

2.5. Means of Securing your Site
This section discusses various means by which you can secure the assets you have
worked hard for: your local computer, your data, your users, your network, even
your reputation. What would happen to your reputation if an intruder deleted
some of your users' data? Or defaced your web site? Or published your company's
corporate project plan for the next quarter? If you are planning a network installation, there are many factors you must take into account before adding a single
computer to your network.
Even if you have a single dial up PPP account, or just a small site, this does not
mean intruders will not be interested in your systems. Large, high-profile sites are
not the only targets – many intruders simply want to exploit as many sites as
possible, regardless of their size. Additionally, they may use a security hole in your
site to gain access to other sites you are connected to.
Intruders often have a lot of time on their hands, and can guess how you have
obscured your system just by trying all the possibilities. There are also a number
of reasons an intruder may be interested in your systems, which we will discuss
later.

2.5.1. Host Security
Perhaps the area of security on which administrators concentrate most is hostbased security. This typically involves making sure your own system is secure,
and hoping everyone else on your network does the same. Choosing good passwords, securing your host's local network services, keeping good accounting records, and upgrading programs with known security exploits are among the things
the local security administrator is responsible for. Although this is absolutely necessary, it can become a daunting task once your network becomes larger than a
few computers.
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2.5.2. Local Network Security
Network security is as necessary as local host security. With hundreds, thousands,
or more computers on the same network, you cannot rely on each one of those
systems being secure. Ensuring that only authorized users can use your network,
by building firewalls, by using strong encryption, and by ensuring there are no
“rogue” (that is, unsecured) computers on your network are all part of the network
security administrator's duties.
This document discusses some of the techniques which can be used to secure your
site, and hopefully shows you some of the ways to prevent intruders from gaining
access to that which you are trying to protect.

2.5.3. Security Through Obscurity
One type of security that must be discussed is “security through obscurity”. This
means, for example, moving a service that has known security vulnerabilities to
a non-standard port in the hope that an attacker won't notice it's there and thus
won't exploit it. Rest assured that they can determine that it is there and will exploit
it. Security through obscurity is no security at all. Simply because you have a small
site, or a relatively low profile, does not mean an intruder will not be interested
in what you have. We will discuss what you are protecting in the next sections.

2.6. Organization of This Chapter
This chapter has been divided into a number of sections. They cover several broad
security issues. The first, Section 3, “Physical Security” [631], covers how to protect
your physical machine from tampering. The second, Section 4, “Local Security” [637],
describes how to protect your system from tampering by local users. The third,
Section 5, “Files and File-System Security” [639], shows you how to set up your file
systems and permissions on your files. The next, Section 6, “Password Security
and Encryption” [646], discusses how to use encryption to better secure your machine and network. Section 7, “Kernel Security” [655] discusses what kernel options
you should set or be aware of for a more secure system. Section 8, “Network Security” [660], describes how to better secure your GNU/Linux system from network
attacks. Section 9, “Security Preparation (Before You Go On-Line)” [670], discusses
how to prepare your machine(s) before bringing them on-line. Next, Section 10,
“What to Do During and After a Break-in” [673], discusses what to do when you
detect a system compromise in progress or detect one that has recently happened.
In Section 11, “Security Sources” [676], some primary security resources are enumerated. The Q & A section Section 12, “Frequently Asked Questions” [679], answers
some frequently-asked questions, and finally, a conclusion in Section 13, “Conclusion” [681].
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3. Physical Security
The two main points to understand when reading this chapter are:
• Be aware of your system. Check system logs such as /var/log/messages and
keep an eye on your system;
• Keep your system up-to-date by making sure you have installed the current
versions of software and have upgraded per security alerts. Just doing this will
help make your system markedly more secure.

3. Physical Security
The first layer of security you need to take into account is the physical security of
your computer systems. Who has direct physical access to your computer? Should
they? Can you protect your computer from their tampering? Should you?
How much physical security you need on your system is very dependent on your
situation, and/or budget.
If you are a home user, you probably don't need a lot (although you might need
to protect your computer from tampering by children or annoying relatives). If
you are in a lab, you need considerably more, but users will still need to be able
to get work done on the computers. Many of the following sections will help out.
If you are in an office, you may or may not need to secure your computer afterhours or while you are away. In some companies, leaving your console unsecured
is a termination offense.
Obvious physical security methods such as locks on doors, cables, locked cabinets,
and video surveillance are all good ideas, but beyond the scope of this chapter.

3.1. Computer Locks
Many modern computer cases include a “locking” feature. Usually this will be a
socket on the front of the case that allows you to turn an included key to a locked
or unlocked position. Case locks can help prevent someone from stealing your
computer, or opening up the case and directly manipulating or stealing your
hardware. Some locks can even prevent someone from rebooting your computer
from their own floppy or other hardware.
These case locks do different things according to the support in the motherboard
and how the case is constructed. On many computers, they make it so you have
to break the case to get the case open. On some others, they will not let you plug
in new keyboards or mice. Check your motherboard or case instructions for more
information. This can sometimes be a very useful feature, even though the locks
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are usually very low quality and can easily be defeated by attackers with locksmithing skills.
Some computers (most notably SPARCs and Macs) have a dongle on the back: if
you put a cable through, attackers would have to cut the cable or break the case
to get into it. Just putting a padlock or combo lock through these can be a good
deterrent to someone stealing your computer.

3.2. BIOS Security
The BIOS is the lowest level of software to configure or manipulate your x86-based
hardware. LILO and other GNU/Linux boot methods access the BIOS to determine
how to boot your GNU/Linux computer. Other hardware that GNU/Linux runs
on has similar software (Open Firmware on Macs and new Suns, Sun boot PROM,
etc...). You can use your BIOS to prevent attackers from rebooting your computer
and manipulating your GNU/Linux system.
Many PC BIOSes let you set a boot password. This does not provide much security
(the BIOS can be reset, or removed if someone can get into the case), but may be
a good deterrent (i.e. it will take time and leave traces of tampering). Similarly, on
S/Linux (GNU/Linux for SPARC(tm) processor computers), your EEPROM can
be set to require a boot-up password. This may slow attackers down.
Another risk of trusting BIOS passwords to secure your system is the default
password problem. Most BIOS makers do not expect people to open up their
computer and disconnect batteries if they forget their password and have equipped
their BIOSes with default passwords which work regardless of your chosen password. Some of the more common passwords include:
j262
AWARD_SW
AWARD_PW
lkwpeter
Biostar
AMI
Award
bios
BIOS
setup
cmos
AMI!SW1
AMI?SW1
password
hewittrand
shift + s y x z
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I tested an Award BIOS and AWARD_PW worked. These passwords are quite
easily available from manufacturers' web sites and astalavista [http://astalavista.
box.sk] and as such a BIOS password cannot be considered adequate protection
from a knowledgeable attacker.
Many x86 BIOSes also allow you to specify various other good security settings.
Check your BIOS manual or look at it the next time you boot up. For example,
some BIOSes disallow booting from floppy drives and some require passwords to
access some BIOS features.
If you have a server computer, and you set a boot password, your computer will not boot up unattended. Bear in mind that you will need to
come in and supply the password in the event of a power failure.

3.3. OpenBoot Security
The PROM is the lowest level of software to configure or manipulate your SPARCbased hardware. SILO and other GNU/Linux boot methods access the PROM to
determine how to boot your GNU/Linux computer. Other hardware which
GNU/Linux runs on has similar software (OpenFirmware on Macs and new Suns,
x86 BIOS, etc.). You can use your PROM to prevent attackers from rebooting your
computer and manipulating your GNU/Linux system.
OpenBoot is much more advanced than a PC BIOS when it comes to security
(consult the “Installation Guide” on how to access and use OpenBoot).
1.

It is important to set your password before setting the security mode,
as you would be unable to change it later. Moreover, SUN claims
you need to contact your vendor's customer support service to make
your computer bootable again.
This is an interaction example on how to set your boot password:
> password
> New password (only first 8 chars are used):
> Retype new password:
>

2.

You can choose between three security levels by setting the security-mode
variable:
a.

Full: all commands except for go require the password.
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b.

Command: all commands except for boot and go require the password.

c. None: no password required (default).
This is an interactive example on how to set your security mode:
> setenv security-mode full
>

If you have a server computer, and you set up a boot password, your
computer will not boot up unattended. Bear in mind that you will need
to come in and supply the password in the event of a power failure.

3.4. Bootloader Security
Bear in mind when setting these passwords that you need to remember them. Also
remember that these passwords will only slow the determined attacker. They will
not prevent someone from booting from a floppy and mounting your root partition.
If you are using security in conjunction with a bootloader, you might as well disable
booting from a floppy in your computer's BIOS, and password-protect the BIOS.
If you are using security in conjunction with a bootloader, you might as well
password-protect the PROM.
Once again, if you have a server computer, and you set up a boot password, your computer will not boot up unattended. Bear in mind that you
will need to come in and supply the password in the event of a power
failure!

3.4.1. With LILO
LILO can have a password set. It has password and restricted settings; password
requires a password at boot time, whereas restricted requires a boot-time password only if you specify options (such as single) at the LILO prompt.
Please refer to lilo.conf(5) for more information on the password and restricted
settings.
Also bear in mind that the /etc/lilo.conf will need to be mode 600 (readable
and writing for root only), or others will be able to read your boot passwords!

3.4.2. With GRUB
GRUB is quite flexible when it comes to password setting: your default configuration file, /boot/grub/menu.lst, may contain a line allowing the loading of a new
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configuration file with different options (this new file may contain a new password
to access another third configuration file and so on).
So you must add a line in your /boot/grub/menu.lst file, something like:
password very_secret /boot/grub/menu2.lst

and of course generate a new /boot/grub/menu2.lst configuration file where you
move insecure entries previously removed from /boot/grub/menu.lst.
Please refer to the GRUB info page for more information.

3.4.3. With SILO
SILO's options are like LILO's. Please refer to silo.conf(5) for more information on
the password and restricted settings.

3.5. xlock and vlock
If you wander away from your computer from time to time, it is nice to be able to
“lock” your console so that no one can tamper with or look at your work. Two
programs that do this are: xlock and vlock.
xlock is a X display locker. You can run xlock from any xterm on your console and
it will lock the display and require your password to unlock. Most desktop environments also provide this feature in their respective menus.
vlock is a simple little program which allows you to lock some or all of the virtual
consoles on your GNU/Linux box. You can lock just the one you are working in
or all of them. If you just lock one, others can come in and use the console; they
will just not be able to use your virtual console until you unlock it.
Of course, locking your console will prevent someone from tampering with your
work, but won't prevent them from rebooting your computer or otherwise disrupting your work. It also does not prevent them from accessing your computer from
another computer on the network and causing problems.
More importantly, it does not prevent someone from switching out of the X Window
System entirely, and going to a normal virtual console login prompt, or to the VC
that X11 was started from, and suspending it, thus obtaining your privileges. For
this reason, you might consider only using it while under control of KDM (or
other login manager).

3.6. Security of Local Devices
If you have a webcam or a microphone attached to your system, you should consider if there is some danger of an attacker gaining access to those devices. When
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not in use, unplugging or removing such devices might be an option. Otherwise
you should carefully read and look at any software which provides access to such
devices.

3.7. Detecting Physical Security Compromises
The first thing to always note is when your computer was rebooted. Since
GNU/Linux is a robust and stable OS, the only time your computer should reboot
is when you take it down for OS upgrades, hardware swapping, or the like. If your
computer has rebooted without you doing it, that may be a sign that an intruder
has compromised it. Many of the ways that your computer can be compromised
require the intruder to reboot or power off your computer.
Check for signs of tampering on the case and computer area. Although many intruders clean traces of their presence out of logs, it's a good idea to check through
them all and note any discrepancies.
It is also a good idea to store log data at a secure location, such as a dedicated log
server within your well-protected network. Once a computer has been compromised, log data becomes of little use as it most likely has also been modified by the
intruder.
The syslog daemon can be configured to automatically send log data to a central
syslog server, but this is typically sent in unencrypted form, allowing an intruder
to view data as it is being transferred. This may reveal information about your
network which is not intended to be public. There are syslog daemons available
which encrypt the data as it is being sent.
Also be aware that faking syslog messages is easy – with an exploit program having
been published. syslog even accepts net log entries claiming to come from the
local host without indicating their true origin.
Some things to check for in your logs:
• short or incomplete logs;
• logs containing strange timestamps;
• logs with incorrect permissions or ownership;
• records of reboots or restarting of services;
• missing logs;
• su entries or logins from strange places.
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We will discuss system log data in Section 9.5, “Keep Track of your System Accounting Data” [672].

4. Local Security
The next thing to take a look at is the security in your system against attacks from
local users. Did we just say local users? Yes!
Getting access to a local user account is one of the first things that system intruders
attempt while on their way to exploiting the root account. With lax local security,
they can then “upgrade” their normal user access to root access using a variety
of bugs and poorly set up local services. If you make sure your local security is
tight, then the intruder will have another hurdle to jump.
Local users can also cause a lot of havoc with your system even (especially) if they
really are who they say they are. Providing accounts to people you do not know
or for whom you have no contact information is a very bad idea.

4.1. Creating New Accounts
You should make sure you provide user accounts with only the minimal requirements for the task they need to do. If you provide your son (age 10) with an account,
you might want him to only have access to a word processor or drawing program,
but be unable to delete data that is not his.
Several good rules of thumb when allowing other people legitimate access to your
GNU/Linux computer:
• give them the minimal amount of privileges they need;
• be aware when/where they log in from, or should be logging in from;
• make sure you remove inactive accounts, which you can determine by using
the last command and/or checking log files for any activity by the user;
• the use of the same userid on all computers and networks is advisable to ease
account maintenance, and permits easier analysis of log data;
• the creation of group user-ids should be absolutely prohibited. User accounts
also provide accountability, and this is not possible with group accounts.
Many local user accounts which are utilized in security compromises have not
been used in months or years. Since no one is using them, they provide the ideal
attack vehicle.
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4.2. Root Security
The most sought-after account on your computer is the root (superuser) account.
It has authority over the entire computer, which may also include authority over
other computers on the network. Remember that you should only use the root
account for very short, specific tasks, and should mostly run as a normal user.
Even small mistakes made while logged in as the root user can cause problems.
The less time you are on with root privileges, the safer you will be.
Several tricks to avoid messing up your own box as root:
• When doing some complex command, try running it first in a non-destructive
way... especially commands that use globbing: e.g., if you want to do rm -f
foo*.bak, first do ls foo*.bak and make sure you are going to delete the files
you think you are deleting. Using echo in place of destructive commands
sometimes works too.
• Only become root to do single specific tasks. If you find yourself trying to figure
out how to do something, go back to a normal user shell until you are sure
what needs to be done by root.
• The command path for the root user is very important. The command path
(that is, the PATH environment variable) specifies the directories in which the
shell searches for programs. Try to limit the command path for the root user
as much as possible, and never include . (which means “the current directory”)
in your PATH. Additionally, never have writable directories in your search path,
as this can allow attackers to modify or place new binaries in your search path,
allowing them to run as root the next time you run that command.
• Never use the rlogin/rsh/rexec suite of tools (called the “r-utilities”) as root.
They are subject to many kinds of attacks, and are downright dangerous when
run as root. Never create a .rhosts file for root.
• The /etc/securetty file contains a list of terminals that root can login from.
By default, this is set to only the local virtual consoles (ttys). Be very wary of
adding anything else to this file. You should be able to log in remotely as your
regular user account and then su if you need to (hopefully over ssh or other
encrypted channel), so there is no need to be able to login directly as root.
• Always be slow and deliberate running as root. Your actions could affect a lot
of things. Think before you type!
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If you absolutely, positively need to allow someone (hopefully very trusted) to
have root access to your computer, there are a few tools which can help. sudo allows users to use their own password to access a limited set of commands as root.
This could allow you to, for instance, let a user be able to eject and mount removable
media on your GNU/Linux box, but have no other root privileges. sudo also
keeps a log of all successful and unsuccessful sudo attempts, allowing you to track
down who used what command to do what. For this reason, sudo works well even
in places where a number of people have root access, because it helps you to keep
track of changes made.
Although sudo can be used to give specific users special privileges for particular
tasks, it does have several shortcomings. It should be used only for a limited set
of tasks, such as restarting a server, or adding new users. Any program that offers
a shell escape will give root access to a user invoking it via sudo. This includes
most editors, for example. Also, a program as innocuous as /bin/cat can be used
to overwrite files, which could allow root to be exploited. Consider sudo as a
means for accountability, and don't expect it to replace the root user and still be
secure.

5. Files and File-System Security
A few minutes of preparation and planning ahead before putting your systems
on-line can help protect them and the data stored in them.
• There should never be a reason for users' home directories to allow SUID/SGID
programs to be run from them. Use the nosuid option in /etc/fstab for partitions which are writable by users other than root. You may also wish to use
nodev and noexec on users' home partitions, as well as /var, thus prohibiting
execution of programs, and creation of character or block devices, which should
never be necessary anyway.
• If you are exporting file systems using NFS, be sure to configure the /etc/exports file with the most restrictive access possible. This means not using
wildcards, not allowing root write access, and exporting read-only wherever
possible.
• Configure your users' file-creation umask to be as restrictive as possible. See
Section 5.1, “umask Settings” [641].
• If you are mounting file systems using a network file system such as NFS, be
sure to configure /etc/fstab with suitable restrictions. Typically, using nodev,
nosuid, and perhaps noexec, are desirable.
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• Set file system limits instead of allowing unlimited as default. You can control
the per-user limits using the resource-limits PAM module and
/etc/pam.d/limits.conf. For example, limits for group users might look like
this:
@users
@users
@users

hard
hard
hard

core
nproc
rss

0
50
5000

This says to prohibit the creation of core files, to restrict the number of processes
to 50, and to restrict memory usage per user to 5MB.
You can also use the /etc/login.defs configuration file to set the same limits.
• The /var/log/wtmp and /var/run/utmp files contain the login records for all
users on your system. Their integrity must be maintained because they can be
used to determine when and from where a user (or potential intruder) has
entered your system. These files should also have 644 permissions, without
affecting normal system operation.
• The immutable bit can be used to prevent accidentally deleting or overwriting
a file which must be protected. It also prevents someone from creating a hard
link to the file. See chattr(1) for information on the immutable bit.
• SUID and SGID files on your system are a potential security risk, and should
be monitored closely. Because these programs grant special privileges to the
user who is executing them, it is necessary to ensure that insecure programs
are not installed. A favorite trick of crackers is to exploit SUID-root programs,
then leave a SUID program as a back door to get in the next time, even if the
original hole is plugged.
Find all SUID/SGID programs on your system, and keep track of what they
are, so you are aware of any changes which could indicate a potential intruder.
Use the following command to find all SUID/SGID programs on your system:
root#

find / -type f \( -perm -04000 -o -perm -02000 \)

You can remove the SUID or SGID permissions on a suspicious program with
chmod, then restore them if you feel it is absolutely necessary.
• World-writable files, particularly system files, can be a security hole if a cracker
gains access to your system and modifies them. Additionally, world-writable
directories are dangerous, since they allow a cracker to add or delete files as
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he wishes. To locate all world-writable files on your system, use the following
command:
root# find / -perm -2 ! -type l -ls

and be sure you know why those files are writable. In the normal course of
operation, several files will be world-writable, including some from /dev, and
symbolic links, thus the ! -type l which excludes these from the previous
find command.
• Un-owned files may also be an indication that an intruder has accessed your
system. You can locate files on your system that have no owner or belong to
no group with the command:
root# find / \( -nouser -o -nogroup \) -print

• Finding .rhosts files should be a part of your regular system administration
duties, as they should not be permitted on your system. Remember, a cracker
only needs one insecure account to potentially gain access to your entire network. You can locate all .rhosts files on your system with the following command:
root# find /home -name .rhosts -print

• Finally, before changing permissions on any system files, make sure you understand what you are doing. Never change permissions on a file because it seems
like the easy way to get things working. Always determine why the file has
that permission before changing it.

5.1. umask Settings
The umask command can be used to determine the default file-creation mode on
your system. It is the octal complement of the desired file mode. If files are created
without any regard to their permission settings, the user could inadvertently give
read or write permission to someone who should not have it. Typical umask settings
include 022, 027, and 077 (which is the most restrictive). Normally, the umask is
set in /etc/profile, so it applies to all users on the system. The file creation mask
can be calculated by subtracting the desired value from 777. In other words, a
umask of 777 would cause newly-created files to contain no read, write or execute
permission for anyone. A mask of 666 would cause newly-created files to have a
mask of 111. For example, you may have a line that looks like this:
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# Set the user's default umask
umask 033

Be sure to make root's umask 077, which will disable read, write, and execute
permission for other users, unless explicitly changed using chmod. In this case,
newly-created directories would have 744 permissions, obtained by subtracting
033 from 777. Newly-created files using the 033 umask would have permissions
of 644.
In Mandriva Linux, it is only necessary to use 002 for a umask. This is
due to the fact that the default configuration is one user per group.

5.2. File Permissions
It is important to ensure that your system files are not open for casual editing by
users and groups who should not be doing such system maintenance.
UNIX® separates access control on files and directories according to three characteristics: owner, group, and other. There is always exactly one owner, any number
of members of the group, and everyone else.
A quick explanation of UNIX® permissions:
Ownership – Which user(s) and group(s) retain(s) control of the permission settings
of the node and parent of the node.
Permissions – Bits capable of being set or reset to allow certain types of access to
a file. Permissions for directories may have a different meaning to the same set of
permissions on a file.
Read:
• To be able to view contents of a file.
• To be able to read a directory.
Write:
• To be able to add to or change a file.
• To be able to delete or move files in a directory.
Execute:
• To be able to run a binary program or shell script.
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• To be able to search in a directory, combined with read permission.
Save Text Attribute: (For directories)
The “sticky bit” also has a different meaning when applied to directories than
when applied to files. If the sticky bit is set on a directory, then a user may
only delete files that he owns or for which he has had explicit write permission
granted, even when he has write access to the directory. This is designed for
directories such as /tmp, which are world-writable, but where it may not be
desirable to allow any user to delete files at will. The sticky bit is seen as a t
in a long directory listing.
SUID Attribute: (For Files)
This describes set-user-id permissions on the file. When the set user ID access
mode is set in the owner permissions, and the file is executable, processes
which run it are granted access to system resources based on the user who
owns the file, as opposed to the user who created the process. This is the cause
of many “buffer overflow” exploits.
SGID Attribute: (For Files)
If set in the group permissions, this bit controls the “set group id” status of a
file. This behaves in the same way as suid, except that the group is affected
instead. The file must be executable for this to have any effect.
SGID Attribute: (For directories)
If you set the SGID bit on a directory (with chmod g+s directory), files created
in that directory will have their group set to the directory's group.
You – The owner of the file.
Group – The group you belong to.
Everyone – Anyone on the system that is not the owner or a member of the group.
File Example:
-rw-r--r-- 1 queen users
114 Aug 28 1997 .zlogin
1st bit - directory?
(no)
2nd bit - read by owner?
(yes, by queen)
3rd bit - write by owner?
(yes, by queen)
4th bit - execute by owner?
(no)
5th bit - read by group?
(yes, by users)
6th bit - write by group?
(no)
7th bit - execute by group?
(no)
8th bit - read by everyone?
(yes, by everyone)
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9th bit - write by everyone?
(no)
10th bit - execute by everyone? (no)

The following lines are examples of the minimum sets of permissions required to
perform the access described. You may want to give more permission than those
listed here, but this should describe what these minimum permissions on files do:
-r---------w-------

Allow read access to the file by owner
Allows the owner to modify or delete the file
(Note that anyone with write permission to the directory
the file is in can overwrite it and thus delete it)
---x------ The owner can execute this program, but not shell scripts,
which still need read permission
---s------ Will execute with effective User ID = to owner
------s--- Will execute with effective Group ID = to group
-rw------T No update of "last modified time". Usually used for swap
files
---------t No effect. (formerly sticky bit)

Directory Example:
drwxr-xr-x 3 queen users
512 Sep 19 13:47 .public_html/
1st bit - directory?
(yes, it contains many files)
2nd bit - read by owner?
(yes, by queen)
3rd bit - write by owner?
(yes, by queen)
4th bit - execute by owner?
(yes, by queen)
5th bit - read by group?
(yes, by users)
6th bit - write by group?
(no)
7th bit - execute by group?
(yes, by users)
8th bit - read by everyone?
(yes, by everyone)
9th bit - write by everyone?
(no)
10th bit - execute by everyone? (yes, by everyone)

The following lines are examples of the minimum sets of permissions required to
perform the access described. You may want to give more permission than those
listed, but this should describe what these minimum permissions on directories
do:
dr-------d--x------

The contents can be listed, but file attributes can't be read
The directory can be entered, and used in full execution
paths
dr-x------ File attributes can be read by owner
d-wx------ Files can be created/deleted, even if the directory
isn't the current one
d-----x--t Prevents files from deletion by others with write
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access. Used on /tmp
d--s--s--- No effect

System configuration files (usually in the /etc directory) are usually mode 640
(-rw-r-----), and owned by root. Depending on your site's security requirements,
you might want to adjust this. Never leave any system files writable by a group
or everyone. Some configuration files, including the /etc/shadow one, should only
be readable by root, and directories in /etc should at least not be accessible by
others.
SUID Shell Scripts
suid shell scripts are a serious security risk, and for this reason the kernel
will not honor them. Regardless of how secure you think the shell script is,
it can still be exploited to give the cracker a root shell.

5.3. Integrity Checking
Another very good way to detect local (and also network) attacks on your system
is to run an integrity checker such as Tripwire, Aide or Osiris. These integrity
checkers run a number of checksums on all your important binaries and configuration files and compares them against a database of former, known-good values
as a reference. Thus, any changes in the files will be flagged.
It is a good idea to install these types of program onto a floppy, and then physically
set the write protect on the floppy. This way intruders cannot tamper with the integrity checker itself or change the database. Once you have something like this
setup, it is a good idea to run it as part of your normal security administration
duties to see if anything has changed.
You can even add a crontab entry to run the checker from your floppy every night
and mail you the results in the morning. Something like:
# set mailto
MAILTO=queen
# run Tripwire
15 05 * * * root /usr/local/adm/tcheck/tripwire

will mail you a report each morning at 5:15am.
Integrity checkers can be a godsend to detecting intruders before you would otherwise notice them. Since a lot of files change on the average system, you have to
be careful to determine which is cracker activity and which is your own doing.
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You can find the freely available unsupported version of Tripwire on the TripWire
web site [http://www.tripwire.org] free of charge. Manuals and support can be
purchased.
Aide can be found on Sourceforge [http://sourceforge.net/projects/aide].
OSIRIS can be found on the OSIRIS web site [http://osiris.shmoo.com/].

5.4. Trojan Horses
“Trojan Horses” are named after the fabled ploy in Homer's "Iliad". The idea is
that a cracker distributes a program or binary that sounds great, and encourages
other people to download it and run it as root. Then the program can compromise
their systems while they are not paying attention. While they think the binary they
just pulled down does one thing (and it might very well do so), it also compromises
their security.
You should take care of what programs you install on your computer. Mandriva
provides MD5 checksums and PGP signatures on its RPM files so you can verify
you are installing the real thing. You should never run any unfamiliar binary, for
which you don't have the source, as root! Few attackers are willing to release
source code to public scrutiny.
Although it can be complex, make sure you are getting the source for a program
from its real distribution site. If the program is going to run as root, make sure
either you or someone you trust has looked over the source and verified it.

6. Password Security and Encryption
Most of the encryption programs described in this chapter are available
in your Mandriva Linux distribution.
One of the most important security features used today are passwords. It is important for both you and all of your users to have secure, unguessable passwords. Your
Mandriva Linux distributions include a passwd program that does not allow you
to set an easy to guess password. Make sure your passwd program is up to date.
In-depth discussion of encryption is beyond the scope of this chapter, but an introduction is in order. Encryption is very useful, possibly even necessary in this day
and age. There are all sorts of methods of encrypting data, each with its own set
of characteristics.
Most UNIX® systems (and GNU/Linux is no exception) primarily use a one-way
encryption algorithm, called DES (Data Encryption Standard) to encrypt your
passwords. This encrypted password is then stored in /etc/shadow. When you
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attempt to login, the password you type in is encrypted again and compared with
the entry in the file that stores your passwords. If they match, it must be the same
password, and you are allowed access. Although DES is a two-way encryption
algorithm (you can code and then decode a message, given the right keys), the
variant that most Unixes use is one-way. This means that it should not be possible
to reverse the encryption to get the password from the contents of /etc/shadow.
Brute force attacks, such as “Crack” or “John the Ripper” (see Section 6.9, ““Crack”
and “John the Ripper”” [653]) can often guess passwords unless your password is
sufficiently random. PAM modules (see below) allow you to use a different encryption routine with your passwords (MD5 or the like). You can use Crack to your
advantage, as well. Consider periodically running Crack against your own password database, to find insecure passwords. Then contact the offending user, and
instruct him to change his password.
To obtain information on how to choose a good password, check the CERN web
site [http://consult.cern.ch/writeup/security/security_3.html].

6.1. PGP And Public-Key Cryptography
Public-key cryptography, such as that used for PGP, uses one key for encryption,
and one key for decryption. Traditional cryptography, however, uses the same
key for encryption and decryption; this key must be known to both parties, and
thus somehow transferred from one to the other securely.
To alleviate the need to securely transmit the encryption key, public-key encryption
uses two separate keys: a public key and a private key. Each person's public key
is available by anyone to do the encryption, while at the same time each person
keeps his or her private key to decrypt messages encrypted with the correct public
key.
There are advantages to both public key and private key cryptography, and you
can read about those differences in the RSA Cryptography FAQ, listed at the end
of this section.
PGP (Pretty Good Privacy) is well-supported on GNU/Linux. Versions 2.6.2 and
5.0 are known to work well. For a good primer on PGP and how to use it, take a
look at the different PGP FAQs available on the Internet FAQ Archives [http://
www.faqs.org/faqs/pgp-faq/].
Be sure to use the version that is applicable to your country. Due to export restrictions by the US Government, strong-encryption is prohibited from being transferred
in electronic form outside the country.
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US export controls are now managed by EAR (Export Administration Regulations).
They are no longer governed by ITAR.
There is also a step-by-step guide for configuring PGP on GNU/Linux available
at LinuxFocus [http://mercury.chem.pitt.edu/~sasha/LinuxFocus/English/
November1997/article7.html]. It was written for the international version of PGP,
but is easily adaptable to the United States version. You may also need a patch for
some of the latest versions of GNU/Linux; the patch is available at metalab [ftp:/
/metalab.unc.edu/pub/Linux/apps/crypto].
There is a project maintaining a free re-implementation of PGP with open source.
GnuPG is a complete and free replacement for PGP. Because it does not use IDEA
or RSA it can be used without any restrictions. GnuPG is in compliance with
OpenPGP [http://www.faqs.org/rfcs/rfc2440.html]. See the GNU Privacy Guard
web page [http://www.gnupg.org] for more information.
More information on cryptography can be found in the RSA cryptography FAQ
[http://www.rsasecurity.com/rsalabs/faq/]. Here you will find information on
such terms as “Diffie-Hellman”, “public-key cryptography”, “digital certificates”,
etc.

6.2. SSL, S-HTTP and S/MIME
Often users ask about the differences between the various security and encryption
protocols, and how to use them. While this isn't an encryption document, it is a
good idea to explain briefly what each protocol is, and where to find more information.
• SSL: - SSL, or Secure Sockets Layer, is an encryption method developed by
Netscape to provide security over the Internet. It supports several different
encryption protocols, and provides client and server authentication. SSL operates
at the transport layer, creates a secure encrypted channel of data, and thus can
seamlessly encrypt data of many types. This is most commonly seen when going
to a secure site to view a secure on-line document with Communicator, and
serves as the basis for secure communications with Communicator, as well as
many other Netscape Communications data encryption. More information can
be found on the OpenSSL web site [http://www.openssl.org]. Information on
Netscape's other security implementations, and a good starting point for these
protocols is available at Netscape Security Center [http://wp.netscape.com/
security/index.html]. It's also worth noting that the SSL protocol can be used
to pass many other common protocols, “wrapping” them for security. See the
sslwrap web page [http://www.quiltaholic.com/rickk/sslwrap/].
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• S-HTTP: - S-HTTP is another protocol which provides security services across
the Internet. It was designed to provide confidentiality, authentication, integrity,
and non-repudiability [cannot be mistaken for someone else] while supporting
multiple key-management mechanisms and cryptographic algorithms via option
negotiation between the parties involved in each transaction. S-HTTP is limited
to the specific software that is implementing it, and encrypts each message individually. [ From RSA Cryptography FAQ, page 138]
• S/MIME: - S/MIME, or Secure Multipurpose Internet Mail Extension, is an
encryption standard used to encrypt electronic mail and other types of messages
on the Internet. It is an open standard developed by RSA, so it is likely we will
see it on GNU/Linux one day soon. More information on S/MIME can be found
at rfc2311 [http://www.ietf.org/rfc/rfc2311.txt].

6.3. IPSEC Implementations
Along with CIPE, and other forms of data encryption, there are also several other
implementations of IPSEC for GNU/Linux. IPSEC is an effort by the IETF to create
cryptographically-secure communications at the IP network level, and to provide
authentication, integrity, access control, and confidentiality. Information on IPSEC
and Internet draft can be found at the ipsec Charter [http://www.ietf.org/html.
charters/ipsec-charter.html]. You can also find links to other protocols involving
key management, and an IPSEC mailing list and archives.
The x-kernel GNU/Linux implementation, which was being developed at the
University of Arizona, uses an object-based framework for implementing network
protocols called x-kernel. Most simply, the x-kernel is a method of passing messages
at the kernel level, which makes for an easier implementation. This project is now
closed, but contact information can be found on The x-Kernel Project [http://
openresource.com/openres/orgs/DP/P/x-Kernel.shtml] web site.
Another freely-available IPSEC implementation is the GNU/Linux FreeS/WAN
IPSEC. Their web page states, “These services allow you to build secure tunnels
through untrusted networks. Everything passing through the untrusted net is encrypted by the IPSEC gateway computer and decrypted by the gateway at the
other end. The result is Virtual Private Network or VPN. This is a network which
is effectively private even though it includes computers at several different sites
connected by the insecure Internet.”
It's available for download from the Linux FreeS/WAN web site [http://www.
freeswan.org/].
As with other forms of cryptography, it is not distributed with the kernel by default
due to export restrictions.
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6.4. ssh (Secure SHell) and stelnet
ssh and stelnet are suites of programs that allow you to login to remote systems
and to have a encrypted connection.
openssh is a suite of programs used as a secure replacement for rlogin, rsh and
rcp. It uses public-key cryptography to encrypt communications between two
hosts, as well as to authenticate users. It can be used to securely login to a remote
host or to copy data between hosts, while preventing man-in-the-middle attacks
(session hijacking) and DNS spoofing. It will perform data compression on your
connections, and secure X11 communications between hosts.
There are several ssh implementations now. The original commercial implementation by Data Fellows can be found at the ssh home page available on the
Datafellows web site [http://www.datafellows.com].
The excellent OpenSSH implementation is based on a early version of the
DataFellows ssh and has been totally reworked so as not to include any patented
or proprietary parts. It is free and released under a BSD license. It can be found
on the OpenSSH web site [http://www.openssh.com].
There is also a open source project to re-implement ssh from the ground up called
“lsh”. For more information see the LSH [http://www.lysator.liu.se/~nisse/lsh/]
web site.
You can also use ssh from your Windows® workstation to your GNU/Linux ssh
server. There are several freely available Windows® clients, including PuTTY [http:
//www.chiark.greenend.org.uk/~sgtatham/putty/] and a commercial implementation from DataFellows on the Datafellows web site [http://www.datafellows.
com].
SSLeay (outdated, see OpenSSL below) is a free implementation of Netscape's Secure Sockets Layer, developed by Eric Young. It includes several applications,
such as “Secure telnet”, a module for Apache, several databases, as well as several
algorithms including DES, IDEA and “Blowfish”.
Using this library, a secure telnet replacement has been created which does encryption over a telnet connection. Unlike SSH, stelnet uses SSL, the Secure Sockets
Layer protocol developed by Netscape. You can find Secure telnet and Secure FTP
by starting with the SSLeay and SSLapps FAQ [http://www.psy.uq.oz.au/~ftp/
Crypto/].
The OpenSSL Project is based on SSLeay and is intended to develop a
robust, commercial-grade, full-featured, and Open Source toolkit implementing the Secure Sockets Layer (SSL v2/v3) and Transport Layer Se650
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curity (TLS v1) protocols as well as a full-strength general purpose
cryptography library. For more information about this project, consult
the OpenSSL home page [http://www.openssl.org]. There is a large list
of applications based on OpenSSL at OpenSSL-related applications [http:
//www.openssl.org/related/apps.html].
SRP is another secure telnet/ftp implementation. From their web page:
“The SRP project is developing secure Internet software for free worldwide use.
Starting with a fully-secure Telnet and FTP distribution, we hope to supplant weak
networked authentication systems with strong replacements that do not sacrifice
user-friendliness for security. Security should be the default, not an option!”
For more information, visit the Stanford University web site [http://srp.stanford.
edu/].

6.5. PAM - Pluggable Authentication Modules
Your version of the Mandriva Linux distribution ships with a unified authentication
scheme called PAM. PAM allows you to change your authentication methods and
requirements on the fly, and encapsulate all local authentication methods without
recompiling any of your binaries. Configuration of PAM is beyond the scope of
this chapter, but be sure to take a look at the PAM web site [http://www.kernel.
org/pub/linux/libs/pam/index.html] for more information.
Just a few of the things you can do with PAM:
• Use encryption other than DES for your passwords. (Making them harder to
brute-force decode)
• Set resource limits on all your users so they cannot perform denial-of-service
attacks (number of processes, amount of memory, etc.)
• Enable shadow passwords (see below) on the fly
• allow specific users to login only at specific times from specific places
Within a few hours of installing and configuring your system, you can prevent
many attacks before they even occur. For example, use PAM to disable the systemwide usage of .rhosts files in user's home directories by adding these lines to
/etc/pam.d/rlogin:
#
# Disable rsh/rlogin/rexec for users
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#
login auth required pam_rhosts_auth.so no_rhosts

6.6. Cryptographic IP Encapsulation (CIPE)
The primary goal of this software is to provide a facility for secure (against eavesdropping, including traffic analysis, and faked message injection) subnetwork interconnection across an insecure packet network such as the Internet.
CIPE encrypts the data at the network level. Packets traveling between hosts on
the network are encrypted. The encryption engine is placed near the driver which
sends and receives packets.
This is unlike SSH, which encrypts the data by connection, at the socket level. A
logical connection between programs running on different hosts is encrypted.
CIPE can be used in tunneling, in order to create a Virtual Private Network. Lowlevel encryption has the advantage that it can be made to work transparently
between the two networks connected in the VPN, without any change to application
software.
Summarized from the CIPE documentation:
“The IPSEC standards define a set of protocols which can be used (among other
things) to build encrypted VPNs. However, IPSEC is a rather heavyweight and
complicated protocol set with a lot of options, implementations of the full protocol
set are still rarely used and some issues (such as key management) are still not
fully resolved. CIPE uses a simpler approach, in which many of the things which
can be parameterized (such as the choice of the actual encryption algorithm used)
are an install-time fixed choice. This limits flexibility, but allows for a simple (and
therefore efficient, and easy to debug...) implementation.”
At the CIPE project [http://sites.inka.de/sites/bigred/devel/cipe.html] web site
more information can be found.
As with other forms of cryptography, it is not distributed with the kernel by default
due to export restrictions.

6.7. Kerberos
Kerberos is an authentication system developed by the Athena Project at MIT.
When a user logs in, Kerberos authenticates that user (using a password), and
provides the user with a way to prove their identity to other servers and hosts
scattered around the network.
This authentication is then used by programs such as rlogin to allow the user to
login to other hosts without a password (in place of the .rhosts file). This authen652
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tication method can also be used by the mail system in order to guarantee that
mail is delivered to the correct person, as well as to guarantee that the sender is
who he claims to be.
Kerberos and the other programs that come with it, prevent users from “spoofing”
the system into believing they are someone else. Unfortunately, installing Kerberos
is very intrusive, requiring the modification or replacement of numerous standard
programs.
You can find more information about Kerberos by looking at the Kerberos FAQ
[http://www.faqs.org/faqs/kerberos-faq/general/], and the code can be found
on the Kerberos web site [http://web.mit.edu/kerberos/www/].
[From: Stein, Jennifer G., Clifford Neuman, and Jeffrey L. Schiller. "Kerberos: An
Authentication Service for Open Network Systems." USENIX Conference Proceedings, Dallas, Texas, Winter 1998.]
Kerberos should not be your first step in improving security of your host. It is quite
involved, and not as widely used as, say, SSH.

6.8. Shadow Passwords
Shadow passwords are a means of keeping your encrypted password information
secret from normal users. Your Mandriva Linux system uses shadow passwords
by default, but on other systems, encrypted passwords are stored in the
/etc/passwd file for all to read. Anyone can then run password-guesser programs
on them and attempt to determine what they are. Shadow passwords, by contrast,
are saved in the /etc/shadow file, which only privileged users can read. You can
refer to the Shadow-Password HOWTO [http://www.tldp.org/HOWTO/
Shadow-Password-HOWTO.html] for further information if necessary. It is rather
dated now, and will not be required for distributions supporting PAM, like your
Mandriva Linux system.

6.9. “Crack” and “John the Ripper”
If for some reason your passwd program is not enforcing hard-to-guess passwords,
you might want to run a password-cracking program and make sure your users'
passwords are secure.
Password cracking programs work on a simple idea: they try every word in the
dictionary, and then variations on those words, encrypting each one and checking
it against your encrypted password. If they get a match they know what your
password is.
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And TCFS –– Transparent Cryptographic
File there...the
System two most notable of which are
There are a number of programs out
Crack and John the Ripper (See OpenWall [http://www.openwall.com/john/]).
They will take up a lot of your CPU time, but you should be able to tell if an attacker
could get in using them by running them first yourself and notifying users with
weak passwords. Note that an attacker would have to use some other hole first in
order to read your /etc/shadow file, but such holes are more common than you
might think.
Because security is only as strong as the most insecure host, it is worth mentioning
that if you have any Windows® computers on your network, you should check
out L0phtCrack, a Crack implementation for Windows®. Check out the @stake LC
4 web site [http://www.atstake.com/research/lc3/].

6.10. CFS –– Cryptographic File System And TCFS –– Transparent Cryptographic File System
CFS is a way of encrypting an entire directory tree and allowing users to store encrypted files on them. It uses an NFS server running on the local computer. More
information and source code is available on the AT&T web site [ftp://ftp.research.
att.com/dist/mab/].
TCFS improves on CFS by adding more integration with the file system, so that
it's transparent to users when the file system is encrypted. More information is
available on the TCFS web site [http://www.tcfs.it/].
It also need not be used on entire file systems. It works on directory trees as well.

6.11. X11, SVGA And Display Security
6.11.1. X11
It's important for you to secure your graphical display to prevent attackers from
grabbing your passwords as you type them, reading documents or information
you are reading on your screen, or even using a hole to gain root access. Running
remote X applications over a network can also be fraught with peril, allowing
sniffers to see all your interaction with the remote system.
X has a number of access-control mechanisms. The simplest of them is host-based:
you use xhost to specify the hosts that are allowed access to your display. This is
not very secure at all, because if someone has access to your computer, they can
xhost + their computer and get in easily. Also, if you have to allow access from
an untrusted computer, anyone there can compromise your display.
When using xdm (X Display Manager), or its KDE counterpart: KDM, to log in,
you get a much better access method: MIT-MAGIC-COOKIE-1. A 128-bit “cookie”
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is generated and stored in your .Xauthority file. If you need to allow a remote
computer access to your display, you can use the xauth command and the information in your .Xauthority file to provide access to only that connection. See the
Remote-X-Apps mini-howto, available at The Linux Documentation Project [http:
//www.tldp.org/HOWTO/Remote-X-Apps.html] web site.
You can also use ssh (see Section 6.4, “ssh (Secure SHell) and stelnet” [650]) to allow
secure X connections. This has the advantage of also being transparent to the end
user, and means that no unencrypted data flows across the network.
You can also disable any remote connections to your X server by using the
-nolisten tcp options to your X server. This will prevent any network connections
to your server over tcp sockets.
Take a look at Xsecurity(7x) for more information on X security. The safest bet is
to use xdm to login to your console and then use ssh to go to remote sites on which
you wish to run X programs.

6.11.2. SVGA
SVGAlib programs are typically suid-root in order to access all your GNU/Linux
computer's video hardware. This makes them very dangerous. If they crash, you
typically need to reboot your computer to get a usable console back. Make sure
any SVGA programs you are running are authentic, and can at least be somewhat
trusted. Even better, don't run them at all.

6.11.3. GGI (Generic Graphics Interface Project)
The GNU/Linux GGI project is trying to solve several of the problems with video
interfaces on GNU/Linux. GGI will move a small piece of the video code into the
GNU/Linux kernel, and then control access to the video system. This means GGI
will be able to restore your console at any time to a known good state. They will
also allow a secure attention key, so you can be sure that there is no Trojan horse
login program running on your console. More information available at the GGI
Project [http://www.ggi-project.org/] web site.

7. Kernel Security
This is a description of the kernel configuration options which relate to security,
and an explanation of what they do, and how to use them.
As the kernel controls your computer's networking, it is important that it be very
secure, and not be compromised. To prevent some of the latest networking attacks,
you should try to keep your kernel version current. You can find new kernels at
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kernel dot org [ftp://ftp.kernel.org] or from packages updates available through
MandrivaUpdate.
There is also an international group providing a single unified cryptographic patch
to the mainstream GNU/Linux kernel. This patch provides support for a number
of cryptographic subsystems and things which cannot be included in the mainstream kernel due to export restrictions. For more information, visit the GNU/Linux
Crypto API [http://www.kerneli.org] web site.

7.1. Kernel Compile Options
When this document was written, kernel 2.2 was state-of-the-art. Still today, most
firewalls still run 2.2. However, with kernel 2.4, a lot of things have changed. Most
of the compile options in this chapter are still valid, but the Masquerading and
port forwarding have been replaced by iptables. You can find more information
on iptables on the Linux Guruz web site [http://www.linuxguruz.org/iptables/
howto/iptables-HOWTO.html].
For 2.2.x kernels, the following options apply. You should see these options during
the kernel configuration process. Many of the comments here are from
/usr/src/linux/Documentation/Configure.help, which is the same document
that is referenced while using the Help facility during the make config stage of
compiling the kernel. Please consult the chapter Compiling and Installing New
Kernels of the Reference Manual for a full description of the compilation of a brand
new kernel.
• Network Firewalls (CONFIG_FIREWALL)
This option should be on if you intend to run any firewalling or masquerading
on your GNU/Linux computer. If it's just going to be a regular client computer,
it's safe to say no.
• IP: forwarding/gatewaying (CONFIG_IP_FORWARD)
If you enable IP forwarding, your GNU/Linux box essentially becomes a router.
If your computer is on a network, you could be forwarding data from one network to another, and perhaps subverting a firewall that was put there to prevent
this from happening. Normal dial-up users will want to disable this, and other
users should concentrate on the security implications of doing this. Firewall
computers will want this enabled, and used in conjunction with firewall software.
You can enable IP forwarding dynamically using the following command:
root#
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and disable it with the command:
root#

echo 0 > /proc/sys/net/ipv4/ip_forward

• IP: syn cookies (CONFIG_SYN_COOKIES)
A “SYN Attack” is a denial of service (DoS) attack which consumes all the resources on your computer, forcing you to reboot. We can't think of a reason
you wouldn't normally enable this. In the 2.1 kernel series this config option
merely allows syn cookies, but does not enable them. To enable them, you have
to do:
root# echo 1 > /proc/sys/net/ipv4/tcp_syncookies <P>

• IP: Firewalling (CONFIG_IP_FIREWALL)
This option is necessary if you are going to configure your computer as a firewall, do masquerading, or wish to protect your dial-up workstation from
someone entering via your PPP dial-up interface.
• IP: firewall packet logging (CONFIG_IP_FIREWALL_VERBOSE)
This option gives you information about packets your firewall receives, such
as sender, recipient, port, etc.
• IP: Drop source routed frames (CONFIG_IP_NOSR)
This option should be enabled. Source routed frames contain the entire path
to their destination inside of the packet. This means that routers through which
the packet goes do not need to inspect it, and just forward it on. This could lead
to data entering your system which may be potential exploits.
• IP: masquerading (CONFIG_IP_MASQUERADE)
If one of the computers on your local network for which your GNU/Linux box
acts as a firewall wants to send something to the outside, your box can “masquerade” as that host, i.e., it forwards the traffic to the intended destination,
but makes it look like it came from the firewall box itself. See the Indyramp
web site [http://www.indyramp.com/masq] and Chapter 41, Configuring
Masqueraded Clients [529] for more information.
• IP: ICMP masquerading (CONFIG_IP_MASQUERADE_ICMP)
This option adds ICMP masquerading to the previous option of only masquerading TCP or UDP traffic.
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• IP: transparent proxy support (CONFIG_IP_TRANSPARENT_PROXY)
This enables your GNU/Linux firewall to transparently redirect any network
traffic originating from the local network and destined for a remote host to a
local server, called a “transparent proxy server”. This makes the local computers
think they are talking to the remote end, while in fact they are connected to the
local proxy. See the IP Masquerade HOWTO [http://www.tldp.org/HOWTO/
IP-Masquerade-HOWTO/index.html] for more information.
• IP: always defragment (CONFIG_IP_ALWAYS_DEFRAG)
Generally this option is disabled, but if you are building a firewall or a masquerading host, you will want to enable it. When data is sent from one host to
another, it does not always get sent as a single packet of data, but rather it is
fragmented into several pieces. The problem with this is that the port numbers
are only stored in the first fragment. This means that someone can insert information into the remaining packets which isn't supposed to be there. It could also
prevent a teardrop attack against an internal host which is not itself patched
against it.
• Packet Signatures (CONFIG_NCPFS_PACKET_SIGNING)
This is an option that will sign NCP packets for stronger security. Normally
you can leave it off, but it is there if you do need it.
• IP: Firewall packet netlink device (CONFIG_IP_FIREWALL_NETLINK)
This is a really neat option which allows you to analyze the first 128 bytes of
the packets in a user-space program, to determine if you would like to accept
or deny the packet, based on its validity.
• Socket Filtering (CONFIG_FILTER)
For most people, it's safe to say no to this option. This option allows you to
connect a user-space filter to any socket and determine if packets should be
allowed or denied. Unless you have a very specific need and are capable of
programming such a filter, you should say no. Also note that as of this writing,
all protocols were supported except TCP.
• Port Forwarding
Port Forwarding is an addition to IP Masquerading which allows some forwarding of packets from outside to inside a firewall on given ports. This could be
useful if, for example, you want to run a web server behind the firewall or
masquerading host and that web server should be accessible from the outside
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world. An external client sends a request to port 80 of the firewall, the firewall
forwards this request to the web server, the web server handles the request
and the results are sent through the firewall to the original client. The client
thinks that the firewall computer itself is running the web server. This can also
be used for load balancing if you have a farm of identical web servers behind
the firewall. Information about this feature is available from monmouth [http:
//www.monmouth.demon.co.uk/ipsubs/portforwarding.html].
• Socket Filtering (CONFIG_FILTER)
Using this option, user-space programs can attach a filter to any socket and
thereby tell the kernel that it should allow or disallow certain types of data to
get through the socket. GNU/Linux socket filtering works on all socket types
except TCP for now. See the text file /usr/src/linux/Documentation/networking/filter.txt for more information.
• IP: Masquerading
The 2.2 kernel masquerading has been improved. It provides additional support
for masquerading special protocols, etc. Be sure to read the IP Chains HOWTO
for more information.

7.2. Kernel Devices
There are a few block and character devices available on GNU/Linux which can
also help you with security.
The two devices /dev/random and /dev/urandom are provided by the kernel to
provide random data at any time.
Both /dev/random and /dev/urandom should be secure enough to use in generating
PGP keys, ssh challenges, and other applications where secure random numbers
are required. Attackers should be unable to predict the next number given any
initial sequence of numbers from these sources. There has been a lot of effort put
in to ensuring that the numbers you get from these sources are random in every
sense of the word.
The only difference between the two devices, is that /dev/random can run out of
random bytes and makes you wait for more to be accumulated. Note that on some
systems, it can block for a long time waiting for new user-generated entropy to be
entered into the system. So you have to use care before using /dev/random. (Perhaps
the best thing to do is to use it when you're generating sensitive keying information,
and you tell the user to pound on the keyboard repeatedly until you print out “OK,
enough”.)
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/dev/random is high quality entropy, generated from measuring the inter-interrupt
times etc. It blocks until enough bits of random data are available.
/dev/urandom is similar, but when the store of entropy is running low, it'll return
a cryptographically strong hash of what there is. This isn't as secure, but it's enough
for most applications.
You might read from the devices using something like:
root# head -c 6 /dev/urandom | mimencode

This will print six random characters on the console, suitable for password generation. You can find mimencode in the metamail package.
See /usr/src/linux/drivers/char/random.c for a description of the algorithm.

8. Network Security
Network security is becoming more and more important as people spend more
and more time connected. Compromising network security is often much easier
than compromising physical or local security, and is much more common.
There are a number of good tools to assist with network security, and more and
more of them are shipped with your Mandriva Linux distribution, either in the
main CD-ROM, contribs, or through the FTP crypto server (see above).

8.1. Packet Sniffers
One of the most common ways intruders gain access to systems on your network
is by employing a packet sniffer on a already compromised host. This "sniffer" just
listens on the Ethernet port for things like passwd and login and su in the packet
stream and then logs the traffic after that. This way, attackers gain passwords for
systems they are not even attempting to break into. Clear-text passwords are very
vulnerable to this attack.
Example: Host A has been compromised. Attacker installs a sniffer. Sniffer picks
up admin logging into Host B from Host C. It gets the admins personal password
as they login to B. Then, the admin does a su to fix a problem. They now have the
root password for Host B. Later the admin lets someone telnet from his account
to Host Z on another site. Now the attacker has a password/login on Host Z.
In this day and age, the attacker doesn't even need to compromise a system to do
this: they could also bring a computer (portable or not) into a building and tap
into your net.
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Using ssh or other encrypted password methods thwarts this attack. Things like
APOP for POP accounts also prevents this attack. Normal POP logins are very
vulnerable to this, as is anything that sends clear-text passwords over the network.

8.2. System Services and tcp_wrappers
Before you put your GNU/Linux system on ANY network the first thing to look
at is what services you need to offer. Services that you do not need to offer should
be disabled so that you have one less thing to worry about and attackers have one
less place to look for a hole.
There are a number of ways to disable services under GNU/Linux. You can look
at your /etc/inetd.conf file and see what services are being offered by your inetd.
Disable any that you do not need by commenting them out (# at the beginning of
the line), and then restart your inetd service.
You can also remove (or comment out) services in your /etc/services file. This
will mean that local clients will also be unable to find the service (i.e., if you remove
ftp, and try and ftp to a remote site from that computer it will fail with an unknown
service message). It's usually not worth the trouble to remove services from
/etc/services, since it provides no additional security. If a local person wanted
to use ftp even though you had commented it out, they would make their own
client that use the common FTP port and would still work fine.
Some of the services you might want to leave enabled are:
• ftp
• telnet (or ssh)
• mail, such as pop-3 or imap
• identd
If you know you are not going to use some particular package, you can also delete
it entirely. rpm -e packagename or urpme packagename will erase an entire
package.
Additionally, you really want to disable the rsh/rlogin/rcp utilities, including login
(used by rlogin), shell (used by rcp), and exec (used by rsh) from being started
in /etc/inetd.conf. These protocols are extremely insecure and have been the
cause of exploits in the past.
You should check your /etc/rc.d/rc[0-9].d, and see if any of the servers started
in that directory are not needed. The files in that directory are actually symbolic
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links to files in the directory /etc/rc.d/init.d. Renaming the files in the init.d
directory disables all the symbolic links which point to that file. If you only wish
to disable a service for a particular run level, rename the appropriate symbolic link
by replacing the S with a K, like this:
root#
root#

cd /etc/rc6.d
mv S45dhcpd K45dhcpd

You may also use a command line utility to do that: chkconfig or the
graphical interface under KDE: ksysv.
Your Mandriva Linux distribution ships with a tcp_wrapper “wrapping” all your
TCP services. The tcp_wrapper (tcpd) is invoked from inetd instead of the real
server. tcpd then checks the host requesting the service, and either executes the
real server, or denies access from that host. tcpd allows you to restrict access to
your TCP services. You should edit /etc/hosts.allow and add in only those hosts
which need to have access to your computer's services.
If you are a home dial up user, we suggest you deny ALL. tcpd also logs failed
attempts to access services, so this can alert you if you are under attack. If you add
new services, you should be sure to configure them to use tcp_wrappers if they
are TCP-based. For example, a normal dial-up user can prevent outsiders from
connecting to his computer, yet still have the ability to retrieve mail, and make
network connections to the Internet. To do this, you might add the following to
your /etc/hosts.allow:
ALL: 127.
And of course /etc/hosts.deny would contain:
ALL: ALL
which will prevent external connections to your computer, yet still allow you from
the inside to connect to servers on the Internet.
Bear in mind that tcp_wrappers only protects services executed from inetd, and
a select few others. There very well may be other services running on your computer. You can use netstat -ta to find a list of all the services your computer is offering.

8.3. Verify Your DNS Information
Keeping up-to-date DNS information about all of the hosts on your network can
help to increase security. If an unauthorized host becomes connected to your net662
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work, you can recognize it by its lack of a DNS entry. Many services can be configured to reject connections from hosts that do not have valid DNS entries.

8.4. identd
identd is a small program that typically runs out of your inetd server. It keeps
track of which user is running which TCP services, and can then report this to
whoever requests this information.
Many people misunderstand the usefulness of identd, and so disable it or block
all off-site requests for it. identd is not there to help out remote sites. There is no
way of knowing if the data you get from the remote identd is correct or not. There
is no authentication in identd requests.
Why would you want to run it then? Because it helps you out, and is another datapoint in tracking. If your identd is not compromised, then you know it's telling
remote sites the user-name or UID of people using TCP services. If the admin at a
remote site comes back to you and tells you user so-and-so was trying to hack into
their site, you can easily take action against that user. If you are not running identd,
you will have to look at lots and lots of logs, figure out who was on at the time,
and in general take a lot more time to track down the user.
The identd that ships with most distributions is more configurable than many
people think. You can disable it for specific users (they can make a .noident file),
you can log all identd requests (Which we recommend), you can even have identd
return a UID instead of a user name or even NO-USER.

8.5. Configuring and Securing the Postfix MTA
The Postfix mail server was written by Wietse Venema, author of Postfix and several other staple Internet security products, as an “attempt to provide an alternative
to the widely-used Sendmail program. Postfix attempts to be fast, easy to administer, and hopefully secure, while at the same time being Sendmail-compatible
enough to not upset your users.”
Further information on postfix can be found at the Postfix web site [http://www.
postfix.org] and in Configuring and Securing Postfix [ http://www.linuxsecurity.
com/feature_stories/feature_story-91.html].

8.6. SATAN, ISS, and Other Network Scanners
There are a number of software packages out there that do port and service-based
scanning of computers or networks. SATAN, ISS, SAINT, and Nessus are some of
the more well-known ones. This software connects to the target computer (or all
the target computers on a network) on as many of the ports as they can, and try
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to determine what services are running. Based on this information, you can tell if
the computer is vulnerable to specific exploits on that server.
SATAN (Security Administrator's Tool for Analyzing Networks) is a port scanner
with a web interface. It can be configured to do light, medium, or strong checks
on a computer or a network of computers. It's a good idea to get SATAN and scan
your computer or network, and fix any problems it finds. Make sure you get the
copy of SATAN from metalab [http://metalab.unc.edu/pub/packages/security/
Satan-for-Linux/] or a reputable FTP or web site. There was a Trojan copy of
SATAN that was distributed on the net (see the Trouble web site [http://www.
trouble.org/~zen/satan/satan.html]). Note that SATAN has not been updated in
quite a while, and some of the other tools below may do a better job.
ISS (Internet Security Scanner) is another port-based scanner. It is faster than Satan,
and thus may be better for large networks. However, SATAN tends to provide
more information.
SAINTTM is an updated version of SATAN. It is web based and has many more
up to date tests than SATAN. You can find out more about it at the SAINT [http:
//www.wwdsi.com/saint] home page.
Nessus is a free security scanner. It has a GTK graphical interface for ease of use.
It is also designed with a very nice plugin setup for new port-scanning tests. For
more information, take a look at the Nessus web site [http://www.nessus.org/].

8.6.1. Detecting Port Scans
There are some tools designed to alert you to probes by SATAN and ISS and other
scanning software. However, if you liberally use tcp_wrappers, look over your
log files regularly, you should be able to notice such probes. Even on the lowest
setting, SATAN still leaves traces in the logs.
There are also “stealth” port scanners. A packet with the TCP ACK bit set (as is
done with established connections) will likely get through a packet-filtering firewall.
The returned RST packet from a port which _has no established session_ can be taken
as proof of life on that port. I don't think TCP wrappers will detect this.
You might also look at SNORTTM [http://www.snort.org], which is a free IDS
(Intrusion Detection System), which can detect other network intrusions.
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One of the most important services you can provide is a mail server. Unfortunately,
it is also one of the most vulnerable to attack, simply due to the number of tasks
it must perform and the privileges it typically needs.
If you are using sendmail it is very important to keep up with current versions.
sendmail has a long long history of security exploits. Always make sure you are
running the most recent version from sendmail [http://www.sendmail.org/].
Bear in mind that sendmail does not have to be running in order for you to send
mail. If you are a home user, you can disable sendmail entirely, and simply use
your mail client to send mail. You might also choose to remove the -bd flag from
the sendmail startup file, thereby disabling incoming requests for mail. In other
words, you can execute sendmail from your startup script using the following instead:
# /usr/lib/sendmail -q15m

This will cause sendmail to flush the mail queue every fifteen minutes for any
messages which could not be successfully delivered on the first attempt.
Many administrators choose not to use sendmail, and instead choose one of the
other mail transport agents. You might consider switching to qmail. qmail was
designed with security in mind from the ground up. It's fast, stable, and secure.
Qmail can be found on the qmail web site [http://www.qmail.org].
In direct competition to qmail is Postfix, written by Wietse Venema, the author of
tcp_wrappers and other security tools. Formerly called vmailer, and sponsored
by IBM, this is also a mail transport agent written from the ground up with security
in mind. You can find more information about Postfix on the Postfix web site [http:
/www.postfix.org].
Postfix is the default MTA shipped with Mandriva Linux. Please refer
to Chapter 44, Postfix Mail Server [575].

8.8. Denial of Service (DoS) Attacks
A “Denial of Service” (DoS) attack is one where the attacker tries to make some
resource too busy to answer legitimate requests, or to deny legitimate users access
to a computer or network.
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Denial of service attacks have increased greatly in recent years. Some of the more
popular and recent ones are listed below. Note that new ones show up all the time,
so this is just a few examples. Read the GNU/Linux security lists and the bugtraq
list and archives for more current information.
• SYN Flooding - SYN flooding is a network denial of service attack. It takes advantage of a "loophole" in the way TCP connections are created. The newer
GNU/Linux kernels (2.0.30 and up) have several configurable options to prevent
SYN flood attacks from denying people access to your computer or services.
See Section 7, “Kernel Security” [655] for proper kernel protection options.
• Ping Flooding - Ping flooding is a simple brute-force denial of service attack.
The attacker sends a “flood” of ICMP packets to your computer. If they are
doing this from a host with better bandwidth than yours, your computer will
be unable to send anything on the network. A variation on this attack, called
“smurfing”, sends ICMP packets to a host with your computer's return IP, allowing them to flood you less detectably. You can find more information about
the “smurf” attack on the Linux Security web site [http://www.linuxsecurity.
com/articles/network_security_article-4258.html].
If you are ever under a ping flood attack, use a tool like tcpdump to determine
where the packets are coming from (or appear to be coming from), then contact
your provider with this information. Ping floods can most easily be stopped
at the router level or by using a firewall.
• Ping o' Death - The Ping o' Death attack sends ICMP ECHO REQUEST packets that
are too large for the kernel data structures intended to store them. Because
sending a single, large (65,510 bytes) "ping" packet to many systems will cause
them to hang or even crash, this problem was quickly dubbed the “Ping o'
Death”. This one has long been fixed, and is no longer anything to worry about.
You can find code for most exploits, and a more in-depth descriptions of how they
work, on the Insecure web site [http://www.insecure.org/sploits.html] using
their search engine.

8.9. NFS (Network File System) Security
NFS is a very widely-used file sharing protocol. It allows servers running nfsd
and mountd to “export” entire file systems to other computers using NFS file
system support built into their kernels (or some other client support if they are not
GNU/Linux computers). mountd keeps track of mounted file systems in /etc/mtab,
and can display them with showmount.
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Many sites use NFS to serve home directories to users, so that no matter what
computer in the cluster they login to, they will have all their home files.
There is some small amount of security allowed in exporting file systems. You can
make your nfsd map the remote root user (UID=0) to the nobody user, denying
them total access to the files exported. However, since individual users have access
to their own (or at least the same UID) files, the remote root user can login or su
to their account and have total access to their files. This is only a small hindrance
to an attacker that has access to mount your remote file systems.
If you must use NFS, make sure you export to only to those computers that you
really need to. Never export your entire root directory; export only directories you
need to export.
See the NFS HOWTO [http://www.tldp.org/HOWTO/NFS-HOWTO/] for more
information on NFS.

8.10. NIS (Network Information Service)
Network Information Service (formerly YP) is a means of distributing information
to a group of computers. The NIS master holds the information tables and converts
them into NIS map files. These maps are then served over the network, allowing
NIS client computers to get login, password, home directory and shell information
(all the information in a standard /etc/passwd file). This allows users to change
their password once and have it take effect on all the computers in the NIS domain.
NIS is not at all secure. It was never meant to be. It was meant to be handy and
useful. Anyone that can guess the name of your NIS domain (anywhere on the
net) can get a copy of your passwd file, and use crack and John the Ripper against
your users' passwords. Also, it is possible to spoof NIS and do all sorts of nasty
tricks. If you must use NIS, make sure you are aware of the dangers.
There is a much more secure replacement for NIS, called NIS+. Check out the NIS
HOWTO [http://www.tldp.org/HOWTO/NIS-HOWTO/] for more information.

8.11. Firewalls
Firewalls are a means of controlling what information is allowed into and out of
your local network. Typically the firewall host is connected to the Internet and
your local LAN, and the only access from your LAN to the Internet is through the
firewall. This way the firewall can control what passes back and forth from the
Internet and your LAN.
There are a number of types of firewalls and methods of setting them up.
GNU/Linux computers make pretty good firewalls. Firewall code can be built
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right into 2.0 and higher kernels. The user-space tools ipchains for 2.2 kernels, and
iptables for 2.4 kernels, allow you to change, on the fly, the types of network traffic
you allow. You can also log particular types of network traffic.
Firewalls are a very useful and important technique in securing your network.
However, never think that because you have a firewall, you don't need to secure
the computers behind it. This is a fatal mistake. Check out the very good Firewall
HOWTO [http://www.ibiblio.org/mdw/HOWTO/Firewall-HOWTO.html] for
more information on firewalls and GNU/Linux.
If you have no experience with firewalls, and plan to set up one for more than just
a simple security policy, the Firewalls book by O'Reilly and Associates or other online firewall documents are mandatory reading. Check out the O'Reilly site [http:
//www.ora.com] for more information. The National Institute of Standards and
Technology have put together an excellent document on firewalls. Although dated
1995, it is still quite good. You can find on the Computer Security Resource Center
(CSRC) web site [http://cs-www.ncsl.nist.gov/publications/nistpubs/800-10/
main.html]. Also of interest are:
• The Freefire Project — a list of freely-available firewall tools, available at freefire
[http://sites.inka.de/sites/lina/freefire-l/index_en.html].
• Mason — the automated firewall builder for GNU/Linux. This is a firewall script
that learns as you do the things you need to do on your network! More info at
mason [http://www.stearns.org/mason/].

8.12. IP Chains – GNU/Linux Kernel 2.2.x Firewalling
GNU/Linux IP Firewalling Chains is an update to the 2.0 GNU/Linux firewalling
code for the 2.2 kernel. It has many more features than previous implementations,
including:
• More flexible packet manipulations.
• More complex accounting.
• Simple policy changes possible automatically.
• Fragments can be explicitly blocked, denied, etc.
• Logs suspicious packets.
• Can handle protocols other than ICMP/TCP/UDP.
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Be sure to read the IP Chains HOWTO [http://www.tldp.org/HOWTO/
IPCHAINS-HOWTO.html] for further information.

8.13. Netfilter – Linux Kernel 2.4.x Firewalling
In yet another set of advancements to the kernel IP packet filtering code, netfilter
allows users to set up, maintain, and inspect the packet filtering rules in the new
2.4 kernel.
The netfilter subsystem is a complete rewrite of previous packet filtering implementations including ipchains and ipfwadm. Netfilter provides a large number
of improvements, and it has now become an even more mature and robust solution
for protecting corporate networks.
iptables is the command-line interface used to manipulate the firewall tables
within the kernel.
Netfilter provides a raw framework for manipulating packets as they traverse the
various parts of the kernel. Part of this framework includes support for masquerading, standard packet filtering, and now more complete network address translation. It even includes improved support for load balancing requests for a particular service between a group of servers behind the firewall.
The stateful inspection features are especially powerful. Stateful inspection provides
the ability to track and control the flow of communication passing through the
filter. The ability to keep track of state and context information about a session not
only makes rules simpler but also helps to better interpret higher-level protocols.
Additionally, small modules can be developed to perform additional specific
functions, such as passing packets to programs in userspace for processing then
reinjecting back into the normal packet flow. The ability to develop these programs
in userspace reduces the level of complexity that was previously associated with
having to make changes directly at the kernel level.
Other IP Tables references include:
• Oskar Andreasson IP Tables Tutorial [http://www.linuxsecurity.com/
feature_stories/feature_story-94.html] — Oskar Andreasson speaks with
LinuxSecurity.com about his comprehensive IP Tables tutorial and how this
document can be used to build a robust firewall for your organization.
• Hal Burgiss Introduces Linux Security Quick-Start Guides [ http://www.
linuxsecurity.com/feature_stories/feature_story-93.html] — Hal Burgiss has
written two authoritative guides on securing Linux, including managing firewalling.
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• Netfilter Home page [http://www.netfilter.org] — The netfilter/iptables home
page.
• Linux Kernel 2.4 Firewalling Matures: netfilter [ http://www.linuxsecurity.
com/feature_stories/kernel-netfilter.html] — This LinuxSecurity.com article
describes the basics of packet filtering, how to get started using iptables, and
a list of the new features available in the latest generation of firewalling for
Linux.

8.14. VPNs: Virtual Private Networks
VPNs are a way to establish a “virtual” network on top of some already existing
network. This virtual network is often encrypted and passes traffic only to and
from some known entities that have joined the network. VPN's are often used to
connect someone working at home over the public Internet to a internal company
network.
There are several GNU/Linux VPN solutions available:
• vpnd. See the VPN Daemon [http://sunsite.dk/vpnd/] web site.
• Free S/Wan, available on the Linux FreeS/WAN web site [http://www.
freeswan.org/].
• ssh can be used to construct a VPN. See the VPN PPP-SSH mini-HOWTO [http:
//www.tldp.org/HOWTO/ppp-ssh/index.html] for more information.
• vps (virtual private server) at strongcrypto [http://www.strongcrypto.com].
• vtun (virtual tunnel) at sourceforge [http://vtun.sourceforge.net/].
• yavipin [http://yavipin.sourceforge.net].
Also see the section on IPSEC for more pointers and information.

9. Security Preparation (Before You Go On-Line)
Ok, so you have checked over your system, and determined that it is as secure as
feasible, and you're ready to put it on-line. There are a few things you should now
do in order to prepare for an intrusion, so you can quickly disable the intruder,
and get back up and running.
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9.1. Make a Full Backup of Your Computer
Discussion of backup methods and storage is beyond the scope of this chapter, but
here are a few words relating to backups and security:
If you have less than 650MB of data to store on a partition, a CD-R copy of your
data is a good way to go (as it's hard to tamper with later, and if stored properly
can last a long time), you will of course need at least 650MB of space to make the
image. Tapes and other re-writable media should be write-protected as soon as
your backup is complete, and then verified to prevent tampering. Make sure you
store your backups in a secure off-line area. A good backup will ensure that you
have a known good point to restore your system from.

9.2. Choosing a Good Backup Schedule
A six-tape cycle is easy to maintain. This includes four tapes for during the week,
one tape for even Fridays, and one tape for odd Fridays. Perform an incremental
backup every day, and a full backup on the appropriate Friday tape. If you make
some particularly important changes or add some important data to your system,
a full backup might well be in order.

9.3. Testing your Backups
You should do periodic tests of your backups to make sure they are working as
you might expect them to. Restores of files and checking against the real data, sizes
and listings of backups, and reading old backups should be done on a regular
basis.

9.4. Backup your RPM File Database
In the event of an intrusion, you can use your RPM database like you would use
tripwire, but only if you can be sure that it has not been modified. You should
copy the RPM database to a floppy, and keep this copy off-line at all times.
The files /var/lib/rpm/fileindex.rpm and /var/lib/rpm/packages.rpm probably
will not fit on a single floppy. But if compressed, each should fit on a separate
floppy.
Now, when your system is compromised, you can use the command:
root#

rpm -Va

to verify each file on the system. See the rpm man page, as there are a few other
options which can be included to make it less verbose. Bear in mind that you must
also be sure your RPM binary has not been compromised.
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This means that every time a new RPM is added to the system, the RPM database
will need to be re-archived. You will have to decide the advantages versus drawbacks.

9.5. Keep Track of your System Accounting Data
It is very important that the information that comes from syslog has not been
compromised. Making the files in /var/log readable and writable by only a limited
number of users is a good start.
Be sure to keep an eye on what gets written there, especially under the auth facility.
Multiple login failures, for example, can indicate an attempted break-in.
You will want to look in /var/log and check messages, mail.log, and others.
You may also want to configure your log-rotating script to keep logs around longer
so you have time to examine them. Take a look at logrotate(8).
If your log files have been tampered with, see if you can determine when the
tampering started, and what sort of things appeared to be tampered with. Are
there large periods of time which cannot be accounted for? Checking backup tapes
(if you have any) for untampered log files is a good idea.
Intruders typically modify log files in order to cover their tracks, but they should
still be checked for strange happenings. You may notice the intruder attempting
to gain entrance, or exploit a program in order to obtain the root account. You
might see log entries before the intruder has time to modify them.
You should also be sure to separate the auth facility from other log data, including
attempts to switch users using su, login attempts, and other user accounting information.
If possible, configure syslog to send a copy of the most important data to a secure
system. This will prevent an intruder from covering his tracks by deleting his login/su/ftp etc attempts. See the syslog.conf man page, and refer to the @ option.
There are several more advanced syslogd programs out there. Take a look at the
SDSC Syslog Home Page [http://security.sdsc.edu/software/sdsc-syslog/] for
Secure Syslog. Secure Syslog allows you to encrypt your syslog entries and make
sure no one has tampered with them.
Another syslogd with more features is syslog-ng [http://www.balabit.com/
products/syslog_ng/]. It allows you a lot more flexibility in your logging and can
also encrypt your remote syslog streams to prevent tampering.
Finally, log files are much less useful when no one is reading them. Take some
time out every once in a while to look over your log files, and get a feeling for what
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they look like on a normal day. Knowing this can help make unusual things stand
out.

9.6. Apply All New System Updates
Most users install their systems from CD-ROM. Due to the fast-paced nature of
security fixes, new (fixed) programs are always being released. Before you connect
your computer to the network, it's a good idea to run MandrivaUpdate (on another
computer connected to the Internet) and get all the updated packages since you
received your distribution CD-ROM. Many times these packages contain important
security fixes, so it's a good idea to get them installed.

10. What to Do During and After a Break-in
So you have followed some of the advice here (or elsewhere) and have detected a
break-in? The first thing to do is to remain calm. Hasty actions can cause more
harm than the attacker would have.

10.1. Security Compromise Underway
Spotting a security compromise under way can be a tense undertaking. How you
react can have large consequences.
If the compromise you are seeing is a physical one, odds are you have spotted
someone who has broken into your home, office or lab. You should notify your
local authorities. In a lab, you might have spotted someone trying to open a case
or reboot a computer. Depending on your own level of authority and procedures,
you might ask them to stop, or contact your local security people.
If you have detected a local user trying to compromise your security, the first thing
to do is confirm they are in fact who you think they are. Check the site they are
logging in from. Is it the site they normally log in from? No? Then use a non-electronic means of getting in touch. For instance, call them on the phone or walk over
to their office/house and talk to them. If they agree that they are on, you can ask
them to explain what they were doing or tell them to cease doing it. If they are not
on, and have no idea what you are talking about, odds are this incident requires
further investigation. Look into such incidents , and have lots of information before
making any accusations.
If you have detected a network compromise, the first thing to do (if you are able)
is to disconnect your network. If they are connected via modem, unplug the modem
cable; if they are connected via Ethernet, unplug the Ethernet cable. This will
prevent them from doing any further damage, and they will probably see it as a
network problem rather than detection.
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If you are unable to disconnect the network (if you have a busy site, or you do not
have physical control of your computers), the next best step is to use something
like tcp_wrappers or ipfwadm to deny access from the intruder's site.
If you can't deny all people from the same site as the intruder, locking that user's
account will have to do. Note that locking an account is not an easy thing. You
have to keep in mind .rhosts files, FTP access, and a host of possible back doors.
After you have done one of the above (disconnected the network, denied access
from their site, and/or disabled their account), you need to kill all their user processes and log them off.
You should monitor your site well for the next few minutes, as the attacker will
try to get back in. Perhaps using a different account, and/or from a different network address.

10.2. Security Compromise Has Already Happened
So you have either detected a compromise that has already happened or you have
detected it and locked (hopefully) the offending attacker out of your system. Now
what?

10.2.1. Closing the Hole
If you are able to determine what means the attacker used to get into your system,
you should try to close that hole. For instance, perhaps you see several FTP entries
just before the user logged in. Disable the FTP service and check to see if there is
an updated version, or if any of the lists know of a fix.
Check all your log files, and make a visit to your security lists and pages and see
if there are any new common exploits you can fix. You can find your Mandriva
Linux security fixes by running the MandrakeUpdate regularly.
There is now a GNU/Linux security auditing project. They are methodically going
through all the user-space utilities and looking for possible security exploits and
overflows. From their announcement:
“We are attempting a systematic audit of GNU/Linux sources with a view to being
as secure as OpenBSD. We have already uncovered (and fixed) some problems,
but more help is welcome. The list is unmoderated and also a useful resource for
general security discussions. The list address is: security-audit@ferret.lmh.ox.ac.uk To subscribe, send a mail to: security-audit-subscribe@ferret.lmh.ox.ac.uk ”.
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If you don't lock the attacker out, they will likely be back. Not just back on your
computer, but back somewhere on your network. If they were running a packet
sniffer, odds are good they have access to other local computers.

10.2.2. Assessing the Damage
The first thing is to assess the damage. What has been compromised? If you are
running an Integrity Checker like Tripwire, you can use it to perform a file integrity
check; this should help to show you what has been compromised. If not, you will
have to look around at all your important data.
Since GNU/Linux systems are getting easier and easier to install, you might consider saving your config files, wiping your disk(s), reinstalling, then restoring your
user files and your config files from backups. This will ensure that you have a new,
clean system. If you have to backup files from the compromised system, be especially cautious of any binaries that you restore, as they may be Trojan horses placed
there by the intruder.
Re-installation should be considered mandatory upon an intruder obtaining root
access. Additionally, you should keep any evidence there is, so having a spare disk
in the safe may make sense.
Then you have to worry about how long ago the compromise happened, and
whether the backups hold any damaged work. More on backups later.

10.2.3. Backups, Backups, Backups!
Having regular backups is a godsend for security matters. If your system is compromised, you can restore the data you need from backups. Of course, some data
is valuable to the attacker too, and they will not only destroy it, they will steal it
and have their own copies; but at least you will still have the data.
You should check several backups back into the past before restoring a file that
has been tampered with. The intruder could have compromised your files long
ago, and you could have made many successful backups of the compromised file!
Of course, there are also a raft of security concerns with backups. Make sure you
are storing them in a secure place. Know who has access to them. If an attacker
can get your backups, they can have access to all your data without you ever
knowing it.

10.2.4. Tracking Down the Intruder
Ok, you have locked the intruder out, and recovered your system, but you're not
quite done yet. While it is unlikely that most intruders will ever be caught, you
should report the attack.
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You should report the attack to the admin contact at the site from which the attacker
attacked your system. You can look up this contact with whois or the Internic
database. You might send them an email with all applicable log entries and dates
and times. If you spotted anything else distinctive about your intruder, you might
mention that too. After sending the email, you should (if you are so inclined) follow
up with a phone call. If that admin in turn spots your attacker, they might be able
to talk to the admin of the site where they are coming from and so on.
Good crackers often use many intermediate systems, some (or many) of which
may not even know they have been compromised. Trying to track a cracker back
to their home system can be difficult. Being polite to the admins you talk to can
go a long way to getting help from them.
You should also notify any security organizations you are a part of: (CERT [http:
//www.cert.org/] or similar).

11. Security Sources
There are a lot of good sites out there for UNIX® security in general and GNU/Linux
security specifically. It is very important to subscribe to one (or more) of the security
mailing lists and keep current on security fixes. Most of these lists are very low
volume, and very informative.

11.1. LinuxSecurity.com References
The Linux Security [http://www.linuxsecurity.com] web site has numerous Linux
and open source security references written by the Linux Security staff and people
collectively around the world.
• Linux Advisory Watch [http://www.linuxsecurity.com/vuln-newsletter.html]
— A comprehensive newsletter that outlines the security vulnerabilities that
have been announced throughout the week. It includes pointers to updated
packages and descriptions of each vulnerability.
• Linux Security Week [http://www.linuxsecurity.com/newsletter.html] — The
purpose of this document is to provide readers with a quick summary of each
week's most relevant Linux security headlines.
• Linux Security Discussion List [ http://www.linuxsecurity.com/general/
mailinglists.html] — This mailing list is for general security-related questions
and comments.
• Linux Security Newsletters [ http://www.linuxsecurity.com/general/
mailinglists.html] — Subscription information for all newsletters.
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• comp.os.linux.security FAQ [http://www.linuxsecurity.com/docs/colsfaq.
html] — Frequently Asked Questions with answers for the
comp.os.linux.security newsgroup.
• Linux Security Documentation [http://www.linuxsecurity.com/docs/] — A
great starting point for information pertaining to Linux and Open Source security.

11.2. FTP Sites
CERT is the Computer Emergency Response Team. They often send out alerts of
current attacks and fixes. See the CERT web site [ftp://ftp.cert.org] for more information.
ZEDZ [http://www.zedz.net] (formerly Replay) has archives of many security
programs. Since they are outside the US, they do not need to obey US crypto restrictions.
Matt Blaze is the author of CFS and a great security advocate. Matt's archive is
available on the AT&T web site [ftp://ftp.research.att.com/pub/mab].

11.3. Web Sites
• The Hacker FAQ is a FAQ about hackers available on the Plethora web site
[http://www.plethora.net/~seebs/faqs/hacker.html].
• The COAST archive has a large number of UNIX® security programs and information. It is available at CERIAS [http://www.cerias.purdue.edu].
• SuSE Security Page available at SuSE [http://www.suse.de/de/security/].
• BUGTRAQ puts out advisories on security issues, available on Security Focus
[http://www.securityfocus.com/archive/1].
• CERT, the Computer Emergency Response Team, puts out advisories on common attacks on UNIX® platforms available at CERT [http://www.cert.org/].
• Dan Farmer is the author of SATAN and many other security tools. His home
site has some interesting security survey information, as well as security tools
available on the Trouble web site [http://www.trouble.org/security].
• CIAC sends out periodic security bulletins on common exploits. See CIAC
[http://ciac.llnl.gov/cgi-bin/index/bulletins] for more information.
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• A good starting point for GNU/Linux Pluggable Authentication modules can
be found on The Linux Kernel Archives [http://www.kernel.org/pub/linux/
libs/pam/].
• WWW Security FAQ, written by Lincoln Stein, is a great web security reference.
Find it on the W3C web site [http://www.w3.org/Security/Faq/
www-security-faq.html].
• Mandriva Security Advisories [http://www.mandriva.com/security] is Mandriva Linux official security page, notably holding new advisories, End of life
product support policy, etc.

11.4. Mailing Lists
Mandriva Linux security lists. You can be informed for each security fix by subscribing to our security mailing-lists [http://www.mandriva.com/community/
resources/newsgroups].
Bugtraq: To subscribe to bugtraq, send mail to listserv@netspace.org containing
the message body “subscribe bugtraq”. (See links above for archives.)
CIAC: Send e-mail to majordomo@tholia.llnl.gov. In the BODY (not subject) of the
message put: “subscribe ciac-bulletin”

11.5. Books – Printed Reading Material
There are a number of good security books out there. This section lists a few of
them. In addition to the security specific books, security is covered in a number of
other books on system administration.
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12. Frequently Asked Questions
Q:

Is it more secure to compile driver support directly into the kernel, instead
of making it a module?

A:

Some people think it is better to disable the ability to load device drivers
using modules, because an intruder could load a Trojan module or a module
which could affect system security.
However, in order to load modules, you must be root. The module object
files are also only writable by root. This means the intruder would need
root access to insert a module. If the intruder gains root access, there are
more serious things to worry about than whether he will load a module.
Modules are for dynamically loading support for a particular device that
may be infrequently used. On server computers, or firewalls for instance,
this is very unlikely to happen. For this reason, it would make more sense
to compile support directly into the kernel for machines acting as servers.
Modules are also slower than support compiled directly in the kernel.

Q:

Why does logging in as root from a remote machine always fail?

A:

See Section 4.2, “Root Security” [638]. This is done intentionally to prevent
remote users from attempting to connect via telnet to your computer as root,
which is a serious security vulnerability, because then the root password
would be transmitted, in clear text, across the network. Don't forget: potential
intruders have time on their side, and can run automated programs to find
your password. Additionally, this is done to keep a clear record of who
logged in, not just root.

Q:

How can I enable the Apache SSL extensions?
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A:

Simply install the package mod_ssl, and consult the documentation at mod_ssl
home page [www.modssl.org].
You should also consider the mod_sxnet module, which is a plugin for mod_ssl and allows the activation of the “Thawte Secure
Extranet”. mod_ssl encrypt communications, but mod_ssl-sxnet
goes further and allows you to securely authenticate the user of the
web page thanks to a personal certificate. You have more info on
this application on Thawte [http://www.thawte.com/certs/
strongextranet/] or install the mod_sxnet module from your Mandriva Linux distribution and read the included package documentation.
You might also try ZEDZ net [http://www.zedz.net] which has many prebuilt packages, and is located outside of the United States.

Q:

How can I manipulate user accounts, and still retain security?

A:

Your Mandriva Linux distribution contains a large number of tools to change
the properties of user accounts.
• The pwconv and unpwconv programs can be used to convert between
shadowed and non-shadowed passwords.
• The pwck and grpck programs can be used to verify proper organization
of the /etc/passwd and /etc/group files.
• The useradd, usermod, and userdel programs can be used to add, delete
and modify user accounts. The groupadd, groupmod, and groupdel
programs will do the same for groups.
• Group passwords can be created using gpasswd.
All these programs are “shadow-aware” – that is, if you enable shadow they
will use /etc/shadow for password information, otherwise they will not.

Q:

How can I password-protect specific HTML documents using Apache?

A:

I bet you did not know about Apache Week [http://www.apacheweek.com],
did you?
You can find information on user authentication on Apache Week [http://
www.apacheweek.com/features/userauth] as well as other web server-se-
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curity tips from Apache [http://www.apache.org/docs/misc/security_tips.
html].

13. Conclusion
By subscribing to the security alert mailing lists, and keeping current, you can do
a lot towards securing your computer. If you pay attention to your log files and
run something like tripwire regularly, you can do even more.
A reasonable level of computer security is not difficult to maintain on a home
computer. More effort is required on business computers, but GNU/Linux can
indeed be a secure platform. Due to the nature of GNU/Linux development, security fixes often come out much faster than they do on commercial operating systems,
making GNU/Linux an ideal platform when security is a requirement.

Security-Related Terms
Included below are several of the most frequently used terms in computer security.
A comprehensive dictionary of computer security terms is available in the Linux
Security Dictionary [http://www.linuxsecurity.com/dictionary/]
authentication

The process of knowing that the data received is
the same as the data that was sent, and that the
claimed sender is in fact the actual sender.

bastion host

A computer system that must be highly secured
because it is vulnerable to attack, usually because
it is exposed to the Internet and is a main point
of contact for users of internal networks. It gets
its name from the highly fortified projects on the
outer walls of medieval castles. Bastions overlook
critical areas of defense, usually having strong
walls, room for extra troops, and the occasional
useful tub of boiling oil for discouraging attackers.
Some reasonable definition here.

buffer overflow

Common coding style is to never allocate large
enough buffers, and to not check for overflows.
When such buffers overflow, the executing program (daemon or set-uid program) can be tricked
in doing some other things. Generally this works
by overwriting a function's return address on the
stack to point to another location.
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denial of service

An attack which consumes the resources of your
computer for things it was not intended to be
doing, thus preventing normal use of your network resources for legitimate purposes.

dual-homed host

A general-purpose computer system which has
at least two network interfaces.

firewall

A component or set of components which restricts
access between a protected network and the Internet, or between other sets of networks.

host

A computer system attached to a network.

IP spoofing

IP Spoofing is a complex technical attack which
is made up of several components. It is a security
exploit that works by tricking computers in a trust
relationship into thinking that you really are
someone you are not. There is an extensive paper
written by daemon9, route, and infinity in the
Volume Seven, Issue Forty-Eight of Phrack
Magazine.

non-repudiation

The property of a receiver being able to prove
that the sender of some data did in fact send the
data even though the sender might later deny
ever having sent it.

packet

The fundamental unit of communication on the
Internet.

packet filtering

The action a device takes to selectively control
the flow of data to and from a network. Packet
filters allow or block packets, usually while routing them from one network to another (most often
from the Internet to an internal network, and viceversa). To accomplish packet filtering, you set up
rules which specify what types of packets (those
to or from a particular IP address or port) are to
be allowed and what types are to be blocked.

perimeter network

A network added between a protected network
and an external network, in order to provide an
additional layer of security. A perimeter network
is sometimes called a DMZ.
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proxy server

A program which deals with external servers on
behalf of internal clients. Proxy clients talk to
proxy servers, which relay approved client requests to real servers, and relay answers back to
clients.

superuser

An informal name for root.
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Chapter 51. Networking Overview
1. Copyright
This chapter is based on a HOWTO by Joshua D. Drake {POET}, the original of which
is hosted by the The Linux Review [http://www.thelinuxreview.com/] web site.
The NET-3/4-HOWTO, NET-3, and Networking-HOWTO, information on how
to install and configure networking support for Linux. Copyright (c) 1997 Terry
Dawson, 1998 Alessandro Rubini, 1999 Joshua D. Drake {POET} , CommandPrompt,
Inc. is a FREE document. You may redistribute it under the terms of the GNU
General Public License.
Modifications from v1.7.0, 2000, (C)opyright 2000 - 2005 Mandriva.

2. How to Use this Chapter
This document is organized top-down. The first sections include informative material and may be skipped if you are not interested; what follows is a generic discussion of networking issues, and you must ensure that you understand this before
proceeding to more specific parts. The rest, technology-specific information, is
grouped into three main sections: Ethernet and IP-related information, technologies
pertaining to widespread PC hardware, and seldom-used technologies.
The suggested path through the document follows:
Read the generic sections
These sections apply to almost every technology described, and they are very
important for you to understand. Most readers should be comfortable with
this material.
Consider your network
You should know how your network is, or will be, designed and you should
also be familiar with exactly which hardware and technology types you will
be implementing.
Read Section 5, “Ethernet Information” [693] if you are directly connected to a LAN
or the Internet:
This section describes basic Ethernet configuration and the various features
that Linux offers for IP networking, such as firewalling, advanced routing and
so on.
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Read the next section if you are interested in low-cost local networks or dial-up
connections
This section describes PLIP, PPP, SLIP and ISDN, the most widespread technologies used on personal workstations.
Read the technology-specific sections related to your requirements
If your needs differ from IP and/or common hardware, Section 8, “Other
Network Technologies” [698] provides some pointers to information on nonIP protocols and other communications hardware.
Do the configuration work
You should actually try to configure your network and take careful note of
any problems you might have.
Look for further help if needed
If you experience problems that this chapter does not help you to resolve, then
read the section related to where to get help or where to report bugs.
Have fun!
Networking is fun, enjoy it.

2.1. Conventions Used in this chapter
No special conventions are used here, but you should be warned about the way
commands are shown. Following the classic UNIX documentation, any command
you type to your shell is prefixed by a prompt. This chapter shows “user%” as the
prompt for commands which do not require superuser privileges, and “root#” as
the prompt for commands that need to be run as root. “root#” is preferred instead
of a plain “#” to prevent confusion with snapshots from shell scripts, where the
hash mark is used to define comment lines.

3. General Information about Linux Networking
3.1. Linux Networking Resources
There are a number of places where you can find good information about Linux
networking.
There is a wealth of consultants available. A searchable listing can be found on the
linuxports [http://www.linuxports.com/] web site. There is also a newsgroup in
the Linux news hierarchy dedicated to networking and related matters, it is:
comp.os.linux.networking [news:comp.os.linux.networking].
686

3.2. Where to Get some non Linux-Specific Network Information
When reporting problems, please remember to include as much relevant detail
about the problem as you can. Specifically, you should identify the versions of
software that you are using, especially the kernel version, the version of tools such
as pppd or dip and the exact nature of the problem you are experiencing. This
means taking note of the exact syntax of any error messages you receive and of
any commands you issued.

3.2. Where to Get some non Linux-Specific Network Information
If you are after more basic tutorial information on TCP/IP networking, then the
following documents are recommended:
TCP/IP Introduction
This document comes as both a text [ftp://athos.rutgers.edu/runet/
tcp-ip-intro.doc] and a postscript [ftp://athos.rutgers.edu/runet/tcp-ip-intro.
ps] version.
TCP/IP Administration
This document comes both as a text [ftp://athos.rutgers.edu/runet/
tcp-ip-admin.doc] and a postscript
[ftp://athos.rutgers.edu/runet/
tcp-ip-admin.ps] version.
If you are looking for more detailed information on TCP/IP networking, then Inter
networking with TCP/IP, Volume 1: principles, protocols and architecture, by Douglas
E. Comer, ISBN 0-13-227836-7, Prentice Hall publications, 3rd Edition or newer,
is highly recommended.
If you want to learn about how to write network applications in a UNIX-compatible
environment, then Unix Network Programming, by W. Richard Stevens, ISBN 0-13949876-1, Prentice Hall publications, 2nd Edition or newer, is highly recommended.
Check the Prentice-Hall Professional Technical Reference [http://www.phptr.
com/] web site for more information.
You might also try the TCP-IP Protocol Newsgroup [news:comp.protocols.tcp-ip].
An important source of specific technical information relating to the Internet and
the TCP/IP suite of protocols are RFCs. RFC is an acronym for “Request For
Comment” and is the standard means of submitting and documenting Internet
protocol standards. There are many RFC repositories and some allow you to search
the RFC database for particular keywords. One such repository with a search engine
is available at NEXOR dot com [http://www.nexor.com/rfc_search.htm].

687

4. Generic Network Configuration Information

4. Generic Network Configuration Information
The following sections present concepts that need to be known and understood
before actually trying to configure a network. These fundamental principles apply
regardless of the exact nature of the network you wish to deploy.

4.1. What Do I Need to Start?
Before you start building or configuring your network, the most important things
needed are:

4.1.1. Kernel Support for the Network Hardware and Protocols
Your Mandriva Linux distribution comes with networking enabled, and with a
kernel which supports most well-known networking hardware (for example:
3COM, RealTek, NE2000 or Intel NICs) and protocols. Please refer to your hardware
documentation for more information.

4.1.2. An Explanation of IP Addresses
Internet Protocol (IP) addresses are composed of four bytes1. The convention is to
write addresses in what is called “dotted decimal notation”. In this form, each byte
is represented in decimal notation (0-255), dropping any leading zeroes, unless
the number is zero, and written with each byte separated by a “.” character. By
convention, each host or router interface has an IP address. In some circumstances,
the same IP address could be used on each interface of a single machine, but usually,
each interface will have its own address.
Internet Protocol networks are contiguous sequences of IP addresses. All addresses
within a network have a number of digits within the address in common. The
portion of the address which is common to all addresses within the network is
called the “network portion”. The remaining digits are called the “host portion”.
The number of bits that are shared by all addresses within a network form the
“netmask” whose role is to determine which addresses belong to the network it
is applied to and which don't. For example, consider the following:
Host Address

192.168.110.23

Network Mask

255.255.255.0

Network Portion

192.168.110.

Host Portion

.23

1

for version 4 of IP, a.k.a IPv4
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4.1. What Do I Need to Start?
Host Address

192.168.110.23

Network Address 192.168.110.0
Broadcast Address 192.168.110.255
Any address that is “bitwise ANDed” with its netmask will reveal the address of
the network it belongs to. The network address is therefore always the lowest
numbered address within the range of addresses on the network and always has
the host portion of the address coded with zeroes.
The broadcast address is a special one which every host on the network listens to
(in addition to its own unique address). Datagrams (like certain type of routing
information and warning messages) that are to be received by all hosts on the
network are sent to this address. The standard is to use one of the addresses at
either extreme of the network address range as the broadcast address, preferring
the one at the high end of the range. In the example above, this would be
192.168.110.255. In practice, it doesn't matter very much which one you use, just
make sure that every host on the network is configured with the same broadcast
address.
For administrative reasons, some time early in the development of the IP protocol,
some arbitrary groups of addresses were formed into networks and these networks
were grouped into what are called classes. These classes provide a number of
standard size networks that can be allocated. The ranges allocated are:
Network Class Netmask

Network Addresses

A

255.0.0.0

0.0.0.0 - 127.255.255.255

B

255.255.0.0

128.0.0.0 - 191.255.255.255

C

255.255.255.0 192.0.0.0 - 223.255.255.255

Multicast

240.0.0.0

224.0.0.0 - 239.255.255.255

The addresses you should use depend on exactly what it is that you are doing.
You may have to use a combination of the following activities to get all the addresses you need:
Installing a Linux machine on an existing IP network
If you wish to install a Linux machine onto an existing IP network, then you
should contact whoever administers that network and ask them for the following information:
689

4.2. Routing
• Host IP Address
• IP Network Address
• IP Broadcast Address
• IP Netmask
• Router Address
• Domain Name Server Address
You should then configure your Linux network device with those details. You
can not just make them up and then expect your configuration to work.
Building a brand new network which will never connect to the Internet
If you are building a private network and you never intend that network to
be connected to the Internet, then you can choose whatever addresses you like.
However, for safety and consistency reasons, there have been some IP network
addresses that have been reserved specifically for this purpose. These are
specified in RFC1597 and are as follows:
Table 51.1. Reserved Private Network Allocations
Network Class Netmask

Network Addresses

A

255.0.0.0

10.0.0.0 - 10.255.255.255

B

255.255.0.0

172.16.0.0 - 172.31.255.255

C

255.255.255.0 192.168.0.0 - 192.168.255.255

You should first decide how large you want your network to be, and then
choose as many addresses as you require.

4.2. Routing
Routing is a big topic. Whole books are written about it. Most of you will have
fairly simple routing requirements, some of you will not. Only the basic fundamentals of routing are covered.
What is IP routing? Here is a possible definition: “IP routing is the process by
which a host with multiple network connections decides where to deliver the IP
datagrams it has received.”
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It might be useful to illustrate this with an example. Imagine a typical office router.
It might have a PPP link off to the Internet, a number of Ethernet segments feeding
the workstations, and another PPP link off to another office. When the router receives a datagram on any of its network connections, routing is the mechanism it
uses to determine which interface it should send the datagram to next. Simple
hosts also need to route, all Internet hosts have two network devices, one is the
loopback interface, and the other is the one it uses to talk to the rest of the network,
perhaps an Ethernet, perhaps a PPP or SLIP serial interface.
Ok, so how does routing work? Each host keeps a special list of routing rules,
called a routing table. This table contains rows which typically contain at least
three fields: the first is a destination address, the second is the name of the interface
to which the datagram is to be routed, and the third is optionally the IP address
of another machine which will carry the datagram on its next step through the
network. You can see this table by using the following command:
user% cat /proc/net/route

or by using either one of the following commands:
user% /sbin/route -n
user% netstat -r

The routing process is fairly simple: an incoming datagram is received, the destination address (who it is for) is examined and compared with each entry in the table.
The entry that best matches that address is selected and the datagram is forwarded
to the specified interface. If the gateway field is filled, then the datagram is forwarded to that host via the specified interface. Otherwise, the destination address is
assumed to be on the network supported by the interface.
To manipulate this table, the route command is used. Please refer to route(8) for
more information.

4.2.1. What Does the Routed Program Do?
The routing configuration described above is best suited for simple network arrangements where there is only one possible path to a determined destination.
When you have a more complex network arrangement, things get a little more
complicated.
The big problem with “manual routing”, or “static routing” as described, is that
if a machine or link fails on your network, then the only way you can direct your
datagrams another way, if another way exists, is by manually intervening and
executing the appropriate commands. Naturally this is clumsy, slow, impractical
and error-prone. Various techniques have been developed to automatically adjust
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routing tables in the event of network failures where there are alternate routes. All
of these techniques are loosely grouped by the term “dynamic routing protocols”.
You may have heard of some of the more common dynamic routing protocols.
The most common are probably RIP (Routing Information Protocol) and OSPF
(Open Shortest Path First). The Routing Information Protocol is very common on
small networks such as small-to-medium size corporate networks or building
networks. OSPF is more modern and more capable of handling large network
configurations and better suited to environments where there are a large number
of possible paths through the network. Common implementations of these protocols
are: routed - RIP and gated - RIP, OSPF and others. The routed program is supplied
with your Linux distribution.
An example of where and how you might use a dynamic routing protocol may
look something like Figure 51.1, “A Dynamic Routing Example” [692].

Figure 51.1. A Dynamic Routing Example
There are three routers: A, B and C, supporting one Ethernet segment with a Class
C IP network (netmask 255.255.255.0). All routers also have a PPP link to each
other. The network forms a triangle.
It should be clear that the routing table at router A could look like:
root# route add -net 192.168.1.0 netmask 255.255.255.0 eth0
root# route add -net 192.168.2.0 netmask 255.255.255.0 ppp0
root# route add -net 192.168.3.0 netmask 255.255.255.0 ppp1
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5. Ethernet Information
This would work just fine until the link between router A and B fails. If that link
fails, then with the routing entry shown above, hosts on the A Ethernet segment
could not reach hosts on the B segment because their datagram would be directed
to router A's ppp0 link, which is broken. They could still continue to talk to hosts
on the C segment and hosts on the C segment could still talk to hosts on the B
segment, because the link between B and C is still intact.
But wait, if A can talk to C and C can still talk to B, why shouldn't A route its datagrams for B via C and let C send them on to B? This is exactly the sort of problem
that dynamic routing protocols like RIP were designed to solve. If each of the
routers A, B and C were running a routing daemon, then their routing tables would
be automatically adjusted to reflect the new state of the network should any one
of the links in the network fail. To configure such a network is simple. For each
router, you only need to do the following (for example, for router A):
root# route add -net 192.168.1.0 netmask 255.255.255.0 eth0
root# /usr/sbin/routed

The routed routing daemon automatically finds all active network ports when it
starts and sends and listens for messages on each of the network devices, to allow
it to determine and update the routing table on the host.
This has been a very brief explanation of dynamic routing and where you would
use it. If you need more information, then you should refer to the suggested references listed in Section 3, “General Information about Linux Networking” [686].
The important points relating to dynamic routing are:
1.

You only need to run a dynamic routing protocol daemon when your Linux
machine has the capability of selecting multiple possible routes to a destination.
An example of this would be if you plan to use IP masquerading.

2.

The dynamic routing daemon will automatically modify your routing table
to adjust to changes in your network.

3.

RIP is suited for small-to-medium size networks.

5. Ethernet Information
This section covers information specific to Ethernet and to the configuring of Ethernet cards.
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5.1. Supported Ethernet Cards
GNU/Linux supports almost every known network card. It would be pointless to
list them all here. If you have trouble setting your network card up, please refer
to its accompanying documentation (if any) or to its manufacturer's web site. You
can also check your kernel's specific documentation for some NICs.

5.2. General Ethernet Information
Ethernet device names are eth0, eth1, eth2 etc. The first card detected by the
kernel is assigned eth0 and the rest are assigned sequentially in the order in which
they are detected.
Card configuration is easy. Typically, you would use something like (which most
distributions already do for you, if you configured them to support your Ethernet)
this:
root# ifconfig eth0 192.168.0.1 netmask 255.255.255.0 up
root# route add -net 192.168.0.0 netmask 255.255.255.0 eth0

5.3. Using Multiple Ethernet Cards in The Same Machine
If you have a computer with three NE2000 cards, one at 0x300, one at 0x240, and
one at 0x220 then you would add the following lines to the /etc/modprobe.conf
file:
alias eth0
alias eth1
alias eth2
options ne

ne
ne
ne
io=0x220,0x240,0x300

What this does is tell the modprobe program to look for three NE-based cards at the
listed I/O addresses. It also states in which order they should be found and the
device to which they should be assigned.
Most ISA modules can take multiple comma separated I/O values. For example:
alias eth0 3c501
alias eth1 3c501
options eth0 -o 3c501-0 io=0x280 irq=5
options eth1 -o 3c501-1 io=0x300 irq=7

The -o option allows for a unique name to be assigned to each module. The reason
for this is so that you cannot load two copies of the same module.
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6. IP-Related Information
The irq= option is used to specify the hardware IRQ, and the io= to specify the
different I/O ports.
Please refer to the Ethernet-HOWTO [http://www.tldp.org/HOWTO/
Ethernet-HOWTO.html] for more information about Ethernet.

6. IP-Related Information
6.1. DNS
DNS stands for Domain Name System. It is responsible of mapping a machine
name such as www.mandriva.com with the IP address of that machine, in this case:
212.85.150.181 at the time of writing. Mapping is available in both directions,
that is from name to IP and vice versa (called reverse DNS lookup).
The DNS is composed of a great number of machines all over the Internet responsible for a certain number of names. Each machine is attributed a DNS server to
which it can ask to map a particular name with its address. If that server does not
have the answer, then it asks another one and so on. You can also have a local DNS
responsible for mapping addresses on your LAN.
We can differentiate two major DNS classes: caching DNS and master DNS servers.
The first only “remembers” a previous request and then it can answer without
asking a master DNS server again. The latter servers are really responsible as a
last resort to map an address with a name — or possibly to specify that a given
name does not map to any known address.

6.2. DHCP
DHCP is an acronym for Dynamic Host Configuration Protocol. The creation of
DHCP has made configuring the network on multiple hosts extremely simple. Instead of having to configure each host separately, you can configure them all
automatically, assigning all common parameters through a DHCP server.
Each time the host boots up, it will broadcast a packet to the network. This packet
is a call to any DHCP servers located on the same segment to configure the host.

6.3. IP Aliasing
There are some applications where being able to configure multiple IP addresses
to a single network device is useful. Internet Service Providers often use this facility
to provide a “customized” feature to their World Wide Web and FTP offerings for
their customers. You can refer to the IP-Alias mini-HOWTO [http://www.tldp.
org/HOWTO/IP-Alias/] for more information.
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6.4. IP Firewall
IP Firewall and Firewalling issues are covered in more depth in the FirewallHOWTO [http://tldp.org/HOWTO/Firewall-HOWTO.html]. IP Firewalling allows
you to secure your machine or network against unauthorized network access by
filtering or allowing datagrams to or from IP addresses which you nominate. There
are three different classes of rules; incoming filtering, outgoing filtering, and forwarding filtering. Incoming rules are applied to datagrams that are received by a
network device. Outgoing rules are applied to datagrams that are to be transmitted
from a network device. Forwarding rules are applied to datagrams that are received
but are not intended for this machine (ie. datagrams that would be routed).

6.5. IP Masquerade
Many people have a single link to connect to the Internet being assigned a single
IP address by the Internet Service Provider. This is enough to allow only one host
full access to the Internet. IP Masquerade is a technique enabling many machines
make use of that one IP address, causing the other hosts to “look like” (be masqueraded by) the machine having the Internet connection. There is one caveat: the
masquerade function usually works in only one direction. That is, the masqueraded
hosts can make calls out, but they cannot accept or receive network connections
from remote hosts. This means that some network services do not work (such as
talk), and others (such as FTP) must be configured in passive (PASV) mode to operate. Fortunately, the most common network services work just fine.

6.6. IPv6
Just when you thought you were beginning to understand IP networking, the rules
get changed! IPv6 is the shorthand notation for version 6 of the Internet Protocol.
IPv6 was developed primarily to overcome the concern that address space wouldn't
be sufficient, making the address 16 bytes long (128 bits). IPv6 incorporates a
number of other changes, mostly simplifications, that will make IPv6 networks
more manageable than IPv4 networks.
Please refer to the Linux IPv6 HOWTO [http://www.tldp.org/HOWTO/
Linux+IPv6-HOWTO/] for more information.

6.7. Traffic Shaping
Traffic shaping is used to limit the traffic to given maximum values. This technique
is useful to “partition” the available bandwidth among network interfaces. The
traffic shaper creates new interface devices which rely on physical network devices
for actual transmission, and can be used as outgoing routes for network traffic.
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7. Using Commodity PC Hardware
Please refer to the Traffic Control HOWTO [http://www.tldp.org/HOWTO/
Traffic-Control-HOWTO/] for more information on traffic control in general, and
traffic shaping in particular.

7. Using Commodity PC Hardware
7.1. ISDN
The Integrated Services Digital Network (ISDN) is a series of standards which
specify a general purpose switched digital data network. An ISDN “call” creates
a synchronous point-to-point data service to the destination. ISDN is generally
delivered on a high-speed link that is broken down into a number of discrete
channels. There are two different types of channels: the “B Channels” which will
actually carry the user data, and a single channel called the “D channel” which is
used to send control information to establish calls and other functions. In Australia
for example, ISDN may be delivered on a 2Mbps link that is broken into 30 discrete
64Kbps data channels with one 64Kbps control channel. Any number of channels
may be used at a time and in any combination. You could for example establish
30 separate calls to 30 different destinations at 64Kbps each, or you could establish
15 calls to 15 different destinations at 128Kbps each (two channels used per call),
or just a small number of calls and leave the rest idle. A channel may be used for
either incoming or outgoing calls. The original intention of ISDN was to allow
telecommunications companies to provide a single data service which could deliver
either telephone (via digitized voice) or data services to your home or business
without requiring you to make any special configuration changes.
There are a few different ways to connect your computer to an ISDN service. One
way is to use a device called a “Terminal Adaptor” which plugs into the Digital
Network Terminal that your telecommunications carrier will have installed when
you got your ISDN service and presents a number of serial interfaces. One of these
interfaces is used to enter commands to establish calls and configuration while the
others are actually connected to the network devices that will use the data circuits
when they are established. This sort of configuration doesn't need special setup:
you just treat the port on the Terminal Adaptor like you would treat any other
serial device. Another way, which is the way the kernel ISDN support was designed,
allows you to install an ISDN card into your machine and then have your Linux
software handle the protocols and make the calls itself.
Both passive and active internal ISDN cards are supported. We will not list them
all here.
Some of these cards may require software to be downloaded in order to make them
operational. There are separate utilities to do this.
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7.2. PLIP
Please refer to the included ISDN documentation and to the FAQ available on the
ISDN4Linux [http://www.isdn4linux.de/faq/] web site, for more information.
About PPP. The PPP suite of protocols will operate over both asynchronous or synchronous serial lines. The commonly distributed PPP daemon
for Linux, pppd, supports only asynchronous mode. If you wish to run
the PPP protocol over your ISDN service, you need a specially modified
version. Details of where to find it are available in the documentation
referred to above.

7.2. PLIP
The new code for PLIP behaves just like the old one. Use the same ifconfig and route
commands as in the previous section, but initialization of the device is different
due to the advanced parallel port support.
The “first” PLIP device is always called plip0, where first is the first device detected
by the system, similar to what happens for Ethernet devices. The actual parallel
port being used is one of the available ports, as shown in /proc/parport. For example, if you have only one parallel port, you'll only have a directory called
/proc/parport/0.
If the IRQ number used by your port wasn't detected, PLIP will fail to work. In
this case, just write the right number to /proc/parport/0/irq and load PLIP again.
You can refer to the PLIP mini-HOWTO [http://www.tldp.org/HOWTO/PLIP.
html] for more information.

7.3. PPP
Due to the nature of PPP, its size, complexity, and flexibility, it has its own HOWTO.
The Linux PPP HOWTO [http://tldp.org/HOWTO/PPP-HOWTO/] is available,
but its official home is now on The Linux Review [http://www.thelinuxreview.
com/howto/ppp/] web site.

8. Other Network Technologies
GNU/Linux networking is not limited to Ethernet and IP. Almost all existing
networking hardware and protocol is supported. The following subsections will
list some of the “more common” ones, introduced in no particular order.

8.1. Appletalk
Appletalk support allows your GNU/Linux machine to connect with Apple networks to share resources such as printers and disks. Install the netatalk package
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and refer to the Networking Applet Macintosh through Open Source [http://
netatalk.sourceforge.net/] web site, for more information.

8.2. IPX
The IPX (Internetwork Packet Exchange) protocol is most commonly utilized in
Novell NetWaretm local area network environments. Linux includes support for
this protocol and may be configured to act as a network end point, or as a router
for IPX.
The IPX protocol and the NCPFS (Netware Core Protocol File System) are covered
in greater depth in the Linux IPX-HOWTO [http://www.tldp.org/HOWTO/
IPX-HOWTO.html].

8.3. NetBEUI, NetBios, CIFS
Samba is an implementation of the Session Management Block protocol (SMB). It
allows Windows® and other systems to mount and use your disks and printers,
as well as access disks and printers served by Windows® servers.
Please refer to the SMB-HOWTO [http://www.tldp.org/HOWTO/SMB-HOWTO.
html] and the Samba - opening windows to a wider world [http://www.samba.
org] web sites for more information.

8.4. Token Ring
Token Ring is an IBM standard LAN protocol which avoids data collisions by
providing a mechanism which allows only one station on the LAN the right to
transmit at a time. A “token” is held by one station at a time and the station holding
the token is the only station allowed to transmit. When it has transmitted its data,
it passes the token on to the next station. The token loops amongst all active stations,
hence the name “Token Ring”.
The configuration of Token Ring is identical to that of Ethernet, with the exception
of the network device name to configure. Token ring device names are tr0, tr1
etc.

9. Cables and Cabling
Those of you handy with a soldering iron may want to build your own cables to
interconnect two Linux machines. The following cabling diagrams should assist
you in this. The PLIP cable is done using D-25 male connectors on both ends, while
the serial NULL-modem cable can be done using D-25 or DB-9 female connectors
on both ends.
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9.1. Serial NULL Modem cable

9.1. Serial NULL Modem cable
Not all NULL modem cables are alike. Many null modem cables do little more
than trick your computer into thinking all the appropriate signals are present and
swap transmit and receive data lines. This is OK, but it means you must use software flow control (XON/XOFF) which is less efficient than the preferred hardware
(RTS/CTS) flow control. The following cable provides the best possible signalling
between machines and allows you to use hardware flow control.

Figure 51.2. The NULL-Modem Cabling
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9.2. Parallel Port Cable (PLIP Cable)

9.2. Parallel Port Cable (PLIP Cable)
If you intend to use the PLIP protocol between two machines, then the cabling
scheme shown in Figure 51.3, “PLIP Cable Cabling” [701] works notwithstanding
the type of parallel ports the machines have.

Figure 51.3. PLIP Cable Cabling
• Do not connect the pins marked with a star;
• extra grounds are on pins 18, 19 ,20, 21 ,22 ,23 and 24;
• if the cable you are using has a metallic shield, it should be connected
to the metallic DB-25 shell at one end only.
A badly wired PLIP cable can destroy the computer's parallel port. Be
very careful and double-check every connection to ensure you don't cause
yourself any unnecessary problems.
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9.3. 10base2 (Thin Coax) Ethernet Cabling
While you may be able to run PLIP cables for long distances, you should avoid it
if you can. The specifications for the cable allow for a cable length of about 1 meter
or so. Please be very careful when running long PLIP cables as sources of strong
electromagnetic fields such as lightning, power lines and radio transmitters can
interfere with and sometimes even damage your controller. If you really want to
connect two of your computers over a large distance, you really should be looking
at obtaining a pair of thin-net Ethernet cards and running some coaxial cable.

9.3. 10base2 (Thin Coax) Ethernet Cabling
10base2 is an Ethernet cabling standard which specifies the use of 50 ohm coaxial
cable with a diameter of about 5 millimeters. There are a couple of important rules
to remember when interconnecting machines with 10base2 cabling. The first is that
you must use terminators at both ends of the cabling. A terminator is a 50 ohm
resistor that helps to ensure that the signal is absorbed and not reflected when it
reaches the end of the cable. Without a terminator at each end of the cabling, you
may find that the Ethernet is unreliable or doesn't work at all. Normally, you
should use “T pieces” to interconnect the machines, so that you end up with
something that looks like what's shown in Figure 51.4, “10base2 Ethernet
Cabling” [702].

Figure 51.4. 10base2 Ethernet Cabling
Both ends have a terminator piece, the coaxial cables have BNC plugs at either
end, and “middle” computers are connected using a “T piece” connector. You
should keep the length of cable between the “T piece” and the actual Ethernet card
in the PC as short as possible, ideally the “T piece” will be plugged directly into
the Ethernet card.

9.4. Twisted-Pair Ethernet Cable
If you only have two computers with twisted pair Ethernet cards and you wish to
connect them, you do not require a hub. You can cable the two cards directly together using the cabling scheme shown in Figure 51.5, “Twisted-Pair “NULL-modem” Cabling” [703].
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9.4. Twisted-Pair Ethernet Cable

Figure 51.5. Twisted-Pair “NULL-modem” Cabling
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Appendix 1. The GNU General Public
License
The following text is the GPL license that applies to most programs found in
Mandriva Linux distributions.
Version 2, June 1991 Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59
Temple Place - Suite 330, Boston, MA 02111-1307, USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

1. Preamble
The licenses for most software are designed to take away your freedom to share
and change it. By contrast, the GNU General Public License is intended to guarantee
your freedom to share and change free software — to make sure the software is
free for all its users. This General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to using
it. (Some other Free Software Foundation software is covered by the GNU Library
General Public License instead.) You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you
receive source code or can get it if you want it, that you can change the software
or use pieces of it in new free programs; and that you know you can do these
things.
To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights. These restrictions translate
to certain responsibilities for you if you distribute copies of the software, or if you
modify it.
For example, if you distribute copies of such a program, whether gratis or for a
fee, you must give the recipients all the rights that you have. You must make sure
that they, too, receive or can get the source code. And you must show them these
terms so they know their rights.
We protect your rights with two steps:
1.

copyright the software, and
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2. Terms and conditions for copying,
distribution and modification
2.

offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone
understands that there is no warranty for this free software. If the software is
modified by someone else and passed on, we want its recipients to know that what
they have is not the original, so that any problems introduced by others will not
reflect on the original authors' reputations.
Finally, any free program is threatened constantly by software patents. We wish
to avoid the danger that redistributors of a free program will individually obtain
patent licenses, in effect making the program proprietary. To prevent this, we have
made it clear that any patent must be licensed for everyone's free use or not licensed
at all.
The precise terms and conditions for copying, distribution and modification follow.

2. Terms and conditions for copying, distribution and
modification
• 0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms
of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the Program” means either the Program
or any derivative work under copyright law: that is to say, a work containing
the Program or a portion of it, either verbatim or with modifications and/or
translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.
Activities other than copying, distribution and modification are not covered
by this License; they are outside its scope. The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program). Whether that is true depends on what the Program does.
• 1. You may copy and distribute verbatim copies of the Program's source code
as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer
of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of
this License along with the Program.
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2. Terms and conditions for copying,
distribution and modification
You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.
• 2. You may modify your copy or copies of the Program or any portion of it,
thus forming a work based on the Program, and copy and distribute such
modifications or work under the terms of Section 1 above, provided that you
also meet all of these conditions:
1.

You must cause the modified files to carry prominent notices stating that
you changed the files and the date of any change.

2.

You must cause any work that you distribute or publish, that in whole or
in part contains or is derived from the Program or any part thereof, to be
licensed as a whole at no charge to all third parties under the terms of this
License.

3.

If the modified program normally reads commands interactively when
run, you must cause it, when started running for such interactive use in
the most ordinary way, to print or display an announcement including an
appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that users may redistribute
the program under these conditions, and telling the user how to view a
copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program
is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License,
and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which
is a work based on the Program, the distribution of the whole must be on the
terms of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to
work written entirely by you; rather, the intent is to exercise the right to control
the distribution of derivative or collective works based on the Program.
In addition, mere aggregation of another work not based on the Program with
the Program (or with a work based on the Program) on a volume of a storage
or distribution medium does not bring the other work under the scope of this
License.
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2. Terms and conditions for copying,
distribution and modification
• 3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:
1.

Accompany it with the complete corresponding machine-readable source
code, which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,

2.

Accompany it with a written offer, valid for at least three years, to give
any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and
2 above on a medium customarily used for software interchange; or,

3.

Accompany it with the information you received as to the offer to distribute
corresponding source code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object code
or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making
modifications to it. For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of
the executable. However, as a special exception, the source code distributed
need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself
accompanies the executable.
If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.
• 4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.
• 5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Pro708

2. Terms and conditions for copying,
distribution and modification
gram or its derivative works. These actions are prohibited by law if you do not
accept this License. Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License
to do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.
• 6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to copy,
distribute or modify the Program subject to these terms and conditions. You
may not impose any further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by third
parties to this License.
• 7. If, as a consequence of a court judgment or allegation of patent infringement
or for any other reason (not limited to patent issues), conditions are imposed
on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this
License. If you cannot distribute so as to satisfy simultaneously your obligations
under this License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent license would
not permit royalty-free redistribution of the Program by all those who receive
copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the
Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section
as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this section
has the sole purpose of protecting the integrity of the free software distribution
system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through
that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through
any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.
• 8. If the distribution and/or use of the Program is restricted in certain countries
either by patents or by copyrighted interfaces, the original copyright holder
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NO WARRANTY
who places the Program under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License
incorporates the limitation as if written in the body of this License.
• 9. The Free Software Foundation may publish revised and/or new versions of
the General Public License from time to time. Such new versions will be similar
in spirit to the present version, but may differ in detail to address new problems
or concerns.
Each version is given a distinguishing version number. If the Program specifies
a version number of this License which applies to it and "any later version",
you have the option of following the terms and conditions either of that version
or of any later version published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any
version ever published by the Free Software Foundation.
• 10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY
• 11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS
NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING
THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE
OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
• 12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED
TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY
WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMIT710

NO WARRANTY
TED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD
PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY
OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
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Appendix 2. Glossary
account
On a UNIX® system, the combination of a name, a personal directory, a password and a shell which allows a user to connect to the system.
alias
A mechanism used in a shell in order to substitute one string for another before executing a command. You can see all aliases defined in the current session
by typing alias at the prompt.
ACPI
Advanced Configuration and Power Interface. A feature used to recognize and
configure hardware and for power management. Unlike APM, which relies
on the BIOS only, ACPI also relies on the operating system, making its control
more simple for the user. ACPI also brings power management capabilities to
servers and workstations.
APM
Advanced Power Management. A feature used by some BIOSes in order to make
the machine enter a standby state after a given period of inactivity. On laptops,
APM is also responsible for reporting the battery status and (if supported) the
estimated remaining battery life. However, newer laptops are based on ACPI
rather than APM.
See Also ACPI.
ARP
Address Resolution Protocol. The Internet protocol used to dynamically map an
Internet address to a physical (hardware) address on a local area network. This
is limited to networks which support hardware broadcasting.
ASCII
American Standard Code for Information Interchange. The standard code used for
storing characters, including control characters, on a computer. Many 8-bit
codes (such as ISO 8859-1, usually the Linux default character set, unless you
have chosen to use something like UTF-8) contain ASCII as their lower half.
See Also ISO 8859, UTF-8.
assembly language
Is the programming language that is closest to the computer, which is why it's
called a “low level” programming language. Assembly has the advantage of
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speed since assembly programs are written in terms of processor instructions
so little or no translation is needed when generating executables. Its main
disadvantage is that it is processor (or architecture) dependent. Writing complex
programs is very time-consuming as well. So, assembly is the fastest programming language, but it isn't portable between architectures.
ATAPI
AT Attachment Packet Interface. An extension to the ATA specification (Advanced
Technology Attachment, more commonly known as IDE, Integrated Drive Electronics) which provides additional commands to control CD-ROM drives and
magnetic tape drives. IDE controllers equipped with this extension are also
referred to as EIDE (Enhanced IDE) controllers.
See Also IDE.
ATM
This is an acronym for Asynchronous Transfer Mode. An ATM network packages
data into standard size blocks (53 bytes: 48 for the data and 5 for the header)
which can be conveyed efficiently from point to point. ATM is a circuit switched
packet network technology oriented towards high speed (multi-megabit) networks.
atomic
A set of operations is said to be atomic when they execute all at once and
cannot be preempted. It is commonly used for an “all or nothing” set: either
all of the operations perform successfully or none of them are taken into account. It might also be used for essential or very simple operations, like the
sum of two integral numbers.
background
In shell context, a process is running in the background if you can type
commands that are captured by the process while it is running. It is the opposite
of a foreground process.
See Also job, foreground.
backup
A means of saving important data to a safe medium and location. Backups
should be made regularly, especially with more critical information and configuration files (the most important directories to backup are /etc, /home and
/usr/local). Traditionally, many people use tar with gzip or bzip2 to backup
directories and files. You can use these tools or programs like dump and restore,
along with many other free or commercial backup solutions.
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batch
A processing mode where jobs or instructions which are submitted to the CPU
are executed sequentially until all have been processed.
beep
The little noise your computer's speaker emits to warn you of some ambiguous
situation when you're using command completion and, for example, there's
more than one possible choice for completion. There might be other programs
that make beeps to let you know of some particular situation.
beta testing
The name given to the process of testing the beta version of a program. Programs usually get released in “alpha”, “beta” and “release candidate” states
for testing prior to final release.
binary
In the context of programming, binaries are the compiled, executable code.
bit
Stands for BInary digiT. A single digit which can take the values 0 or 1, because
calculation is done in base two. It is the most basic unit of digital information.
block mode files
Files whose contents are buffered. All read/write operations for such files go
through buffers, which allow for asynchronous reads and writes to the underlying hardware, which prevents the system from making disk accesses if the
data is already in a buffer.
See Also buffer, buffer cache, character mode files.
boot
The procedure taking place when a computer is ifirst switched on, where
peripherals are recognized sequentially and where the operating system is
loaded into memory.
boot disk
A bootable disk (floppy, CD, DVD, or any other device) containing the code
necessary to load the operating system from the hard disk (sometimes it is
self-sufficient).
bootloader
This is a program which starts the operating system. Many bootloaders give
you the opportunity to load more than one operating system by allowing you
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choose between them from a menu. Bootloaders such as GRUB and LILO are
popular because of this feature and are very useful in dual- or multi-boot
systems.
BSD
Berkeley Software Distribution. A UNIX® variant developed at the Berkeley
University computing department. This version has always been considered
more technically advanced than the others, and has brought many innovations
to the computing world in general and to UNIX® in particular.
buffer
A small portion of memory of fixed size, which can be associated with a block
mode file, a system table, a process and so on. The buffer cache maintains coherency of all buffers.
See Also buffer cache.
buffer cache
A crucial part of an operating system kernel, it is in charge of keeping all buffers
up-to-date, shrinking the cache when needed, clearing unneeded buffers and
more.
See Also buffer.
bug
Illogical or incoherent behavior of a program in a special case, or a behavior
that does not follow the documentation or accepted standards issued for the
program. Often, new features introduce new bugs in a program. Historically,
this term comes from the old days of punch cards: a bug (the insect!) slipped
into a hole of a punch card and, as a consequence, the program misbehaved.
Admiral Grace Hopper, having discovered this, declared “It's a bug!”, and
since then the term has remained. Note that this is only one of the many stories
which attempt to explain the term bug.
byte
A sequence of, usually, eight consecutive bits, which when converted to base
ten result in an integer number between 0 and 255. A byte is always “atomic”
on the system, meaning that it is the smallest addressable unit.
See Also bit.
case
When taken in the context of strings, the case is the difference between
lowercase letters and uppercase (or capital) letters.
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CHAP
Challenge-Handshake Authentication Protocol: A protocol used by ISPs to authenticate their clients. In this scheme, a value is sent to the client (the machine
making the connection), which it uses to calculate a hash based on the value.
The client sends the hash back to the server for comparison to the hash calculated by the server. This authentication method is different to PAP in that it
re-authenticates on a periodic basis after the initial authentication.
See Also PAP.
character mode files
Files whose content is not buffered. When associated with physical devices,
all input/output on these devices is performed immediately. Some special
character devices are created by the operating system (/dev/zero, /dev/null
and others). They correspond to data flows.
See Also block mode files.
CIFS
Common Internet File System. The successor to the SMB file system, used on
DOS systems.
See Also SMB.
client
A program or computer which sporadically connects, for a given period of
time, to another program or computer to give it orders or ask for information.
In the case of peer to peer systems such as SLIP or PPP the client is taken to be
the end which initiates the connection, the remote end receiving the call is
designated as the server. It is one of the components of a client/server system.
See Also server.
client/server system
System or protocol consisting of a server and one or more clients.
command line
Provided by a shell and which allows the user to type commands directly.
Also subject of an eternal “flame war” between its supporters and its detractors.
command mode
Under Vi or its clones, it is the state of the program in which pressing a key
does not insert the character into the file being edited, but instead performs
an action specific to the key (unless the clone has re-mappable commands and
you have customized your configuration). You may get out of it typing one of
the “back to insertion mode” commands: i , I , a , A , s , S , o , O , c , C , ...
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compilation
Is the process of translating source code which is human readable (well, with
some training) and which is written in some programming language (C, for
example) into a binary file which is machine readable.
completion
The ability of a shell to automatically expand a substring to a filename, user
name or other item, as long as there is a match.
compression
A way to shrink files or decrease the number of characters sent over a communications link. File compression programs include compress, zip, gzip, and
bzip2.
console
This is the name given to what used to be called terminals. They were the
machines (a screen plus a keyboard) connected to one big central mainframe.
On PCs, the physical terminal is the keyboard and screen.
See Also virtual console.
cookies
Temporary files written on the local hard disk by a remote web server. They
allows the server to be aware of a user's preferences when this user connects
again.
datagram
A datagram is a discrete package of data and headers which contain addresses.
It is the basic unit of transmission across an IP network. You might also hear
this called a “packet”.
dependencies
The stages of compilation which need to be satisfied before going on to other
compilation stages in order to successfully compile a program. This term is
also used where one set of programs you wish to install are dependent on
other programs which may or may not be installed on your system, in which
case you may get a message telling you that the system needs to “satisfy dependencies” in order to continue the installation.
desktop
If you're using the X Window System, the desktop is the place on the screen
where you work and upon which your windows and icons are displayed. It
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is also called the background, and is usually filled with a simple color, a
gradient color or even an image.
See Also virtual desktops.
DHCP
Dynamic Host Configuration Protocol. A protocol designed for machines on a
local network to dynamically get an IP address and other network settings
from a server.
directory
Part of the file system structure. Files or other directories can be stored within
a directory. Sometimes there are subdirectories (or branches) within a directory.
This is often referred to as a directory tree. If you want to see what's inside
another directory, you will either have to list it or change to it. Files inside a
directory are referred to as leaves while subdirectories are referred to as
branches. Directories follow the same restrictions as files although the permissions mean different things. The special directories . and .. refer to the directory itself and to the parent directory respectively. In graphical environments
it is also known as a folder.
discrete values
Are values which are non-continuous. That is, there's some kind of “spacing”
between consecutive values.
distribution
Is a term used to distinguish one GNU/Linux manufacturer's product from
another. A distribution is made up of the core Linux kernel and utilities, as
well as installation programs, third-party programs, and sometimes proprietary
software.
DLCI
The DLCI is the Data Link Connection Identifier and is used to identify a unique
virtual point to point connection via a Frame Relay network. The DLCIs are
normally assigned by the Frame Relay network provider.
DMA
Direct Memory Access. A facility used in the PC architecture which allows a
peripheral to read or write from main memory without the help of the CPU.
PCI peripherals use bus mastering and do not need DMA. Bus mastering allows
a controller to talk to other devices without going through the CPU.
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DNS
Domain Name System. The distributed name and address mechanism used in
the Internet. This mechanism allows you to map a domain name to an IP address, allowing you to look up a site by domain name without knowing the
IP address of the site. DNS also allows reverse lookup, allowing you to obtain
a machine's name from its IP address.
DPMS
Display Power Management System. Protocol used by all modern monitors to
manage power saving features. Monitors supporting these features are commonly called “green” monitors.
echo
Occurs when the characters you type are shown on the screen, such as in a
user name entry field, for example. Some programs may also mask what is
typed for security reasons. The example is a password prompt showing an *,
or even nothing at all, for each typed char instead of the character itself.
editor
Is a term typically used for programs which edit text files (aka text editor). The
most well-known GNU/Linux editors are the GNU Emacs (Emacs) editor and
the UNIX® editor Vi.
ELF
Executable and Linking Format. This is the binary format used by most
GNU/Linux distributions.
email
Stands for Electronic Mail. This is a way to send messages electronically.
Similar to regular mail (aka snail mail), email needs a destination and sender
address to be sent properly. The sender must have an address like
“sender@senders.domain” and the recipient must have an address like “recipient@recipients.domain.” Email is a very fast method of communication and
typically only takes a few minutes to reach anyone, regardless of where in the
world they are located. In order to write email, you need an email client such
as pine or mutt which are text-mode clients, or GUI clients such as KMail.
environment
Is the execution context of a process. It includes all the information that the
operating system needs to manage the process and what the processor needs
to execute the process properly.
See Also process.
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environment variables
A part of a process' environment. Environment variables are directly viewable
from the shell.
See Also process.
escape
In the shell context, is the action of surrounding a string with quotes to prevent
the shell from interpreting that string. For example, when you need to use
spaces in a command line and then pipe the results to some other command
you have to put the first command between quotes or precede the spaces with
a \ (“escape” the command) otherwise the shell will interpret it incorrectly
and your command won't work as expected.
ext2
Short for the “Extended 2 file system”. This is GNU/Linux's native file system
and has the characteristics of any UNIX® file system: support for special files
(character devices, symbolic links, etc), file permissions and ownership, and
other features.
FAQ
Frequently Asked Questions. A document containing a series of questions and
answers about a specific topic. Historically, FAQs appeared in newsgroups,
but this sort of document now appears on various web sites, and even commercial products have FAQs. Generally, they are very good sources of information.
FAT

File Allocation Table. File system used by DOS and Windows®.

FDDI
Fiber Distributed Digital Interface. A high-speed network physical layer, which
uses optical fiber for communication instead of wire. Mostly used on large
networks, mainly because of its price. It is rarely seen as a means of connection
between a PC and a network switch.
FHS
File system Hierarchy Standard. A document containing guidelines for a coherent
file tree organization on UNIX® systems. Mandriva Linux complies with this
standard in most aspects.
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FIFO
First In, First Out. A data structure or hardware buffer where items are taken
out in the order they were put in. UNIX® pipes are the most common examples
of FIFOs.
filesystem
Scheme used to store files on physical media (hard drive, floppy, etc.) in a
consistent manner. Examples of file systems are FAT, GNU/Linux' ext2fs,
ISO9660 (used by CD-ROMs) and so on. An example of a virtual filesystem is
the /proc filesystem.
firewall
A machine or a dedicated piece of hardware which in the topology of a local
network is the single connection point to the outside network, and which filters
and controls the activity on some ports, or makes sure that only some specific
interfaces may have access to, or can be accessed from, the outside world.
flag
Is an indicator (usually a bit) that is used to signal some condition to a program.
For example, a filesystem has, among others, a flag indicating if it has to be
dumped in a backup, so when the flag is active the filesystem gets backed up,
and when it's inactive it doesn't.
focus
The state of a window to receive keyboard events (such as key-presses, keyreleases and mouse clicks) unless they are trapped by the window manager.
foreground
In shell context, the process in the foreground is the one that is currently running and has keyboard and screen control. You have to wait for such a process
to finish in order to be able to type commands again.
See Also job, background.
Frame Relay
Frame Relay is a network technology ideally suited to carrying traffic which
is of a bursty or sporadic nature. Network costs are reduced by having many
Frame Relay customers sharing the same network capacity and relying on
them wanting to make use of the network at slightly different times.
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framebuffer
Projection of a video card's RAM into the machine's address space. This allows
applications to access the video RAM without the chore of having to talk to
the card. All high-end graphical workstations use frame buffers.
FTP
File Transfer Protocol. This is the standard Internet protocol used to transfer
files from one machine to another.
full-screen
This term is used to refer to applications that take up the entire visible area of
your display.
gateway
Machine or device giving a local network access to an outside network.
GFDL
The GNU Free Documentation License. The license which applies to all Mandriva Linux documentation.
GIF
Graphics Interchange Format. An image file format, widely used on the web.
GIF images may be compressed or animated. Due to copyright problems it is
a bad idea to use them, the recommended solution is to replace them as much
as possible by the PNG format.
See Also PNG.
globbing
In the shell, the ability to group a certain set of file names with a globbing
pattern.
See Also globbing pattern.
globbing pattern
A string made of normal characters and special characters. Special characters
are interpreted and expanded by the shell.
GNU
GNU's Not Unix. The GNU project was initiated by Richard Stallman at the
beginning of the 1980s, and aimed at developing a free operating system (“free”
as in “free speech”). Currently, all tools are there, except... the kernel. The GNU
project kernel, Hurd, is not rock solid yet. Linux borrows, among others, two
things from GNU: its C compiler, gcc, and its license, the GPL.
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See Also GPL.
GPL
General Public License. The license of the GNU/Linux kernel, it goes the opposite
way to all proprietary licenses in that it applies no restrictions as to copying,
modifying and redistributing the software, as long as the source code is made
available. The only restriction is that the persons to whom you redistribute it
must also benefit from the same rights.
GUI
Graphical User Interface. Interface to a computer consisting of windows with
menus, buttons, icons and so on. A great majority of users prefer a GUI to a
CLI (Command Line Interface) for ease of use, even though the latter is far more
versatile.
guru
An expert. Used to qualify someone particularly skilled, but also of valuable
help for others.
hardware address
This is a number which uniquely identifies a host in a physical network at the
media access layer. Examples of this are Ethernet Addresses and AX.25 Addresses.
hidden file
A file which can't be “seen” when doing a ls command without options. The
names of hidden files begin with a . and are used to store the user's personal
preferences and configurations for the different programs he uses. For example,
bash's command history is saved into .bash_history, a hidden file.
home directory
Often abbreviated as “home”, this is the name for the personal directory of a
given user.
See Also account.
host
Refers to a computer and is commonly used when talking about computers
which are connected to a network.
HTML
HyperText Markup Language. The language used to create web documents.
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HTTP
HyperText Transfer Protocol. The protocol used to connect to web sites and retrieve HTML documents or files.
icon
Is a little drawing (normally sized 16x16, 32x32, 48x48 and sometimes 64x 64
pixels) which in a graphical environment represents a document, a file or a
program.
IDE
Integrated Drive Electronics. The most widely used bus on today's PCs for hard
disks. An IDE bus may contain up to two devices, and the speed of the bus is
limited by the device on the bus with the slowest command queue (and not
the slowest transfer rate!).
See Also ATAPI, SATA, S-ATA.
IMAP
Internet Message Access Protocol. A protocol which allows you to access your
email messages on a remote server, without the need to transfer them locally
first; as opposed to the POP mail retrieval protocol.
See Also POP.
inode
Entry point leading to the contents of a file on a UNIX®-like filesystem. An
inode is identified in a unique way with a number, and contains meta-information about the file it refers to, such as its access times, its type, its size, but not
its name!
insert mode
Under Vi or any of its clones, it is the state of the program in which pressing
a key will insert that character in the file being edited (except pathological
cases such as the completion of an abbreviation, right justify at the end of the
line, ...). One gets out of it pressing the Esc key, (or Ctrl-[ ).
Internet
Is a huge network which connects computers around the world.
IP address
Is a numeric address consisting (in version 4, also called IPv4) of four parts
which identifies your computer on a network. IP addresses are structured in
a hierarchical manner, with top level and national domains, domains, subdomains and each machine's personal address. An IP address will look some725

thing like 192.168.0.1. A machine's personal address can be one of two types:
static or dynamic. Static IP addresses are addresses which never change, they
are permanently assigned. Dynamic IP addresses mean that an IP address will
change with each new connection to the network. Most home users typically
have dynamic IP addresses while most corporate users typically have static
IP addresses.
IP masquerading
This is a technique where a firewall is used to hide your computer's true IP
address from the outside. Typically, any outside network connections you
make through the firewall will inherit the firewall's IP address. This is useful
in situations where you may have a fast Internet connection with only one IP
address but wish to use more than one computer on your internal network.
IRC
Internet Relay Chat. One of the few Internet standards for live speech. It allows
for channel creation, private talks and file exchange. It also allows servers to
connect to each other, which is why several IRC networks exist today: Undernet,
DALnet, EFnet to name a few.
IRC channels
Are the “places” inside IRC servers where you can chat with other people.
Channels are created in IRC servers and users join those channels so they can
communicate with each other. Messages written on one channel are only visible
to the people connected to that channel. Two or more users can create a
“private” channel so they don't get disturbed by other users. Channel names
begin with a #.
ISA
Industry Standard Architecture. The very first bus used on PCs, it is slowly being
abandoned in favor of the PCI bus. ISA is still commonly found on SCSI cards
supplied with scanners, CD writers and some other older hardware.
ISDN
Integrated Services Digital Network. A set of communication standards for voice,
digital network services and video. It has been designed to eventually replace
the current phone system, known as PSTN (Public Switched Telephone Network)
or POTS (Plain Old Telephone Service). ISDN is known as a circuit switched data
network.
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ISO
International Standards Organization. A group of companies, consultants, universities and other sources which enumerate standards in various disciplines,
including computing. The papers describing standards are numbered. The
standard number iso9660, for example, describes the file system used on CDROMs.
ISO 8859
The ISO 8859 standard includes several 8-bit extensions to the ASCII character
set. Especially important is ISO 8859-1, the “Latin Alphabet No. 1”, which has
become widely implemented and may already be seen as the de facto standard
ASCII replacement.
ISO 8859-1 supports the following languages: Afrikaans, Basque, Catalan,
Danish, Dutch, English, Faroese, Finnish, French, Galician, German, Icelandic,
Irish, Italian, Norwegian, Portuguese, Scottish, Spanish, and Swedish.
Note that the ISO 8859-1 characters are also the first 256 characters of ISO 10646
(Unicode). However, it lacks the EURO symbol and does not fully cover Finnish
and French. ISO 8859-15 is a modification of ISO 8859-1 to covers these needs.
See Also ASCII, UTF-8.
ISP
Internet Service Provider. A company which sells Internet access to customers,
either over telephone lines or high-bandwidth circuits such as dedicated T-1
circuits, DSL or cable.
JPEG
Joint Photographic Experts Group. Another very common image file format. JPEG
is mostly suited for compressing real-world scenes, and does not work very
well on non-realistic images.
job
In a shell context, a job is a process running in the background. You can have
several jobs running in the same shell and control each job independently.
See Also foreground, background.
journaling
Journaling adds robustness to a file system, by making it transactional. Thus,
instead of physically writing data at the moment it's asked for, a journal of the
writes is kept, and data is written “in a block” at a later time which also has a
great impact on performance and on the time needed to analyze and fix the
file system, if needed.
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kernel
Is the core of the operating system. The kernel is responsible for allocating resources and separating processes from each other. It handles all of the lowlevel operations which allow programs to talk directly to the hardware on
your computer, manages the buffer cache and so on.
kill ring
Under Emacs, it is the set of text areas cut or copied since the editor was started.
The text areas may be recalled to be inserted again, and the structure is ringlike.
LAN
Local Area Network. Generic name given to a network of machines connected
to the same physical wiring in a reduced geographical area, such as the same
office or building.
See Also WAN.
launch
Is the action of invoking, or starting, a program.
library
Is a collection of procedures and functions in binary form to be used by programmers in their programs (as long as the library's license allows them to do
so). The program in charge of loading shared libraries at run time is called the
dynamic linker.
link
Reference to an inode in a directory, therefore giving a (file) name to the inode.
Examples of inodes which don't have a link (and hence have no name) are:
anonymous pipes (as used by the shell), sockets (aka network connections),
network devices and so on.
linkage
The last stage of the compilation process, consisting of linking together all
object files in order to produce an executable file, and matching unresolved
symbols with dynamic libraries (unless a static linkage has been requested, in
which case the code of these symbols will be included in the executable).
Linux
Is a UNIX®-like operating system which runs on a variety of different computers, and is free for anyone to use and modify. Linux (the kernel) was written
by Linus Torvalds.
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login
Connection name for a user on a UNIX® system, and the action to connect.
lookup table
Is a table which stores corresponding codes (or tags) and their meanings. It is
often a data file used by a program to get further information about a particular
item.
For example, HardDrake uses such a table to store a manufacturer's product
codes and associated configuration information. This is one line from that
table, giving information about item CTL0001
"CTL0001"
"sb"
"Creative Labs|SB16"
"HAS_OPL3|HAS_MPU401|HAS_DMA16|HAS_JOYSTICK"

"sound" →

loopback
Virtual network interface of a machine to itself, allowing the running programs
not to have to take into account the special case where two network entities
are in fact the same machine.
major
Number specific to the device class.
manual page
Small documents containing the definitions of a command and its usage, to
be consulted with the man command. The first thing one should (learn how
to) read when learning about a command one isn't familiar with.
MBR
Master Boot Record. Name given to the first sector of a bootable hard drive. The
MBR contains the code used to load the operating system into memory or a
bootloader (such as LILO), and the partition table of that hard drive.
MIME
Multipurpose Internet Mail Extensions. A string of the form type/subtype describing the contents of a file attached in an e-mail. This allows MIME-aware
mail clients to define actions depending on the type of the file.
minor
Number identifying the specific device we are talking about.
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MPEG
Moving Picture Experts Group. An ISO committee which generates standards
for video and audio compression. MPEG is also the name of their algorithms.
Unfortunately, the license for this format is very restrictive, and as a consequence there are still no Open Source MPEG players...
mount point
Is the place or directory where a partition or another device is attached to the
GNU/Linux filesystem. For example, your CD-ROM is mounted in the
/mnt/cdrom directory, from where you can explore the contents of any
mounted CDs.
mounted
A device is mounted when it is attached to the GNU/Linux filesystem. When
you mount a device you can browse its contents. This term is partly obsolete
due to the “supermount” feature, so users do not need to manually mount
removable media.
See Also mount point.
MSS
The Maximum Segment Size is the largest quantity of data which can be transmitted at one time across an interface. If you want to prevent local fragmentation MSS would equal the MTU IP header.
MTU
The Maximum Transmission Unit is a parameter which determines the size of
the largest datagram which can be transmitted by an IP interface without it
needing to be broken down into smaller units. The MTU should be larger than
the largest datagram you wish to transmit without fragmentation. Note, this
only prevents fragmentation locally, some other link in the path may have a
smaller MTU and the datagram will be fragmented there. Typical values are
1500 bytes for an Ethernet interface, or 576 bytes for a PPP interface.
multitasking
The ability of an operating system to share CPU time between several processes.
At a low level, this is also known as multiprogramming. Switching from one
process to another requires that all the current process context be saved and
restored when this process runs again. This operation is called a context switch,
and is done several times per second, thereby making it fast enough so that a
user has the illusion that the operating system runs several applications at the
same time. There are two types of multitasking: in preemptive multitasking
the operating system is responsible for taking away the CPU and passing it to
730

another process; cooperative multitasking is where the process itself gives
back the CPU. The first variant, used by GNU/Linux, is obviously the better
choice because no program can consume the entire CPU time and block other
processes. The policy to select which process should be run, depending on
several parameters, is called scheduling.
multiuser
Is used to describe an operating system which allows multiple users to log
into and use the system at the exact same time, each user being able to do their
own work independent of other users. A multitasking operating system is required to provide multiuser support. GNU/Linux is both a multitasking and
multiuser operating system, as is any UNIX® system for that matter.
named pipe
A UNIX® pipe which is linked, as opposed to pipes used in shells.
See Also pipe, link.
naming
A word commonly used in computing for a method to identify objects. You
will often hear of “naming conventions” for files, functions in a program and
so on.
NCP
NetWare Core Protocol. A protocol defined by Novell to access Novell NetWare™
file and print services.
NFS
Network File System. A network file system created by Sun Microsystems in order
to share files across a network in a transparent way.
newsgroups
Discussion and news areas which can be accessed by a news or USENET client
to read and write messages specific to the topic of the newsgroup. For example,
the newsgroup alt.os.linux.mandrake is an alternate newsgroup (alt) dealing
with the Operating System (OS) GNU/Linux (linux), and specifically, Mandriva
Linux (mandrake). Newsgroups are broken down in this fashion to make it
easier to search for a particular topic.
NIC
Network Interface Controller. An adapter installed in a computer which provides
a physical connection to a network, such as an Ethernet card.
731

NIS
Network Information System. NIS was also known as “Yellow Pages”, but British
Telecom holds a copyright on this name. NIS is a protocol designed by Sun
Microsystems in order to share common information across a NIS domain, which
may consist of an entire LAN, or just a part of it. It can export password databases, service databases, groups information and more.
null, character
The character or byte number 0. It is used to mark the end of a string.
object code
Is the code generated by the compilation process to be linked with other object
codes and libraries to form an executable file. Object code is machine readable.
See Also compilation, linkage.
on the fly
Something is said to be done “on the fly” when it's done along with something
else, without you noticing it or explicitly asking for it.
open source
Is the name given to free source code of a program which is made available
to the development community and public at large. The theory behind this is
that allowing source code to be used and modified by a broader group of
programmers will ultimately produce a more useful product for everyone.
Some popular open source programs include Apache, sendmail and
GNU/Linux.
operating system
Is the interface between the applications and the underlying hardware. The
tasks for any operating system are primarily to manage all of the machine
specific resources. On a GNU/Linux system, this is done by the kernel and
loadable modules. Other well-known operating systems include Amiga®OS,
Mac OS®, FreeBSD®, OS/2®, UNIX®, and Windows® in all its variants.
owner
In the context of users and their files, the owner of a file is the user who created
that file.
owner group
In the context of groups and their files, the owner group of a file is the group
to which the user who created that file belongs.
732

PAP
Password Authentication Protocol. A protocol used by many ISPs to authenticate
their clients. In this scheme, the client (you) sends an identifier/password pair
to the server, but none of the information is encrypted. CHAP is a more secure,
and thus preferred, authentication protocol.
See Also CHAP.
pager
A program which displays a text file one screen at a time, making it easy to
move back and forth and search for strings in this file. We suggest you to use
less.
password
Is a secret word or combination of words or letters which is used to secure
something. Passwords are used in conjunction with user logins to multi-user
operating systems, web sites, FTP sites, and so forth. Passwords should be
hard-to-guess phrases or alphanumeric combinations, and should never be
based on common dictionary words. Passwords ensure that other people
cannot log into a computer or site with your account.
patch, to patch
A file containing a list of corrections to issue to source code in order to add
new features, to remove bugs, or to modify it according to one's wishes and
needs. The action consisting of the application of these corrections to the archive
of source code (aka “patching”).
path
Is an assignment for files and directories to the filesystem. The different layers
of a path are separated by the "slash" or '/' character. There are two types of
paths on GNU/Linux systems. The relative path is the position of a file or directory in relation to the current directory. The absolute (or full) path is the position of a file or directory in relation to the root directory.
PCI
Peripheral Component Interconnect. A bus created by Intel which today is the
standard bus for PC and other architectures. It is the successor to ISA, and it
offers numerous services: device identification, configuration information,
IRQ sharing, bus mastering and more.
PCMCIA
Personal Computer Memory Card International Association. More and more commonly called “PC Card” for simplicity reasons, this is the standard for external
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cards attached to a laptop: modems, hard disks, memory cards, Ethernet
cards, and more. The acronym is sometimes humorously expanded to People
Cannot Memorize Computer Industry Acronyms...
pipe
A special UNIX® file type. One program writes data into the pipe, and another
program reads the data from the other end. UNIX® pipes are FIFOs, so the
data is read at the other end in the order it was sent. Very widely used with
the shell. See also named pipe.
pixmap
Is an acronym for “pixel map”. It's another way of referring to bitmap images.
plugin
Add-on program used to display or play some multimedia content found on
a web document. It can usually be easily downloaded if your browser is not
yet able to display or play that kind of information.
PNG
Portable Network Graphics. Image file format created mainly for web use, it has
been designed as a patent-free replacement for GIF and also has some additional features.
PnP
Plug'N'Play. First an add-on for ISA in order to add configuration information
for devices, it has become a more widespread term which groups all devices
able to report their configuration parameters. All PCI devices are Plug'N'Play.
POP
Post Office Protocol. One common protocol used for retrieving mail from an
ISP. IMAP is an example of another remote-access mail protocol.
See Also IMAP.
porting
One of two ways to run a program on a system it was not originally intended
for. For example, to be able to run a Windows®-native program under
GNU/Linux (natively), it must first be ported to GNU/Linux.
PPP
Point to Point Protocol. This is the protocol used to send data over serial lines.
It is commonly used to send IP packets to the Internet, but it can also be used
with other protocols such as Novell's IPX protocol.
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precedence
Dictates the order of evaluation of operands in an expression. For example: If
you have 4 + 3 * 2 you get 10 as the result, since the multiplication has
higher precedence than the addition. If you want to evaluate the addition first,
then you have to add parenthesis like this: (4 + 3) * 2. When you do this,
you'll get 14 as the result since the parenthesis have higher precedence than
the addition and the multiplication, so the operations in parenthesis get evaluated first.
preprocessors
Are compilation directives which instruct the compiler to replace those directives for code in the programming language used in the source file. Examples
of C 's preprocessors are #include, #define, etc.
process
In the operating system context, a process is an instance of a program being
executed along with its environment.
prompt
In a shell, this is the string before the cursor. When you see it, you can type
your commands.
protocol
Protocols organize the communications between different machines across a
network, either using hardware or software. They define the format of transferred data, whether one machine controls another, etc. Many well-known
protocols include HTTP, FTP, TCP, and UDP.
proxy
A machine which sits between a network and the Internet, whose role is to
speed up data transfers for the most widely used protocols (for example, HTTP
and FTP). It maintains a cache of previous requests, so that a machine which
makes a request for something which is already cached will receive it quickly,
because it will get the information from the local cache. Proxies are very useful
on low bandwidth networks (such as modem connections). Sometimes the
proxy is the only machine able to access the outside network.
pull-down menu
Is a menu that is “rolled” with a button in one of its corners. When you press
that button, the menu “unrolls” itself, showing you the full menu.
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quota
Is a method of restricting disk usage and place limits on users. Administrators
can restrict the size of home directories for a user by setting quota limits on
specific file systems.
RAID
Redundant Array of Independent Disks. A project initiated at the computing science department of Berkeley University, in which the storage of data is spread
across an array of disks using different schemes. At first, this was implemented
using low-cost, older, drives, which is why the acronym originally stood for
Redundant Array of Inexpensive Disks.
RAM
Random Access Memory. Term used to identify a computer's main memory. The
“Random” here means that any part of the memory may be directly accessed.
read-only mode
For a file means that the file cannot be written to. You may read its content
but you cannot modify it.
See Also read-write mode.
read-write mode
For a file, it means that the file can be written to. You may read its content and
modify them.
See Also read-only mode.
regular expression
A powerful theoretical tool which is used to search and match text strings. It
lets one specify patterns these strings must obey. Many UNIX® utilities use it:
sed, awk, grep, perl and others.
RFC
Request For Comments. RFCs are the official Internet standard documents,
published by the IETF (Internet Engineering Task Force). They describe all protocols, their usage, their requirements and so on. When you want to learn how
a protocol works, pick up the corresponding RFC.
root
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Is the superuser of any UNIX® system. Typically root (aka the system administrator) is the person responsible for maintaining and supervising the UNIX®
system. This person also has complete access to everything on the system.

root directory
This is the top level directory of a filesystem. This directory has no parent
directory, thus '..' for root points back to itself. The root directory is written as
'/'.
root filesystem
This is the top level filesystem. This is the filesystem where GNU/Linux mounts
its root directory tree. It is necessary for the root filesystem to reside in a partition of its own, as it is the basis for the whole system. It contains the root
directory.
route
Is the path which your datagrams take through the network to reach their
destination. It is the path between one machine and another in a network.
RPM
RPM Package Manager. A packaging format developed by Red Hat in order to
create software packages, it is used in many GNU/Linux distributions, including Mandriva Linux.
run level
Is a configuration of the system software which only allows certain selected
processes to exist. Allowed processes are defined, for each runlevel, in the file
/etc/inittab. Usually, there are seven defined runlevels: 0, 1, 2, 3, 4, 5, 6 and
switching between them can only be achieved by a privileged user by means
of executing the commands init and telinit.
SATA, S-ATA
Serial ATA. The successor to the ATA specification. First generation SATA has
a bandwidth of 1.5Gbps, but the serial link and underlying technologies allow
for much greater bandwidths, while parallel ATA has reached its practical
limits with UDMA133.
See Also ATAPI, IDE.
script
shell scripts are sequences of commands to be executed as if they were sequentially entered in the console. shell scripts are UNIX®'s (somewhat) equivalent
of DOS batch files.
SCSI
Small Computers System Interface. A bus with a high throughput designed to
allow for several types of peripherals to be connected to it. Unlike IDE, a SCSI
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bus is not limited by the speed at which the peripherals accept commands.
Usually only high-end machines integrate a SCSI bus directly on the motherboard, therefore most PCs need add-on cards.
security levels
Mandriva Linux's unique feature which allows you to set different levels of
restriction according to how secure you want to make your system. There are
6 predefined levels ranging from 0 to 5, where 5 is the tightest security. You
can also define your own security level.
segmentation fault
A segmentation fault occurs when a program tries to access memory that is
not allocated to it. This generally causes the program to stop immediately.
server
A program or computer which provides a feature or service and awaits connections from clients to execute their orders or give them the information they
ask for. In the case of peer to peer systems such as SLIP or PPP, the server is
taken to be the end of the link that is called and the end calling is taken to be
the client. It is one of the components of a client/server system.
See Also client, client/server system.
shadow passwords
A password management suite on UNIX® systems in which the file containing
the encrypted passwords is not world-readable, unlike that usually found with
a normal password system. It also offers other features such as password aging.
shell
The shell is the basic interface to the operating system kernel and provides
the command line where users enter commands to run programs and system
commands. All shells provide a scripting language which can be used to
automate tasks or simplify often-used complex tasks. These shell scripts are
similar to batch files from the DOS operating system, but are much more
powerful. Some example shells are bash, sh, and tcsh.
single user
Is used to describe a state of an operating system, or even an operating system
itself, which only allows a single user to log into and use the system at any
one time.
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site dependent
Means that the information used by programs such as imake and make to
compile some source file depends on the site, the computer architecture, the
computer's installed libraries, and so on.
SMB
Server Message Block. Protocol used by Windows® machines for file and printer
sharing across a network.
See Also CIFS.
SMTP
Simple Mail Transfer Protocol. This is the common protocol for transferring
email. Mail Transfer Agents such as sendmail or postfix use SMTP. They are
sometimes called SMTP servers.
socket
File type corresponding to any network connection.
soft links
See symbolic links.
standard error
The file descriptor number 2, opened by every process, used by convention as
the file descriptor to which the process writes errors. It is usually the computer's
screen.
See Also standard input, standard output.
standard input
The file descriptor number 0, opened by every process, used by convention as
the file descriptor from which the process receives data. It is usually the computer's keyboard.
See Also standard error, standard output.
standard output
The file descriptor number 1, opened by every process, used by convention as
the file descriptor in which the process prints its output. It is usually the computer's screen.
See Also standard error, standard input.
streamer
Is a device which takes “streams” (not interrupted or divided into shorter
chunks) of characters as its input. A typical streamer is a tape drive.
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SVGA
Super Video Graphics Array. The video display standard defined by VESA for
the PC architecture. The resolution was at first 800x 600 x 16 colors, quickly
extended to 1024x768 x 16 colors, and beyond.
switch
Switches are used to change the behavior of programs, and are also called
command-line options or arguments. To determine if a program has optional
switches which may be used, read the man pages or try to pass the --help
switch to the program (i.e.. program --help).
symbolic links
Are special files, containing nothing but a string which references another file.
Any access to them is the same as accessing the file whose name is the referenced string, which may or may not exist, and the path to which can be given
in a relative or an absolute way.
target
Is the object of compilation, i.e. the binary file to be generated by the compiler.
TCP
Transmission Control Protocol. This is the most common reliable protocol which
uses IP to transfer network packets. TCP adds the necessary checks on top of
IP to make sure that packets are delivered. Unlike UDP, TCP works in connected mode, which means that two machines must have established a connection
before exchanging data.
telnet
Creates a connection to a remote host and allows you to log into the machine,
provided you have an account. Telnet is the most widely-used method of remote logins, however there are better and more secure alternatives, such as
ssh.
theme-able
A graphical application is theme-able if it is able to change its appearance in
real time. Many window managers are theme-able.
TLDP
The Linux Documentation Project. A nonprofit organization which maintains
GNU/Linux documentation. It's mostly known for documents such as HOWTOs,
but it also maintains FAQs, and even a few books.
See Also FAQ.
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traverse
For a directory on a UNIX® system, this means that the user is allowed to go
through this directory, and possibly to directories under it. This requires that
the user has execute permission on this directory.
URL
Uniform Resource Locator. A string with a special format used to identify a resource on the Internet in a unique way. The resource may be a file, a server or
other item. The syntax for a URL is
protocol://user:password@server.name[:port]/path/to/resource.
When only a machine name is given and the protocol is http://, it defaults
to retrieving the file that the server is configured to show by default, usually
it is the index.html file.
username
Is a name (or more generally a word) which identifies a user on a system. Each
username is attached to a unique and single UID (user ID)
See Also login.
UTF-8
Unicode Transformation Format 8. It is an octet (8-bit) lossless encoding of Unicode characters. UTF-8 encodes each Unicode character as a variable number
of 1 to 4 octets, where the number of octets depends on the integer value assigned to the Unicode character. It is an efficient encoding of Unicode documents which mostly use US-ASCII characters because it represents each character in the range U+0000 through U+007F as a single octet. UTF-8 is the default
encoding for XML.
See Also ISO 8859, ASCII.
variables
Are strings which are used in Makefile files to be replaced by their value each
time they appear. Usually they are set at the beginning of the Makefile. They
are used to simplify Makefile and source files tree management.
More generally, variables in programming are words which refer to other entities (numbers, strings, tables, etc.) that are likely to vary while the program
is executing.
verbose
For commands, the verbose mode means that the command reports to standard
(or possibly error) output all the actions it performs and the results of those
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actions. Sometimes, commands have a way to define the “verbosity level”,
which means that the amount of information that the command will report
can be controlled.
VESA
Video Electronics Standards Association. An industry standards association aimed
at the PC architecture. For example, it is the author of the SVGA standard.
virtual console
Is the name given to what used to be called terminals. On GNU/Linux systems,
you have what are called virtual consoles which enable you to use one screen
or monitor for many independently running sessions. By default, you have
six virtual consoles which can be reached by pressing ALT - F1 through
ALT - F6 . There is a seventh virtual console, ALT - F7 , which will permit you
to reach a running X Window System. In X, you can reach the text console by
pressing CTRL - ALT - F1 through CTRL - ALT - F6 .
See Also console.
virtual desktops
In the X Window System, the window manager may provide you with several
desktops. This handy feature allows you to organize your windows, avoiding
the problem of having dozens of them stacked on top of each other. It works
as if you had several screens. You can switch from one virtual desktop to another in a manner which depends on the window manager you're using.
See Also window manager, desktop.
WAN
Wide Area Network. This network, although similar to a LAN, connects computers on networks which are not physically connected to the same wiring
and are separated by a greater distance.
See Also LAN.
wildcard
The '*' and '?' characters are used as wildcard characters and may represent
anything. The '*' represents any number of characters, including no characters.
The '?' represents exactly one character. Wildcards are often used in regular
expressions.
window
In networking, the window is the largest amount of data that the receiving end
can accept at a given point in time.
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In the context of a graphical user environment, a window is the rectangle which
occupies a given running application which usually contains a title, a menu,
a status bar, and the application's work area.
window manager
The program responsible for the “look and feel” of a graphical environment,
dealing with window bars, frames, buttons, root menus, and some keyboard
shortcuts. Without it, it would be hard or impossible to have virtual desktops,
to resize windows on the fly, to move them around, ...
workspace switcher
A little applet which allows you to switch between the available virtual
desktops. It is also known as pager.
See Also virtual desktops.
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file, 444
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Active Directory, 22
LDAP, 22
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B
background, 46
backup, 359
Master Boot Record, 366
restore, 298, 363
tar, 361–362
wizard, 290
BIOS, 3
Plug'n'Play, 3
bookmarks, 85
boot
different run level, 364
dual-boot, 1, 32
file-system, 364
services, 30
system hanging, 363
boot disk, 357
Master Boot Record, 366
boot disk, floppy
GNU/Linux, 374
Windows, 373
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bootloader
configuration, 327
dual-boot, 366
GRUB, 24
LILO, 24
menu, 43
reinstall, 365
uninstall, 33
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null modem, 700
parallel, 701
PLIP, 701
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CD, 308
burning, 186
cdrom.img, 372
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globbing, 447
special, 451
chat, 93, 95
chkdsk, 1
CIFS, 699
clipboard, 131
collating order, 448
command
exit, 286
command line
completion, 451
introduction, 441
utilities, 467
commands
at, 480
bzip2, 483
cat, 390
cd, 388
chgrp, 445
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chkdsk, 1
chmod, 445
chown, 445
cp, 444
crontab, 479
defrag, 1
DrakConf, 201
find, 475
grep, 469
gzip, 483
init, 493
kill, killall, 489
Kppp, 371
less, 391, 449
lilo, 33
ls, 391
minicom, 371
mkdir, 441
mount, 436
mv, 443
ps, 487
pwd, 388
rm, 442
rmdir, 442
scandisk, 1
scp, 498
sed, 449
ssh, 497
ssh-add, 498
ssh-keygen, 498
tar, 361, 481
touch, 442
umount, 437
urpmi, 501
wc, 449
computer group
managing, 219
configuration, 25
general, 199
console, 382
access, 286

switch to another, 368
virtual terminal, 286
country
configuration, 26

DrakPerm, 320
DrakSec, 317
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DVD, 308
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date
adjust, 280
defrag, 1
dependencies
automatic, 21
desktop, 46
environment, 55
virtual, 48
development, xxiii
devices
removable, 308
DHCP, 268, 695
digital photo cameras, 161
directory
copying, 444
creating, 441
deleting, 442
moving, 443
renaming, 443
DiskDrake
hda, 304
NFS, 312
removable devices, 308
Samba, 310
disks, 395
DNS, 695
DocBook, 2
documentation
accessing, 49
Mandriva Linux, xxv
manuals, 51
DOS, 540
drag'n'drop, 131
Drakbug, 206
DrakConf, 201

e-mail
mailing lists, 375
E-mail
Newsgroup, 376
environment
desktop, 55
process, 422
variable, 389
eth0, 694
Ethernet
card, 693

F
fax, 183
FHS, 401
file
attribute, 418, 444
block mode, 410, 415
character mode, 410, 415
copying, 444
creating, 441
deleting, 442
deletion recovery, 367
find, 475
link, 410, 412
moving, 443
permissions, 320
renaming, 443
sharing, 312
socket, 411
file managers
Konqueror, 129
filesystem
damaged superblock, 367
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firewall
basic configuration, 323
configuration, 27
floppy, 308
auto-install, 32
boot disk images, 372
fonts
management, 278

G
gateway, 529
configuring, 265
GID, 383
GIMP, 153
globbing
character, 447
GNU/Linux
floppy boot disk, 374
GPL, 705
graphic tools
GIMP, 151
graphical interface
configuration, 26
group, 381
change, 445
GRUB, 24
reinstall, 366

H
HardDrake, 223
other devices, 225
hardware
configuration, 223
support, 3
troubleshooting, 225
hd_grub.img, 372
home
partition, 397

I
IDE
devices, 398
IMAP, 583
inode, 411
table, 411
install
alternatives, 372
installation
alternatives, 372
automated, 33
class, 11
replay, 32
save package selection, 33
updates, 31
installation options
kernel, 7
noauto, 7
text, 7
vgalo, 7
instant messenger, 93
internationalization, xxiii
Internet
chat, 93, 95
Firefox, 81
introduction, 65
Konqueror, 132
Linux web sites, 49
netiquette, 375
Newsgroup, 376
plugins, 87
IP
address, 688
routing, 690
IPX, 699
IRC, 95
ISDN, 697

K
KDE, 55
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desktop, 45
keyboard, 12
changing layout, 232
configuration, 26
Konqueror, 129
deleting files, 132
file manipulation, 131
file, moving, 131
linking files, 131
web, 132

L
language, 8
keyboard, 12, 232
LDAP, 22
legacy-free
desktops, 371
laptops, 371
legal disclaimer, 4
license, 10
LILO, 24
reinstall, 365
link
hard, 417
symbolic, 417
Linux, 37
log files
searching through, 281
login, 43
login mode
autologin, 326
configuring, 325
graphical interface, 325
logout, 43, 48
lpd, 249

M
MacOS, 541, 544
mailing
list, 375

man pages, 51
Mandriva Club, xxi
Mandriva Expert, xxi
Mandriva Linux, 376
configuration, 199
documentation, 49
mailing lists, xxi
security, xxi
uninstall, 33
upgrade, 11
upgrading, 214
Mandriva Linux Control Center, 201
Mandriva Store, xxii
Master Boot Record, 33
MBR, 33
MenuDrake, 271
add entry, 272
advanced features, 275
modems
linmodems, 371
winmodem, 371
modules, 427
mount points, 15
mouse
configuration, 26, 233
movie, 142
Kaffeine, 143
msec, 317, 320
multimedia
graphic tools, 151
movie, 142, 144
picture brightness, 164
picture contrast, 164
picture deletion, 163
picture gamma, 164
picture red-eye reduction, 166
picture resize, 166
picture rotation, 163
picture sharpen, 165
picture touch-up, 163
pictures from digital cameras, 162
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multiuser system, 43
MySQL, 613

N
NetBEUI, 699
NetBIOS, 699
netiquette, 375
netmask, 689
network
cable, 699
class, 689
configuration, 26, 688
connection, 253
Network Information System, 619
private, 690
proxy, 27
network.img, 372
networking, 685
network_drivers.img, 372
NFS
file sharing, 312
NIS, 22, 619
nVidia 3D graphics cards
OpenGL, 371

O
office
Open Office, 120
OpenOffice.org, 105, 113
openGL
ATI 3D Graphics Cards, 371
nVidia 3D Graphics Cards, 371
operating system, 37
OS/2, 548
owner, 444
change, 445

P
packages
graphical environment, 19
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individual selection, 19
installing, 18, 218
management, 209, 501
server, 19
workstation, 19
packaging, xxiii
ParkRpmdrake, 219
partition table, 303
partitions, 395, 434
bad blocks, 17
custom, 15
DrakX, 14
extended, 398
formatting, 16, 308
logical, 399
management, 303
NTFS, 1
pre-existing, 16
primary, 398
password, 382
management, 87
root, 21
pcmcia.img, 372
permissions, 445
Peter Pingus, xxvii
PID, 387
pipe, 450
anonymous, 413
file, 411
named, 413
PLIP, 698
Plug'n'Play
OS, 3
plugins
Java, 87
PnP OS, 3
POP, 583
PPP, 698
presentation software
Open Office, 120
primary

master, 398
slave, 398
printer, 3
add, 238
auto-configuration, 235
configuration, 26, 234
connection type, 249
default, 238, 244
edit, 238
expert mode, 239
local, 249
multi-function, 242
network, 249
options, 245
refresh, 239
remote lpd, 249
remote printers, 248
removal, 238
sharing, 239
SMB, 249
testing, 245
URI, 249
PrinterDrake, 235
printing, 178
process, 386, 421, 452
processes, 487
profile
boot, 206
programming, xxiii
prompt, 382, 388
proxy
media, 216

Q
Queen Pingusa, xxvii

R
RAM memory, 396
redirection, 449
remote access, 497

automation, 498
remote control, 341
resolution
changing display, 225
RFC, 687
root, 43
directory, 401, 423
partition, 396
password, 21
user, 383
window, 46
routing, 690
runlevel, 494

S
Samba, 310, 699
directories, importing, 310
scandisk, 1
scanner, 170
OCR software, 177
ScannerDrake, 170
SCSI
disks, 398
sector, 395
security
choose, 318
configuration, 27
level, 13
server
Network Information System, 619
services, 30
configuration, 27
configuration at start-up, 276
mail delivery, 583
session, 43
shell, 388, 441
globbing patterns, 447
sound card
configuration, 26
Soundblaster, 398
spreadsheet software
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OpenOffice.org, 113
ssh
client, 498
key, 498
server, 497
standard
error, 448
input, 448
output, 448
superblock
repairing, 367
swap, 395
partition, 396
size, 396
synopsis
command, xxvi
system request, 369

T
tabs, 85
TCP/IP, 687
text editors
Emacs, 455
vi, 460
time
adjust, 280
time zone
configuration, 26
settings, 281
timestamps
atime, 442
ctime, 442
mtime, 442
Token Ring, 699
troubleshooting, 357, 376
computer is slow, 372
filesystem, 367
hardware, 225
Mandriva Linux, 376
TV
configuration, 230
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tv card
configuration, 26
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udev, 400
UID, 383
uninstall, 33
UNIX®, 381
updates, 31
upgrade, 11
USB, 4
UserDrake, 287
users, 381
adding, 23, 289
generic, xxvii
management, 287
Peter Pingus, 288
Queen Pingusa, 288
usr
partition, 397
utilities
file-handling, 441

V
values
discrete, 447
video conferencing, 145
virus, 387

W
webcam, 145
WebDAV
mounting, 314
Webmin, 549
window
moving, 48
Windows, 37
file sharing, 310, 312
floppy boot disk, 373
windows 3.11, 540

windows 95/98, 532
windows NT/2000, 535
Windows XP, 531
word processor
OpenOffice.org, 105

X
X, 364
configuration, 365
X graphical server
configuration, monitor, 228
on boot-up, 229
x server
kill, 368
X Window System, 28
X-Chat, 95

753

754

